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Using This Online Manual

= Symbols Used in This Document
= Touch-enabled Device Users (Windows)

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»>» Note

* |cons may vary depending on your product.

Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

» Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. App Store, AirPrint and the AirPrint logo are trademarks of
Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play, Google Drive,
Google Apps and Picasa are either registered trademarks or trademarks of Google Inc.

» Adobe, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

» Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the
purpose of discussing and improving the Work, but excluding communication that is conspicuously
marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
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copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work, where such license applies only to those patent claims licensable by such
Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their
Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
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limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
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* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS I1S" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

--—-- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
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This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--—-- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2009, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
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IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

LEADTOOLS
Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote

products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
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Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon

Contents | > MNotes on Site Usage and Cookies

Online Manual

- series -

E Satug | E Change Preduct

&) Featured Topics

32 Important

+ This function may not be available in some countries/regions.

»» Note

The displayed screen may vary.
When searching from this page without entering your product's model name or your application's name,
all products supported by this guide will be considered for the search.

If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper

Enter "(your product's model name) load paper" in the search window and perform a search
Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1003" in the search window and perform a search
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Media Type : Flain Faper
Page Size - Letter 857017 Zacdiem

Start

»>» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions
Enter your application's name and a keyword for the function you want to learn about
Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Printer Functions

» Connecting Device to Printer Directly via Wireless LAN (Direct Connection)
» Managing Printer Conveniently Using Quick Utility Toolbox
» Available Connection Methods

» Managing Printer Status Using Device Management Console

32



Connecting Device to Printer Directly via Wireless LAN (Direct
Connection)

The printer supports "direct connection" in which you can connect to the printer wirelessly from devices (e.g.
smartphone, or tablet) without a wireless router.

Switch to "direct connection" to print wirelessly.

= Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct Connection)
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Managing Printer Conveniently Using Quick Utility Toolbox

Quick Utility Toolbox is a shortcut menu that lets you access the functions you want to use with one click.
After installing utilities compatible with Quick Utility Toolbox, they will be added to this menu. The Quick
Utility Toolbox provides a convenient way to quickly launch added utilities for making printer settings and
doing other management tasks.

Refer to the following for details.

= Quick Utility Toolbox Guide (Windows)
= Quick Utility Toolbox Guide (Mac OS)

L
A

34



Available Connection Methods

The following connection methods are available on the printer.

(tp)

Wireless Connection

* With a wireless router

USB Connection

Wireless Connection

There are two methods for connecting the printer to your device (e.g. smartphone or tablet). One method
is to connect using a wireless router, and the other method is to connect without using a wireless router.

The two connection methods cannot be used at the same time.
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If you have a wireless router, we recommend you use the method described in Connection Using a
Wireless Router.

When connecting another device while a device is already connected to the printer, connect it using the
same connection method as the connected device.

If you connect using a different connection method, the connection to the device in use will be disabled.

» Connection Using a Wireless Router

o Connect the printer and a device using a wireless router.
o Connection methods vary depending on the wireless router type.

> You can change network settings such as the SSID and security protocol on the printer.
—

o When the connection between a device and a wireless router is completed and O (Wi-Fi icon) is
displayed in the device's screen, you can connect the device to the printer using the wireless
router.

» Connection without Using a Wireless Router

o Connect the printer and a device without using a wireless router. Connect the device and the
printer directly using the printer's direct connection.

o If you connect a device connected to the Internet via a wireless router to the printer that is in the

direct connection, the connection between the device and wireless router will be disabled. In that

case, the connection of the device may switch to a mobile data connection automatically

depending on your device. Transmission fees for connecting to the Internet using a mobile data

connection apply.

In the direct connection, you can connect up to five devices at the same time. If you try to connect

another device while five devices are already connected, disconnect a device you do not use and

configure settings again.

Network settings such as the SSID and security protocol are specified automatically.

o

o
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Wired Connection

Connect the printer and a hub or router with an Ethernet cable. Prepare an Ethernet cable.

USB Connection

Connect the printer and a computer with a USB cable. Prepare a USB cable.

Restrictions

(Appears in a new window)
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Managing Printer Status Using Device Management Console

Device Management Console is software for checking the printer status or color calibrating the printer.
Use Device Management Console to:

* Check the status of a printer connected via a network or USB.
» E-mail the administrator in case of a printer warning or error.
+ Identify the color calibration status or perform color calibration.

Refer to the following for details.

= Device Management Console Guide (Windows)
= Device Management Console Guide (Mac OS)
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Handling and Use of Paper
» Paper

« Types of Paper

t.

Paper Sizes

t.

Using Paper Other Than Genuine Paper and feed confirmed Paper

t.

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

@« Printing on Paper Other Than Genuine Paper and feed confirmed Paper by
Adding a Media Type

« Paper Information List
« Updating paper information
» Handling rolls
« Loading Rolls on the Roll Holder
@« Loading the Upper Roll on the Printer
« Loading the Lower Roll on the Roll Unit (Option)
@« Changing the Type of Paper
@« Specifying the Paper Length
« Removing the Upper Roll from the Printer
« Removing the Lower Roll from the Roll Unit (Option)
« Removing Rolls From the Roll Holder
@ Clearing Jammed Roll Paper
@« Feeding Roll Paper Manually
@« Keeping Track of the Amount of Roll Paper Left
@« Specifying the Ink Drying Time for Rolls
« Specifying the Cutting Method for Rolls
« Cutting the Leading Edge of Roll Paper Automatically
@« Reducing Dust from Cutting Rolls

@ Roll Holder Set
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« Automatically Switch Rolls
» Handling sheets

@« Loading Sheets in the Printer

t.

Changing the Type of Paper

t.

Printing From a Desired Starting Point

t.

Removing Sheets

t.

Clearing a Jammed Sheet
» Basket
« Parts of the Basket
@« Using the Basket
« Example Basket Configurations
« Storing the Basket
» Roll Unit
« Parts of the Roll Unit

Roll Unit

t.

t.

Switching Roll Unit Modes

t.

Using the Roll Unit In Take-Up Mode

t.

Removing Printed Paper from the Roll Unit

» Media Configuration Tool Guide
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Paper

=» Types of Paper
=» Paper Sizes
=$ Using Paper Other Than Genuine Paper and feed confirmed Paper

=$ Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings

=$ Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type

= Paper Information List

=p Updating paper information
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Types of Paper

The following media types are supported by the printer. For details on the media types supported by the
printer, see "Paper Information List."

* Plain Paper

» Coated Paper

» Photo Paper

» Glossy Paper

* Proofing Paper

+ CAD-dedicated Paper Etc.
The Paper Information List includes the following information.

» Types of paper

» Paper handling

» Paper product specifications

» Use precautions

+ Setting of printer driver, control panel etc.

»>»Note

 For instructions on using paper not included in the Paper Information List, see "Using Paper Other Than
Genuine Paper and feed confirmed Paper."

» Method of Updating Supported Paper
Paper that is supported by the printer may be newly released on the Canon website.

To use newly released paper, register the latest paper information on the printer with the Media
Configuration Tool. (See "Updating paper information.")

»2»Important

» Even if you are not using the printer driver, you should install the Media Configuration Tool in order
to register the media types for your region in the printer.

(See "Media Configuration Tool Guide" (Windows).)
(See "Media Configuration Tool Guide" (Mac OS).)
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Paper Sizes

Rolls

Rolls that meet the following conditions are supported.

» Outer diameter is 6.7 in (170 mm) or less

* Inner diameter of paper core: 2 or 3 inches

* Printing side out

Roll Width Printer Driver Roll Paper Width Settings |Borderless Printing (*1)
609.6 mm (24.00 in) |24-in. Roll (609.6mm) Recommended
594.0 mm (23.39 in) [ISO A1/A2 Roll (594.0mm) Recommended
515.0 mm (20.28 in) |JIS B2/B3 Roll (515.0mm) Recommended
431.8 mm (17.00 in) |17-in. Roll (431.8mm) Recommended
420.0 mm (16.54 in) |1SO A2/A3 Roll (420.0mm) Possible(*2)
406.4 mm (16.00 in) | 16-in. Roll (406.4mm) Possible(*2)
355.6 mm (14.00 in) | 14-in. Roll (355.6mm) Recommended
329.0 mm (12.95in) [ A3+ Roll (329.0mm) Possible(*2)
300.0 mm (11.81in) [300mm Roll (300.0mm) Possible(*2)
297.0 mm (11.69 in) [ISO A3/A4 Roll (297.0mm) Possible(*2)
257.0 mm (10.12in) | JIS B4 Roll (257.0mm) Possible(*2)
254.0 mm (10.00 in) | 10-in. Roll (254.0mm) Recommended
203.2 mm (8.00 in) | 8-in. Roll (203.2mm) Possible(*2)

*1:For details on media types that can be used for borderless printing, see "Paper Information List."

*2:As opposed to standard borderless printing, there will be a small margin on the left and right because the paper

width is set a little bit smaller than the width of the document.

Sheets

Sheets of the following sizes are supported.

Paper Sizes Dimensions

ISO A1 594.0 x 841.0 mm (23.39 x 33.11 in)
ISO A2 420.0 x 594.0 mm (16.54 x 23.39 in)
ISO A2+ 431.8 x 609.6 mm (17.00 x 24.00 in)
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Paper Sizes

Dimensions

ISO A3 297.0 x 420.0 mm (11.69 x 16.54 in)
ISO A3+ 329.0 x 483.0 mm (12.95 x 19.02 in)
ISO A4 210.0 x 297.0 mm (8.27 x 11.69 in)

ISO B2 500.0 x 707.0 mm (19.69 x 27.83 in)
ISO B3 353.0 x 500.0 mm (13.90 x 19.69 in)
ISO B4 250.0 x 353.0 mm (9.84 x 13.90 in)

JIS B2 515.0 x 728.0 mm (20.28 x 28.66 in)
JIS B3 364.0 x 515.0 mm (14.33 x 20.28 in)
JIS B4 257.0 x 364.0 mm (10.12 x 14.33 in)

22"x34"(ANSI D)

558.8 x 863.6 mm (22.00 x 34.00 in)

17"x22"(ANSI C)

431.8 x 558.8 mm (17.00 x 22.00 in)

11"x17"(Ledger)

279.4 x 431.8 mm (11.00 x 17.00 in)

13"x19"(Super B)

330.2 x 482.6 mm (13.00 x 19.00 in)

Letter(8.5"x11")

215.9 x 279.4 mm (8.50 x 11.00 in)

Legal(8.5"x14")

215.9 x 355.6 mm (8.50 x 14.00 in)

24"x36"(ARCH D)

609.6 x 914.4 mm (24.00 x 36.00 in)

18"x24"(ARCH C)

457.2 x 609.6 mm (18.00 x 24.00 in)

12"x18"(ARCH B)

304.8 x 457.2 mm (12.00 x 18.00 in)

9"x12"(ARCH A)

228.6 x 304.8 mm (9.00 x 12.00 in)

DIN C2 458.0 x 648.0 mm (18.03 x 25.51 in)
DIN C3 324.0 x 458.0 mm (12.76 x 18.03 in)
DIN C4 229.0 x 324.0 mm (9.02 x 12.76 in)

20"x24" 508.0 x 609.6 mm (20.00 x 24.00 in)
18"x22" 457.2 x 558.8 mm (18.00 x 22.00 in)
14"x17" 355.6 x 431.8 mm (14.00 x 17.00 in)
12"x16" 304.8 x 406.4 mm (12.00 x 16.00 in)
10"x12" 254.0 x 304.8 mm (10.00 x 12.00 in)
10"x15" 254.0 x 381.0 mm (10.00 x 15.00 in)

44




Paper Sizes Dimensions

8"x10" 203.2 x 254.0 mm (8.00 x 10.00 in)

US Photo 16"x20" |406.4 x 508.0 mm (16.00 x 20.00 in)

Poster 20"x30" 508.0 x 762.0 mm (20.00 x 30.00 in)

13"x22" 329.0 x 558.0 mm (12.95 x 21.97 in)

Poster 300x900mm | 300.0 x 900.0 mm (11.81 x 35.43 in)

Custom Paper Size | 8.00 x 8.00 in (203.2 x 203.2 mm) to 24.02 x 70.87 in (610.0 x 1800.0 mm)

»>»Note

» For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or
"Setting Paper Dimensions (Custom Size)" (Mac OS).

» Borderless printing is not supported on sheets.
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Using Paper Other Than Genuine Paper and feed confirmed Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

»»Note

» For Canon genuine paper/feed confirmed paper, see "Paper Information List."

» Paper where the size is described in "Paper Sizes" (See "Paper Sizes.")
» Paper where the thickness is described in "Paper Thickness" in "Specifications” (See "Specifications.")
» Paper where bleeding and ink overflow does not occur when printing

» Paper that does not warp severely when loading the paper or printing

»2»Important

« If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely
no guarantees regarding print quality or paper feed properties. For Canon genuine paper/feed
confirmed paper, see "Paper Information List."

After loading the paper in the printer, select the media type in the control panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

Printing Using Existing Settings

You can print easily by selecting from existing settings provided in the printer control panel and printer
driver. (See "Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings.")

Printing Using Additional Settings

You can use the Media Configuration Tool function for adding custom paper to create settings suitable for
non-Canon genuine paper/feed confirmed paper and add as a new media type to the printer's Control
Panel and the printer driver for printing. (See "Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type.")
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Printing on Paper Other Than Genuine Paper and feed confirmed
Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the printer control panel and printer driver
depending on the media type you are using. The existing settings consist of general-purpose paper settings
provided for different media types.

»2»Important

» The Canon genuine paper settings provided in the printer control panel and printer driver are optimized
for Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

»>»Note

» For an overview of the media types, see "Types of Paper."

 For instructions on selecting the media type with the control panel, see "Types of Paper". For
instructions on selecting the media type with the printer driver, see "How to Open the Printer Driver
Setup Window" (Windows) or "How to Open the Printer Driver Setup Window" (Mac OS).

Choosing General-Purpose Paper Settings

These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "Paper Information List."

»P»Note

« If you cannot obtain the desired results by selecting the general-purpose paper settings, use the
custom paper adding function in Media Configuration Tool to create settings suitable for the paper
you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the printer control panel and printer driver.

For details on Media Configuration Tool, refer as follows.
* Media Configuration Tool Guide (Windows)
» Media Configuration Tool Guide (Mac OS)

»2»Important

» For details on how to select the added media type in the control panel, see "Changing the Type of
Paper."

* You can select the media type to be used in printing from Media Type in the Main sheet (Windows)
or Quality & Media (Mac OS) in the printer driver. For details, see "Main Tab Description"
(Windows) or "Quality & Media" (Mac OS).

» We recommend that you use an ICC profile created using commercially available profile creation
software to perform color management accurately on paper other than Canon genuine paper and
feed confirmed paper. You can register the ICC profile you created when creating a custom paper
with Media Configuration Tool.

(See "Adding Custom Paper" (Windows).)
(See "Adding Custom Paper" (Mac OS).)
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Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.
* Media Configuration Tool Guide (Windows)
» Media Configuration Tool Guide (Mac OS)

»2»Important

+ If you are using the Media Configuration Tool, the new Media Information File is downloaded
automatically when released on the Canon website. A computer connected to the Internet is
required to download the Media Information File.
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Handling rolls

=p | oading Rolls on the Roll Holder

=) | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

=$ Changing the Type of Paper

=$ Specifying the Paper Length

=$ Removing the Upper Roll from the Printer

=P Removing the Lower Roll from the Roll Unit (Option)

= Removing Rolls From the Roll Holder

=$ Feeding Roll Paper Manually

=$ Keeping Track of the Amount of Roll Paper Left

=p Specifying the Ink Drying Time for Rolls

=} Specifying the Cutting Method for Rolls

=) Cutting the Leading Edge of Roll Paper Automatically

=p Reducing Dust from Cutting Rolls

= Roll Holder Set
=$ Automatically Switch Rolls
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Loading Rolls on the Roll Holder

When printing on roll paper, attach the roll paper to the Roll Holder.

Roll paper comes in two types: 2-inch and 3-inch cores. If using 3-inch core roll paper, attach the 3-Inch
Paper Core Attachment to the Roll Holder and holder stopper.

&Caution

+ Set the roll on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and dropping a
roll may cause injury.

2»2Important

» When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.
We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

 Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding
problems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.

| ¥ L ‘ |-- e ] :}4Um11

+ Align the edges of the paper on both ends of the roll. This may cause feeding problems.

»>»Note

 For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information
List".

1. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from Roll Holder.
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22 Important

* Do not use the roll holder for feeding paper with the spacer (A) removed from the flange. It will
result in the paper being sent askew.

2. If using 3-inch core paper, align 3-Inch Paper Core Attachment tabs (A) with Roll Holder
holes (B) and insert firmly.

3. With leading edge of roll paper facing forward as shown, insert Roll Holder from right side of
roll. Insert firmly until roll paper touches flange (A) of Roll Holder.
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2»P»Important

* When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage the
Roll Holder.

4. If using 3-inch core roll paper, attach 3-Inch Paper Core Attachment to holder stopper.

Align the tabs (A) of the attachment with the holes (B) of the holder stopper, and insert firmly.

5. Insert holder stopper from left into Roll Holder as shown, and while holding in position (B),
push firmly until holder stopper flange (A) touches roll paper. Lift holder stopper lever (C)
from shaft to lock.
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Loading the Upper Roll on the Printer

Follow these steps to load rolls in the printer.

»2Important

+ Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be
advanced correctly when you turn the printer on.

» Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.").

»2Note

* When using the optional roll unit, you can also load roll paper on the roll unit separately from the printer
that is described here. (See "Loading the Lower Roll on the Roll Unit (Option).")

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.

- - -
PM R C PGYMBKFEKX B

There is no paper.
There is no paper.

There is no paper.

Maintenance

2»2Note

+ If the Home screen does not appear, tap the Home button.

2. Tap area.

3. Tap Load paper. or Replace paper, check message that appears, and then tap Yes.

P»»Note

« If any cut sheet has been fed, or roll paper that will not be used has been fed from Roll 1 (Upper),
a message is shown requesting you to remove it.

After following the instructions on the screen to remove the paper, redo the operation.

« If roll paper is loaded in Roll 1 (Upper) but Roll 1 (Upper) is not selected as the paper source, a
message asking you whether or not to change paper is displayed.

Tap Replace paper, remove the paper, and go to the next step.

4. Open top cover and lift output guide.
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5. Hold flanges (A) so that roll holder's white gear is on left, align roll holder shaft with roll
holder slot left and right guide grooves (B), and load.

&Caution

* Be careful not to drop the roll and hurt yourself when loading it.

 Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.

32»Important

« |If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,
remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

2»>»Note

 For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll
Holder."
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6. Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly
beneath it, and feed roll paper until you hear a sound.

»P»Important

« If the roll paper has become unwound, remove the slack before loading the roll paper.

* When feeding the leading edge of the roll paper, make sure the entire width of the roll paper is
separating and feeding from the roll. If the roll paper is fed with some of the roll paper still stuck to
the roll, the roll paper will be damaged.

* Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

« If the paper is wrinkled or warped, straighten it out before loading it.

 Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

» Depending on the paper, the roll paper may be scratched when being fed and not feed well. In this
case, you must feed the paper manually after setting Paper retention setting to Release on the
touch screen. Lift the release lever, advance the roll paper until its leading edge appears on
platen, lower the release lever, and then proceed to the next step. However, if Paper retention
setting is set to Release, automatic switching of the upper and lower rolls is not possible.

7. Lower output guide.
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9. Tap Start feeding.

The paper is now advanced.

10. Once paper feeding starts, you will need to do the following, based on the Manage
remaining roll amount setting and the barcode printed on rolls. (See "Keeping Track of
the Amount of Roll Paper Left.")

Manage re- |Barcodes |Printer Operation After the Paper is Fed
maining roll
amount
Disable Printed A menu for selecting the media type appears on the touch
screen.
Not prin- )
ted Operate the touch screen and select the media type to be used.
Enable Printed The type and amount of paper left is automatically detected
based on the barcode printed on the roll.
There is no need to specify the type and length of the paper.
Not prin- | A menu for selection of the media type and length is shown on
ted the touch screen.
Operate the touch screen, select the media type to be used, and
enter its length.
»P»Important

» Cut the edge of the roll using the Cut paper function if the edge is creased or soiled. (See
"Specifying the Cutting Method for Rolls.")
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* When selecting the media type on the touch screen, make sure the media type set in the printer
driver and the media type loaded on the printer match.

2»»Note

* For details on media types that you can select, see "Paper Information List."

+ Adjusting the printhead alignment with the type of paper to be used in printing may enhance
printing quality. (See "Automatic Adjustment to Straighten Lines and Colors.")
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Loading the Lower Roll on the Roll Unit (Option)

Follow these steps to load roll paper in the roll unit (Roll 2 (Lower)).

»2»Important

+ Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be
advanced correctly when you turn the printer on.

» Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.").

« If using the roll unit as the feed device, depending on the basket position, the ejected roll paper's cut
end enters the roll unit and may cause a paper jam or affect the print quality when set to "Borderless
Printing" or "Trim Edge First" when loading the paper. In this case, change the basket position, and then
print. (See "Example Basket Configurations.")

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.

. B . =]
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There is no paper.
There is no paper.
There is no paper.

Maintenance

2»»Note

« If the Home screen does not appear, tap the Home button.

2. Tap area.

3. Tap Load paper. or Replace paper, check message that appears, and then tap Yes.

2»»Note

« If any cut sheet has been fed, or roll paper that will not be used has been fed from Roll 1 (Upper),
a message is shown requesting you to remove it.

After following the instructions on the screen to remove the paper, redo the operation.

« If roll paper is loaded in Roll 1 (Upper) but Roll 1 (Upper) is not selected as the paper source, a
message asking you whether or not to change paper is displayed.

Tap Replace paper, remove the paper, and go to the next step.

4. Change Roll Holder Lock switch on roll unit to release position.
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5. Hold flanges (A) so that roll holder's white gear is on left, align roll holder shaft with roll
holder slot left and right guide grooves (B), and load.

&Caution

» Be careful not to drop the roll and hurt yourself when loading it.

* Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.
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2»2Important

« If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,
remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

>»>»Note

» For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll
Holder."

6. Change Roll Holder Lock switch on roll unit to locked position.
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8. Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly
beneath it, and feed roll paper until you hear a sound.

»P»Important

« If the roll paper has become unwound, remove the slack before loading the roll paper.

» When feeding the leading edge of the roll paper, make sure the entire width of the roll paper is
separating and feeding from the roll. If the roll paper is fed with some of the roll paper still stuck to
the roll, the roll paper will be damaged.

» Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

« If the paper is wrinkled or warped, straighten it out before loading it.

» Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

» Depending on the paper, the roll paper may be scratched when being fed and not feed well. In this
case, you must feed the paper manually after setting Paper retention setting to Release on the
touch screen. Lift the release lever, advance the roll paper until its leading edge appears on
platen, lower the release lever, and then proceed to the next step. However, if Paper retention
setting is set to Release, automatic switching of the upper and lower rolls is not possible.
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9. Tap Start feeding.

The paper is now advanced.

10. Once paper feeding starts, you will need to do the following, based on the Manage
remaining roll amount setting and the barcode printed on rolls. (See "Keeping Track of
the Amount of Roll Paper Left.")

Manage re- |Barcodes [Printer Operation After the Paper is Fed
maining roll
amount
Disable Printed A menu for selecting the media type appears on the touch
screen.
Not printed .
Tap media type loaded.
Enable Printed The type and amount of paper left is automatically detected
based on the barcode printed on the roll.
There is no need to specify the type and length of the paper.
Not printed [ A menu for selecting the media type and length appears on the
touch screen.
After tapping the media type loaded, enter the length of the pa-
per loaded on the touch screen.
»2»Important

» Cut the edge of the roll using the Cut paper function if the edge is creased or soiled. (See
"Specifying the Cutting Method for Rolls.")

» When selecting the media type on the touch screen, make sure the media type set in the printer
driver and the media type loaded on the printer match.

2»2Note

 For details on media types that you can select, see "Paper Information List."

« Adjusting the printhead alignment with the type of paper to be used in printing may enhance
printing quality. (See "Automatic Adjustment to Straighten Lines and Colors.")
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Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

If you continue using the same type of paper and set Keep media type to Enable, when you load paper, the
media type selected before Enable was set is selected automatically, eliminating the need to set the media
type. (See "Using the Same Type of Paper Regularly.")

»»Important

» For best printing results, the printer fine-tunes the print head height and the feed amount for each type
of paper. Be sure to select the type of paper to use correctly before printing.

» Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of
printed images may vary depending on the type of paper used. If margins and the size of images are
not as you expected, adjust the paper feed amount.

(See "Adjusting Feed Amount.")

* Rolls and sheets have different printing areas, and sheets having a larger bottom margin than rolls.

(See "Print Area.")

Changing the Type of Paper
3»Note

* When you load roll paper, a menu for selecting the media type appears on the touch screen. Tap the
media type.

If no barcode has been printed on the roll paper and you have set Manage remaining roll amount to
Enable, specify the roll length after selecting the media type. (See "Specifying the Paper Length.")

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.

L .
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(®1 Plain Paper

©z Plain Paper
B Plain Paper

Maintenance

»P»Note

« If the Home screen does not appear, tap the Home button.

2. Tap paper feed slot where paper whose type you want to change is loaded.
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3. Tap Paper settings.
4. Tap Type.

5. Tap media type of roll paper loaded in printer.

»¥»Important

» Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.

»P»Note

» For details on media types, see "Paper Information List." At the factory default settings, Plain
Paper is selected for the media type.

* When the release lever is operated, the settings automatically return to the last selected media
type.

Using the Same Type of Paper Regularly

Configure this setting so that current media type settings will be automatically selected when you load the
same type of paper later.

1. Tap Device settings on Home screen of touch screen.

Ready to print.

e Print from USB flash drive

1/ LAN settings

il Device settings t

w", Printer information

»2»Note

« |If the Home screen does not appear, tap the Home button.

2. Tap Paper-related settings.

3. Tap Keep media type.

4. Tap Enable.
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2»>»Note

» The specified media type setting is updated in the following situations.

* When using sheets, if you send a print job before loading a sheet, the media type setting is
updated to match the type of paper specified by the print job.

« If a barcode is printed on the roll paper and you have set Manage remaining roll amount to

Enable in the operation panel menu, the media type setting is updated to match the media type
specified by the barcode.

» To change the media type setting, see "Changing the Type of Paper."
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Specifying the Paper Length
When changing the length of paper after the paper has been advanced, specify the length as follows.

»2Note

+ Specify the roll paper length when you have set Manage remaining roll amount to Enable. (See
"Keeping Track of the Amount of Roll Paper Left.")

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.

| -
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(@)1 Plain Paper

(®)z Plain Paper
I Plain Paper

Maintenance

P»»Note

+ If the Home screen does not appear, tap the Home button.

2. Tap paper feed slot where paper whose length you want to change is loaded.

3. Tap Paper settings.

4. Tap Length.

5. Enter roll paper length.
Specify the roll length as follows.
1. Tap the gray numerical input field.
2. Tap the keypad appearing on the touch screen, enter the roll paper length, and then tap OK.
3. Check the entered length and tap OK.
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Removing the Upper Roll from the Printer

Remove rolls from the printer as follows.

»2Note

+ If you need to cut a printed roll, select Feed/cut in the printer menu and cut the roll paper at the desired
position. (See "Specifying the Cutting Method for Rolls.")

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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(@)1 Plain Paper

(®)z Plain Paper
I Plain Paper

Maintenance

P»»Note

+ If the Home screen does not appear, tap the Home button.

2. Tap area.

3. Tap Remove paper.

4. Tap Yes.
The roll is rewound.

»P»Important

+ If Manage remaining roll amount is set to Enable in the operation panel menu, a barcode is
printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the
amount of roll paper left. (See "Keeping Track of the Amount of Roll Paper Left.")
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5. Open top cover and lift output guide.
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»2Note

» For instructions on removing the Roll Holder from rolls, see "Removing Rolls From the Roll
Holder."

8. Lower output guide and close top cover.
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»P»Note

» To load new paper in the printer at this point, see "Loading the Upper Roll on the Printer."

* Clean inside the top cover before loading paper.

(See "Cleaning Inside the Top Cover.")
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Removing the Lower Roll from the Roll Unit (Option)

Follow these steps to remove roll paper from the roll unit.

»2Note

+ If you need to cut a printed roll, select Feed/cut in the printer menu and cut the roll paper at the desired
position. (See "Specifying the Cutting Method for Rolls.")

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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(®)z Plain Paper
I Plain Paper

Maintenance

P»»Note

+ If the Home screen does not appear, tap the Home button.

2. Tap area.

3. Tap Remove paper.

4. Check touch screen message and tap Yes.

The roll is rewound.

»P»Important

+ If Manage remaining roll amount is set to Enable in the operation panel menu, a barcode is
printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the
amount of roll paper left. (See "Keeping Track of the Amount of Roll Paper Left.")

Bose o e,
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5. Using both hands, rotate roll holder in direction of arrow to rewind roll paper.
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7. Hold roll holder by its flanges (A) and remove from roll holder slot.
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>»>»Note

* For instruction on removing the roll paper from the roll holder, see "Removing Rolls From the Roll
Holder."

* To load new paper in the printer at this point, see "Loading the Upper Roll on the Printer."
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Removing Rolls From the Roll Holder

1. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from roll holder.

2. Remove roll holder from roll paper.

b

3. To remove 3-Inch Paper Core Attachment, press tabs (A) inward and remove attachment.

« roll holder Side
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»2»Important

« Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If
paper is not stored properly, the printing surface may become scratched, which may affect the printing
quality when you use it again.
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Feeding Roll Paper Manually

After feeding the roll paper, you can move it forward and back.

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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Maintenance

2»2Note

+ If the Home screen does not appear, tap the Home button.

2. Tap or area.
3. Tap Feed/cut.

4. Tap or touch Advance and Rewind to move roll paper forward or back.

P»»Note

» Tapping Advance or Rewind moves the roll paper approximately 0.04 inches (1 mm).

Touching Advance or Rewind moves the roll paper until you release the key. If "Cannot advance
the paper any more." appears on the touch screen, release the key.

5. Tap OK when you have determined position of roll paper.
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Keeping Track of the Amount of Roll Paper Left

When you set Manage remaining roll amount to Enable in Device settings on the Home screen, the
amount of remaining roll paper and the media type information are printed as a barcode and text when the
paper is removed. When Manage remaining roll amount is set to Enable and you load roll paper with a
printed barcode, the media type and remaining amount are automatically detected after the roll paper is
loaded. The barcode will be cut off after it has been read.

. - =.-- m -I l'll-= &
W4 LR L L W
»2»Important

+ If the barcode on the roll paper is not detected, enter the media type and length on the touch screen.

Follow the steps below when setting Manage remaining roll amount to Enable.

1. Tap Device settings on Home screen of touch screen.

Ready to print.

8 Print from USE flash drive

1/ LAN settings

i Device settings |

w, Printer information

2»»Note

« If the Home screen does not appear, tap the Home button.

2. Tap Paper-related settings.

3. Tap Manage remaining roll amount.

4. Tap Enable.
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Specifying the Ink Drying Time for Rolls

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

»>Note

+ If the Cutter touches the print surface on which the ink is not dry, the paper surface may become
scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without allowing printed materials to fall after printing, set Cutting mode on the
printer menu to Eject cut. (See "Specifying the Cutting Method for Rolls.")

* The settings can also be made from the touch screen on the printer. From Paper settings, select
Paper settings > Advanced and set Pause between scans and Pause between pages.

Windows

1. Display the printer driver dialog box.

(See "How to Open the Printer Driver Setup Window.")

2. Select Main sheet and click Specify for Media Type.
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3. In the Paper Detailed Settings dialog box displayed next, select the desired values from
the lists for Between Pages and Between Scans in Drying Time, and then click OK.

(See "Main Tab Description.")

Paper Detailed Settings |
E Cirving Time
E Between Pages ﬂjmter Default v]
E EBetween Scans lPtrtet Diefault v]
E Rall Paper Margin for Safety
E Mear End Margin : LPII'II.H Dafault "J
Cut Speed: | Printer Defaul -

Calibration Value ; letel Default d ]

ﬁ@rﬂ [ Mirrar

Mac OS

1. Choose Print in the application menu.

2. Select Paper Detailed Settings panel.

Printer:  Canan i

Prasats:  Dafnult Sottings E

Copies: |1
Pagas: e

= Holes

Papar Gize:  Loyout wy TOT e
Caler Matching

Paper Handling %
Cover Page

Owientation:
¢ Chanity & Modia i
Paoll  \idional Sattings B

Print Qualiny; = Fast E
Black arsd White Phata Print

Tadd

fendaering Intart: | Perceptual {Phots) 2]

Print Proview

poF B | Hide Details cancel | [ELEED
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3. Select desired values from lists for Dry Time (Between Pages) and Dry Time (Between
Scans).

(See "Paper Detailed Settings.")

Printer: | Canon l
Presets: Dafault Settings Z]
Copies: |1
Pages: D AR
Fram: 1 to: 1
Paper Size: A4 B rowzrem
Driendation: T r TI- Scale: 100 %
Paper Dataied Settings B

Dry Time {Batween Pages):] Printer Default

Dry Time (Batwean Scans):]| Printer Default

1af Roll Papor Safety Margin: |~ Prisber Dafault

DoEmo

Cut Speed:  Printer Default

LUniciractional Printing

Calibration Value: | Printer Dofpult %]

poF B | Hide Datails cancel | [EEEN
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Specifying the Cutting Method for Rolls

How rolls are cut after ejection varies depending on printer settings.

Cutting Method Printer Setting Driver Setting
Automatic cut [ The roll is automatically cut by the cutter Roll Paper | Automatic | Automatic | Yes

blade according to the printer driver set- 1/Roll Paper | cut Cutting

tings. 2 > Paper See "Cut-

settings > :
Roll
Eject (when | Select this to move the cutter by touch Advanced |Eiect cut ting Roll Yes
, . Paper after

the paper screen operation and cut paper. With Auto- | 5 Cutting Brinting”
surface is be- | matic cut, the paper drops and may rub mode %g
ing scratch- [ against the basket, resulting in damage to fj -
ed / to wait the print surface, but you can cut using this ows).
for ink to dry) [ method and supporting the paper so that it See "Cut-

does not drop to avoid damage to the pa- ting Roll

per. Also, you can prevent paper that has Paper after

not dried from dropping by visually check- Printing”

ing the ink has dried, and then cutting the (Mac OS).

paper.

After printing, tap Cut paper and cut the

roll paper on the cutter blade.
Manual Select this if the paper cannot be cut on the User cut No, Yes, Print
(when using | cutter blade. Cut Guideline
media that Cut each page from the roll using scissors.
ca.anecut For continuous printing (if you will cut each
with the cut- page later), select Automatic Cutting >
ter blade Yes or select Print Cut Guideline.
Paper cutting | Select this when you want to cut the roll pa- [ Roll Paper |Yes No, Print Cut
(to have the | per by operating the cutter blade using the | 1/Roll Paper Guideline
roll cut at touch screen after printing with No or Print |2 >
your specified | Cut Guideline selected in Automatic Cut- | Feed/cut >
position) ting in the printer driver. Cut paper

Otherwise choose this option if you want to

cut the roll edge after loading a roll.

»P»Note

» Automatic and Eject are valid only when you have selected Automatic Cutting > Yes in the printer

driver.

» With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is

cut.

* Eject cut is the preset selection in Cutting mode for some types of paper. For this paper, we
recommend keeping the preset cutting mode.
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+ If documents printed using Automatic, Eject, or manual cutting are short, rolls are advanced a specific

amount before cutting to prevent problems with cutting and paper ejection. This may create a wider
bottom margin, in some cases.

Cut rolls manually in the following cases:

Eject (when the paper surface is being scratched / to wait for ink to dry)

=)

|
®

Select Eject cut, Print Stopped automatically Support the printed material so that
al the eul positien it does not fall and tap Cut paper lo
£ut the paper.
»¥»Important

* When cutting wide printed documents after ejection, have two people support the documents. If the
paper drops, printed documents may be damaged.

» Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

2»>»Note

» Once the following step has been performed, the procedure can be started from step 7 the next time.

* Printing the second and subsequent times

* Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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(=1 Plain Paper

@z Plain Paper
B Plain Paper

| Maintenance

>2»Note

« |If the Home screen does not appear, tap the Home button.
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2. Tap paper feed slot where roll paper for which you want to set cutting method is loaded.
3. Tap Paper settings.

4. Tap Advanced.

5. Tap Cutting mode.

6. Tap Eject cut.

7. Print the job.

When printing is finished, the printer will stop without cutting.

8. While holding printed document to prevent it from dropping, tap Cut paper to cut roll
paper.

Manual (when using media that cannot be cut with the cutter blade)

U

|©
Salect User cut. Brint Tap Advance paper lo feed Tap OK to rewind
thi paper to the cutting the paper.

position and cut it manually.

2»P»Note

» Once the following step has been performed, the procedure can be started from step 8 the next time.
* Printing the second and subsequent times

* Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of touch screen.
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Ready to print. I
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(®1 Plain Paper

©z Plain Paper
B Plain Paper

,  Maintenance

>»2»Note

« |If the Home screen does not appear, tap the Home button.

. Tap paper feed slot where roll paper for which you want to set cutting method is loaded.

. Tap Paper settings.

. Tap Advanced.

. Tap Cutting mode.

. Tap User cut.

. When Do you want to set to detect the leading edge of the paper? is displayed, select
Detect (recommended).

. Print the job.

The printer stops advancing the paper after printing.

. Tap Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.

. Cut the roll paper manually with scissors or the like.
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11. Tap OK.

After the roll is rewound, it stops automatically.

Manual (for paper of which the leading edge rubs the printhead)

U

|©
Saolect User cut. Brint Tap Adwance paper to fead Tap OK to rewind
the paper o the cutling the paper.

position and cut it manually.

2»>»Note

» Once the following step has been performed, the procedure can be started from step 8 the next time.

* Printing the second and subsequent times

* Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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»P»Note

« |If the Home screen does not appear, tap the Home button.

2. Tap paper feed slot where roll paper for which you want to set cutting method is loaded.

3. Tap Paper settings.

4. Tap Advanced.

5. Tap Cutting mode.

6. Tap User cut.

7. When Do you want to set to detect the leading edge of the paper? is displayed, select
Do not detect.
22Note

* If you set the detection of paper leading edge to Do not detect, a margin of about 10 cm is
created at the paper leading edge when printing starts.

» When the detection of paper leading edge is set to Do not detect, printing will start at the
position at which the roll was set for the first printing after replacing a roll. Thus, the margin of
the paper leading edge will enlarge.

(See "Loading the Upper Roll on the Printer.")

8. Tap Back button twice to display roll paper screen.

9. Tap Feed/cut.

10. Tap or touch Advance or Rewindand align paper's leading edge with position (A).
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11. Print the job.

The printer stops advancing the paper after printing.

12. Tap Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.

13. Cut the roll paper manually with scissors or the like.

14. Tap OK.

After the roll is rewound, it stops automatically.

Paper cutting (to have the roll cut at your specified position)

Do you want to cut
the paper?

Tap Rewind and Advance Cul paper
to feed the paper o the
cutting position,

1. Tap paper settings display area on Home screen of touch screen.
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Ready to print. I
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>»2»Note

« |If the Home screen does not appear, tap the Home button.

. Tap paper feed slot where roll paper you want to cut is loaded.

. Tap Feed/cut.

. Tap or touch Advance or Rewind to feed roll paper to desired cutting position.

. Tap Cut paper.

. Tap Yes.

After the roll paper is cut, it is rewound automatically.
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Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the touch screen menu.

The following settings are available for Trim edge first.

* Auto
If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the
printer.

» Auto (default length)
The amount to cut from the leading edge of the paper varies depending on the media type and is cut to
a prescribed length. For the leading edge precut length, see "Paper Information List".

» Auto (specified length)
Specify the amount to cut from the leading edge of paper on the touch screen. The amount to cut from
the leading edge can be specified in the range of lengths that appear on the touch screen. The range of
lengths differs according to the media type.

»2Note

» The amount to cut from the leading edge of paper cannot be set shorter than the length that
appears on the touch screen.

* Manual
The amount to cut from the leading edge of paper can be adjusted by using the touch screen.

To cut the paper after adjusting, tap Cut paper and Yes.
After cutting the paper, tap Complete paper loading.

»>»Note

« If you do not tap Complete paper loading after cutting the paper, you cannot print the next job.

+ OFF
The edge is not cut and scraps are not removed.

Follow these steps to change the Trim edge first setting.

1. Tap paper settings display area on Home screen of touch screen.
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Ready to print.
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Maintenance

»2Note

+ If the Home screen does not appear, tap the Home button.

: Tapor.

. Tap Paper settings.
. Tap Advanced.
. Tap Trim edge first.

. Tap desired Trim edge first settings.

This setting takes effect the next time you load a roll.
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Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the touch screen menu, which will coat the leading and trailing edges of the
printed document with ink. As a result, you can reduce problems with the print head. You can set Cut-dust
reduction according to the media type.

( I

-

Cut Position
The ink is r,'/
coated.

\am <

»2»Important

* Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight
paper. If not cut properly, the paper may jam.

* Borderless printing is not available when Cut-dust reduction is set to ON. When performing borderless
printing, set Cut-dust reduction to OFF.

Follow these steps to set Cut-dust reduction to ON.

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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>»»Note

+ If the Home screen does not appear, tap the Home button.

2. Tap or Ok area.

3. Tap Paper settings.
4. Tap Advanced.

5. Tap Cut-dust reduction.
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6. Tap ON.
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Automatically Switch Rolls

By using the optional roll unit as a roll paper feed device, you can load an upper roll (Roll 1 on printer) and a
lower roll (Roll 2 on the roll unit), and print on while automatically changing between Roll 1 and Roll 2
depending on the print job.

For details on how to switch between Roll 1 and Roll 2, see "How to Switch Paper Rolls" (Windows) or "How
to Switch Paper Rolls" (Mac OS).

»P»Important

+ If Paper retention setting is set to Release, automatic switching of roll paper cannot be used.
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Handling sheets

=) | oading Sheets in the Printer

=p Changing the Type of Paper

=$ Printing From a Desired Starting Point

=$ Removing Sheets

=$ Clearing a Jammed Sheet

94



Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

»2Important

* Printing on sheets is supported only when using the Stand. However, paper that is up to 16.5 inches
(420 mm) in length can also be loaded even without using a Stand.

» Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.

* Load the paper straight. Loading paper askew will cause an error. (See "1317.")

»>»Note

» Before loading cut sheets, check whether or not the inside of the top cover or the output guide is soiled.
If these areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top
Cover.").

+ Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1. Select sheets as the paper source.

+ If a print job was received
Sheets are automatically selected, and the media type and size specified by the print job are
shown on the touch screen.

Tap OK and Load paper..
+ If no print job was received
1. Tap paper settings display area on touch screen.
Ready to print.
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»2»Note

+ If the Home screen does not appear, tap the Home button.

2. Tap D area.

3. Tap Load paper. or Replace paper.
»>»Note

* If any paper has been advanced that will not be used, a message is shown requesting you to
remove it.
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Follow the instructions on the screen to remove the paper, and redo the operation.

2. Open top cover and lift release lever.

»2Important

» Do not touch Linear Scale (A), carriage shaft (B), or Ink Tube Stabilizer (C). Touching these parts
may damage them.

A B C

3. Place cut sheet with the print side up, insert in portrait orientation between platen (A) and
paper retainer (B), and align paper's far edge using the following steps.

1. Load while aligning with right side paper alignment line (C).

2. Align far edge of inserted sheet with leading edge of paper alignment line (D) as shown.
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When you insert the sheet, it will adhere automatically to the surface of the platen.

»P»Important

* Load the sheet so that it is parallel to the right paper alignment line (C). Loading paper askew will
cause an error.

» Warped paper may rub against the print head. Straighten paper if it is warped before loading.

2»»Note

* You can also align the cut sheet based on its near edge. In this case, load the cut sheet aligning
its near edge with marks (A) on the platen and the right edge with the right-side paper alignment
line (B).

* You can adjust the vacuum strength holding the paper against the platen when the release lever is
up. If it is difficult to load the paper, tap Suction on the touch screen and adjust the vacuum
strength. You can adjust the vacuum strength to 5 levels.

However, even if you increase the suction, it may not be sufficient to hold some types of paper
against the platen well. In this case, use your hand to load the paper.

» Sheets are held in place by suction through holes on the platen. Although the suction may
produce a noise when paper is loaded in some positions, it does not indicate a problem. If the

97



noise is distracting, try moving the paper over slightly to the left or right (up to 0.039 in /1 mm)
while keeping it parallel to the paper alignment line.

» The suction remains on for about 30 seconds during loading. If you cannot finish loading a sheet
during this time, pull the sheet away and reinsert it to start the suction again.

4. Lower release lever and close top cover.

+ If a print job was received
Tap OK to feed the paper and begin printing.

* If no print job was received
A menu for selecting the media type appears.

Select the media type loaded and tap OK.

The printer now starts feeding the paper.

2»2»Note

 For details on media types that you can select, see "Paper Information List."
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Printing From a Desired Starting Point

Print on sheets from a desired starting point as follows.

Setting Detect paper width to Disable

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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»P»Note

« If the Home screen does not appear, tap the Home button.

2. Tap D area.

3. Tap Paper settings.
4. Tap Advanced.

5. Select Detect paper width and tap Disable.

Load paper in the desired position to start printing from

Follow these instructions to load paper at the desired starting position for printing when Detect paper
width is set to Disable.

1. If you did not send a print job in advance, a menu for selection of the type of paper is
displayed.
Tap media type loaded.
2»2Note

« If a print job was received before the paper was fed, the media type and size specified by the
job are shown on the touch screen.

Go to step 2.
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2. When "[Detect paper width] is disabled. Do you want to keep it disabled and
continue?" appears on touch screen, tap Keep it disabled and continue.

3. Open top cover and check position where paper is loaded.

To start printing from the current position, close the top cover.

To reposition the paper, lift the release lever.

4. Load paper keeping right edge of paper aligned with extended line of paper alignment line
(A) on right side of printer and position from which to start printing aligned with groove (B)
at far end of platen.
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6. When screen for selecting paper size appears, select size of paper loaded.
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Removing Sheets

Remove sheets from the printer as follows.

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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2»2Note

+ If the Home screen does not appear, tap the Home button.

2. Tap D area.
3. Tap Remove paper.
4. Check touch screen message and tap Yes.

5. When instructions for removing sheet appear on touch screen, lift release lever while
holding sheet, and remove sheet.
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6. Lower release lever.
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=$ Parts of the Basket

=) Using the Basket

=$ Example Basket Configurations

= Storing the Basket
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Parts of the Basket

C D E B

A. Basket Rod (tag side)
Secures the cloth basket to the tips of the basket arm.

B. Basket Arm
Retains the basket rod (tag side).

By changing the length and the angle, you can make the basket suitable for various conditions.

When not using the basket, you can lower it and store alongside of the stand. (See "Storing the
Basket.")

C. Basket
A cloth tray that catches ejected documents.

D. White Tag
Marks indicating basket attachment orientation.

E. Basket Rewind Button
Press this button when rewinding the basket after it has been wound on the basket rod (tag side).

F. Basket Rod (cord side)
Secures the cloth basket on the rod holder.

G. Rod Holder
Retains the basket rod (cord side).

For instructions on using the basket, see "Using the Basket."
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Using the Basket

By changing the following four items for the basket, which is a part of the optional Stand, you can use the
basket in various ways to suit your application.

» Length of basket arm
+ Tilt of basket arm
+ Attachment position of basket
» Length of basket
This section describes how to change the basket.

For specific examples of basket use, see "Example Basket Configurations."

»>»Important

* When changing the position of the basket, first return the basket to a unwound state while pressing the
basket rewind button on the right end of the basket rod (tag side), and then make the change.

+ If the basket rod (tag side) has come off the basket arm, attach it by inserting the projections on both
ends of the basket rod (tag side) into oval holes on the tip of the basket arm.

* When moving the printer, remove the basket.
» Do not apply excessive force to the basket. Doing so may damage the basket.

« If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.

Changing Length of basket arm
You can change the length of the basket arm in two steps.
To lengthen, expand the left/right basket arm in the direction of the arrow.

To shorten, contract the left/right basket arm in the opposite direction of the arrow.
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»P»Important

* When lengthening the basket arm, first return the basket to an unwound state while pressing the
basket rewind button on the right edge of the basket rod (tag side), and then make the change.

Changing Tilt of basket arm

You can change the tilt of the basket arm in three steps.

2

o
»P»Important

« If you are changing the angle of the basket arm, make sure the thick part of the basket arm is pulled
out as far as possible.

* When changing the angle of the basket arm, hold the thick part of the left/right basket arm, and adjust
them.

Changing Attachment Position of basket
You can attach the basket rod (cord side) to the stand's rod holder or the front of the printer.

To attach, hang both sides of the basket rod (cord side) on the paired attachment locations shown in the
illustration.
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3P»Important

* When attaching the basket rod (cord side) to the front of the printer, make sure both ends of the rod
(A) are securely hooked onto the attachment parts.

Changing Length of basket
You can adjust the basket length by rotating the basket rod (tag side).
To shorten, rotate the basket rod (tag side) in the direction of the arrow to wind the basket.

To lengthen, rotate the basket rod (tag side) in the opposite direction of the arrow while pressing the
basket rewind button (A) on the right end of the basket rod (tag side). You can return the wound basket to
its original position.
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Example Basket Configurations

Various positions are possible for the basket that collects the printed materials.

In this section, we present the following five positions as examples of using the basket. Switch the position
of the basket to suit to the media type and the print job.

» Using Without roll unit (Position 1)

» Using With roll unit (Position 2)

* Printing on Large-Format or Easily Damaged Paper (Position 3)

» Stacking Printed Materials (Position 4)

* Moving Printed Materials to Next Work Area Immediately (Position 5)

For instructions on switching the basket position, see "Using the Basket."

»P»Important

* If replacing the roll paper or using the roll unit as a take-up device, you must store the basket. For
instructions on storing the basket, see "Storing the Basket."

« If the printed materials collected are damaged or folded, select Eject cut in Cutting mode or use the
basket in a different position. (See "Specifying the Cutting Method for Rolls.")

»>»Note

+ For details on the printer dimensions when using the basket, see "Specifications."

Using Without roll unit (Position 1)

You can use the basket in the following positions when not using the roll unit.

»2»Important

» The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.
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* If using the roll unit as a feed device, we recommend using it as described in "Using With roll unit
(Position 2)".

« If using the roll unit and using the Position 1 basket, the printed materials may come in contact with

the roll unit depending on the paper, resulting in damage.

« If using the roll unit as a feed device and using the Position 1 basket, the ejected roll paper's cut end
enters the roll unit and may cause a paper jam or affect the print quality when set to Borderless
Printing or Trim edge first when loading the paper.

* Roll paper up to 62 inches (1,575 mm) in length can be collected in the basket. If printing on longer
roll paper, use as described in "Printing on Large-Format or Easily Damaged Paper (Position 3)" or
use with the roll unit as the take-up device.

Using With roll unit (Position 2)

You can use the basket in the following positions when using the roll unit as a feed device.
This position is useful also when rewinding printed roll paper by hand.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, and extend the basket arm as far as possible at the angle shown to achieve this position.

You can adjust the basket length so that it is easy to use.

»2»Important

* You can place up to approximately 4.41 Ibs (2 kg) of printed materials in the basket. If the weight of
the printed materials is greater than that, the basket may fall over.

Printing on Large-Format or Easily Damaged Paper (Position 3)
If printing on large-format or easily damaged paper, you can use the basket in the following position.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible, and lower it to the angle shown. Next, adjust the length
so that the basket is pulled into this position.
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»¥»Important

» Always select Eject cut in Cutting mode when used in this position. If you select Automatic cut, the
printed materials may be damaged. (See "Specifying the Cutting Method for Rolls.")

» Be extra careful when using paper that tends to curl or is damaged easily in this position.

» With some types of paper, the leading edge may curl or bend during ejection. In this case, straighten
out the paper. Printed documents may be damaged if the paper is curled or bent.

* Depending on the paper, the paper may be caught between the output guide and the basket when
being ejected. In this case, fix the paper that is caught. If the paper is caught, printed documents may
be damaged.

Stacking Printed Materials (Position 4)

You can use the basket in following positions when you want to stack printed materials.

Move the basket rod (cord side) to the lower of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible in the angle shown. Next, adjust the length so that the
basket is pulled into this position.
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»2»Important

* You can stack up to 10 sheets of A2 Portrait Glossy Photo Paper and 20 sheets of Heavyweight
Coated Paper HG with the basket in this position. If you stack more than this, it may damage the print
side of the paper or cause the basket to fall over.

+ In the following cases, use as described in "Using Without roll unit (Position 1)" or "Using With roll
unit (Position 2)". If printing multiple pages in these positions, print after removing each sheet.

» Paper other than Glossy Photo Paper/Heavyweight Coated Paper HG
» Printed materials other than A2 portrait
» Paper curls an extreme amount due to paper characteristics and printing environment

« If there is not much paper remaining on the roll, and the paper curls an extreme amount

Moving Printed Materials to Next Work Area Immediately (Position 5)

You can use the basket in the following position when moving the printed materials to the next work area
immediately.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible in the angle shown. Next, adjust the length so that the

basket is pulled into this position.

»2»Important

» Be extra careful when using paper that tends to curl or is damaged easily in this position.

» With some types of paper, the leading edge may curl or bend during ejection. In this case, straighten
out the paper. Printed documents may be damaged if the paper is curled or bent.

» Depending on the paper, the paper may be caught between the output guide and the basket when
being ejected. In this case, fix the paper that is caught. If the paper is caught, printed documents may
be damaged.
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Storing the Basket

Store the basket in the following two positions when not in use. Select the position to suit the circumstances.

« If Changing Roll Paper or Using roll unit as Take-up Device

» Using Without basket (Only When roll unit Is Not Used)

If Changing Roll Paper or Using roll unit as Take-up Device

If replacing the roll paper or using the roll unit as a take-up device, store the basket.

You can store the basket, by attaching the basket rod (cord side) to the rod holder, lowering the basket arm
until level, and then pushing as far back as possible.

»2»Important

+ If changing the basket position, first release and rewind the basket. If it is not released and rewound,
the change may not be performed smoothly, or the basket may be damaged. (See "Using the
Basket.").

* If you are changing the angle of the basket arm, make sure the thick part of the basket arm is pulled out
as far as possible.

« If the basket rod (tag side) has come off the basket arm, attach it by inserting the projections on both
ends of the basket rod (tag side) into oval holes on the tip of the basket arm.

» Do not apply excessive force to the basket. Doing so may damage the basket.

Using Without basket (Only When roll unit Is Not Used)

If you are not using the roll unit, you can easily store the basket by holding the thick parts of the left/right
basket arm in the Position 1 (See "Example Basket Configurations.") state, and moving them in the
direction of the arrow.
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Roll Unit

=} Parts of the Roll Unit

=p Roll Unit
=$ Switching Roll Unit Modes

=$ Using the Roll Unit In Take-Up Mode

=$ Removing Printed Paper from the Roll Unit
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Parts of the Roll Unit
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. Roll Holder Lock Switch

Locks and releases the Roll Holder loaded in the roll unit.

. Feed Mode Lamp

Lights up when you have selected the feed mode on the roll unit.

. Auto Take-up Lamp

Lights up when the paper is being taken up.

. Pause Lamp

Lights up when the paper winding is paused.

. Take-up Button

You can rotate the roll unit the desired amount as long as winding is not in progress. When the winding
direction is set to inward winding, the unit takes up the paper; when it is set to outward winding, the unit
rewinds the paper.

. Rewind Button

You can rotate the roll unit the desired amount as long as winding is not in progress. When the winding
direction is set to inward winding, the unit rewinds the paper; when it is set to outward winding, the unit
takes up the paper.

. Auto Take-up/Pause Button

Pauses and resumes the taking up of paper.

. Inward/Outward Winding Changeover Switch

Changes the winding direction when the paper is wound (inward winding and outward winding).

. Take-up Mode Lamp

Lights up when you have selected the take-up mode on the roll unit.

. Roll Holder Slot

Slide the Roll Holder into these guide grooves.

. 3-Inch Paper Core Attachment

Attaches to the Roll Holder when you are using a roll paper with a 3-inch paper core.

Feed Flap Switch
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Change the feed flap position depending on the roll unit mode.

M. Roll Holder
Load the roll on this holder.

N. Holder Stopper
This part secures the roll paper on the Roll Holder.
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Roll Unit

The roll unit functions as a feed device that can accommodate an additional roll for a total of two rolls on the
printer and as a take-up device that automatically takes up the printed roll paper.

Switch between these two functions depending on the circumstances.

For instructions on attaching the roll unit, see the Roll Unit Setup Guide.
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Switching Roll Unit Modes

Before using the roll unit, follow these steps to select the mode you want to use.

»2®Important

+ After switching the roll unit function, you must use a separate computer to apply the roll unit settings to
the printer driver. For details, see "Reflect Roll Unit Settings in the Printer Driver" (Windows) or "Reflect
Roll Unit Settings in the Printer Driver" (Mac OS).

+ If you change the roll unit from a take-up device to a feed device, first cut the paper that has been taken
up.

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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»2»Important

+ If the Home screen does not appear, tap the Home button.

2. Tap or area.

Paper settings

= Plain Paper
©: A3

—  Plain Paper
©: 567.8mm

Plain Paper
r Ad

3. Change function of roll unit.

» Using as feed device
1. Tap Roll unit use setting.

2. Tap ON when message confirming roll unit's change to feed mode appears.
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»2»Note

+ If you change the mode without cutting the roll paper with the printer's cutter, a screen
confirming whether or not the paper taken up has been cut appears after you tap ON. If
the paper has not been cut, select No and cut the paper that has been taken up first.

3. Load roll paper on roll unit.

For details, see "Loading the Lower Roll on the Roll Unit (Option)."

» Using as take-up device
1. Tap Roll unit use setting.

2. Tap ON when message confirming roll unit's change to take-up mode appears.

3. Tap to select paper cutting settings when using take-up mode.

»P»Note

* If you selected Do not cut, the roll paper will not be cut after printing regardless of the
Cutting mode setting (See "Specifying the Cutting Method for Rolls.") on the printer.
Select this option when you want to print multiple pages consecutively without cutting.

If you selected Use the cutting mode setting, cutting for each page will be performed
according to the Cutting mode setting (See "Specifying the Cutting Method for Rolls.") on
the printer.

If you select Use the cutting mode setting, and Automatic Cutting is set in the Cutting
mode settings (See "Specifying the Cutting Method for Rolls.")on the printer, we
recommend setting Wind up after cutting to Enable. When set to Disable, a printed
document that has been taken up is cut automatically without being pressed, resulting in
fraying.

« If roll paper is loaded from the roll unit to the printer, a screen confirming whether or not to
remove the roll paper appears. If you select Yes, the roll paper is positioned so that it can
be removed and the roll unit changes to a take-up device.

4. Tap Yes or No when message confirming whether roll unit will be used immediately in take-up
mode appears.

If you tap Yes, the steps for loading the paper on the roll unit appear on the touch screen.

If you tap No, the operation ends here. Load the paper on the roll unit when printing. However,
in this case, you must load the paper while printing is progressing, so instructions will not
appear on the touch screen.

For details on loading paper on the roll unit set as a take-up device, see "Using the Roll Unit In
Take-Up Mode."

»P»Note

« If you select Yes, a margin of approximately 23.62 inches (600 mm) is generated at the
leading edge because the roll paper advances to the roll unit before printing.
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Using the Roll Unit In Take-Up Mode

»2»Important

For details on the roll paper compatible with winding, see "Paper Information List.".

Before loading the roll paper to be taken up on the roll unit, set the roll unit mode to take-up device on
the printer touch screen. (See "Switching Roll Unit Modes.")

The following operation assumes that the roll holder is not installed on the roll unit and that roll paper is
not loaded on the roll holder. If the roll holder is installed on the roll unit, first remove the roll holder from
the roll unit, and then remove the roll paper loaded on the roll holder. (See "Removing the Lower Roll
from the Roll Unit (Option).") (See "Removing Rolls From the Roll Holder.")

Paper winding is possible until the outer diameter of the wound paper is the same as the outer diameter
of the holder stopper.

When printing on lightweight paper or without a border, the border of the paper may get wrinkled
coming in contact with the roll holder, resulting in poor winding. If these problems occur when winding
using a 2-inch core, remove the spacer held in place by 4 hex screws on the roll holder flange, and then

wind.

1. Store basket. (See "Storing the Basket.")

2. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),

remove holder stopper from roll holder.

=\ 6
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If taking up roll paper whose paper core has an inner diameter of 3 inches (76.2 mm), insert
3-Inch Paper Core Attachment in roll holder and holder stopper.

Align the 3-Inch Paper Core Attachment tabs (A) with the holes on the roll holder or holder stopper (B)
and insert firmly.
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roll holder Side holder stopper Side

2»2Important

» We recommend using a paper core that is wider than the paper to be wound when winding paper.
If you use a narrower paper core, use with a gap between the holder stopper and the paper.

» Always use a paper core for winding that is the same thickness or is thicker than the roll paper's
paper core. If you use a paper core that is thinner, it may affect take up.

5. Insert holder stopper from left into roll holder as shown, and then while holding in position

(B), push firmly until holder stopper flange (A) touches roll paper. Lift holder stopper lever
(C) from shaft to lock.

6. Change Roll Holder Lock switch on roll unit to release direction.
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7. Hold flanges (A) so that roll holder's white gear is on left, align roll holder shaft with roll
holder slot left and right guide grooves (B), and load.

8. Change Roll Holder Lock switch on roll unit to lock direction.
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9. Change the feed flap switch on top of the roll unit so that the switch indicator (A) is aligned
with e (B) position on the take-up icon.

10. Change Inward/Outward Winding Changeover switch on roll unit to desired winding
direction.
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2»>Note

 For the winding direction of the roll paper, you can select either outward winding to make the
printed surface on the outside of the roll or inward winding to make the printed surface on the
inside of the roll.

11. Follow these steps to secure the leading edge of the roll paper to the paper core with tape.

+ If message appears on touch screen to confirm whether or not to advance paper automatically so
it can be secured with tape
1. Tap Yes.

The leading edge of the roll paper advances until it is close to the roll unit.

2. Hold center of leading edge of roll paper, align right edge of take-up spool paper core's right
edge and tape center to paper core while pulling on roll paper evenly.

Outward Winding Inward Winding

»¥»Important

+ If winding with inward winding, you must pass the leading edge of the roll paper to the
back of the paper core and secure with tape. If this operation is difficult, you can also
remove the roll holder, push the roll paper into the back, reinstall the roll holder, and pass
the roll paper to the back of the paper core.

3. Align right edge of roll paper to right edge of paper core while pulling on roll paper evenly, and
secure with tape.

4. While making sure that roll paper is flat, secure left edge of roll paper to paper core with tape.
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Outward Winding Inward Winding

»¥Important

» Secure the left and right edges of the roll paper with tape within 1.97 inches (50 mm) of
the edges so that neither end of the roll paper lift up.

» When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a
rewinding problem may result.

* If you use a paper core narrower than the paper to be wound, adjust the position of the
holder stopper, so that there is a gap between the holder stopper and the paper.

5. Make sure the leading edge of the roll paper is not lifting up from the paper core, and if there
are places lifting up, tape in additional places so that the paper does not lift up.

6. Push roll holder downward, check that roll holder is not lifting up, and tap OK.

Outward Winding Inward Winding

2»2Important

« If the roll holder lifts up, it may cause an error.

7. To stabilize operations when starting taking up, advance roll paper with operation panel and
wind roll paper approximately one revolution. (See "Feeding Roll Paper Manually.")

8. Push roll holder downward again, and check that roll holder is not lifting up.
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The winding preparation is complete. When printing to the roll starts, the roll paper can be
automatically wound.
 If Ready to print. appears on touch screen
1. Manually advance roll paper (See "Feeding Roll Paper Manually.") or start printing, and wait
for leading edge of roll paper to reach roll unit.

2. Hold center of leading edge of roll paper, align right edge of take-up spool paper core's right
edge and tape center to paper core while pulling on roll paper evenly.

Outward Winding Inward Winding

»¥Important

+ If winding with inward winding, you must pass the leading edge of the roll paper to the
back of the paper core and secure with tape. If this operation is difficult, you can also
remove the roll holder, push the roll paper into the back, reinstall the roll holder, and pass
the roll paper to the back of the paper core.

3. Align right edge of roll paper to right edge of paper core while pulling on roll paper evenly, and
secure with tape.

4. While making sure that roll paper is flat, secure left edge of roll paper to paper core with tape.
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Outward Winding Inward Winding

»¥Important

» Secure the left and right edges of the roll paper with tape within 1.97 inches (50 mm) of
the edges so that neither end of the roll paper lift up.

» When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a
rewinding problem may result.

* If you use a paper core narrower than the paper to be wound, adjust the position of the
holder stopper, so that there is a gap between the holder stopper and the paper.

5. Make sure the leading edge of the roll paper is not lifting up from the paper core, and if there
are places lifting up, tape in additional places so that the paper does not lift up.

6. Push roll holder downward and check that roll holder is not lifting up.

Outward Winding Inward Winding

2»2Important

« If the roll holder lifts up, it may cause an error.

7. Make sure Inward/Outward Winding Changeover switch on roll unit is in desired direction
and press Auto Take-up/Pause button.
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The Pause lamp, which has been lighted up to this point, turns off, and the Auto Take-up
lamp lights up instead.

The winding preparation is complete. During printing, the winding starts. Before printing, the
winding starts at the same time as the printing.

»2Important

» When winding inwardly, loosening of the wound paper can be prevented by pressing the
roll paper with the arm. However, doing so may produce pressure traces on the paper. In
this case, tap the roll unit area of the media information display area and set Paper
retention setting to Release.
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Removing Printed Paper from the Roll Unit

»>»Note

» By tapping the paper settings display area and then area when setting Take-up mode and setting
Wind up after cutting to Enable in advance, you can omit steps 6 and 7 below, because when the
paper is cut after printing, the next paper will be automatically taken up after that. However, be careful
when using easily damaged roll paper because the roll paper touches the roller when paper is cut.

1. Tap paper settings display area on Home screen of touch screen.

Ready to print.
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»2®Important

+ If the Home screen does not appear, tap the Home button.

2. Tap area.

Paper settings
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Plain Paper
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3. Tap Feed/cut.

4. Tap Advance or Rewind to advance roll paper a little.

With the winding direction set to outward winding, advance the length of one circumference of the roll or
more to protect the print side.

5. Tap Cut paper.
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6. Hold printed paper between output guide and roll unit, then tap Yes.

The roll is now cut.

22 Important

* When cutting the roll paper, always hold the printed paper. If cut without holding the printed paper,
the paper may fall to the floor and become soiled.

7. While holding trailing edge of printed paper, press Take-up or Rewind button to wind
printed paper.

Apply adhesive tape to the rewound paper to hold it in place, if necessary.

22Important

» Be careful not to scratch the printed surface.

8. Change Roll Holder Lock switch on roll unit to release side.
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10.

11.

Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from roll holder.

Remove printed material that has been taken up, from roll holder for each paper core.
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Changing Settings from Operation Panel/Web Browser

» Operations and Touch Screen

]

]

]

Operation Panel
Touch Screen

Checking Instructions During Printer Operations

» Changing Settings from Operation Panel

]

]

Printer Menu Operations

Menu Operations

Menu Structure

Changing Settings from Operation Panel
Setting Items on Operation Panel

Status Print

» Changing Printer's Setting Using Web Browser

]

Changing Settings Using Web Browser

Changeable Setting Iltems Using Web Browser
Setting Password

Registering Printer's Root Certificate to Web Browser
Setting Mail Server

Receiving Printer Status by E-mail
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Operations and Touch Screen

=p Operation Panel

=p Touch Screen

=$ Checking Instructions During Printer Operations
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Operation Panel

A B C D

A. ON button/ON lamp
Turns the printer on and off.

=$ Turning the Printer On and Off

The ON lamp is lit when the printer is on or in Sleep mode.

B. Home button
The Home screen appears.

=$ Touch Screen

C. Back button
Displays the screen before the current screen.

D. Stop button
Cancels print jobs in progress and ends the ink drying period.

E. touch screen
Shows printer menus, as well as the printer status and messages. You can select menu items and
display buttons by gently touching the screen with your fingertip.

=$ Touch Screen

F. Status lamp
* Flashing (white)
During printing, the Data lamp flashes when the printer is receiving or processing print jobs.
Otherwise, this lamp flashes when the print job is paused or the printer is updating the firmware.

+ Lit (orange)
A warning message is displayed.

+ Flashing (orange)
An error message is displayed.

« Off
There are no active print jobs, warnings, or errors.
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»>»Note

* When the printer is in Sleep mode, you can touch the touch screen to recover from Sleep mode.
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Touch Screen

After the printer starts up, the Home screen appears on the touch screen.

From the Home screen, you can check the printer status and select the maintenance, settings, and other
menus. Flick the Home screen up and down, and select the display position.

=pBasic Touch Screen Operations

[
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@i Plain Paper
)2 Plain Paper
Flain Paper

Maintenance

B lob management

Primt from USE flash drive
LAN settings

 Device settings

8. Printer information

L =y

A. Printer Information Display Area

Displays the printer status, messages, and other information. Tap this item when a message appears to
view the message on the list screen and to jump to the screen with detailed information and operations.

B. Ink Display Area

Displays the ink status. Tap this item to view the remaining amount of ink and how to replace the ink
tanks.

C. Paper Setting Display Area

Displays the media information for each feeding location. Tap this item to configure the size and type of
the paper loaded.

D. Other Menu ltems
Displays the items used to perform maintenance and configure the various settings.

=¥ Printer Menu Operations

Basic Touch Screen Operations

You can select various functions and settings by gently touching and swiping the touch screen with your
fingertip.

2 ¥»Important

» Take the following precautions when operating the touch screen. Otherwise, the touch screen may
malfunction or become damaged.
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» Do not forcibly press the touch screen with your finger.

» Do not press the touch screen with an object other than your finger (such as a ballpoint pen,
pencil, fingernail, or other object with a sharp tip).

» Do not operate the touch screen with wet or dirty hands.
Do not place objects on top of the touch screen.

» Do not place a protective film over the touch screen. Removing it can damage the touch screen.

Tap
Gently touch with your fingertip and then release.

Use this when selecting an item on the screen.

Touch
Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick
Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.

Drag
Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.

Use this to move a menu or list while viewing it.
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Notification Messages

When the ink is low or there is another notification, New notice. appears in the printer information display
area. Tap this to display the Notice list screen to view messages with the newest one appearing first. Tap
a message to display the message details screen to view the details and take action.

New notice,

The mantenance
cartridge becomes
Plain Paper almast full.

(=i Plain Paper

= =
WMEEPEX B COGY ¥ M PC =

Part replacement needed.

. Plain Faper See the manual and contact

| i the cervice cerbe
I} Maintenance the service center. v
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Checking Instructions During Printer Operations

You can refer to instructions on the touch screen when loading paper, replacing ink tanks, or performing
other operations.

How to view instructions

Once you complete an action described in the instructions, the printer detects the action and switches to
the next instruction screen.

Operation screens are switched every 3 seconds, and the sequence of operations is shown repeatedly.
For actions the printer cannot detect, tap OK to display the instruction screen for the next step.

Example: Ink tank replacement
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Changing Settings from Operation Panel
» Printer Menu Operations
» Menu Operations
» Menu Structure
» Changing Settings from Operation Panel

» Status Print
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Printer Menu Operations

The printer menu is classified into regular menu items available when no print job is in progress and menu
during printing items only available while printing is in progress.

Flicking HOME screen and tapping the menu displays each setting item.

The menus below are available.

Ready to print

Ready to print.

Ready to print.

e
- ] = -
PMOR CPOYEEEPE B COGY ¥ M PO

Print from USE flash drive

| Maintenance

(€ Plain Paper B /ob management LAN settings
e Plaln Paper

P Pain Paper

ugs Print from USE flash drive Y Device settings =B

1" LAN settings

L Printer information =8

|} Maintenance

1. Printer status
Displays the printer status and LAN connection status.
2. Ink status
Displays the ink status.
3. Paper information
Perform paper settings. (grays-out while a print job is in progress)
4. Maintenance
Perform maintenance settings. (grays-out while a print job is in progress)
5. Job management
Perform job management settings.
6. Print from USB flash drive
Perform print settings when you print data on a USB flash drive.
7. LAN settings
Perform LAN settings. (grays-out while a print job is in progress)
8. Device settings
Perform various printer settings. (grays-out while a print job is in progress)
9. Printer information

Displays various printer information.

»» Note

By default, menu settings apply to all print jobs. However, for settings that are also available in the
printer driver, the values specified in the printer driver take priority.
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Menu Operations

The operation panel features a touch screen (A) and buttons (B).

Touch icons on the touch screen's HOME screen to select menus.

1! LA s=ttings

A. Touch screen

B. Buttons on the operation panel

Basic Touch Screen Operations

Tap the touch screen lightly or use other gestures to access various functions and settings.

22 Important

* Note the following touch screen precautions to avoid malfunction or damage to the printer.

» Do not press hard against the touch screen.

» Do not press the touch screen with objects other than your finger, especially sharp objects, such
as pens, pencils, or nails.

» Do not touch the touch screen if your hands are wet or dirty.

* Do not place any objects on the touch screen.

» Do not apply a screen protector to the touch screen. Removing it may damage the touch screen.

» Tap
Touch lightly and briefly with your fingertip.

Tap to select an item on the screen, for example.
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» Touch
Touch with your fingertip, pressing lightly.

Keep touching the "next" (or "back") icon to move forward or back through menus or a list
continuously, for example.

* Flick
Flick up, down, left, or right on the screen with your finger.

Flick to move forward or back through menus or a list, for example.

* Drag
While lightly touching the screen, move your finger up, down, left, or right.

Drag to move listed items or a list while viewing them, for example.
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Example of Using Touch Screen

These touch screen operations are available when you print data on a USB flash drive.

Ready to print.

| Maintenance

A
F

c
B
AUT_0001.1PG
Settings |||| Start print E
A

Tapping A displays the print settings menu.
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Print settings

P iy rge

Pagier src Auto select

0 degrees

ON

Print settings
g
Auto select
0 degrees

ON

Drag up or down, and then tap an item to select it.

After the list is displayed, tap a setting to select it.

Tap D to confirm the settings.

Tap B to display the screen for selecting the number of copies.

Tap a number to specify the number of copies, and then tap OK.
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Tap C to display the preview screen.

Touch the Back button to return to the previous screen.
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Menu Structure

* Ink information

Current estimated ink levels

Replace

Order ink now

* Paper settings

Roll paper 1

Replace paper

Feed/cut

Remove paper

Paper settings

Width/Length/Type/Advanced

Roll paper 2

Replace paper

Feed/cut

Remove paper

Roll unit use setting

Paper settings

Width/Length/Type/Advanced

Take-up mode

Roll unit use setting

Auto feed to take-up position

Skip errors during take-up

ON/OFF

Wind up after cutting

Enable/Disable

Paper retention setting

Release/Retain
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Use in take-up mode

Use/Do not use

Manual

Replace paper

Remove paper

Paper settings

Page size/Type/Advanced

* Maintenance

Print nozzle check pattern

Print head cleaning

Cleaning

All colors/Pattern 1/Pattern 2/Pattern 3

Deep cleaning

All colors/Pattern 1/Pattern 2/Pattern 3

System cleaning

All colors/Pattern 1/Pattern 2/Pattern 3

Print head alignment

Auto (standard)

Roll paper 1/Roll paper 2/Manual

Auto (fine)

Roll paper 1/Roll paper 2/Manual

Manual

Roll paper 1/Roll paper 2/Manual

Paper feed adjustment

Set priority

Roll paper 1

Auto/Prioritize print quality/Prioritize length accuracy
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Roll paper 2

Auto/Prioritize print quality/Prioritize length accuracy

Manual

Auto/Prioritize print quality/Prioritize length accuracy

Adjust print quality

Auto/Manual

Adjust feed length

Print alignment pattern

Roll paper 1/Roll paper 2/Manual

Change adjustment values

Color calibration

Auto adjust

Roll paper 1/Roll paper 2/Manual

Enable/disable adjustment values

Enable/Disable

Adjustment information

Roll paper 1/Roll paper 2/Manual

Calibration guide setting

Enable/Disable

Reset adjustment values

Maintenance cartridge info

Maintenance cartridge usage

Replace

Head replacement

Replace cutter blade unit

Platen cleaning

Prepare to transportation

152




Move indoors on the same floor

Move indoors to a different floor

Transport outdoors

» Job management

Print job

List of print jobs

Delete/Priority printing/Release hold

Saved job

Job box list

Job list

Delete/Start print

Print the job list

Job history

Display job history

Print job history

Pause printing

Enable

Disable

* Print from USB flash drive

Folderffile list

Number of copies

Preview

Settings

Start print

* LAN settings

Change LAN

Activate wired LAN
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Activate wireless LAN

Activate direct connect.

Disable LAN

Wireless LAN setup

Cableless setup

Standard setup

WPS (Push button method)

Other setup

Advanced setup/WPS (PIN code method)

» Device settings

Test print

Print nozzle check pattern

Status print

Status print (administrator)

Print LAN details

Print setting print

Print advanced paper settings

Print job history

Print menu map

Print settings

Print head movable width setting

Data width/Maximum movable width/Paper width

Prioritize paper size

Enable/Disable

PDF print settings

Print quality settings

Color mode

Monochrome/Color
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Matching method

Perceptual (Photo)/Saturation (Poster)

Print quality

Standard/High/Highest

Input resolution

600 dpi/300 dpi

Paper settings

Paper src
Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Man-
ual
Margin
3mm/5mm
Rotate
0 degrees/90 degrees
Fit paper
ON/OFF

Display during process

Warning display

Enable/Disable

JPEG print settings

Print quality settings

Color mode

Monochrome/Color

Matching method

Perceptual (Photo)/Saturation (Poster)

Print quality

Standard/High/Highest

Input resolution

600 dpi/300 dpi
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Paper settings

Paper src
Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Man-
ual

Margin
3mm/5mm

Rotate
0 degrees/90 degrees

Fit paper
ON/OFF

Print from USB flash settings

Color mode

Monochrome/Color

Print glty

Standard/High/Highest

Paper src

Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Manual

Rotate

0 degrees/90 degrees

Fit paper

ON/OFF

Print setting print

LAN settings

Change LAN

Activate wired LAN

Activate wireless LAN

Activate direct connect.

Disable LAN

Wireless LAN setup
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Cableless setup

Standard setup

WPS (Push button method)

Other setup

Advanced setup/WPS (PIN code method)

Confirm LAN settings

LAN setting list

WLAN setting list

Direct connection setting list

Print LAN details

Other settings

Set printer name

TCPI/IP settings

IPv4

IP address/DNS server/Proxy server

IPv6

Enable/disable IPv6/IPsec settings/Use DHCPv6/Manual address/DNS server

WSD setting

Enable/disable WSD

Enable/Disable

Optimize inbound WSD

Enable/Disable

Timeout setting

20 minutes/15 minutes/10 minutes/5 minutes/1 minute

Bonjour settings

Enable/disable Bonjour

Enable/Disable

Service name

IEEE802.1X settings
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Authentication

Do not use/TLS/TTLS/PEAP

EAP-TTLS internal auth. method

MSCHAPvV2/PAP

Weak encryption restriction

Restrict/Do not restrict

Weak certificate restriction

Restrict/Do not restrict

Advanced setup

User-ID/Username/Password/Authentication server name

Last authentication result

SNTP settings

Client operation status

Active/lnactive

NTP/SNTP server address

Polling interval

Spanning tree setting

Active/lnactive

LPR protocol setting

Enable/Disable

RAW protocol

ON/OFF

LLMNR

ON/OFF

Wireless LAN DRX setting

Enable/Disable

Wired LAN DRX setting

Enable/Disable

Direct connection settings
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Update SSID/password

Direct connection device name

Connection request confirmation

Yes/No

Reset SSL certificates

Reset LAN settings

Paper-related settings

Manage remaining roll amount

Enable/Disable

Roll paper auto switching

Identify size/Do not identify size

Keep media type

Enable/Disable

Detect paper setting mismatch

Pause/Display warning/Do not detect/Hold job

Paper retention setting

Release/Retain

Advanced paper settings

Paper size recognition settings

Cut sheet setting 1/Cut sheet setting 2/Roll paper setting 1/Roll paper setting 2

Adjust roll unit

Print advanced paper settings

Reset paper settings for all paper

Auto maintenance settings

Auto nozzle check

Standard/1 page/10 pages/Disable

Nozzle check error display

Enable/Disable
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System cleaning frequency

Standard/Short

Print pattern after new head

ON/OFF

Hard disk settings

Output method

Print/Print (auto delete)/Save to job box

Save first and print

ON/OFF

Common job box setting

Print/Print (auto delete)

Data deletion

Fast/Fast secure/Secure

Monitoring service settings

Enable/disable monitoring service

Enable/Disable

Communication test

Yes/No

Communication log

Device user settings

Energy saving settings

Auto power off

5 minutes/10 min./30 min./1 hour/4 hours/8 hours/12 hours/OFF

Sleep timer

5 minutes/10 min./15 min./20 min./30 min./40 min./50 min./60 min./210 min.

Operation restrictions

Job history

Restrict/Do not restrict
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Remote Ul

Restrict/Do not restrict

Print from USB flash drive

Restrict/Do not restrict

Use USB connection

Use/Do not use

Date/time setting

Date display format

YYYY/MM/DD / MM/DD/YYYY / DD/IMM/YYYY

Time zone (GMT)

0/+1/+2/+3/+4/+5/+6/+7/+8/+9/+10/+11/+12/-12/-11/-10/-9/-8/-7/-6/-5/-4/-3/-2/-1

Length unit setting

Meters/Feet/inches

Buzzer setting

Enable/Disable

EOP timer setting

10 seconds/30 seconds/1 minute/2 minutes/5 minutes/10 minutes/30 minutes/60 minutes

Job history sending setting

Send/Do not send

Language selection

Administrator password setting

Remote Ul or other tools/LCD, Remote Ul, or other tools

Printer information

System information

Hard disk information

Error history

Hardware error

Recoverable error
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Records of use

Head information

Head alignment performance log

Values applied with auto settings
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Changing Settings from Operation Panel

This section describes the procedure to change the settings in the Device settings screen, taking the steps
to specify Print head movable width setting as an example.

1. Make sure printer is turned on.

2. Flick HOME screen and tap n Device settings.

= Menu Operations

The Device settings screen appears.

3. Tap setting item to adjust.

Device settings

Test print

Print settings

LAN settings

Paper-related settings

Brrkn maintenance cattinne

The setting screen for the selected item appears.

4. Tap setting item.

Print settings

”_F‘rint head movable width setting |

Prioritize paper size

PDF print settings

JPEG print settings

Primt fraom | 1SR flach cattinnc v

5. Tap setting to specify.
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DEVERYI

Maximum movable width

Paper width

For more on setting items on the operation panel:

= Setting Items on Operation Panel
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Setting Items on Operation Panel

»» Note

» The administrator password is required to change some setting items if it is enabled for changing
settings using the operation panel.

For more on setting items which the administrator password is required:

= Setting Administrator Password on Operation Panel

Items for Security

= Administrator password setting

Items for Printer

= Device user settings
= Hard disk settings
= [ anguage selection

Items for Paper/Printing

= Paper-related settings
= Print settings

Items for Maintenance/Management

= Job management
= Printer information
= Test print

= LAN settings
=

(=

Auto maintenance settings
Special administration mode
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Job management

Select this setting item from HOME screen.

* Print job

Displays the print job list. Tapping a job displays the details. You can also delete or preempt jobs on this
menu.

» Saved job

Displays the saved print job list. You can print job list on each saving box.

»» Note

* Enter the password if it is enabled for a personal box using Remote Ul.

+ Job history
32 Important

» The administrator password is required to display the job history if it is enabled for changing
settings using the operation panel.

> Display job history

Displays the print job history. Tapping a print job displays the details.
° Print job history

Prints out the print job history.

* Pause printing

Selecting Enable while a print job is in progress pauses the print job after the current job is completed.
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Test print

Select this setting item from Device settings.

* Print nozzle check pattern
Prints out the nozzle check pattern.

= Checking for Nozzle Clogging

+ Status print
Prints out the printer status and setting value information.

= Status Print

* Print LAN details
Prints out the network information list.

= Printing Network Settings

* Print setting print

Prints out the print settings list.

* Print advanced paper settings

Prints out the setting values specified by Advanced paper settings.

 Print job history

Prints out a record of print jobs, including the paper type and size, amount of ink consumed, and so on.
Ink consumption indicates a rough estimate of the amount of ink consumed per print job.

= Job management

* Print menu map

Prints out the menu list.
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Print settings

Select this setting item from Device settings.

* Print head movable width setting

Adjusts the print head movable width.

* Prioritize paper size

Select Enable to use the paper size setting as the basis for printing instead of other settings. The text or
images in the margin are not printed.

Select Disable to give priority to printing text or images.

»» Note

» The printed paper length is longer than the actual paper length. This is because the printed paper
includes the upper/lower margins specified by Roll Paper Safety Margin and Leading Edge
Margin in the printer driver and excludes the paper margins.

* PDF print settings
Performs PDF print settings.

» JPEG print settings
Performs JPEG print settings.

* Print from USB flash settings
Performs settings for printing data saved on the USB flash drive.

= Setting Items for Printing Using Operation Panel

* Print setting print

Prints out the print settings list.
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LAN settings

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

* Change LAN

Enables either wireless LAN, wired LAN, or direct connection. You can also disable all.

* Wireless LAN setup
Selects the setup method for wireless LAN connection.

»» Note

* You can also enter this setting menu by selecting LAN settings on the HOME screen. In this case,
enable wireless LAN.

o Cableless setup

Select if you specify the settings of the access point information to the printer directly from a device
(e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen instructions
of the connecting device for the setup procedure.

o Standard setup
Select when you perform settings for wireless LAN manually using the operation panel of the printer.
o WPS (Push button method)

Select when you perform settings for wireless LAN using a wireless router supporting a Wi-Fi
Protected Setup (WPS) push button method. Follow the on-screen instructions during setup.

o Other setup
m Advanced setup

Select when you perform settings for wireless LAN manually. You can specify multiple WEP
keys.

m WPS (PIN code method)
Select when you perform settings for wireless LAN using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.
+ Confirm LAN settings

The list of wireless/wired LAN settings or the direct connection of this printer is displayed on the touch
screen.

For more information on the printer's network setting is printed out:
= Printing Network Settings
22 Important

» The network settings printout contains important information about your network. Handle it with
care.
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o LAN setting list
The list of wired LAN settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the

printer settings.)

Items Setting
Connection Active/lnactive
IPv4 address XXX, XXX, XXX. XXX (12 characters)

IPv4 subnet mask

XXX XXX, XXX. XXX (12 characters)

IPv4 default gateway

XXX, XXX. XXX. XXX (12 characters)

IPv4 DNS dynamic setting

Active/lnactive

IPv4 DNS host name

XXXXXXXXXXXX

IPv4 DNS domain name

XXXXXXXXXXXX

IPv6 address

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway

XXXX: XXXX: XXXX:
: XXXX (32 characters)

XXXX: XXXX: XXXX

XXXX:

IPv6 subnet prefix length

XXX (up to 3 digits)

IPv6 link-local address

XXXX: XXXX: XXXX:
: XXXX (32 characters)

XXXX: XXXX: XXXX

XXXX:

IPv6 link-local prefix length

XXX (up to 3 digits)

IPv6 manual address

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 manual prefix length

XXX (up to 3 digits)

IPv6 stateless address 1

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 1

XXX (up to 3 digits)

IPv6 stateless address 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 2

XXX (up to 3 digits)

IPv6 stateless address 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 3

XXX (up to 3 digits)
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IPv6 stateless address 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 4

XXX (up to 3 digits)

IPv6 default gateway 1 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
IPv6 default gateway 2 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
IPv6 default gateway 3 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)

DHCPv6

Active/lnactive

DHCPv6 stateful address

XXXXXXXXXXXX

DHCPv6 stateful prefix length

XXX (up to 3 digits)

IPv6 primary DNS server address

XXXXXXXXXXXX

IPv6 secondary DNS server add.

XXXXXXXXXXXX

IPv6 DNS dyn. update: manual

Active/lnactive

IPv6 DNS dyn. update: stateless

Active/lnactive

IPv6 DNS dyn. update: stateful

Active/lnactive

IPv6 Use IPv4 host/domain name

Active/lnactive

IPv6 DNS host name

XXXXXXXXXXXX

IPv6 DNS domain name

XXXXXXXXXXXX

MAC address

XXXXXX XX XX:XX (12 characters)

IPsec settings

Enable (ESP)/Enable (ESP & AH)/Enable (AH)/Disable

Pre-shared key

XXXXXXXXXXXXXXXX (16 characters)

Authentication

TLS/TTLS/PEAP/TTLS/PEAP/EAP-TTLS internal auth. method/
MSCHAPvV2/PAP/Do not use

EAP-TTLS internal auth. method

MSCHAPv2/PAP

Weak encryption restriction

Restrict/Do not restrict

Weak certificate restriction

Restrict/Do not restrict

Authentication server name

XXXXXXXXXXXX

Client operation status

XXXXXXXXXXXX
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NTP/SNTP server address XXXXXXXXXXXX

Polling interval XXXXXXXXXXXX
Spanning tree setting XXXXXXXXXXXX
Printer name XXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX

XXXXXXXXXXXXX (up to 52 characters)

Root cert. thumbprint (SHA-1) XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) | XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXKXX XXXXXXXX XXKXXXXXX

("XX" represents alphanumeric characters.)
o WLAN setting list
The list of wireless LAN settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting
Connection Active/lnactive
SSID )9.9.0.90.9.9.9.9.9.9.0.9.9.9.0.4

XXXXXXXXXXXXXXXX (up to 32 characters)

Communication mode Infrastructure
Channel XX (up to 2 digits)
Wireless LAN security Inactive/WEP(64bit)/WEP(128bit)/WPA-PSK(TKIP)/WPA-PSK(AES)/

WPA2-PSK(TKIP)/WPA2-PSK(AES)

IPv4 address XXX, XXX, XXX. XXX (12 characters)
IPv4 subnet mask XXX, XXX, XXX. XXX (12 characters)
IPv4 default gateway XXX, XXX, XXX. XXX (12 characters)
IPv4 DNS dynamic setting Active/lnactive

IPv4 DNS host name XXXXXXXXXXXX

IPv4 DNS domain name XXXXXXXXXXXX

IPv6 address XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
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IPv6 default gateway

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 subnet prefix length

XXX (up to 3 digits)

IPv6 link-local address

XXXX: XXXX: XXXX:
: XXXX (32 characters)

XXXX: XXXX: XXXX

XXXX:

IPv6 link-local prefix length

XXX (up to 3 digits)

IPv6 manual address

XXXX: XXXX: XXXX:
1 XXXX (32 characters)

XXXX: XXXX: XXXX

XXXX:

IPv6 manual prefix length

XXX (up to 3 digits)

IPv6 stateless address 1

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 1

XXX (up to 3 digits)

IPv6 stateless address 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 2

XXX (up to 3 digits)

IPv6 stateless address 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 3

XXX (up to 3 digits)

IPv6 stateless address 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 4

XXX (up to 3 digits)

IPv6 default gateway 1 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
IPv6 default gateway 2 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
IPv6 default gateway 3 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)
IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)

DHCPv6

Active/lnactive

DHCPv6 stateful address

XXXXXXXXXXXX

DHCPv6 stateful prefix length

XXX (up to 3 digits)

IPv6 primary DNS server address

XXXXXXXXXXXX

IPv6 secondary DNS server add.

XXXXXXXXXXXX
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IPv6 DNS dyn. update: manual

Active/lnactive

IPv6 DNS dyn. update: stateless

Active/lnactive

IPv6 DNS dyn. update: stateful

Active/lnactive

IPv6 Use IPv4 host/domain name

Active/lnactive

IPv6 DNS host name

XXXXXXXXXXXX

IPv6 DNS domain name

XXXXXXXXXXXX

MAC address

XXXXXXXX:XX:XX (12 characters)

IPsec settings

Enable (ESP)/Enable (ESP & AH)/Enable (AH)/Disable

Pre-shared key

XXXXXXXXXXXXXXXX (16 characters)

Client operation status XXXXXXXXX XXX
NTP/SNTP server address XXXXXXXXX XXX
Polling interval XXXXXXXXXXXX

Printer name

XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name

XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

Root cert. thumbprint (SHA-1)

XXXXXXXX XXXXXKXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256)

XXXXXXXX XXXXXXXX XXXXXXXX XXKXXXXXX
XXXXXXXX XXXXXXXX XXXXXKXX XXXXXXXX

("XX" represents alphanumeric characters.)

o Direct connection setting list

The list of direct connection settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the

printer settings.)

Items Setting

Connection Active/Inactive

SSID DIRECT-XXXX-XXXXXXseries
Password XXXXXXXXXX (10 characters)

Communication mode

Direct connection

Channel
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Wireless LAN security

WPA2-PSK(AES)

IPv4 address

XXX, XXX, XXX. XXX (12 characters)

IPv4 subnet mask

XXX, XXX, XXX. XXX (12 characters)

IPv4 default gateway

XXX, XXX, XXX. XXX (12 characters)

IPv4 DNS dynamic setting

Active/lnactive

IPv4 DNS host name

XXXXXXXXXXXX

IPv4 DNS domain name

XXXXXXXXXXXX

IPv6 address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 default gateway

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 subnet prefix length

XXX (up to 3 digits)

IPv6 link-local address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 link-local prefix length

XXX (up to 3 digits)

MAC address

XX XX XX XX:XX: XX (12 characters)

IPsec settings

Enable (ESP)/Enable (ESP & AH)/Enable (AH)/Disable

Pre-shared key

XXXXXXXXKXXXXXXXX (16 characters)

Printer name

XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name

XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

Direct connection device name | XXXXXX-XXXXXXseries

Root cert. thumbprint (SHA-1) | XXXXXXXX XXXXXXXX XXXXXXXX

XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) | XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX XXKXXKXX XXXXXXXX

("XX" represents alphanumeric characters.)

» Other settings
22 Important

* You cannot select the items below when Disable LAN is selected for Change LAN.

o Set printer name
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Specifies the printer name. You can use up to 15 characters for the name.

»» Note

* You cannot use the same printer name as that already used for other LAN connected devices.
* You cannot use a hyphen for the initial or last character of the printer name.

o TCP/IP settings
Performs IPv4 or IPv6 setting.
o WSD setting

Setting items when you use WSD (one of the network protocols supported in Windows 10, Windows
8.1, Windows 8, Windows 7, and Windows Vista).

m Enable/disable WSD
Selects whether WSD is enabled or disabled.

»» Note

* When this setting is enabled, the printer icon is displayed on the Network Explorer in
Windows 10, Windows 8.1, Windows 8, Windows 7, and Windows Vista.

m Optimize inbound WSD
Selecting Enable allows you to receive the WSD printing data faster.
m Timeout setting
Specifies the timeout length.
o Bonjour settings
Setting items for LAN using Bonjour for Mac OS.
m Enable/disable Bonjour
Selecting Enable allows you to use Bonjour to perform the network settings.
m Service name

Specifies the Bonjour service name. You can use up to 48 characters for the name.

»» Note

* You cannot use the same service name as that already used for other LAN connected
devices.

o |EEE802.1X settings
Performs various settings for IEEE802.1.X.
o SNTP settings
Performs various settings for SNTP (Simple Network Time Protocol).
o Spanning tree setting
Enables/Disables spanning tree. Selecting Enable avoids circulating data on a network.
o LPR protocol setting
Enables/Disables the LPR setting.
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o RAW protocol
Enables/Disables RAW printing.
o LLMNR

Enables/Disables LLMNR (Link-Local Multicast Name Resolution). Selecting Active allows the
printer to detect printer's IP address from the printer name without a DNS server.

> Wireless LAN DRX setting
Selecting Enable allows you to activate discontinuous reception when using wireless LAN.
> Wired LAN DRX setting

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.

o Direct connection settings

Setting items are available when you connect a device to the printer.

32 Important

* You can select these setting items only when Activate direct connect. is selected for Change
LAN.

m Update SSID/password
m Selecting Yes updates the identifier (SSID) and password for direct connection.
o Direct connection device name
Changes the printer's name displayed on a Wi-Fi Direct compatible device.
o Connection request confirmation

Selecting Yes displays the confirmation screen when a Wi-Fi Direct compatible device is connecting
the printer.

= Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct Connection)

* Reset LAN settings
Initializes the network settings on the printer.

After resetting, perform setup again as necessary.
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Device user settings

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

* Energy saving settings

To save electricity, enable this setting to turn off the printer automatically or to enter sleep mode when
specified length of time has elapsed.

o Auto power off

Sets the time until the printer turns off automatically. If no operations are performed on the printer for
the specified duration of the time after entering Sleep mode, the printer automatically turns off.

o Sleep timer

Specifies the length of time to enter sleep mode automatically when no operation is made.

* Operation restrictions
Restricts the following operations.
> Job history
Restricts to display the print job history.
> Remote Ul
Restricts to use Remote Ul.
o Print from USB flash drive

Restricts to print data on USB flash drive.

* Use USB connection

Enables/Disables USB connection.

» Date/time setting

Sets the current date and time.

+ Date display format

Sets the format of dates displayed on the touch screen and printed on photos.

» Time zone (GMT)
Specifies the time zone according to a country or region you live in.

Specifying the time zone allows you to display the correct time and date an e-mail was sent on your mail
software.

Select the time difference from GMT (Greenwich mean time) according to a country or region you live in.

* Length unit setting

Selects the length unit (meter or feet/inch).
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* Buzzer setting

The printer beeps once for warnings, and 3 times for errors when Enable is selected.

+ EOP timer setting

Specify the timeout period before cancellation of print jobs that cannot be received by the printer.

+ Job history sending setting

The printer sends a job history tool when Send is selected.
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Language selection

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

Changes the language for the messages and menus on the touch screen.
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Paper-related settings

Select this setting item from Device settings.

* Manage remaining roll amount
Select ON to print a barcode at the end of a roll before you remove it. The printed barcode can be used
in managing the amount of roll paper left. Select OFF if you prefer not to print the barcode.

* Roll paper auto switching

Enables/Disables switching roll paper feed position by detecting the paper size.

* Keep media type

Select Enable to keep using the same type of paper.

* Detect paper setting mismatch
Selects printer action when you start printing with the paper size, the media type, and print settings
different from those registered.

* Paper retention setting
Selects whether to contact the roll nip with the rolls in feeding paper.

If you select Release, the roll nip does not contact with the rolls and you can feed paper manually. If you
select Retain, the roll nip contacts with the rolls and automatic feeding is enabled. Selecting Release
does not allow you to switch the paper source of rolls (upper or lower) automatically.

+ Advanced paper settings

Specifies advanced paper settings for each paper feed position.

22 Important

* You can select Extension for borderless printing as a setting item for some paper types.

If you select Small for Paper with adequate width on this setting item, a slight border remains on
the paper. In addition, the paper may be smudged with extra ink.

» Paper size recognition settings
Selects which size is preferred when paper size detection is enabled.
o Cut sheet setting 1

Select whether ISO A3+ or 13"x19"(Super B) is applied when a sheet of an intermediate size is
detected.

o Cut sheet setting 2

Select whether ISO B1 or 28"x40" (ANSI F) is applied when a sheet of an intermediate size is
detected.

> Roll paper setting 1
Select whether A3 or 300 mm is applied when a sheet of an intermediate size is detected.

> Roll paper setting 2
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Select whether B4 or 10 inch is applied when a sheet of an intermediate size is detected.

* Adjust roll unit

Select this setting item when you replace the roll unit.

» Print advanced paper settings

Tapping Yes prints out each setting specified in Advanced paper settings.

* Reset paper settings for all paper
Tapping Yes initializes each setting specified in Advanced paper settings.
Entering the administrator password is required if it is enabled.

3% Important

* When you set the paper settings back to the factory default, added or updated paper information
using Media Configuration Tool is erased.

In addition, the color calibration values are also erased.

Perform color calibration to specify the color calibration values.
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Auto maintenance settings

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

» Auto nozzle check
Enables/Disables automatic nozzle checking. You can also select the page interval to perform automatic
nozzle checking.

* Nozzle check error display

Enables/Disables displaying the nozzle check error.

» System cleaning frequency

Specifies the frequency of automatic system cleaning.

»» Note

» To maintain print quality, we recommend you select Short if you use the printer at a higher place.

 Print pattern after new head

Selects whether you print an adjustment pattern after replacing the print head.
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Administrator password setting

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

You can specify or disable the administrator password.
If you specify the administrator password, select the range and specify the administrator password.

Remote Ul or other tools

Entering the administrator password is required to change the setting items using Remote Ul or some
software.

LCD, Remote Ul or other tools
Entering the administrator password is required to change the setting items using the operation panel of
the printer, Remote Ul, or some software.

For details:

= Setting Administrator Password on Operation Panel
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Setting Administrator Password on Operation Panel

You can specify or disable the administrator password.

Specifying the administrator password requires you to enter the password to use the items or change the

settings below.

LAN settings

Device user settings

Language selection

Auto maintenance settings
Hard disk settings
Administrator password setting
Status print (administrator)
Special administration mode

Follow the procedure below to specify the administrator password.

1. Make sure printer is turned on.

Flick HOME screen and tap n Device settings.

= Menu Operations

The Device settings screen appears.
Tap Administrator password setting.

. When confirmation screen to specify administrator password is displayed, tap Yes.

If an administrator password is not specified, the register confirmation message appears. Tapping Yes
displays the message again. Tap OK.

2% Important

» The administrator password is set at the time of purchase. The printer's serial number is used as
the password.

For the administrator password, refer to Administrator Password.

Tap Change administrator password.

If you do not specify an administrator password, tap Remove administrator password. Tapping Yes
displays the message again. Tap OK.

Tap range where administrator password is valid.

Remote Ul or other tools
Entering the administrator password is required to change the setting items using Remote Ul or
some software.
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LCD, Remote Ul, or other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, Remote Ul, or some software.

7. Enter administrator password.

3% Important

» The following character restrictions apply to the password:

+ Set the password by using 4 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.
» For security reasons, we recommend you use 6 and more alphanumeric characters.

8. Tap Apply.
9. Enter administrator password you specified again.

10. Tap Apply.

The administrator password is enabled.

When You Want to Change or Disable the Administrator Password:

When the administrator password is enabled, tapping Device settings and Administrator password
setting in this order and entering the administrator password displays Change administrator password
and Remove administrator password on the touch screen. Select either item and follow the on-screen
instructions to perform settings.
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Hard disk settings

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

* Output method

Selects the printing method for jobs received from software other than the printer driver. When using the
printer driver, configure settings on the printer.

° Print

Performs printing as usual.
o Print (auto delete)

Deletes the data from the printer's hard disk after printing is completed.
o Save to job box

Only saves the print job in the box without printing it.

 Save first and print
A setting for jobs received from software other than the printer driver. When using the printer driver,
configure settings on the printer. Select ON to print the job after it has been saved.

+ Common job box setting

Select Print (auto delete) to print without saving jobs in the box shared among multiple users.

+ Data deletion
Selects the method to delete data on printer's hard disk.

= Erasing Data on Printer's Hard Disk
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Special administration mode

Select this setting item from Device settings.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

» Enable/disable monitoring service

Selecting Active allows the printer to send error details to the service center.

« Communication test

Performs a communication test with the service center.

+ Communication log

Displays the list of error numbers (up to 30), error code, and time the error occurs. Tapping an item
displays the error details.
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Printer information

Select this setting item from HOME screen.

» System information

Displays printer's system information.

* Hard disk information

Displays the total hard disk capacity and the mail box free space.

* Error history
Displays the error history.
o Hardware error
Displays the hardware error codes (up to 5).
> Recoverable error
Displays the recoverable error (e.g. paper or ink related error) codes (up to 5).

For more on the error code, refer to List of Support Code for Error.

* Records of use

Displays the printer's record of use such as total print area or the amount of ink consumption.

* Head information

Displays the print head serial number, elapsed days since the current print head was installed, and dot
count.

+ Head alignment performance log

Displays the print head alignment performance log (up to 5).

» Values applied with auto settings

Displays the print settings applied the last print job.
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Status Print

You can print a "Status Print" report indicating the current status of the printer.

With "Status Print", information is printed regarding the printer firmware version, various settings, and the
status of consumables.

Follow the procedure below to print.

1. Make sure printer is turned on.

2. Flick HOME screen and tap n Device settings.

= Menu Operations

3. Tap Test print.

4. Tap Status print.
»» Note

« If you specify the administrator password, tap Status print (administrator).

The printer starts printing.

The following information is included.

Canon XXXXXXXXXXXXXXXXXxXX Status Print Printer model
S/IN Printer serial number
Firm Firmware version
Boot Boot ROM version
Date When the status print report was printed
Paper Info Prints information on the loaded paper for each paper feed posi-
tion.
Job Menu
Job History
Log * Information history
about each job (Job
name is printed as
II*II')
* Printed only when you select Status print (administrator).
Settings
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Printer Settings

Print Settings

Setting value of Print head mov-
able width setting/Prioritize pa-
per size

Paper-related
settings

Setting value of Prioritize paper
size

Device settings

Auto mainte-
nance settings

Each setting value of Auto main-
tenance settings

Hard disk set-
tings

Each setting value of Hard disk
settings

Device user set-
tings

Each setting value of Device
user settings

Language se-
lection

Each setting value of Language
selection

Roll unit use
setting *2

Each setting value of Roll unit
use setting

*2 Printed only when you select ON.

Maintenance

Color calibration

Setting value of Color calibration

Usage Condition

Hard disk information

Hard disk capacity and Job box free space

Hardware error

History information of Hardware error

Error

History information of Recoverable error

Warning

History information of warning

Maintenance cartridge us-
age / Remaining ink level

Information of Ink consumed

Duty counter

Information of Duty counter

PARTS STATUS

COUNTER

Prints out the parts status.

Head information
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HEAD LOT NUMBER/ DATE OF IN-
STALLATION

Head alignment performance log

Print head lot number

COUNTER

Media Use of each specified media
THE NUMBER OF CUTS Total number of cuts
AFTER INSTALLATION Days of use
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Changing Printer's Setting Using Web Browser
» Changing Settings Using Web Browser
» Changeable Setting Items Using Web Browser
» Setting Password
» Setting Mail Server

» Receiving Printer Status by E-mail
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Changing Settings Using Web Browser

You can check the printer status and change the printer settings using the web browser on your smartphone,
tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

»» Note

* Remote Ul is a software that enables you to perform operations, which are usually performed on the
printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote Ul.
* You can use Remote Ul on the following OS and the web browser.
+ iOS device
0S:i0S 7.0 or later
Web browser: iOS standard Web browser (Mobile Safari)
» Android device
OS: Android 4.0 or later
Web browser: Android standard Web browser (Browser or Chrome)
* Mac OS device
OS: Mac OS X v.10.6 or later
Web browser: Safari 5.1 or later
» Windows device
OS: Windows Vista SP2 or later

Web browser: Internet Explorer 9 or later, Google Chrome 41.0.2272.118m or later, Mozilla Firefox
37.0.1 or later

1. Make sure printer is turned on.

2. Check printer's IP address.

Check the printer's IP address by following the steps below.

1. Flick HOME screen and tap n Device settings.

= Menu Operations

The menu screen appears.

Tap LAN settings.

Tap Confirm LAN settings.

. Tap LAN setting list or WLAN setting list.

. Tap Yes.

o o A W N

. Check IPv4 address.
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3. Open web browser on your smartphone, tablet, or computer and enter IP address.
Enter as following in the URL field of the web browser.
http://XXX. XXX XXX
Enter the IP address in "XXX. XXX XXX".

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or
computer.

4. If you display Remote Ul for the first time on your smartphone, tablet, or computer, select
For secure communication.

Download the root certificate, and then register it.

= Registering Printer's Root Certificate to WWeb Browser

»» Note

» Once you register the root certificate to the web browser on your smartphone, tablet, or computer,
this step is not necessary after the next time.

« If the root certificate is not registered, a message to warn you that the secure connection is not
guaranteed may appear.

5. Select Log on.

The password authentication screen appears.

> Note

* When the standard user mode is enabled, choose either administrator mode or standard user
mode to log on.

After choosing a mode and selecting Log on, the password authentication screen of each mode
appears.

6. Enter password.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.

2 Important

» The password is set at the time of purchase. The password is the printer serial number. The
printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

For details on setting password, see Setting Password.

7. Check printer status and change printer settings.

For changeable setting items, see below.

= Changeable Setting Items Using Web Browser
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8. When you finish checking printer status and changing printer settings, select Log off.

9. Close web browser.
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Changeable Setting Items Using Web Browser

»» Note

» The items described here and the items displayed in the web browser may differ in display order.
» The item which can be used is different in administrator mode or in standard user mode.

Items for Security

Security (Item for administrator)

This function allows you to specify the password, the standard user mode settings, and SSL/TLS
settings of certificate for encrypted communication.

This function allows you to specify the password, the standard user mode settings, the operation
restrictions, and SSL/TLS settings of certificate for encrypted communication.

For details on setting password, see Setting Password.

Items for Maintenance/Management
Utilities
This function allows you to set and execute the printer utility functions such as cleaning.

Job management
This function allows you to display the job history and print it.

»>» Note

* When you are logging on in administrator mode, you can restrict this function in standard user mode.

System info and LAN settings
This function allows you to check the system information and to change the LAN settings.

Using IP filtering in Other settings in LAN settings, you can permit or refuse the connection of a
specific IP address for IPv4 address or IPv6 address.

Using SNMP settings in Other settings in LAN settings, you can specify the SNMP and MIB setting
to management the printer via a network.

22 Important

« If you have refused the IP address of administrator's device using IP filtering by mistake, reset LAN
settings of the printer. To reset LAN settings, select System info and LAN settings > LAN settings
> Other settings > Reset LAN settings, and then select Yes.

»>» Note

» Some of the menu is available only when you logged on in administrator mode.

Language selection
This function allows you to change the language on the display.
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Items for Printer

Device settings
This function allows you to change the printer settings such as the quiet setting, the energy saving
settings, and the print settings.

Additionally, this function allows you to receive the printer status information such as the remaining
ink level and the error.

= Setting Mail Server
= Receiving Printer Status by E-mail

»>» Note

« Some of the menu is available only when you logged on in administrator mode.

Other ltems

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.

You can also connect to the ink purchase site or support page, and use Web Services.

Records of use
This function displays the total number of printing.

Manual (Online)
This function displays the Online Manual.
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Setting Password

Each of passwords for administrator and standard user can be set.
When logging on with password for administrator, all settings can be changed.
When logging on with password for standard user, some of the settings can be changed.

When logging on with password for administrator, you can restrict the function for standard user.

= Setting Administrator Password
= Setting Standard User Password

»» Note

» Password can be set only when you are logged in administrator mode.

Setting Administrator Password
Change the administrator password by following the steps below.

22 Important

» The password is set at the time of purchase. The password is the printer serial number. The printer
serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

1. Display printer status on web browser.

2. Select Security.

The menus appear.
3. Select Administrator password setting.

4. Select Change administrator password.

If the administrator password is not set, registration confirming message is displayed. Select Yes.
When message is displayed again, select OK.

5. Select range where administrator password is valid and select OK.

Remote Ul or other tools

Entering the administrator password is required to change the setting items using the Remote Ul
or some software.

Operation panel/Remote Ul/other tools

Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote Ul, or some software.

6. Enter password and select OK.

3% Important

» The following character restrictions apply to the password:
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+ Set the password by using 4 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.
» For security reasons, we recommend you use 6 and more alphanumeric characters.

7. When completion message appears, select OK.

Setting Standard User Password

For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

—_—

. Display printer status on web browser.

2. Select Security.

The menus appear.
3. Select Standard user mode settings.
4. When confirming message appears, select Yes.

5. Enter password and select OK.

3% Important

» The following character restrictions apply to the password:

+ Set the password by using 4 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.
» For security reasons, we recommend you use 6 and more alphanumeric characters.

6. When completion message appears, select OK.
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Registering Printer's Root Certificate to Web Browser

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote Ul for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear.

How to register the root certificate varies depending on the web browser.

= For Internet Explorer

= For Safari

= For Chrome on Android
= For Mobile Safari on iOS

For other web browser, refer to each help.

22 Important

» Make sure that you have accessed to the printer IP address correctly by checking the URL field of the
web browser before registering the root certificate.

For Internet Explorer

1. Select Download on Remote UI.

Downloading the root certificate is started.

2. If confirmation screen appears, select Open.

The Certificate screen appears.

> Note

» To save the certificate file to your device and register it, select Save. Select Internet options
from Tool menu of Internet Explorer, register the root certificate from Certificates on Content
sheet.

3. Select Install Certificate.

The Certificate Import Wizard screen appears.

4. Select Next.

5. Select Place all certificates in the following store.

6. Select Browse.

The Select Certificate Store screen appears.

7. Select Trusted Root Certification Authorities and OK.
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8. Select Next on Certificate Import Wizard screen.

9. If Completing the Certificate Import Wizard appears, select Finish.

The Security Warning screen appears.

10. Make sure thumbprint on Security Warning screen matches printer's thumbprint.

For printer's thumbprint, touch the HOME button, select Device settings > LAN settings > Confirm
LAN settings, check Root cert. thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

11. If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.

12. Select Yes on Certificate Import Wizard screen.

The root certificate registration is completed.

For Safari

1. Select Download on Remote UI.

Downloading the root certificate is started.

2. Open download file.

The Add Certificates screen appears.

3. Select Add.

The certificate information appears.

4. Make sure thumbprint of certificate detail information matches printer's thumbprint.

For printer's thumbprint, touch the HOME button, select Device settings > LAN settings > Confirm
LAN settings, check Root cert. thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

5. If thumbprint of certificate detail information matches printer's thumbprint, select Always
Trust.

The root certificate registration is completed.

»» Note

+ If a password is set on your device, entering a password may be required.

For Chrome on Android

1. Select Download on Remote UI.

Downloading the root certificate is started and then Name the certificate screen is displayed.
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2. As entering the root certificate name is required, enter an arbitrary certificate name and
select OK.

The root certificate registration is completed.

> Note

« If PIN or password is not set as security type, the attention screen may appear. Select OK, and
then set the security type to PIN or password.

After Root Certificate Registration
We recommend that you make sure that the correct root certificate has been registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of
certificate information matches printer's thumbprint. Follow the steps below.

»» Note

» Some Android devices cannot be checked the thumbprint of a registered route certificate.

1. From Settings menu on your device, select Security, Trust credentials, and USER.
The list of downloaded certificates appears.

2. Select downloaded certificate.
The certificate information appears.

3. Make sure that thumbprint of certificate information matches printer's thumbprint.

For printer's thumbprint, touch the HOME button, select Device settings > LAN settings >
Confirm LAN settings, check Root cert. thumbprint (SHA-1) or Root cert. thumbprint
(SHA-256).

4. If thumbprint of certificate information screen matches printer's thumbprint, select OK.
The root certificate registration is completed.

If the message to warn you that the secure connection is not guaranteed appears when you select
Log on on Remote Ul after registering the root certificate, restart the web browser. The message
will not appear on the web browser.

»» Note

» Depending on the Android device, a warning may appear even after registering the proper root
certificate.

For Mobile Safari on iOS

1. Select Download on Remote UI.

Downloading the root certificate is started and then Install Profile screen is displayed.

2. Select Install.

The Warning screen appears.
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»» Note

« If a password is set on your device, entering a password may be required.

3. Select Install.

4. Select Install on displayed dialog.

The root certificate registration is completed.
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Setting Mail Server

To use mail function, specify the mail server settings.

»» Note

+ If you did not specify the time zone setting using the printer's operation panel, a message to inform you
that the correct time may not be reflected on the sent e-mail appears. We recommended that you set
the time zone setting using the printer's operation panel.

For the time zone setting, see Device user settings.

» These functions can be set only when you are logged in administrator mode.

—

. Display printer status on web browser.

2. Select Device settings.

The menus appear.

3. Select Set mail server / test connect.

N

. Select Set mail server.

The setting items for mail server appear.

[&)]

. Specify mail server settings.

Specify the following items.

Sender address
Enter the e-mail address of the sender (this printer).

Outgoing mail server (SMTP)
Enter the address of your SMTP server.

Port number (SMTP)
Enter the port number of your SMTP server.

Secure connection (SSL)
Select if you use the secure connection (SSL).

Don't verify certificates
Select if you do not verify the certificate.

Authentication method
Select one of the following authentication methods.

SMTP authentication
Select if you send e-mail with SMTP authentication.

Next, you can specify the following settings.
+ Outgoing account
Enter the account name for sending to perform the authentication.

+ Outgoing password
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Enter the password for sending to perform the authentication.

POP before SMTP
Select if you send e-mail with POP before SMTP authentication.

Next, you can specify the following settings.
* Incoming mail server (POP3)

Enter the address of your POP server.
* Port number (POP3)

Enter the port number of your POP server.
* Incoming account

Enter the account name for receiving to perform the authentication.
* Incoming password

Enter the password for receiving to perform the authentication.
+ Use APOP authentication

Select if you send the password by the encryption transmission.
+ Clear mailbox

Select if you delete the e-mails that remain in the POP3 server.

32 Important

* When this setting is enabled, e-mail in the Inbox on the server will have all been removed. If you
specify the e-mail address of your everyday, be sure to disable this setting as unread e-mail is
not deleted. We recommended that you prepare this printer dedicated e-mail account not to
accidentally delete the unread e-mail.

No authentication
Select if the authentication is not necessary.

6. After specifying mail server settings, select OK.

The setting operation is completed.
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Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.

»» Note

» Specify the mail server settings in advance.

= Setting Mail Server

+ If you did not specify the date and time setting using the printer's operation panel, the date and time
may not be reflected on the sent e-mail. We recommended that you set the date and time setting using
the printer's operation panel.

For the date and time setting, see Device user settings.

» These functions can be set only when you are logged in administrator mode.

Specify the information settings by following the steps below.

1. Display printer status on web browser.

2. Select Device settings.

The menus appear.
3. Select Status notification e-mail.

4. Select Notification recipients.

The screen to register the destination appears.

5. Specify destination settings.
Up to 5 destinations can be registered by following the steps below.
1. Select number of destination.
2. Select Register.
3. Enter e-mail address, and then select printer status to send information.
4. Select OK.

The registration for destination is completed.
6. Select Device settings > Status notification e-mail > Retry settings.

7. Specify resending settings.
The number of resending can be specified by following the steps below.
1. Specify number of resending.
2. Specify interval of resending.

3. Select OK.
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The resending setting is completed.
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Printer Parts
» Printer Parts
« Front
« Back
« Top Cover (Inside)
« Carriage
@ Ink Tank Cover (Inside)
@« Operation Panel
» Hard Disk
@ Printer Hard Disk Operations
@« Checking Free Hard Disk Space
@« Erasing Data on Printer's Hard Disk
» Optional accessories
« Roll Holder Set
« Stand
« Stand Parts
« Parts of the Basket
« Roll Unit

@ Parts of the Roll Unit
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Printer Parts

=) Front
=§ Back
=$ Top Cover (Inside)

=p Carriage
=$ |nk Tank Cover (Inside)

=p Operation Panel
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Front

A. Top Cover
Open this cover to install the print head, load paper, and remove any jammed paper from inside the
printer as needed. (See "Top Cover (Inside).")

B. Output Guide
Guides printed documents as they are ejected. Open this guide when loading a roll.

C. Roll holder Slot
Slide the Roll Holder into this slot.

D. Roll Holder
Load the roll on this holder.

E. Holder Stopper
Secure the roll on the Roll Holder with this part.

F. Release Lever
To release paper retainer, lift the lever.

G. Maintenance Cartridge Cover
Open this cover to replace the maintenance cartridge.

H. Maintenance Cartridge
Ink used for maintenance purposes such as head cleaning is absorbed. (Replace the cartridge when it
is full.)

I. Stand
A stand that holds the printer. Equipped with casters to facilitate moving it. (See "Stand Parts.")

J. USB flash drive port
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Insert a USB flash drive to this port.

K. Touch Screen
Use this screen to operate the printer and check the printer status. (See "Operation Panel.")

L. Ink Tank Cover
Open this cover to replace the ink tank. (See "Ink Tank Cover (Inside).")
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Back

A. Carrying Grips
When carrying the printer, have six people hold it by these handles under both sides.

B. USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

C. Wired LAN Connector
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly and

communication is possible between the computer and printer.

D. Power Cord Connector
Connect the power cord to this connector.

E. Roll Unit Power Supply Inlet
Connect the connection cord for the roll unit.
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Top Cover (Inside)

A. Top Cover Roller
Prevents paper from rising when ejected.
B. Cleaning Brush

When cleaning inside the printer under the top cover, use this brush to sweep away paper dust on the
platen.

C. Cutter Blade
A round-bladed cutter for automatic paper cutting.
D. Paper Alignment Line
Align paper with this line when loading it.
E. Carriage
Moves the print head. It serves a key role in printing. (See "Carriage.")

F. Carriage Shaft
The Carriage slides along this shaft.

G. Platen
The print head moves across the platen to print. Vacuum holes on the platen hold paper in place.

H. Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.

I. Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.
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Carriage

A. Print Head Locking Cover
Secures the print head.

B. Print Head
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

C. Print Head Lock Lever
Lock print head locking cover.
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Ink Tank Cover (Inside)

Right Side

Left Side

*1:The figure shows the printer as loaded with a 23.7 fl oz (700 ml) ink tank.

A. Ink Color Label
Load an ink tank that matches the color and name on this label.

B. Ink Lamp (red)
Indicates the state of the ink tank as follows when the ink tank cover is opened.

*+ On
The ink tank is installed correctly.

« Off
No ink tank is installed, or the ink level detection function is disabled.

* Flashing
Ink tank is empty.

»»Note

* When there is little ink left, the ink lamp is lit and @ appears on the touch screen.

C. Ink Tank
Cartridges of ink in various colors.

D. Ink Tank Lock Lever
A lever that locks the ink tank in place and protects it. Lift and lower the lever when replacing an ink

tank. To open it, lift the stopper of the lever until it stops, and then push it down toward the front. To

close it, push it down until it clicks into place.
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Hard Disk

» Printer Hard Disk Operations
» Checking Free Hard Disk Space

» Erasing Data on Printer's Hard Disk
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Printer Hard Disk Operations

Printer hard disk operations are available from the following programs and interfaces.

* Printer driver
* Remote Ul

* Operation panel

The hard disk operations available through each interface are as follows.

Operation Printer driver | Remote Ul | Operation
panel
Saving print jobs Save in mail box v - -
Do not save print jobs in the common box - - v
Save print jobs sent from sources other than | - - v
the printer driver
Operations with saved jobs | Print saved jobs - v v
Delete saved jobs - v v
Job queue management Display job queue - v v
Delete - v v
Preempt jobs - v v
Operations with held jobs - v v
Mail box management Move saved jobs - v -
Modify saved jobs - v -
Modify mail boxes - v -
Print a list of saved jobs - - v
Display a list of saved jobs - v v
Other operations Display free hard disk space - v v
Initialize hard disk - - v
Display the time of printing - v v
Display error messages - v v
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Checking Free Hard Disk Space

Check the space available on the printer's hard disk as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap H Printer information.

= Menu Operations

3. Tap Hard disk information.

The free hard disk space appears.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Hard disk information.

The free hard disk space is shown in the upper-right corner.

Adimmisdialor mode Log of

Hard disk information

Printer status Hard disk capacity

| 260.0GE
Lrtilinies

| Job box free space
Device settings 140.0GE

Job management
Security
Syslem info and LAN seltings

Language selection

Manual (Onling)
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Erasing Data on Printer's Hard Disk

3% Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

» For a more secure method of preventing data recovery, we recommend physically or magnetically
destroying the hard disk. In this case, the hard disk can no longer be used.

* You cannot erase HDD data if there is a job queue. Additionally, print jobs are not processed while data
erasing is in progress.

1. Make sure printer is turned on.

2. Flick HOME screen and tap n Device settings.

= Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap erasing method.

Fast
Erases file management data for print job data stored on the printer's hard disk. Choose this method
for relatively fast erasure. Because only the file management data is erased, the print job data itself
is not erased. Note that it may be possible to read this data using commercial data recovery
software.

Fast secure
Overwrites the entire hard disk with random data. No verification is performed to check if the data
was correctly written. Choose this method to erase highly confidential data. Note that it may be
possible to read the overwritten data using specialized data recovery tools.

Secure
Overwrites the entire hard disk with 00, FF, and random data (one time each). Verification is
performed to check if the data was correctly written. Choose this method to erase especially
confidential data. It is virtually impossible to recover the overwritten data. Conforms to the
DoD5220.22-M standard of the U.S. Department of Defense.

6. Check the message that is displayed and tap Yes.

Data on the hard disk are erased.
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Optional accessories

=) Roll Holder Set

=» Stand

=} Stand Parts

=} Parts of the Basket

=$ Roll unit
=$ Parts of the Roll Unit

221



Roll Holder Set

Load roll paper on the roll holder and then load the holder in the printer. You can use the Roll Holder in the
RH2-27 roll holder set with both 2-inch and 3-inch paper cores. However, if using 3-inch core roll paper,
attach the 3-Inch Paper Core Attachment. (See "Loading Rolls on the Roll Holder.").

* Roll Holder Set RH2-27

> Roll Holder (for 2- and 3-inch paper cores)

o 3-Inch Paper Core Attachment (x2)
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Stand

The following Stand can be used with the printer.

* Printer Stand SD-21

For more information on the main parts of the Stand, see "Stand Parts."

»P»Important

* When moving the Stand, be sure to set the locking caster lock to the OFF position to release the lock.

If you move it while the locking caster are locked, the floor may become scratched.

»P»Note

 For instructions on installing the Stand, see the Setup Guide provided with the Stand.
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Stand Parts

A. Stand Unit
A stand that holds the printer. Equipped with casters to facilitate moving the printer.

B. Basket
Catches the ejected printed documents. (See "Parts of the Basket.")

For instructions on how to use the basket, see "Using the Basket" and "Example Basket
Configurations”.

C. Locking Caster
A locking caster that, when the lock is in the ON position, immobilizes the printer.

When moving the Stand, be sure to set the locking caster lock to the OFF position to release the lock.
If you move it while the locking caster are locked, the floor may become scratched.

D. Accessory Pocket
Store printer manuals, assembly tools, and other items in this pocket.
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Roll Unit

You can use the following roll unit with this printer.

* roll unit RU-21

For details on the main parts of the roll unit, see "Parts of the Roll Unit."

»2»Note

» For instructions on installing the roll unit, see the documentation provided with the roll unit.
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Network Setting
» Network Connection Tips
@ Default Network Settings
@« Another Printer Found with Same Name

@« Connecting to Another Computer via LAN/Changing from USB to LAN
Connection

@ Printing Network Settings

@« Changing LAN Connection Method/Changing Wireless LAN Connection Method
(Windows)

@« Changing Network Settings Using Remote Ul
» |J Network Device Setup Utility
« |J Network Device Setup Utility
« Starting Up IJ Network Device Setup Utility
@ |J Network Device Setup Utility Screen
@« Performing Network Settings
@« Checking Network Status
« |J Network Device Setup Utility Menus
@« Other Network Information
» Sharing the Printer on a Network (Windows)
@« Setting Up a Shared Printer
@ Restrictions on Printer Sharing
» Sharing the Printer on a Network (Mac OS)
@« Settings on Print Server
@« Settings on Client PC
@ Restrictions on Printer Sharing
» Connecting Smartphone/Tablet to Printer via Wireless LAN

@« Connecting Smartphone/Tablet to Printer via Wireless LAN Router
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Network Connection Tips
» Default Network Settings
» Another Printer Found with Same Name

» Connecting to Another Computer via LAN/Changing from USB to LAN
Connection

» Printing Network Settings

» Changing LAN Connection Method/Changing Wireless LAN Connection Method
(Windows)

» Changing Network Settings Using Remote Ul
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Default Network Settings

LAN Connection Defaults

Item Default

Change LAN Activate wired LAN
SSID BJNPSETUP
Communication mode Infrastructure

Wireless LAN security Disable

IP address (IPv4) Auto setup

IP address (IPv6) Auto setup

Set printer name* XXXXXXXXX XXX
Enable/disable IPv6 Enable
Enable/disable WSD Enable

Timeout setting 1 minute

Enable/disable Bonjour Enable

Service name Canon PRO-2000

LPR protocol setting Enable

Wireless LAN DRX setting | Enable

Wired LAN DRX setting Enable

("XX" represents alphanumeric characters.)

* Default value depends on printer. To check value, use operation panel.

= L AN settings

Direct Connection Defaults

Item Default

SSID (Identifier for direct connection) | DIRECT-abXX-PRO-2000 *1

Password YYYYYYYYYY *2

Wireless LAN security WPA2-PSK (AES)

Direct connection device name Z27272777-PR0O-2000 *3

Connection request confirmation | Displayed

*1 "ab" is specified at random and "XX" represents last two digits of printer's MAC address.
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*2 The password is specified automatically when the printer is turned on for the first time.

*3"Z2Z7Z77" represents last six digits of printer's MAC address.
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Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results
screen.

Select a printer with checking the printer settings against those on detection result screen.

Check the printer's MAC address or serial to select the correct printer from the results.

»» Note

+ Serial number may not appear on result screen.

Check the printer's MAC address and the serial number by one of the following methods.
+ Display on the touch screen.
MAC address
= |LAN settings
Serial number

= Printer information

* Print the network settings.

= Printing Network Settings
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Connecting to Another Computer via LAN/Changing from USB to
LAN Connection

= For Windows:
= For Mac OS:

For Windows:

To add a computer to connect to the printer on a LAN or to change from USB to LAN connection, perform
setup using the Setup CD-ROM or follow the instructions on the Canon website.

For Mac OS:

To connect an additional computer to the printer via LAN, or to change from USB to LAN connection,
follow the instructions on the Canon website.
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Printing Network Settings

Use the operation panel to print the printer's current network settings.

32 Important

» The network settings printout contains important information about your network. Handle it with care.

1. Make sure printer is turned on.

2. Load plain paper.

= | oading Rolls on the Roll Holder
= |oading the Upper Roll on the Printer

If you use sheets, load at least 10 sheets (A4 or Letter-sized).

= | oading Sheets in the Printer

3. Flick HOME screen and tap H Device settings.

= Menu Operations

The menu screen appears.

4. Tap Test print.

If you specify the administrator password, enter the password.

5. Tap Print LAN details.
The printer starts printing network settings information.

> Note

* You can also print the printer's network settings. Tap Device settings on the HOME screen, tap
LAN settings and Confirm LAN settings in this order, and then tap Print LAN details and tap
Yes.

The printed network settings information is as follows: (Some setting values are not displayed depending
on the printer settings.)

Item Description Setting

LAN Setting Basic setting information -

Basic Info IPv4 setting information (Wired LAN) |-

LAN Interface Mode Current interface Wired/Wireless/AP Mode/WFD
Mode

Link Active Operation status Inactive/Active

IP Address IPv4 IP address XXX XXX XXX XXX
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Gateway Address

IPv4 default gateway

XXX XXX XXX XXX

Subnet Mask

IPv4 subnet mask

XXX XXX XXX XXX

IP Mode Acquiring method of IPv4 IP address | Auto IP/DHCP/Manual
Use DNS Auto Mode Acquiring DNS server automatically On/Off

Primary DNS Server Address Primary DNS server address XXX XXX XXX XXX
Secondary DNS Server Address | Secondary DNS server address XXX XXX XXX XXX
Control Filtering SNMP filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select

IP filtering method

Admit/Prohibit

IP Filtering Permission Address

IP filtering permission address

Start Address 1 Start address 1 XXX XXX XXX XXX
End Address 1 End address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX XXX XXX XXX
End Address 2 End address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX
End Address 3 End address 3 XXXXXX XXX XXX
Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX
End Address 4 End address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX XXX XXX XXX
End Address 5 End address 5 XXXXXX XXX XXX
Use Single On 5 Use single on 5 On/Off

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 1 Start address 1 XXX XXX XXX XXX
End Address 1 End address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off
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Start Address 2 Start address 2 XXX XXX XXX XXX
End Address 2 End address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX
End Address 3 End address 3 XXX XXX XXX XXX
Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX
End Address 4 End address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off

LAN Setting Basic setting information -

Basic Info IPv4 setting information (Wired LAN) |-

Control Filtering SNMP filtering setting information -

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 5 Start address 5 XXX XXX XXX XXX
End Address 5 End address 5 XXX XXX XXX XXX
Use Single On 5 Use single on 5 On/Off

Print Filtering Print filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select

IP filtering method

Admit/Prohibit

IP Filtering Permission Address

IP filtering permission address

Start Address 1 Start address 1 XXX XXX XXX XXX
End Address 1 End address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off
Start Address 2 Start address 2 XXXXXX XXX XXX
End Address 2 End address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off
Start Address 3 Start address 3 XXX XXX XXX XXX
End Address 3 End address 3 XXX XXX XXX XXX
Use Single On 3 Use single on 3 On/Off

234




Start Address 4 Start address 4 XXX XXX XXX XXX

End Address 4 End address 4 XXX XXX XXX XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX XXX XXX XXX

End Address 5 End address 5 XXX XXX XXX XXX

Use Single On 5 Use single on 5 On/Off

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 1 Start address 1 XXX XXX XXX XXX

End Address 1 End address 1 XXX XXX XXX XXX

Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX XXX XXX XXX

End Address 2 End address 2 XXX XXX XXX XXX

Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX

End Address 3 End address 3 XXX XXX XXX XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX

End Address 4 End address 4 XXX XXX XXX XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX XXX XXX XXX

End Address 5 End address 5 XXX XXX XXX XXX

Use Single On 5 Use single on 5 On/Off

LAN Setting Basic setting information -

IPV6 Info IPVv6 setting information (Wired LAN) |-

Link Local Address Link local address XXXXXXXX XXX XK XXXX
XXXXXXXXKXXXXKXXXX

IP Address IPv6 IP address XXXX:XXXXXXXXXXXX
XXXXXXXXXXXXKXXXX

Prefix Length

Link local address prefix length

XXX (0 to 128)
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Use Manual Mode Operation status of IPv6 manual ad- On/Off
dress
Manual Address Manual address -
IP Address IPv6 IP address XXX XXX XXX XXX X
XXX XXX XXX XXX X

Prefix Length

Prefix length

XXX (0 to 128)

Use Stateful Address Mode Operation status of stateful address On/Off
mode
Stateful Address Stateful address -
IP Address IPv6 IP address XXXXEXXXX XXX X XXX X
XXX XXX XX XX XXXX

Prefix Length

Prefix length

XXX (0 to 128)

Stateless Address

Stateless address

IP Address 1

IP address 1

XXXXXKXXXXXXXXXX
XXXXXKXXXXXXXXXX

Prefix Length 1

Prefix length 1

XXX (0 to 128)

IP Address 2

IP address 2

XXXXXKXXXXXXXXXX
XXXXXKXXXXXXXXXX

Prefix Length 2

Prefix length 2

XXX (0 to 128)

IP Address 3

IP address 3

XXXXXXXXXXXXXXXX
XXXX XXX XXXXXXXX

Prefix Length 3

Prefix length 3

XXX (0 to 128)

IP Address 4

IP address 4

XXXXXKXXXXXXXXXX
XXXXXXXXXXXXXXXX

Prefix Length 4

Prefix length 4

XXX (0 to 128)

Gateway Address

Gateway address

IP Address 1

IP address 1

XXXXXKXXXXXXXXXX
XXXXXKXXXXXXXXXX

Prefix Length 1

Prefix length 1

XXX (0 to 128)

IP Address 2

IP address 2

XXXXXKXXXXXXXXXX
XXXXXKXXXXXXXXXX

Prefix Length 2

Prefix length 2

XXX (0 to 128)

IP Address 3

IP address 3

XXXXXXXXXXXXXXXX
XXXXXKXXXXXXXXXX
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Prefix Length 3

Prefix length 3

XXX (0 to 128)

IP Address 4

IP address 4

XXXXXKXXXXXXXXXX
XXXXXXXXXXXXXXXX

Prefix Length 4

Prefix length 4

XXX (0 to 128)

Use DNS Auto Mode Acquiring DNS server automatically On/Off

Primary DNS Server Address Primary DNS server address XXX XXX XXX XXX
Secondary DNS Server Address | Secondary DNS server address XXX XXX XXX XXX
Control Filtering SNMP filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select

IP filtering method

Admit/Prohibit

IPVv6 Filtering Permission Info

IPV6 filtering permission information

IP Filtering Start Address 1 IP filtering start address 1 XXX XXX XXX XXX
IP Filtering End Address 1 IP filtering end address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off

LAN Setting Basic setting information -

IPv6 Info IPv6 setting information (Wired LAN) |-

Control Filtering SNMP filtering setting information -

IP Filtering Start Address 2 IP filtering start address 2 XXX XXX XXX XXX
IP Filtering End Address 2 IP filtering end address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXX XXX XXX XXX
IP Filtering End Address 3 IP filtering end address 3 XXX XXX XXX XXX
Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXXXX XXX XXX
IP Filtering End Address 4 IP filtering end address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXX XXX XXX XXX
IP Filtering End Address 5 IP filtering end address 5 XXXXXX XXX XXX
Use Single On 5 Use single on 5 On/Off
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IPv6 Filtering Prohibit Info

IPv6 Filtering prohibit information

IP Filtering Start Address 1 IP filtering start address 1 XXX XXX XXX XXX
IP Filtering End Address 1 IP filtering end address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXX XXX XXX XXX
IP Filtering End Address 2 IP filtering end address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXX XXX XXX XXX
IP Filtering End Address 3 IP filtering end address 3 XXX XXX XXX XXX
Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXXXX XXX XXX
IP Filtering End Address 4 IP filtering end address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXX XXX XXX XXX
IP Filtering End Address 5 IP filtering end address 5 XXX XXX XXX XXX
Use Single On 5 Use single on 5 On/Off

Print Filtering Print filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select

IP filtering method

Admit/Prohibit

IP Filtering Permission Info

IP filtering permission information

IP Filtering Start Address 1 IP filtering start address 1 XXX XXX XXX XXX
IP Filtering End Address 1 IP filtering end address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off
IP Filtering Start Address 2 IP filtering start address 2 XXX XXX XXX XXX
IP Filtering End Address 2 IP filtering end address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

LAN Setting

Basic setting information

IPv6 Info

IPVv6 setting information (Wired LAN)

Print Filtering

Print filtering setting information
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IP Filtering Start Address 3 IP filtering start address 3 XXX XXX XXX XXX
IP Filtering End Address 3 IP filtering end address 3 XXX XXX XXX XXX
Use Single On 3 Use single on 3 On/Off
IP Filtering Start Address 4 IP filtering start address 4 XXX XXX XXX XXX
IP Filtering End Address 4 IP filtering end address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off
IP Filtering Start Address 5 IP filtering start address 5 XXX XXX XXX XXX
IP Filtering End Address 5 IP filtering end address 5 XXX XXX XXX XXX
Use Single On 5 Use single on 5 On/Off
IPv6 Filtering Prohibit Info IPv6 Filtering prohibit information -
IP Filtering Start Address 1 IP filtering start address 1 XXX XXX XXX XXX
IP Filtering End Address 1 IP filtering end address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off
IP Filtering Start Address 2 IP filtering start address 2 XXX XXX XXX XXX
IP Filtering End Address 2 IP filtering end address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off
IP Filtering Start Address 3 IP filtering start address 3 XXX XXX XXX XXX
IP Filtering End Address 3 IP filtering end address 3 XXXXXX XXX XXX
Use Single On 3 Use single on 3 On/Off
IP Filtering Start Address 4 IP filtering start address 4 XXX XXX XXX XXX
IP Filtering End Address 4 IP filtering end address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off
IP Filtering Start Address 5 IP filtering start address 5 XXX XXX XXX XXX
IP Filtering End Address 5 IP filtering end address 5 XXX XXX XXX XXX
Use Single On 5 Use single on 5 On/Off
MAC Info MAC address setting information -

(Wired/Wireless LAN)
MAC Address(Wired) MAC address (Wired LAN) XXXX XX XX XX XX
MAC Address(Wireless) MAC address (Wireless LAN) XXXXXXXXXXXX
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Use MAC Address Filtering

Operation status of MAC address fil-
tering

On/Off

MAC Filtering Select

MAC address filtering method

Admit/Prohibit

MAC Filtering Permission Info

MAC filtering permission information

MAC Address 1 MAC address 1 XXXXXX XX XX XX
MAC Address 2 MAC address 2 XXXXXX XX XX XX
MAC Address 3 MAC address 3 XX XX XX XX XX XX
MAC Address 4 MAC address 4 XXXXXXXX XX XX
MAC Address 5 MAC address 5 XXXXXXXXXXXX
LAN Setting Basic setting information -

MAC Info MAC address setting information -

(Wired/Wireless LAN)

MAC Filtering Prohibit Info MAC filtering prohibit information -

MAC Address 1 MAC address 1 XX XXXXXX XX XX
MAC Address 2 MAC address 2 XXXX XX XX XX XX
MAC Address 3 MAC address 3 XXXXXXXX XX XX
MAC Address 4 MAC address 4 XXXXXX XX XX XX
MAC Address 5 MAC address 5 XX XX XX XX XX XX
Proxy Setting Proxy server setting information -

Use Proxy Use proxy server On/Off

Proxy Server Address

Proxy server address

XXXXXXXXXXXXXXXX (up to 128
characters)

Proxy Port Number

Proxy port specification

110 65535

Use User Authority Mode

Use user authority mode

On/Off

Proxy Server User Name

Proxy server user name

XXXXXXXXXXXXXXXX (up to 64
characters)

Proxy Server Password

Proxy server password

XXXXXXXXXXXXXXXX (up to 64
characters)

Wireless LAN Setting

Wireless LAN setting information

Channel

Channel (infrastructure)

XXX (0 to 255)
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SSID

SSID

Wireless LAN (infrastructure) SSID
(up to 32 characters)

Security Type Security type for Wireless LAN (infra- | Disabled/WEP 64bit/WEP
structure) 128bit/WPA PSK TKIP/WPA PSK
AES/WPA2 PSK TKIP/WPA2 PSK
AES/MIXED
WEP1 WEP key 1 for Wireless LAN (infra- XXXXXXXX (up to 32 characters)
structure)
WEP2 WEP key 2 for Wireless LAN (infra- XXXXXXXX (up to 32 characters)
structure)
WEP3 WEP key 3 for Wireless LAN (infra- XXXXXXXX (up to 32 characters)
structure)
WEP4 WEP key 4 for Wireless LAN (infra- XXXXXXXX (up to 32 characters)

structure)

WEP Certificate WEP certificate for Wireless LAN (in- [ Open/Shared/Auto
frastructure)
WEP Format WEP format for Wireless LAN (infra- | Hex/String
structure)
WPA PSK Passphrase for Wireless LAN (infra- XXXXXXXX (up to 64 characters)

structure)

P2P LAN Setting

P2P LAN setting information

Channel Channel (P2P) XXX (0 to 255)

SSID SSID Wireless LAN SSID (P2P)

Security Type Security type for Wireless LAN (P2P) | Disabled/WPA2 PSK TKIP/WPA2
(up to 32 characters) PSK AES

WPA PSK Passphrase for Wireless LAN (P2P) XXXXXXXXXX (up to 10 characters)

WEFD LAN Setting

WFD LAN setting information

Device Name

Device name

XXXXXXXX (up to 32 characters)

Channel Channel (WFD) XXX (0 to 255)

SSID SSID Wireless LAN SSID (WFD) (up to 32
characters)

Security Type Security type for Wireless LAN (P2P) | Disabled/WPA2 PSK TKIP/WPA2
PSK AES

WPA PSK Passphrase for Wireless LAN (P2P) XXXXXXXXXX (up to 10 characters)

Use Notify Connection

Use notify connection

On/Off
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Protocol Setting

Protocol setting information

Printer Name

Printer name

XXXXXXXX (up to 16 characters)

Use LPR

Use LPR

On/Off

Printer Location

Printer location

XXXXXXXX (up to 16 characters)

Use Wired Power Save Discontinuous reception (Wired LAN) [ On/Off
Use Wireless Power Save Discontinuous reception (Wireless On/Off
LAN)

Use RAW Use RAW On/Off
Use LLMNR Use LLMNR On/Off
Use Spanning Tree Use spanning tree On/Off
WSD Setting WSD setting information -

Use WSD Use WSD On/Off
WSD Timeout Timeout 1/5/10/15/20 [min]
Use WSD Push Scan Use WSD push scan On/Off
Use WSD Rx Optimization Use WSD reception optimization On/Off
SNMP Setting SNMP setting information -

Use SNMPv1 Use SNMPv1 On/Off
Use SNMPv3 Use SNMPv3 On/Off

SNMP Community Name1

SNMP community name 1

XXXXXXXX (up to 32 characters)

SNMP Community Name2

SNMP community name 2

XXXXXXXX (up to 32 characters)

SNMP Extra Access Authority

SNMP extra access authority

Read Only/Read Write

SNMP Access Authority1

SNMP access authority 1

Read Only/Read Write

SNMP Access Authority?2

SNMP access authority 2

Read Only/Read Write

SNMPV3 Setting

SNMPV3 setting information

User1 User 1 -
User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting

Security setting

No Auth No Encrypt/Auth No En-
crypt/Auto Encrypt
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Authority Algorithm

Authority algorithm

None/MD5/SHA1

Authority Password

Authority password

XXXXXXXX (0 to 16 characters)

Encryption Algorithm

Encryption algorithm

None/AES/DES

Encryption Password

Encryption password

XXXXXXXX (0 to 16 characters)

User2 User 2 -
User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Encrypt/Auth No En-
crypt/Auto Encrypt
Authority Algorithm Authority algorithm None/MD5/SHA1

Authority Password

Authority password

XXXXXXXX (0 to 16 characters)

Encryption Algorithm

Encryption algorithm

None/AES/DES

Encryption Password

Encryption password

XXXXXXXX (0 to 16 characters)

SNMPV3 Setting

SNMPV3 setting information

User3 User 3 -
User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Encrypt/Auth No En-
crypt/Auto Encrypt
Authority Algorithm Authority algorithm None/MD5/SHA1

Authority Password

Authority password

XXXXXXXX (0 to 16 characters)

Encryption Algorithm

Encryption algorithm

None/AES/DES

Encryption Password

Encryption password

XXXXXXXX (0 to 16 characters)

User4 User 4 -
User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write
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Security Setting

Security setting

No Auth No Encrypt/Auth No En-
crypt/Auto Encrypt

Authority Algorithm

Authority algorithm

None/MD5/SHA1

Authority Password

Authority password

XXXXXXXX (0 to 16 characters)

Encryption Algorithm

Encryption algorithm

None/AES/DES

Encryption Password

Encryption password

XXXXXXXX (0 to 16 characters)

User5 User 5 -
User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Encrypt/Auth No En-
crypt/Auto Encrypt
Authority Algorithm Authority algorithm None/MD5/SHA1

Authority Password

Authority password

XXXXXXXX (0 to 16 characters)

Encryption Algorithm

Encryption algorithm

None/AES/DES

Encryption Password

Encryption password

XXXXXXXX (0 to 16 characters)

SNTP Setting

SNTP setting information

Use SNTP

Use SNTP

On/Off

SNTP Polling Interval

SNTP polling interval

1 to 48 [sec]

SNTP Server Name

SNTP server name

XXXXXXXX (up to 256 characters)

FTP Setting FTP setting information -
Use FTP Use FTP On/Off
Use FTP Authority Use FTP authority On/Off

FTP User Name

FTP user name

XXXXXXXX (up to 33 characters)

FTP Password

FTP password

XXXXXXXX (up to 33 characters)

Bonjour Setting

Bonjour setting information

Use Bonjour

Use Bonjour

On/Off

Bonjour Service Name

Bonjour service name

Bonjour service name (Up to 50 al-
phanumeric characters)

802.1X Setting

802.1X setting information
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Authority State

802.1X authority state

Invalid/Authorized

Authority Type Enable/disable 802.1X and authority [ Off/On/EAP-TTLS
type
EAP TTLS Type Internal authority type for EAP-TTLS Invalid/Authorized

Weak Encryption Restriction

Weak encryption restriction

Invalid/Authorized

Weak Certificate Restriction

Weak certificate restriction

Invalid/Authorized

Login Name Login name XXXXXXXX (up to 24 characters)
User Name User name XXXXXXXX (up to 24 characters)
Password Password XXXXXXXX (up to 24 characters)

Server Name

Server name

XXXXXXXX (up to 43 characters)

IPsec Setting

IPsec setting information

Use IPsec

Use IPsec

On/Off

Previous Shared Key

Previous shared key for IPsec

XXXXXXXX (up to 17 characters)

Phase2 Protocol IPsec phase2 protocol AH/ESP/AH+ESP
AAP Location Info AAP location information -
Height Height 0 to 65535

Latitude Info

Latitude information

Direction Direction South Latitude/North Latitude
Time Time 0to 90

Minute Minute 0to 59

Sec1 Sec 1 0to 59

Sec?2 Sec 2 0 to 999

Longitude Info

Longitude information

Direction Direction South Latitude/North Latitude
Time Time 0to 90

Minute Minute 0to 59

Sec1 Sec 1 0to 59

Sec2 Sec 2 0 to 999

Email Setting E-mail setting information -
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Retry Count E-mail retry count Oto5

Retry Interval E-mail retry interval 1 to 60 (min)
Use Email Notification Use E-mail notification On/Off

Use SSL Use SSL On/Off

Use SSL Cert No Check Use SSL certification On/Off

Use Mailbox Delete Use mailbox delete On/Off

Email Setting

E-mail setting information

SMTP Server Address

SMTP server address

XXXXXXXX (up to 64 characters)

SMTP Server Port No

SMTP server port number

110 65535

SMTP State

SMTP state

Invalid/Authorized/POP before
SMTP

From Address 1

From address 1

XXXXXXXX (up to 128 characters)

To Address 1

To address 1

XXXXXXXX (up to 128 characters)

Reply Address 1

Reply address 1

XXXXXXXX (up to 128 characters)

Notice Conditions 1

Notice conditions 1

Job End Job end On/Off
Error Occurred Error occurred On/Off
Warning Occurred Warning occurred On/Off

Signature 1 Signature 1 XXXXXXXX (up to 128 characters)
To Address 2 To address 2 XXXXXXXX (up to 128 characters)
Reply Address 2 Reply address 2 XXXXXXXX (up to 128 characters)

Notice Conditions 2

Notice conditions 2

Job End Job end On/Off
Error Occurred Error occurred On/Off
Warning Occurred Warning occurred On/Off

Signature 2 Signature 2 XXXXXXXX (up to 128 characters)
RUI Setting RUI setting information -

Use RUI Use Remote Ul On/Off

Language Language -
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("XX" represents alphanumeric characters.)
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Changing LAN Connection Method/Changing Wireless LAN
Connection Method (Windows)

= Changing LAN Connection Method
= Changing Wireless LAN Connection Method

Changing LAN Connection Method

Follow either procedure below to change LAN connection method (wired or wireless).

¢ For Windows:

o Use the Setup CD-ROM or follow the instructions on the Canon website to redo setup.
o Tap LAN settings and Change LAN in this order on the HOME screen, and then select Activate
wireless LAN or Activate wired LAN.

After that, perform settings on the Protocol Settings... screen on IJ Network Device Setup Utility.

For details, refer to Performing/Changing Wireless LAN Settings or Performing/Changing Wired
LAN Settings.

¢ For Mac OS:

Follow the instructions on the Canon website to redo setup.

Changing Wireless LAN Connection Method
Follow either procedure below to change wireless LAN connection method (infrastructure or direct
connection).

* For Windows:

o Use the Setup CD-ROM or follow the instructions on the Canon website to redo setup.
o Perform settings on the Protocol Settings screen on IJ Network Device Setup Ultility.

22 Important

» Before you perform settings using |J Network Device Setup Utility, turn on cableless setup
mode on the printer following the procedure below.

1. Make sure printer is turned on.

2. Flick HOME screen and tap LAN settings.

= Menu Operations

If you specify the administrator password, enter the password.
3. Tap Wireless LAN setup.
4. Tap Cableless setup.
5. Check message and tap OK.

Follow instructions on your smartphone or tablet.

6. If message saying setup is completed appears, tap OK.
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¢ For Mac OS:

Follow the instructions on the Canon website to redo setup.
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Changing Network Settings Using Remote Ul

You can use Remote Ul on the following OS and the web browser.
* iOS device
0S:i0S 7.0 or later
Web browser: iOS standard Web browser (Mobile Safari)
» Android device
OS: Android 4.0 or later
Web browser: Android standard Web browser (Browser or Chrome)
* Mac OS device
OS: Mac OS X v.10.6 or later
Web browser: Safari 5.1 or later
* Windows device
OS: Windows Vista SP2 or later

Web browser: Internet Explorer 9 or later, Google Chrome 41.0.2272.118m or later, Mozilla Firefox
37.0.1 or later

22 Important

» Enable JavaScript and cookies in the web browser.

+ If you access Remote Ul with the printer name instead of its IP address, make sure the DNS settings
are correctly configured.

» Depending on the network environment, you may not be able to start Remote UI.

» Make sure Do not restrict is selected for Remote Ul on Operation restrictions in Device user
settings under Device settings.

»» Note

+ Remote Ul also offers many other features. You can display the ink levels, check error messages and
other status information, and cancel print jobs.
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IJ Network Device Setup Utility

» |J Network Device Setup Utility

¥

Starting Up IJ Network Device Setup Utility

¥

IJ Network Device Setup Utility Screen

¥

Performing Network Settings

¥

Checking Network Status

¥

IJ Network Device Setup Utility Menus

¥

Other Network Information
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IJ Network Device Setup Utility

IJ Network Device Setup Utility allows a network/printer administrator to manage printers on network. When
you perform printer setup, the utility is installed at the same time.

Use IJ Network Device Setup Utility for:

» Searching printers on network and performing initial network setup for detected printers

» Performing initial network setup by connecting the printer and computer using a USB cable (Not
available for some models)

» Changing printer network settings

» Checking status between computer on which IJ Network Device Setup Utility is installed and printer if
anything is wrong with connection

3% Important

* You can use |J Network Device Setup Utility only on Windows.

» Depending on the printer you are using, an administrator password is already specified for the printer at
the time of purchase. When you change the network settings, authentication by the administrator
password is required.

For details:
= Administrator Password
For improving security, we recommend to change the administrator password.

= Changing Administrator Password

» To use the printer over LAN, make sure you have the equipment necessary for the connection type,
such as a wireless router or a LAN cable.

* When you perform setup or install IJ Network Device Setup Utility, disable block function of firewall.

» Do not change network settings using IJ Network Device Setup Utility while printing is in progress.
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Starting Up IJ Network Device Setup Utility

Start up IJ Network Device Setup Utility as shown below.

* In Windows 10, select All apps on the Start screen and select IJ Network Device Setup Utility. If IJ
Network Device Setup Utility is not displayed, search for "IJ Network Device Setup Utility" on Search
the web and Windows.

* In Windows 8.1 or Windows 8, select IJ Network Device Setup Utility on the Start screen to start IJ
Network Device Setup Utility. If IJ Network Device Setup Utility is not displayed on the Start screen,
select the Search charm and search for "IJ Network Device Setup Utility".

* In Windows 7 or Windows Vista, click Start and select All Programs, Canon Utilities, IJ Network
Device Setup Utility, and then IJ Network Device Setup Ultility.

When you start up IJ Network Device Setup Ultility, it searches for printers on network and detected printers
are listed.
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IJ Network Device Setup Utility Screen

= |tems on |J Network Device Setup Utility Screen
= Menus on |J Network Device Setup Utility Screen
= |tems on |J Network Device Setup Utility Screen Toolbar

Items on IJ Network Device Setup Utility Screen

The screen below appears when you start up IJ Network Device Setup Utility. Detected printers are listed
on the screen and the items below are shown.
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1. Product Name

Displays the product name of detected printer. The icon below appears on the left if the printer cannot
be used.

'l:i: Appears when the printer has not been connected or configured.

I? : Appears when the IP address is duplicated to another printer.

: Appears when you cannot communicate with the printer.

»» Note

+ If a printer you want to use is not detected, try to set the criteria for printer search.

= Setting Criteria for Printer Search/Searching Specific Printer

2. Serial Number (Last 5 Digits)

Displays the last five digits of printer's serial number.

3. Status

Displays the printer status as shown below.

Available
Indicates the printer is available.
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Setup Completed
Appears after performing network setup and clicking Set to close the window.

Not Connected
Indicates the printer is required to perform wireless LAN setup.

= Performing/Changing Wireless LAN Settings

Not Set
Indicates the printer cannot be used on network. Specify an IP address or enable IPv6.

IP Address Overlap
Indicates the IP address is duplicated to another printer.

Unknown
Indicates the printer used in the past cannot be used currently.

»» Note

 If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

. IP Address

Displays the printer IP address.

»» Note

« If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface
(wireless/wired LAN) disabled on the printer setting.

. Location

Displays the printer location if it is registered.

»» Note

+ If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

= Assigning Printer Information

. Connection Method

Displays printer connection method (wired or wireless LAN).

»» Note

 If USB is selected from the pulldown menu on the toolbar, either of the LAN connection method

(wired or wireless) available for the printer is displayed.

If the printer supports both of the LAN connection methods, the printer is recognized as two

printers and they are displayed separately.

If the printer does not support wired LAN, wired LAN is not displayed.

* If you are using IJ Network Device Setup Utility on the computer which does not support
wireless LAN, wireless LAN is not displayed.

« If you are using the printer with direct connection, neither wired LAN nor wireless LAN is

displayed.
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7.

10.

Setting Method
Displays printer setting method.
* Auto
Appears if the printer is used by IP address specified automatically.
* Manual

Appears if the printer is used by IP address specified manually.

»» Note

« If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface
(wireless/wired LAN) disabled on the printer setting.

. MAC Address

Displays the MAC address of the detected printer.
3> Note

* [f USB is selected from the pulldown menu on the toolbar,
(wireless/wired LAN) disabled on the printer setting.

is displayed for the interface

Device Name

Displays the printer device name if it is registered.

»» Note

 If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

= Assigning Printer Information

IPv6
On appears when an IPv6 address is assigned for the printer.

»» Note

« If USB is selected from the pulldown menu on the toolbar, "-" is displayed.

Menus on IJ Network Device Setup Utility Screen

This section describes menus on |J Network Device Setup Utility screen.

1 2 3 A

o

;[F‘ri.nter] | View) |Option| | Help|

C IPvd A |
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1. Printer menu

= Printer Menu

2. View menu

= View Menu

3. Option menu

= Option Menu

4. Help menu

= Help Menu

Items on IJ Network Device Setup Utility Screen Toolbar

This section describes items on IJ Network Device Setup Utility Screen toolbar.

o

' Printer  View Option Help

o0

4 -1

1. Perform wired or wireless LAN setup.

»» Note

» This item has the same function as Protocol Settings... in the Printer menu.

2. Redetects printers.

> Note

» This item has the same function as Update in the View menu.

3. Stops detecting printers.
3> Note

» This item has the same function as Cancel in the View menu.

4. Switches the printer list. (IPv4, IPv6, or USB printers)
> Note

+ This item has the same function as Switch IPv4/IPv6/USB in the View menu.
* You can also display the USB connected printer list. (Not available for some models.) In this
case, select USB.
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5. Displays this guide.
2> Note

» This item has the same function as Online Manual in the Help menu.
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Performing Network Settings

>

>

Performing/Changing Wired LAN Settings
Performing/Changing Wireless LAN Settings

Assigning Printer Information

Initializing Network Settings

Changing Administrator Password

Setting Criteria for Printer Search/Searching Specific Printer
If WEP Details Screen Appears

If WPA/WPA2 Details Screen Appears
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Performing/Changing Wired LAN Settings

Follow the procedure below to perform/change wired LAN settings.

»» Note

» For some models, you can perform network setup for a USB connected printer using IJ Network Device
Setup Utility. Select USB on Switch IPv4/IPv6/USB under the View menu to display printers for which
you can perform setup.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to perform/change settings from printer list.

Select the printer with Wired LAN displayed on Connection Method and the setting other than
Unknown or Setup Completed displayed on Status to perform settings.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and
select the printer with Wired LAN displayed on Connection Method.

3. Select Protocol Settings... on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

»» Note

* Clicking the icon allows you to perform/change settings.

4. Enter password and click OK.

The Protocol Settings screen appears.

5. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

+ IPv4 settings
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(% 5e= 7 address automancai} 2

Ve et P address

1. Use IPv4 address
Always selected. (displayed in a gray out state)
2. Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP
server functionality must be enabled on your router.

3. Use next IP address

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address, subnet mask, and default gateway.

* |IPv6 settings
22> Note

+ If USB is selected from the pulldown menu on the toolbar, you cannot perform IPv6 settings.

1
# " " 1
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v
-
U] Lo Manual Addrees
3
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a
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Set || cancel Hep
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1. Use IPv6 address
Select when you use the printer with IPv6 environment.
2. Use Stateless Address:

Select when you use an IP address assigned automatically. Use a router compatible with IPv6.

> Note

» This setting item is not available depending on the printer you are using.

3. Use Manual Address:

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address and IP address prefix length.
2> Note

» This setting item is not available depending on the printer you are using.

4. Use DHCPV6:

Select when you obtain an IP address using DHCPV6.

»» Note

+ This setting item is not available depending on the printer you are using.

6. Click Set.
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Performing/Changing Wireless LAN Settings

Follow the procedure below to perform/change wireless LAN settings.

32 Important

» Enable cableless setup before performing printer setup. (Not required if you change the IP address.)
For details, search for "NR049" on your printer's online manual and see the page shown.

»» Note

» For some models, you can perform network setup for a USB connected printer using IJ Network Device
Setup Utility. Select USB on Switch IPv4/IPv6/USB under the View menu to display printers.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to perform/change settings from printer list.

Select the printer with Wireless LAN displayed on Connection Method and the setting other than
Unknown or Setup Completed displayed on Status to perform settings.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and
select the printer with Wireless LAN displayed on Connection Method.

3. Select Protocol Settings... on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

> Note

+ Clicking the icon allows you to perform/change settings.

4. Enter password and click OK.

The Protocol Settings screen appears.

5. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

* IPv4/IPv6 settings
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Hetwork Type:
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Encryption Mathod: | I
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1 Get P address automaticaly
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1. Network Type:
Select the wireless LAN mode.

Infrastructure
Connects the printer to the wireless LAN with a wireless router.

Direct
Connects the printer to wireless communication devices without a wireless router.

> Note

+ If Direct is selected, the Search... button is displayed in a gray out status.

In addition, you cannot connect to Internet from your computer depending on your
operating environment.

2. SSID:
The network identifier (SSID) of the wireless LAN currently used is displayed.
The identifier for direct connection (SSID) appears while in direct connection.
3. Search...

The Detected Wireless Routers screen is displayed to select a wireless router to connect to.
For a wireless router already connected to the computer, Available is displayed on
Communication Status.

If you select a wireless router with Not Connected on Communication Status from the list,
clicking Set displays the WPA/WPA2 or WEP setting screen for a wireless router.

= |f WEP Details Screen Appears
= |[f WPA/WPA2 Details Screen Appears

4. Encryption Method:
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Displays the encryption method used over the wireless LAN.

* |Pv4 settings
2> Note

» The setting items below are available only when Infrastructure is selected for Network
Type:.

If Direct is selected, the setting items below are displayed in a gray out status.

Protocol Settings (Wireless LAN) n
Hetwork Type:
¥ Infrastructure
Diewct
SE1: L — Search...
Ercryption Mathod
Fr | P8
[i Get PP addrass I\.'.c-"'a'\.'.'r.] E

Uiz et IP address 1
a3

1. Use IPv4 address
Always selected. (displayed in a gray out state)
2. Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP
server functionality must be enabled on your router.

3. Use next IP address

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address, subnet mask, and default gateway.

* |IPv6 settings
2> Note

« If USB is selected from the pulldown menu on the toolbar, you cannot perform IPv6 settings.
+ The setting items below are available only when Infrastructure is selected for Network

Type:.

If Direct is selected, the setting items below are displayed in a gray out status.
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Protocol Settings (Wireless LAN) B

lietwark Type:
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1. Use IPv6 address
Select when you use the printer with IPv6 environment.
2. Use Stateless Address:
Select when you use an IP address assigned automatically. Use a router compatible with IPv6.

»» Note

+ This setting item is not available depending on the printer you are using.

3. Use Manual Address:

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address and IP address prefix length.
2> Note

» This setting item is not available depending on the printer you are using.

4. Use DHCPV6:

Select when you obtain an IP address using DHCPVG.

»» Note

 This setting item is not available depending on the printer you are using.

6. Click Set.
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Assigning Printer Information

Follow the procedure below to assign/change printer location name or device name.

The names appear on Device Name: and Location: on the IJ Network Device Setup Utility screen.

»>» Note

* If USB is selected from the pulldown menu on the toolbar, this setting item is not available.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to assign location name and device name.

Select the printer with Available displayed on Status.

3. Select Detailed Printer Settings... on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

The Detailed Printer Settings screen appears.

5. Perform/change settings.

Detadled Printer Settings
[m.--:s Farma J— 1
| [L-:-:r.-\:l': J_ 2

cat Cance

The setting items below are available.
1. Device Name:
Assigns the device name.
2. Location:

Assigns the location name.

6. Click Set.
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Initializing Network Settings

Follow the procedure below to initializing printer network settings.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to initialize settings.

Select the printer with Available displayed on Status.

3. Select Reset LAN settings on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

5. Click Yes on the displayed screen.

6. Click OK on the displayed screen.

The printer network settings are initialized.
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Changing Administrator Password

Follow the procedure below to change the administrator password.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to change password.

Select the printer with Available displayed on Status.

3. Select Change Password... on Printer menu.

The Change Printer Password screen appears.
For more on the password, refer to Administrator Password.

Change Printer Password ﬂ

Dkl Pangaesng

tiew Padgwoord:

oK Cancel

4. Enter current password and new password.
5. Enter new password in Confirm: again.

6. Click OK.

The administrator password is updated.
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Setting Criteria for Printer Search/Searching Specific Printer

You can set the criteria for printer search when you start up IJ Network Device Setup Ultility or update the
printer search, or you can search the specific printer.

Changing these settings may detect the printer you want to use if it is not detected

»» Note

« If the printer you want to use is not detected, it may be detected by entering IP address, subnet mask,
or default gateway on the operation panel and search again.

= Setting Criteria for Printer Search
= Searching Specific Printer

Setting Criteria for Printer Search

1. Start up I|J Network Device Setup Utility.

2. Select Search Settings... on Option menu.

The Search Settings screen appears.

3. Enter criteria for printer search.

Search SeTings ﬂ
Bl Search Tima: 10 = s, [5-30) -1 1
This walss spacifies the ssarch processing -r-w-_]
Tima put: z . s, (149)
This i thob Timw-out vailse Tor not recedang 3 responss from the printer after & has 2
haon detichd
e angel liglp

1. Search Time:
Specifies the time to search printers.
2. Time out:

Specifies the timeout length for not receiving a response from printer.

> Note

* Printers you want to find are more likely to be detected as the values are larger, however, it may
take a while to search them.

4. Click Set.

Searching Specific Printer

1. Start up |J Network Device Setup Utility.
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2. Select Specified Searching... on Option menu.

The Specified Searching screen appears.

3. Select item to specify and enter value.

Select the search method, and then cick [Search].
The results will be displayed in the lst.

1. IPv4 Address

Specifies the IPv4 address of the printer you want to search.
2. IPv6 Address

Specifies the IPv6 address of the printer you want to search.
3. Host Name

Specifies the host name of the printer you want to search.

4. Click Search.

IJ Network Device Setup Utility starts searching by the specified criteria and detected printers are
listed.
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If WEP Details Screen Appears

Enter the password (passphrase) according to wireless router's encryption method if you change a wireless

router to connect to the printer.

1. Enter items below when WEP Details screen appears.

3 WEP Details Ex
i H
Eey Length ;T w =
Eey Format =1 W 3
= =4
Sal Crancel
1. WEP Key:

Enter the same key as the one set to the wireless router.

The number of characters and character type that can be entered differ depending on the
combination of the key length and key format.

Key Length:
64bit 128bit
Key Format: | ASCII 5 characters | 13 characters
Hexadecimal (Hex) | 10 digits 26 digits
2. Key Length:

Select either 64bit or 128bit.
. Key Format:

Select either ASCII or Hex.
. Key ID:

Select the Key ID (index) set to the wireless router.

2. Click Set.
2» Important

« |If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure encryption types for the computer and the wireless router match that set to
the printer.
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If WPA/WPA2 Details Screen Appears

Enter the password (passphrase) according to wireless router's encryption method if you change a wireless
router to connect to the printer.

1. Enter passphrase when WPA/WPA2 Details screen appears.

Enter the passphrase set to the wireless router. The passphrase should be a string of 8 to 63
alphanumeric characters or a 64-digit hexadecimal value.

If you do not know the wireless router passphrase, refer to the instruction manual provided with the
wireless router or contact its manufacturer.

& WPA/WPAZ Details n
[Fars*mh- A58 ]
Set Caancel
2. Click Set.
3% Important

« If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure encryption types for the computer and the wireless router match that set to
the printer.
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Checking Network Status
» Checking Wireless Network Status
» Displaying Computer Network Information
» Displaying Printer Network Information
» Checking Connection Status between Printer and Wireless Router

» Checking Network Setting Difference
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Checking Wireless Network Status

Follow the procedure below to check the wireless network status (signal strength) between the printer and
computer.

If anything is wrong with the wireless LAN connection, check the network status from this menu.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.

2. Select printer to check wireless network status from printer list.

Select the printer with Available displayed on Status.

3. Select Check Wireless Communication Status on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

« If the printer is connected to the computer with a wireless router:

The screen below appears.

Communication status between printer and wireless router
Sgnal Strength: 100%

[ [ vocote |

Communication status between computer and wireless router
Signal Strength: 100%

N -

« If the printer is connected to the computer using direct connection:

The screen below appears.

Communication status between computer and printer
Signal Strength: 100%

Clicking Update measures the signal strength again.

5. Click OK to close screen.
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Displaying Computer Network Information

Follow the procedure below to display the network information of the computer which the printer selected in
the IJ Network Device Setup Utility screen connects to and on which IJ Network Device Setup Utility is
installed.

1. Start up IJ Network Device Setup Utility.

2. Select Computer Network Information on View menu.

The screen below appears.
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Clicking Copy Info copies all network information on the clipboard.

3. Click OK to close screen.
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Displaying Printer Network Information

Follow the procedure below to display the printer network information.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.

2. Select printer to display network information from printer list.

Select the printer with Available displayed on Status.

3. Select Printer Network Information on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

The screen below appears.
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Clicking Copy Info copies all network information on the clipboard.

5. Click OK to close screen.
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Checking Connection Status between Printer and Wireless Router

Follow the procedure below to check the wireless router information detected by the printer.

Detects wireless routers around the printer and the detected ones are listed. Use this menu to make sure
whether the printer is located properly.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.

2. Select printer to check connection status between printer and wireless router from printer
list.

Select the printer with Available displayed on Status and Wireless LAN displayed on Connection
Method.

3. Select Status of Printer and Wireless Router Connection on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

The screen below appears.
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Clicking Update searches wireless routers again.

5. Click OK to close screen.
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Checking Network Setting Difference

If you cannot use a printer you used on the network before, compare the current network status with that
when you could use the printer and check the difference.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.
2. Select printer with Unknown or Not Set displayed on Status from printer list.

3. Select Check Connection Status on View menu.

The screen below appears.
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If the network status when you used the printer is different from the current status, Mismatch appears on
Status and the items are displayed in red. Check the red items.

4. Click OK to close screen.
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IJ Network Device Setup Utility Menus
» Printer Menu
» View Menu
» Option Menu

» Help Menu
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Printer Menu

This section describes the items displayed on the Printer menu.

Y

| Printer  View Option Help

| Protacol Settings... :‘

[Detailed Printer Settinq:‘....}
[Reset LAN settings }

(Change Password...}

[ Check Wireless Communication Siatus —
[5et up device by using web brl:rw:er_}—|
[ E:m‘t':r T

< 00 O AW MN-=

1. Protocol Settings...

Performs wired or wireless LAN settings.

= Performing/Changing Wired LAN Settings
= Performing/Changing Wireless LAN Settings

2. Detailed Printer Settings...

Assigns the printer device name and location name.

= Assigning Printer Information

3. Reset LAN settings

Initializes the printer LAN settings.

= |nitializing Network Settings

4. Change Password...

Changes the password specified for the printer.

= Changing Administrator Password

5. Check Wireless Communication Status

Check wireless LAN communication status.

= Checking Wireless Network Status

6. Set up device by using web browser

Check the printer information or perform settings in detail on the web page.

»» Note

* You can use this function on the following the OS and the web browser.

OS: Windows Vista SP2 or later
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Web browser: Internet Explorer 9 or later, Google Chrome 41.0.2272.118m or later, Mozilla Firefox
37.0.1 or later

7. Exit

Finishes IJ Network Device Setup Utility.
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View Menu

This section describes the items displayed on the View menu.

*
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1. Computer Network Information

Check the computer network information.

= Displaying Computer Network Information

2. Printer Network Information

Check the printer network information.

= Displaying Printer Network Information

3. Status of Printer and Wireless Router Connection

Searches wireless routers and check the wireless router information (wireless channel, communication
status, and signal strength) detected by the printer.

= Checking Connection Status between Printer and Wireless Router

4. Check Connection Status

If you cannot use a printer you used on the network before, compare the current network status with that
when you can use the printer and check the difference.

= Checking Network Setting Difference

5. Switch IPv4/IPv6/USB

Switches the printer list between IPv4 printers and IPv6 printers. For some models, you can list USB
connected printers.

6. Delete from List

Deletes the selected printer from the printer list.

7. Cancel

Cancels printer search.
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»» Note

* You can also cancel printer search by clicking the % icon.

8. Update
Searches printers again.

»» Note

* You can also search printers again by clicking the € icon.
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Option Menu

This section describes the items displayed on the Option menu.

Printer View | Option Help

@ ¢ %/ | (Seachsettings 1
Product Name| (Soecified Searchina. -2

1. Search Settings...

Specifies criteria for printer search.

= Setting Criteria for Printer Search

2. Specified Searching...
Searches the printer by an IP address or host name.

= Searching Specific Printer
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Help Menu

This section describes the items displayed on the Help menu.

Printer View Option | Help |

[ v "] Online Manual

Product Name Senal *“ti""“h’!" Connecti — 2
m Changing Wired/Wireless LAN Connections —_— 3
4

1. Online Manual

Displays this guide.

2. Caution when Connecting to Wireless LAN

Displays the caution message for wireless LAN connection.

3. Changing Wired/Wireless LAN Connections

Displays the message on changing LAN connection method (wired or wireless) for the selected printer.

4. About

Displays IJ Network Device Setup Utility version information.
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Other Network Information
» Technical Terms
» Restrictions

» Firewall
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Technical Terms

In this section, technical terms used in the manual are explained.

AR IR SE 2 JE Bk JE SE JE 2E 2 2R SR 3 2R AR
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Access point mode

The printer is used as an access point to connect external wireless communication devices (e.qg.
computers, smartphones, or tablets) in an environment where no access point (wireless router) is
available. You can connect up to 5 devices to the printer using the access point mode (direct
connection).

Ad-hoc

Client computer and printer setting where wireless communication occurs on a peer-to-peer basis,
i.e., all clients in with the same SSID/network name communicate directly with each other. No wireless
router is required. This printer does not support ad-hoc communication.

Admin Password

Administrator password in IJ Network Device Setup Utility to restrict access to network users. It must
be entered to access the printer and change printer settings.

AES

An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within U.S.
government organizations for information processing.

Authentication Method

The method that a wireless router uses to authenticate a printer through a wireless LAN. The methods
are agreeable each other.

For WPA/WPAZ2, authentication method is PSK.
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Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

Cableless setup

Specifies a wireless router settings using a device (e.g. smartphone) directly without using a wireless
router.

Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the wireless router. This printer supports channels 1 to 13.
(Channels 12 and 13 are not supported depending on the country or region of purchase.) Note that
the number of channels that can be used for your wireless LAN varies depending on the region or
country.

Default Gateway

A relay device to connect to another network such as a router or a computer.

Default router address

A default IP address set for a router.

DHCP server functionality

The router assigns an IP address automatically whenever the printer or the personal computer on a
network starts up.

DHCPv6

A protocol to assign necessary information automatically when a computer connects to network.
DHCPv6 can be used when IPv6 is enabled.

Direct connection (Access point mode)

The printer is used as an access point to connect external wireless communication devices (e.g.
computers, smartphones, or tablets) in an environment where no wireless router is available. You can
connect up to 5 devices to the printer using the direct connection (access point mode).

DNS server

A server that converts device names into IP addresses. When specifying IP addresses manually,
specify the addresses of both a primary and a secondary server.
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Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can use the
firewall function of a broadband router, the security software installed in the computer, or operation
system for computer.

Host name

A name for a computer or printer on network so that it can be recognized easily. Single-byte
alphanumeric characters are used generally.

IEEE802.11b

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
11 Mbps.

IEEE802.11g

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
54 Mbps. Compatible with 802.11b.

IEEE802.11n

International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when
using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using
multiple communication channels at the same time, the transmission speed may be influenced by the
connected apparatus.

At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer
terminals within a dozen or so metre radius.

Compatible with 802.11b and 802.11g.

Infrastructure

One of the wireless communication methods. Wireless communication devices (e.g. computer or
printer) are connected to the network via a wireless router.

IP Address

A unique number with four parts separated by dots. Every network device that is connected to the
Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by a wireless router or a DHCP server of the router automatically.

IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses
128-bit addresses.
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* Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key
differs depending on the selected key formats.

> ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore
characters. It is case-sensitive.

o Hex

Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).

* Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more
complex WEP key.

* Link local address
An IP address generated automatically from a specific prefix (information of current network: fe80::)
and an interface identifier generated from printer's MAC address.

+ Link Quality
The status of the connection between the wireless router and the printer excluding noise
(interference) is indicated with a value from 0 to 100%.

* LPR

A platform-independent printing protocol used in TCP/IP networks. It does not support bidirectional
communication.

« MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is assigned to
network devices by its manufacturer. MAC addresses are 48 bits long and are written as a
hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

Operation Status

Indicates the status on whether the printer can be used.
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Prefix length

The number of bits on the network part of an IP address. The number of bits is 8 bit to 24 bit for IPv4,
and 64 bit for IPv6.

Proxy server

A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the
address and the port number of the proxy server.

PSK

An encryption method employed by WPA/WPA2.

Router

A relay device to connect to another network.

Signal Strength

The strength of the signal received by the printer from the wireless router is indicated with a value
from 0 to 100%.

SSID

Unique label for wireless LAN. It is often represented such as a network name or a wireless router
name.

SSID distinguishes one wireless LAN from another to prevent interference.

The printer and all clients on a wireless LAN must use the same SSID in order to communicate with
each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters.
The SSID may also be referred to by its network name.

Stealth

In the stealth mode, a wireless router hides itself by not broadcasting its SSID. The client must specify
the SSID set to the wireless router to detect it.

Stateful address

An IPv6 address acquired from a DHCP server using DHCPV6.

Stateless address

A tentative IPv6 address generated automatically using a prefix included in RA (Router
Advertisement) and a MAC address. An IPv6 address is generated in an environment where a DHCP
server is not available.
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¢ Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask used to
calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by a
wireless router or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

* TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol
allows different terminals to communicate with each other.

* TKIP

An encryption protocol employed by WPA/WPA2.

- USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and unplugging them
without turning off the power.

* WCN (Windows Connect Now)
Users running Windows Vista or later can obtain the setting information directly via wireless network
(WCN-NET).

+ WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt
data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of
ASCII code or Hexadecimal, and key number of 1 to 4.

* Wi-Fi

International association that certifies interoperability of wireless LAN products based on the IEEE
802.11 specification.

This printer is a Wi-Fi authorized product.

¢ Wireless LAN

A network that, instead of being connected by physical wires, is connected by a wireless technology,
such as Wi-Fi.
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* Wireless Router
A wireless transceiver or base station that receives information from wireless clients/the printer and
rebroadcasts it. Required in an infrastructure network.

+ WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been
strengthened more than WEP.

o Authentication

WPA defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA-802.1x that do require an authentication server.

This printer supports WPA-PSK.
o Passphrase
This encrypted key is used to perform WPA-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

+ WPA2

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA.
Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

o Authentication

WPAZ2 defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA2-802.1x that do require an authentication server.

This printer supports WPA2-PSK.
o Passphrase
This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

* WPS (Wi-Fi Protected Setup)
WPS is a standard for easy and secure establishment of a wireless network.
There are 2 primary methods used in the Wi-Fi Protected Setup:
PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a simulated push
button in the software.
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should
set a network key (WEP or WPA/WPAZ2) to the access point to encrypt wireless transmission. Wireless
communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.
If you use a printer with direct connection, you cannot perform the following settings:

» Specifying an IP address manually
» Enabling/disabling IPv6
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Firewall

A firewall is a function of the security software installed in the computer or operation system for computer,
and is a system that is designed to prevent unauthorized access to a network.

Precautions When Firewall Function is Enabled

« A firewall function may limit communications between a printer and a computer. This may disable
printer setup and communications.

» During the printer setup, you may be prompted to enable or disable communications, depending on
the firewall function of the security software or operation system. If so, choose to enable
communications.

» When using IJ Network Device Setup Utility, you may be prompted to enable or disable
communications, depending on the firewall function of the security software. If so, choose to enable
communications.

* If you cannot set up the printer, temporarily disable the firewall function of the security software or
operation system.

32 Important

+ If you disabled the firewall function, disconnect your network from the Internet.

» Some applications (like the network configuration software) override firewall settings. Check the
application's settings beforehand.

« If the printer you use is set to Get IP address automatically, the IP address changes every time the
printer connects to the network. This may disable printer setup and communications, depending on
the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the
printer. An IP address can be set using |J Network Device Setup Utility.

= Performing/Changing Wired LAN Settings
= Performing/Changing Wireless LAN Settings

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the
computer can communicate.

»>» Note

» For the operation system firewall settings or the security software firewall settings, refer to the
instruction manual of the computer or software, or contact its manufacturer.
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Sharing the Printer on a Network (Windows)

When computers are used in a network environment, documents can be printed from multiple computers

that share a single printer.

Prind Sorvar
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» Setting Up a Shared Printer

This section describes how to set up the print server and the client.

»>» Note

» The Windows versions of the computers connected to the network do not necessarily have to be the

same.
* To set up the fax driver, use the same procedure.

Related Topic

= Restrictions on Printer Sharing

297



Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system

2. Select as described below:

* If you are using Windows 10, right-click the Start menu, and select Control Panel -> Hardware
and Sound -> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server 2012,
from the Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware)
-> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control Panel -
> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

+ If you are using Windows Vista or Windows Server 2008, select the Start menu -> Control Panel -
> Hardware and Sound -> Printers.
The Printers window is displayed.

3. Click the icon for the model name of printer to be shared

* If you are using Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012 R2,
Windows Server 2012, or Windows Server 2008 R2, press the Alt key, and from the displayed File
menu, select Printer properties -> Sharing tab.

« If you are using Windows Vista, press the Alt key, and from the displayed File menu, select Run as
administrator -> Sharing....

* If you are using Windows Server 2008, select Sharing... from the File menu.

3% Important

» When starting up the software and performing install or uninstall, a confirmation or warning dialog
box may appear.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

4. Set sharing

On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an
additional driver

1. Display the Devices and Printers, Printers, or Printers and Faxes window.
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2. Select as described below:

« If you are using Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012
R2, Windows Server 2012, or Windows Server 2008 R2, select the printer icon, click Print
server properties, and select the Drivers tab.

* If you are using Windows Vista, press the Alt key, and from the displayed File menu, select
Run as administrator -> Server Properties..., and select the Drivers tab.

+ If you are using Windows Server 2008 from the File menu, open Server Properties, and
select the Drivers tab.

. Click Add....

. When the Add Printer Driver Wizard window is displayed, click Next.

. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit architecture,
select x86. Then click Next.

. Click Have Disk....

7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver, specify

the "inf" file, and click OK.
8. Select the printer to be used, and click Next.

»» Note

o b~ W

(o]

+ If an error message is displayed, select the other printer.

9. Click Finish

The setup on the print server system is complete. Next, set up the client systems.
6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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Restrictions on Printer Sharing

Canon imagePROGRAF Preview cannot be used when the XPS printer driver is used.

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

Restriction on setting up printer sharing

« If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:

1. Start Explorer on the print server and on the client with the different architecture, paste the
following path in the address bar, and press Enter on the keyboard:
Y%windir%\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.

3. On the Sharing tab, click Share.

4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder
that was shared in step 3, and click OK.

If there are multiples copies, select the file with the latest update date and time.

Restrictions on sharing and using a printer

A print completion message may be displayed. To disable the message display, follow the procedure
below.
o If you are using Windows 10, Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows
Server 2012:

In the Devices and Printers window of the client system, select the printer from Printers, and
click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows 7 or Windows Server 2008 R2:

In the Devices and Printers window of the client system, select the printer from Printers and
Faxes, and click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o |If you are using Windows Vista:

In the Printers window of the client system, press the Alt key, and from the displayed File menu,
click Run as administrator -> Server Properties....
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows Server 2008:

In the Printers window of the client system, click Server Properties... from the File menu.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

» The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
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server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.
When you print from a client system, the following functions cannot be used.
o Canon imagePROGRAF Preview
o Canon imagePROGRAF Free Layout
o Edit from PosterAtrtist Lite

When the functions on the Maintenance tab cannot be set properly from a client system, they may be
grayed out. In this case, change the settings from the print server.

When you change the settings of the print server, you should delete the icon of the shared printer from
the client system, and then specify the shared settings again in the client system.

If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

If an error occurs when you print a document on a shared printer from a client, the error message of
the Canon IJ status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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Connecting Smartphone/Tablet to Printer via Wireless LAN

* To connect a smartphone or tablet to printer via a wireless LAN router:

= Connecting Smartphone/Tablet to Printer via Wireless LAN Router

* To connect a smartphone or tablet to printer without a wireless LAN router:

= Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct Connection)
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Connecting Smartphone/Tablet to Printer via Wireless LAN Router

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

» Wireless connection (connecting devices via a wireless router)
+ Direct wireless connection (connecting devices using direct connection)

This section describes connection via a wireless LAN router.
Follow the procedure below to connect via a wireless router.

1. Check printer LAN setting.

2. Connect smartphone/tablet to printer.

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

» Check the usage restrictions and change the printer LAN setting.

= Restrictions

Checking Printer LAN Setting

Make sure the n icon is displayed on the upper right on the HOME screen.

Ready to print.

- - EmEEE.
PM R CPGYMBEPEK B COGY Y M PC =

(@)1 Plain Paper

@)z Plain Paper
P Plain Paper

| ! Maintenance

If the n icon is not displayed, follow the procedure below to enable wireless LAN and to connect the
printer to the wireless router.

1. Flick HOME screen and tap LAN settings.

= Menu Operations

2. Tap Change LAN.

3. Tap Activate wireless LAN.

The printer wireless LAN is enabled and you can connect the wireless LAN you connected previously.

Connecting Smartphone/Tablet to Printer

= For Android device
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= For iOS device

» For Android device
1. Open "Settings" menu on your device.
2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.

@ . 97%0 16:26
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4. Enter wireless LAN router password.
Your device is connected to the printer.
5. Start printing from application.
* For iOS device
1. Open "Settings" menu on your device.
2. Enable "Wi-Fi".
3. Select wireless router SSID you use from detected device list.

sssss SofiBank = 2:48 PM 46% W

{ Settings Wi-Fi

Wi-Fi L/
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4. Enter wireless LAN router password.
Your device is connected to the printer.

5. Start printing from application.
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Adjustments for Better Print Quality
» Adjusting the Print Head
@« Adjusting the Print Head
@« Troubleshooting Paper Abrasion and Blurry Images
» Adjusting Feed Amount
@« Adjusting Feed Amount

@ Adjusting Vacuum Strength
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Adjusting the Print Head

=) Adjusting the Print Head

=» Troubleshooting Paper Abrasion and Blurry Images
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Adjusting the Print Head

If printed documents are affected by the following problems, try adjusting the print head.

+ Printing is faint or affected by banding in different colors
Execute Print nozzle check pattern in the touch screen menu to check for print head nozzle clogging.

For instructions, see "Checking for Nozzle Clogging."

+ Printed vertical lines are warped or colors are out of alignment
Execute Print head alignment in the touch screen menu to adjust the print head alignment.

Normally, execute Auto (standard) or Auto (fine). However, when printing on special paper or if
printing is not improved after Auto (fine), try Manual.

=) Automatic Adjustment to Straighten Lines and Colors

=# Manual Adjustment to Straighten Lines and Colors

» Paper rubs against the print head, or image edges are blurred
Setting Paper Thickness (Head Height) in the touch screen menu and changing the height of the print

head may improve the situation.

=$ Troubleshooting Paper Abrasion and Blurry Images
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Automatic Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute Print head alignment and adjust
the print head alignment.

Choose from Auto (standard) or Auto (fine) for automatically adjusting the print head.

Minor warping and misaligned colors can usually be improved by executing Auto (standard). If there is no
improvement, perform Auto (fine).

When you execute Auto (standard) or Auto (fine), the adjustment pattern is printed, and the print head
position is adjusted based on the printing result automatically.

.

»2»Important

« This function is not available with Tracing Paper, Translucent Matte Film, or Clear Film.

+ If adjustment is not possible as expected using special paper, try another type of paper or try Manual
adjustment.

=¢ \anual Adjustment to Straighten Lines and Colors

»>»Note

» Because the results of adjustment vary depending on the type of paper used for adjustment, use the
same type of paper as you will use for printing.

+ To change the paper type or for more beautiful color borders, perform Auto (standard).

» To ensure clear quality and when replacing the print head, perform Auto (fine) to fine-tune the position
between nozzles and colors.

To ensure high-quality printing, we recommend that you execute Auto (fine).

Items to Prepare

When Using An unused roll at least 10.00 in (254.0 mm) wide

Rolls

When Using Auto (standard): Three sheets of unused paper, A4/Letter size or larger (or one
Sheets sheet when using A2 or larger)

Auto (fine): Five sheets of unused paper, A4/Letter size or larger (or one sheet
when using A2 or larger)

Perform adjustment as follows.

1. Load paper.

= | oading Rolls on the Roll Holder
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= | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

=p | oading Sheets in the Printer

»2»Important

» Always make sure the loaded paper matches the type of paper specified on the printer.
Adjustment cannot be completed correctly unless the loaded paper matches the settings.

. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.
. Tap Print head alignment.

. Select and tap Auto (standard) or Auto (fine).

A confirmation message appears.

. Tap Yes.

The paper source setting screen appears.

. Select and tap paper source with loaded paper.

A test pattern is printed for adjustment.

Adjustment is now finished if you have printed on a roll or a sheet of A2 size or larger.

. If you are printing on sheets smaller than A2 size, a confirmation message is shown on the
touch screen requesting that you continue printing.

Tap OK and follow the instructions on the touch screen.
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Manual Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute Print head alignment and adjust
the print head alignment.

Normally, execute Auto (standard).

=p Automatic Adjustment to Straighten Lines and Colors

However, when printing on special paper or if printing is not improved after Auto (fine), try Manual.

Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.

5

»>»Note

* We recommend using the type of paper you use most often for adjustment.

Items to Prepare
When Using Rolls | An unused roll at least 10.00 in (254.0 mm) wide

When Using Sheets | Three sheets of unused paper, Ad4/Letter size or larger (or one sheet when us-
ing A2 or larger)

Perform adjustment as follows.

1. Load paper.

=} | oading Rolls on the Roll Holder

= | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

= | oading Sheets in the Printer

»P»Important

» Always make sure the loaded paper matches the type of paper specified on the printer.
Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Flick Home screen and tap Maintenance.

=F Touch Screen

The Maintenance screen appears.

3. Tap Print head alignment.

4. Tap Manual.
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A confirmation message appears.

2»2Note

+ If you do not execute Auto (fine), a confirmation message prompting you to execute Auto (fine)
appears.

In this case, tap Yes and execute Auto (fine).

5. Tap Yes.

The paper source setting screen appears.

6. Select and tap paper source with loaded paper.

A test pattern is printed for adjustment.

7. Tap D-1.

8. Examine adjustment test pattern D-1 and determine the number with straight lines.

o

A. Example with straight lines

B. Example with misaligned lines

2»»Note

+ If two patterns seem equally good and you cannot decide which one is better, choose an
intermediate value.

For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9. Tap confirmed number.

10. Repeat steps 7-9 to specify adjustment value for D-2 to D-35.

Note that D-6, D-12, D-18, D-24, and D-30 cannot be configured.

11. Tap OK.

The adjustment value is now registered, and adjustment is complete.
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Troubleshooting Paper Abrasion and Blurry Images

The print head height setting affects printing quality.

Specifying a low print head height makes images clearer and enhances printing quality but may cause paper
to rub against the print head.

On the other hand, specifying a high print head height will prevent paper from rubbing against the print head
but may reduce the printing quality.

»2»Important

» Paper rubbing against or becoming caught on the print head may jam or result in printed documents
that are soiled.

»>»Note

* Raise or lower print head, depending on nature of the problem.

=$ Paper rubs against the printhead

=) The edges of the paper are dirty

=} Image edges are blurred or white banding occurs

1. Tap paper setting display area on Home screen.

=$ Touch Screen

Ready to print. 1

L |
[ Jeml N . .
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(@) Plain Paper
@)z Plain Paper
P Plain Paper

| ! Maintenance

The Paper settings screen appears.

2. Select paper source for setting height of print head and tap Paper settings.

The Paper settings screen appears.

3. Tap Advanced.

The Advanced paper settings screen appears.
4. Tap Paper Thickness (Head Height).

5. Select and tap setting value.
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2»>Note

» Using Auto will ensure that the printer adjusts the print head height to the optimal level before
printing corresponding to the ambient temperature and humidity, and displays the setting value
selected for the previous print job in Values applied with auto settings.

=§ Printer information

* When a setting other than Auto is used, that value will always be applied.

» Depending on the type of paper, some setting values may not be available.
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Adjusting Feed Amount
» Adjusting Feed Amount

» Adjusting Vacuum Strength
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Adjusting Feed Amount
» Selecting Feed Amount Adjustment Method
» Automatic Banding Adjustment
» Manual Banding Adjustment
* Fine-Tuning Paper Feed Amount

» Adjusting Line Length
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Selecting Feed Amount Adjustment Method

There are two methods of adjusting the paper feed amount, Prioritize print quality and Prioritize length
accuracy, either of which will be applied during printing.

Since the method that is applied during printing is determined from the value of the Set priority setting,
configure Set priority to match the print target.

Follow the procedure below to perform settings.

1. Load paper.

= |oading Rolls on the Roll Holder
= | oading the Upper Roll on the Printer
= | oading Sheets in the Printer

2. Flick HOME screen and tap m Maintenance.

= Menu Operations

3. Tap Paper feed adjustment.

4. Tap Set priority.

5. Tap paper to adjust.

6. Tap setting.

Prioritize print quality
Adjusts the feed amount to reduce banding across the sheet in printed documents. Adjust print
quality settings are applied. When Paper feed fine adjustment is executed, the Paper feed fine
adjustment settings are applied in addition to the Adjust print quality settings.

Prioritize length accuracy
Adjusts the feed amount for better accuracy of lines in printed documents.

Auto
Prioritize print quality or Prioritize length accuracy is selected, depending on the setting as
selected in the printer driver at the time of printing.

7. Tap OK on displayed screen.
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Automatic Banding Adjustment
If printed images are affected by banding in different colors across the sheet, execute Adjust print quality
for automatic adjustment of the paper feed amount.

The printer prints and reads a test pattern for automatic adjustment of the feed amount.

3% Important

» When using highly transparent media, use manual adjustment.

= Manual Banding Adjustment

»» Note

» We recommend executing the adjustment if you have changed the paper type or paper size.
» Always check the Set priority values.

= Selecting Feed Amount Adjustment Method

« If additional fine-tuning is necessary, execute Paper feed fine adjustment.

= Fine-Tuning Paper Feed Amount

» Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
= Adjusting Line Length

» This may take some time, depending on the type of paper.

Items to Prepare

When Using Rolls | An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets | Two sheets of unused paper of at least A4/Letter size (or one sheet when using A2 or larger)

Follow the procedure below to adjust.

1. Load paper.

= | oading Rolls on the Roll Holder
= | oading the Upper Roll on the Printer
= | oading Sheets in the Printer

2. Flick HOME screen and tap m Maintenance.

= Menu Operations

3. Tap Paper feed adjustment.

4. Tap Adjust print quality.

5. Tap Auto.
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6. Tap paper to adjust.

A test pattern is printed for adjustment and adjustment is finished.
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Manual Banding Adjustment

If printed images are affected by banding in different colors, execute Adjust print quality for adjustment of
the paper feed amount.

Use manual adjustment with highly transparent media.
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

»» Note

» We recommend executing the adjustment if you have changed the paper type or paper size.
» Always check the Set priority values.

= Selecting Feed Amount Adjustment Method

+ If additional fine-tuning is necessary, execute Paper feed fine adjustment.

= Fine-Tuning Paper Feed Amount

» Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
= Adjusting Line Length

Items to Prepare

When Using Rolls | An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets | Two sheets of unused paper of at least A4/Letter size

Follow the procedure below to adjust.

1. Load paper.

= | oading Rolls on the Roll Holder
= | oading the Upper Roll on the Printer
= | oading Sheets in the Printer

3% Important

» Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

2. Flick HOME screen and tap m Maintenance.

= Menu Operations

3. Tap Paper feed adjustment.

4. Tap Adjust print quality.

5. Tap Manual.

6. Tap paper to adjust.
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Test pattern A is printed for manual adjustment.

> Note

* When printing on sheets, follow the instructions on the screen and remove the sheet.

7. Examine test pattern A for adjustment. Determine pattern in which banding is least
noticeable.

»» Note

+ If banding seems least noticeable in two patterns but you cannot decide which one is better,
choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or
12 is better.

8. Tap number you decided.

Test pattern B is printed for manual adjustment.

»» Note

* If you printed test pattern A on a sheet, follow the instructions on the screen and use another
sheet of the same type of paper. Additionally, after test pattern B is printed, follow the instructions
on the screen and remove the sheet.

9. Examine test pattern B for adjustment. Determine pattern in which banding is least
noticeable.

10. Tap number you decided.

The adjustment value is now registered, and adjustment is complete.

320



Fine-Tuning Paper Feed Amount

If the contrast is uneven or banding in different colors appears at 30 mm (1.2 in) intervals in printed
documents, try executing Paper feed fine adjustment during printing to fine-tune the feed amount.

»» Note

» The Paper feed fine adjustment menu is only displayed during printing.

Additionally, it is displayed when you have selected Auto or Prioritize print quality in Set priority in
Paper feed adjustment.

+ Always execute Adjust print quality before Paper feed fine adjustment.
Once you execute Adjust print quality, the Paper feed fine adjustment value will revert to 0.

= Automatic Banding Adjustment
= Manual Banding Adjustment

Follow the procedure below to adjust.

1. Flick HOME screen and tap m Maintenance while printing is in progress.

= Menu Operations

2. Tap Paper feed fine adjustment.

3. Tap value.

At this time, if banding in dark colors appears, select a setting value in the range 1 to 5, and if banding in
light colors appears, select a setting value in the range -1 to -5.
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Adjusting Line Length
To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust feed length to
adjust the amount that paper is advanced.

There are two options in Adjust feed length : Print alignment pattern and Change adjustment values.

»» Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
» Always check the Set priority values before adjustment.

= Selecting Feed Amount Adjustment Method

Items to Prepare

When Using Rolls * An unused roll at least 254.0 mm (10.00 in) wide
 High-precision ruler

When Using Sheets| + One sheet of unused paper of at least A4/Letter size
+ High-precision ruler

Follow the procedure below to adjust.

1. Load paper.

= | oading Rolls on the Roll Holder
= |oading the Upper Roll on the Printer
= | oading Sheets in the Printer

3% Important

» Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

2. Flick HOME screen and tap m Maintenance.

= Menu Operations

3. Tap Paper feed adjustment.

4. Tap Adjust feed length.

5. Tap Print alignment pattern or Change adjustment values.
+ If you tap Print alignment pattern:
The test pattern is printed for you to measure the scale and calculate the discrepancy.

The scale bar prints "Millimeter" in 50 mm increments and "Inch" in 1-inch increments.
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Blillimryetisr Inecch

« If you tap Change adjustment values:

No test pattern is printed. Instead, you will measure a document already printed to determine the
discrepancy.
6. Tap amount of discrepancy.

If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative
value.

The feed amount can be adjusted in 0.02% increments.
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Adjusting Vacuum Strength

When printing on heavyweight paper or paper that curls or wrinkles easily, if the print head rubs against
paper, adjusting the level of suction against paper on the platen may improve results.

22 Important

» Paper rubbing against or becoming caught on the print head may jam or result in printed documents
that are soiled.

1. Flick HOME screen and tap paper information area.

= Menu Operations

Ready to print. 1
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[ ! Maintenance

2. Tap paper to change vacuum strength on Paper settings screen.

3. Tap Paper settings.

4. Tap Advanced.

5. Tap Transport unit vacuum strength.

6. Tap vacuum strength.
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Color Management
» Digital Photo Printing Guide
» Color Calibration
« Managing Colors
@« Performing Color Calibration
« Adjustment Types of Color Calibration

» Device Management Console Guide
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Color Calibration

=P Managing Colors

=$ Performing Color Calibration

=» Adjustment Types of Color Calibration
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Managing Colors

Color management (color calibration) corrects for variations in color tones due to differences between
printers and aging, and obtains continuously stable corrected color tones.

The color tones of this printer can be corrected by executing color calibration.

If you have multiple printers, you can make the color tones of the printers the same by executing color
calibration on each of the printers.

Execute Color Calibration

Executing color calibration improves color consistency by compensating for slight differences in how color
appears due to individual variations or aging among the printers.

You can use the operation panel to enable or disable the color calibration adjustment values, view the
calibration status, and configure notifications when color calibration needs to be executed.

You can also execute color calibration from Device Management Console.
See below for details.
= Device Management Console Guide(Windows)

= Device Management Console Guide(Mac OS)

Checking When to Execute Color Calibration

You can use the progress bar on the computer screen to determine when to execute color calibration.
Use Device Management Console to view when to execute color calibration.

See below for details.

= Device Management Console Guide(Windows)

= Device Management Console Guide(Mac OS)

Centrally Managing Multiple Printers

You can view the status of multiple network- and USB-connected printers.
You can also set up email notification if printer warnings or errors occur.
Use Device Management Console to manage the printers.

See below for details.

= Device Management Console Guide(Windows)

= Device Management Console Guide(Mac OS)

Using Paper Other Than Canon Genuine Paper

To execute color calibration for paper other than Canon genuine paper, you must create and register
dedicated media information.

To register this media information, use Media Configuration Tool.
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See below for details.
=» Media Configuration Tool Guide(Windows)
=» Media Configuration Tool Guide(Mac OS)
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Performing Color Calibration

Color calibration improves color consistency by compensating for slight differences in how color appears
when printing due to individual variations or aging among the printers.

Executing color calibration will print a test pattern (built into the printer) that is then read automatically by the
printer.

By this operation, calibration adjustment values reflecting the print result of the test pattern are set
automatically.

»2Important

» To increase the color stability precision when executing color calibration, maintain a constant
temperature and humidity environment each time within the range of temperatures of 59 to 86°F (15 to
30°C) and within the range of humidities of 40 to 60%.

Executing color calibration under various temperature and humidity conditions may prevent the printer
from making the correct adjustments.

» Before color calibration, ensure the printer is not exposed to direct sunlight or other strong sources of
light.

If the printer is exposed to strong sources of light, correct adjustment may not be possible.

Recommend Timing for Color Calibration
We recommend color calibration in the following situations.
« After initial printer installation
« After print head replacement

« If colors seem different from before, despite using the same printing environment, under the same
conditions

* To print with colors aligned from multiple printers

* When the execution guide is displayed

Executing Color Calibration

Execute color calibration using the following procedure.

1. You can confirm whether the paper to be loaded can be used in color calibration.

= Paper Information List

2. Load the paper.

=} | oading Rolls on the Roll Holder

=p | oading the Upper Roll on the Printer

= | pading the Lower Roll on the Roll Unit (Option)

=} | oading Sheets in the Printer
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3. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.

4. Tap Color calibration.

5. Tap Auto adjust.

Color calibration

Auto adjust

Enable/disable adjustment values
Adjustment information
Calibration guide setting

Reset adjustment values

A confirmation message appears.

»P»Note

+ For details about menu items other than Auto adjust, see "Other Menu Items."

6. Tap Yes.

The paper source setting screen appears.

7. Select and tap paper source with loaded paper.

After the paper is confirmed, and color calibration is executed, the calibration adjustment value is set
automatically.

Other Menu Items
» Enable/disable adjustment values
You can select whether to apply the calibration adjustment value when printing.

However, for settings that differ from the Calibration Value of the printer driver, the values specified in
the printer driver take priority.

* Adjustment information

You can confirm the color calibration adjustment date/time and the executed media type.
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Adjustment information

Adjustment date/time

L ERAY

Fro Platinum

+ Calibration guide setting

You can select whether to display a message asking to execute color calibration on the touch screen
in the following situations.

o When a new print head has been installed
o When a certain amount of printing has been executed after color calibration is executed

o When the data of color calibration has been initialized

* Reset adjustment values

Clear the color calibration adjustment value and the adjustment information.
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Adjustment Types of Color Calibration

Adjustment Types of Color Calibration
Common calibration and unique calibration are the two adjustment types of color calibration.

One adjustment type is selected according to the media type that is used to execute color calibration.

Features

Common Calibration
When color calibration is executed for one type of Canon genuine paper, the color is adjusted for
other paper.

You can use multiple media types easily in a short time because it is not necessary to execute color
calibration on each media type.

Unique Calibration
Even when color calibration is executed, the color of other paper is not adjusted, so the color of other
paper is not affected.

2»>»Note

 For details on whether or not color calibration can be executed and the adjustment types for various
types of paper, see "Paper Information List."

* Common Calibration
If color calibration is executed on a media type categorized as common calibration, new common
calibration adjustment values are set.

Among the media type categorized as common calibration, newly set common calibration adjustment
values are set for paper for which color calibration has not been performed.

The common calibration adjustment values apply to all print qualities.

»»Note

« If the paper being used does not support color calibration, execute color calibration with paper
categorized as common calibration in advance.

The new common calibration adjustment values even apply to the paper being used.
« If color calibration has been performed, the calibration adjustment values are already set.

The new common calibration adjustment values are not overwritten for this media type.

» Unique Calibration
If color calibration is executed on a media type categorized as unique calibration, new unique
calibration adjustment values are set.
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2»>»Note

« If color calibration is not executed even once using the paper categorized as unique calibration,
executing common calibration overwrites the calibration adjustment values.

Example: When the following color calibration is executed with the default settings
First time: Execute color calibration with media type A (categorized as common calibration)

= All media types A to N: The calibration adjustment values of media type A are applied.

Second time: Execute color calibration with media type B (categorized as common calibration)
= Media type A: The calibration adjustment values of media type A applied the first time take priority.

= Media types B to N: The calibration adjustment values of media type B are applied.

Media Media Media
typeB | | typeC | -+ | typeN

Third time: Execute color calibration with media type C (categorized as unique calibration)
= Media type A: The calibration adjustment values of media type A applied the first time take priority.

= Media types B and D to N: The calibration adjustment values of media type B applied the second
time take priority.

= Media type C: The calibration adjustment values of media type C are applied.

Media Media Media
type B typeD | -+ | typeN

2»>»Note

* You can confirm the currently applied calibration adjustment date and the executed paper type with
Adjustment information in Color calibration on the touch screen menu.

=$ Performing Color Calibration

To Confirm the Paper Information Registered on the Printer

To print media information, select Device settings > Paper-related settings > Print advanced paper
settings on the touch screen menu.

The following appears.
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Display Meaning

Calibration Ex- | Supports color calibration
ec.

OK(Common) |Executes common calibration

OK(Unique) Executes unique calibration

N/A Color calibration cannot be executed

Calibration Adj. | Calibration application information (Executed date and
Value paper name appear)

Canon nootooooiooaon: Fap. Detadl Print

01 Media Mame: onocooos

Calibration Exec.:OK{Commaon) Calibration Adj. Value: oo oosoeommx

b ot

=
»P»Note

i

* You can check the media information with the Device Management Console or printer driver.
See below for details.
=» Device Management Console Guide(Windows)
= Device Management Console Guide(Mac OS)

=¥ Updating Media Information in Printer Driver(Windows)

=} Confirm the Printer Paper Information(Mac OS)
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Maintenance and Consumables

» Ink Tanks
« Ink Tanks
@« Replacing Ink Tanks
@« Checking Ink Tank Levels
« When to Replace Ink Tanks

» Print Head
@ Print Head
@« Checking for Nozzle Clogging
@ Cleaning the Print Head
@« Replacing the Print Head

» Maintenance Cartridge
@« Maintenance Cartridge
@« Replacing the Maintenance Cartridge
@« Checking the Remaining Maintenance Cartridge Capacity

« When to Replace the Maintenance Cartridge

¥

Cutter Blade
@ Cutter Blade

« Replacing the Cutter Blade

¥

Performing Maintenance Functions from Your Computer (Windows)
@ Cleaning the Print Heads

@ Printing a Nozzle Check Pattern

¥

Performing Maintenance Functions from Your Computer (Mac OS)
@ Cleaning the Print Heads
@« Printing a Nozzle Check Pattern

@« Adjusting the Paper Feed Volume

v

Cleaning the Printer
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t.

Cleaning the Printer Exterior

t.

Cleaning Inside the Top Cover

t.

Cleaning the Roll Unit

t.

Cleaning the Print Head
» Other Maintenance
@« Preparing to Transfer the Printer

@« Reinstalling the Printer
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Ink Tanks

=p |nk Tanks
=P Replacing Ink Tanks

=$ Checking Ink Tank Levels

=$ \When to Replace Ink Tanks
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Ink Tanks

When purchasing, check the Model number.

Shape Colors Model number Ink Type Capacity
Matte Black PFI-1100 MBK Pigmentink |5.4 fl oz (160 ml)
Photo Black PFI-1100 PBK

=
Cyan PFI-1100 C
Magenta PFI-1100 M
Yellow PFI-1100 Y
Photo Cyan PFI-1100 PC
Photo Magenta | PFI-1100 PM
Gray PFI-1100 GY
Photo Gray PFI-1100 PGY
Red PFI-1100 R
Blue PFI-1100 B
Chroma Opti- |PFI-1100 CO
mizer
Matte Black PFI-1300 MBK 11.2 fl 0z (330 ml)
Photo Black PFI-1300 PBK
Cyan PFI-1300 C
Magenta PFI-1300 M
Yellow PFI-1300 Y
Photo Cyan PFI-1300 PC
Photo Magenta | PFI-1300 PM
Gray PFI-1300 GY
Photo Gray PFI-1300 PGY
Red PFI-1300 R
Blue PFI-1300 B
Chroma Opti- |PFI-1300 CO
mizer
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Shape Colors Model number Ink Type Capacity
Matte Black PFI1-1700 MBK Pigmentink [23.7 fl oz (700 ml)
Photo Black PFI-1700 PBK
Cyan PFI-1700 C
=
Magenta PFI-1700 M
Yellow PFI-1700 Y
Photo Cyan PFI-1700 PC
Photo Magenta | PFI-1700 PM
Gray PFI-1700 GY
Photo Gray PFI-1700 PGY
Red PFI-1700 R
Blue PFI-1700 B
Chroma Opti- [PFI-1700 CO
mizer
22»Note

 For instructions on replacing the ink tanks, see "Replacing Ink Tanks."
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Replacing Ink Tanks

Compatible Ink Tanks
For details on compatible ink tanks, see "Ink Tanks."

You can replace ink tanks in 5.4 fl oz (160 ml), 11.2 fl oz (330 ml), and 23.7 fl oz (700 ml) capacities.
32»Note

» Depending on the color, you can also use an ink tank with a different capacity.

Precautions When Handling Ink Tanks

Take the following precautions when handling ink tanks.

&Caution

 For safety, keep ink tanks out of the reach of children.

* Ifink is accidentally ingested, contact a physician immediately.

»¥»Important

» There may be ink around the ink holes of an ink tank you removed. Handle the ink tanks carefully
during replacement. The ink may stain clothing.

* Do not install ink tanks used in this printer in another model of printer.
This will prevent correct ink level detection, which may damage the printer or cause other problems.

* We recommend using up an ink tank in the course of printing within six months after breaking the
seal. Printing quality may be affected if you use older ink tanks.

» Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual
ink may become clogged inside the printer and affect printing quality.

How to replace an ink tank
If a message indicates you should replace an ink tank, check the message details and go to step 2.

1. Selecting Ink Tank Replacement from menu

2. Removing Ink Tanks

=$Removing ink tank (5.4 fl oz (160 ml) / 11.2 fl 0z (330 ml))

=P Removing ink tank (23.7 fl oz (700 ml))

3. Loading New Ink Tanks
=$| oading ink tank (5.4 fl oz (160 ml) / 11.2 fl 0z (330 ml))

=p| oading ink tank (23.7 fl oz (700 ml))
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»¥»Important

» Do not remove an ink tank during initialization immediately after turning on the printer, or during print
head cleaning. Ink may leak out.

»P»Note

* Ink tank replacement is possible even during printing, when print jobs are being canceled, or when
paper is being advanced.

Selecting Ink Tank Replacement from menu

1. Tap ink display area on Home screen.

=$ Touch Screen

Ready to print.

[ | . N . [
PM R CPGYMBEPEX B COGY Y M PC =

(@1 Plain Paper
@z Plain Paper
P PFlain Paper

¥ .
I % Maintenance

The Current estimated ink levels screen appears.

2. Tap Replace.

Instructions appear on the touch screen.

Removing ink tank (5.4 fl oz (160 ml) / 11.2 fl oz (330 ml))

1. Open the ink tank cover of the ink tank you are replacing and check the ink lamp.

The ink lamp flashes if there is no ink left.

341



»P»Important

+ Avoid jarring the printer a lot when replacing an ink tank. Handle the printer gently when
replacing tanks.

2. Pull forward handle part (A) of ink tank lock lever of color to replace while pressing button
at B.

»P»Note

* Check that the ink tank lock lever does not return.

4. Remove ink tank by grips (A), and then tap OK.

»P»Important

+ Store the removed ink tank with ink remaining with the ink holes (A) facing up. Otherwise, ink
may leak and cause stains. Put the removed ink tank in a plastic bag and close the bag.
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»P»Note

« Dispose of the used ink tank in accordance with local regulations.

Removing ink tank (23.7 fl oz (700 ml))

1. Open the ink tank cover of the ink tank you are replacing and check the ink lamp.

The ink lamp flashes if there is no ink left.

»¥Important

» Avoid jarring the printer a lot when replacing an ink tank. Handle the printer gently when
replacing tanks.

2. Pull forward handle part (A) of ink tank lock lever of color to replace while pressing button
at B.

3. Lift ink tank lock lever until it stops, and then push it down toward front.
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»2»Note

* Check that the ink tank lock lever does not return.

4. Remove ink tank by handle (A), and then tap OK.

»¥Important

+ Store the removed ink tank with ink remaining in the box with the ink holes (A) facing up.
Otherwise, ink may leak and cause stains.

»P»Note

 Dispose of the used ink tank in accordance with local regulations.
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Loading ink tank (5.4 fl oz (160 ml) / 11.2 fl oz (330 ml))

1. Before opening the pouch, tilt the ink tank to the left and right gently seven or eight times.

»»Important

» Do not remove and agitate an ink tank that has already been installed in the printer. Ink may
leak out.

+ Failure to agitate the ink tank may cause the ink components to precipitate and may affect
printing quality.

»P»Note

« If the ink tank is at a low temperature, allow it to warm up to room temperature before installing.

2. Open the pouch and remove the ink tank.

»P»Important

» Never touch the ink holes (A) or the metal contacts (B). This may cause stains, damage the ink
tank, and affect printing quality.
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* Avoid dropping the ink tank after removing it from the pouch. Otherwise, ink may leak and
cause stains.

3. Tap OK and insert ink tank into holder with ink holes down and metal contacts at rear.

3¥Important

« An ink tank cannot be loaded in the holder if the color or orientation is incorrect.

If the ink tank does not fit in the holder, do not force it into the holder. Reinstall while checking
the label color display, ink tank color, and ink tank orientation.

4. Lift up ink tank lock lever, and then push it down.

5. Push handle part of ink tank lock lever firmly all the way in.
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»2»Note

« If the ink lamp is not lit, reload the tank.

7. Close ink tank cover.
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Loading ink tank (23.7 fl oz (700 ml))

1. Before opening the pouch, hold the new ink tank with both hands and tilt it to the left and
right as shown, shaking it gently seven or eight times.

&Caution

* A 23.7 fl oz (700 ml) ink tank is heavy, so use your whole arm to agitate it instead of just your
wrist. If you agitate the ink tank using just your wrist, you may injure your wrist.

»P»Important

» Do not remove and agitate an ink tank that has already been installed in the printer. Ink may
leak out.

« Failure to agitate the ink tank may cause the ink components to precipitate and may affect
printing quality.
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»P»Note

« If the ink tank is at a low temperature, allow it to warm up to room temperature before installing.

. Open the pouch and remove the ink tank.

»2»Important

» Never touch the ink holes (A) or the metal contacts (B). This may cause stains, damage the ink
tank, and affect printing quality.

+ Avoid dropping the ink tank after removing it from the pouch. Otherwise, ink may leak and
cause stains.

. Tap OK and insert ink tank into holder with ink holes down and metal contacts at rear.
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2»2Important

« An ink tank cannot be loaded in the holder if the color or orientation is incorrect.

If the ink tank does not fit in the holder, do not force it into the holder. Reinstall while checking
the label color display, ink tank color, and ink tank orientation.

4. Lift up ink tank lock lever, and then push it down.

5. Push handle part of ink tank lock lever firmly all the way in.

6. Make sure ink lamp indicator is lit.
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~ »»Note

« If the ink lamp is not lit, reload the tank.

7. Close ink tank cover.
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Checking Ink Tank Levels

On the touch screen, you can check how much ink is left in the ink tank.

1. Tap ink display area on Home screen.

=$ Touch Screen

Ready to print.

[ | .
PM R C PGYMBX PEX

(@1 Plain Paper
@)z Plain Paper
P Plain Paper

] .
| & Maintenance

The Current estimated ink levels screen appears.

Current estimated ink levels

OOE0O0 ONOEd

PM R CPoYMEKFEK B COGY ¥ M PC

Replace Order ink now

If ink is low, @ appears; if no ink is left, 0 appears; if you have deactivated ink level detection, ®
appears.

The remaining ink level is indicated as shown below.

O &
B _

Full i Mone

Remaining ink levels

If the touch screen indicates to replace the ink tank, replace the ink tank. If a message is displayed
indicating to check the remaining ink levels, or after tasks that consume a lot of ink such as large-format
printing or head cleaning, check the remaining levels and replace ink tank as needed.

=P Replacing Ink Tanks
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2»>Note

» Tap Order ink now to view the ink supplier information.
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When to Replace Ink Tanks

Replace or prepare to replace ink tanks in the following situations.

If Ink Confirmation Message Appears on touch screen

If ink is low, the Status lamp lights orange and a notification message will appear on the touch screen.
You can continue to print, but prepare the ink tanks.

=p Checking Ink Tank Levels

Before print jobs and maintenance that consume a lot of ink

If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance,
which require a lot of ink. Replace or prepare to replace the ink tanks in the following situations.

If Message for Ink Replacement Appears on touch screen

When the ink runs out, the Status lamp flashes orange, a message regarding ink tanks replacement
appears on the touch screen, and printing is disabled. Replace the ink tank.
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Print Head

=} Print Head

=p Checking for Nozzle Clogging

=$ Cleaning the Print Head

=$ Replacing the Print Head

355



Print Head

When purchasing, check the Model number.

Shape Model number

PF-10

»>»Note

 For instructions on replacing the print head, see "Replacing the Print Head."
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Checking for Nozzle Clogging

If printing is faint or affected by banding in different colors, make sure the print head nozzles are clear by
printing a test pattern to check the nozzles.

»»Note

» By default, nozzles are checked at fixed intervals.

=p Auto maintenance settings

Paper to Prepare

When Using Rolls An unused roll at least 10.00 in (254.0 mm) wide

When Using Sheets One sheet of unused paper of at least A4/Letter size

1. Load paper.

= | oading Rolls on the Roll Holder

= | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

=p | oading Sheets in the Printer

2. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.

3. Tap Print nozzle check pattern.

A confirmation message appears.

4. Tap Yes.

The printer now prints a test pattern for checking the nozzles.

5. Check the printing results.

If the horizontal lines are not faint or incomplete, the nozzles are clear.

e
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2»>Note

» Because CO has no color, printing is performed on top of the black pattern. Check if the dark gray
areas have lines (A) in the CO pattern.

If horizontal lines are faint or incomplete, execute print head cleaning.

= Cleaning the Print Head
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Cleaning the Print Head

If printing is faint, cleaning the print head may improve results.

Choose one of three print head cleaning modes (Cleaning, Deep cleaning, or System cleaning),
depending on the problem to resolve.

» Cleaning

Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the
least amount of ink.

It takes about 8 minutes.

* Deep cleaning
Use this mode if no ink is ejected at all or if Cleaning does not solve the problem.
It takes about 8 or 9 minutes.

» System cleaning

Use this if printing is not improved after Deep cleaning. System cleaning consumes a very large
amount of ink. Performing this frequently consumes the ink faster. Perform this only when needed.

It takes about 10 minutes.

»P»Important

» Do not remove the maintenance cartridge or ink tanks during Cleaning, Deep cleaning, or System
cleaning.

Ink may leak or an error may occur.

« If printing is not improved after System cleaning, the print head may be at the end of its service life.
Contact your Canon dealer for assistance.

»>»Note

» Check the nozzle check pattern and select an ink group for which to perform cleaning as needed. You
can clean all print head or select pattern 1, 2, or 3 to clean the print head with a clogged nozzle.
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» By default, nozzles are checked at fixed intervals.

=p Auto maintenance settings

Perform cleaning as follows.

1. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.

2. Tap Print head cleaning.

3. Select and tap Cleaning, Deep cleaning, or System cleaning.

4. Select and tap the ink group to be cleaned.

 All colors

+ Pattern 1:PM/R/C/PGY

« Pattern 2:PBK/MBK/CO/GY
+ Pattern 3:B/Y/M/PC

A confirmation message appears.

5. Tap Yes.

Head cleaning is now executed.
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6. Print a test pattern to check the nozzles and determine whether cleaning has cleared the
nozzles.

=$ Checking for Nozzle Clogging
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Replacing the Print Head

If the touch screen indicates to replace the print head or if instructed to do so by your Canon dealer, replace
the print head.

Compatible print head

For details on compatible print head, see "Print Head."

Precautions When Handling print head

Take the following precautions when handling the print head.

&Caution

» For safety, keep print head out of the reach of children.
* If ink is accidentally ingested, contact a physician immediately.

» Do not touch the print head immediately after printing. The print head becomes extremely hot, and
there is a risk of burns.

»»Important

» There may be ink around the nozzles of the print head you remove. Handle the print head carefully
during replacement. The ink may stain clothing.

» Do not open the print head pouch until immediately before installation. After removing the print head
from the pouch, install it right away. If the print head is left as is after the pouch is opened, the
nozzles may dry out, which may affect printing quality.

Selecting Menu for print head Replacement

ﬁl\Caution

* When replacing the print head immediately after printing, wait a few minutes before replacing it. The
metal parts of the print head become hot during printing, and there is a risk of burns from touching
these parts.

»¥»Important

* Your hands may become dirty during print head replacement. Use the gloves provided in the box with
the new print head for replacement.

2»>»Note

* Prepare a new ink tank when ink levels are low.

* Prepare a new maintenance cartridge when the remaining capacity of the maintenance cartridge is
low.
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1. Remove any paper that has been fed.

* When using a roll, rewind it.

=$ Removing the Upper Roll from the Printer

=$ Removing the Lower Roll from the Roll Unit (Option)

* When using sheets, remove the sheet.

=P Removing Sheets

2. Clean inside top cover.

=p Cleaning Inside the Top Cover

3. Flick Home screen and tap Maintenance.

=p Touch Screen

The Maintenance screen appears.

4. Tap Head replacement.

A confirmation message appears.

5. Tap Yes.

Ink begins being drawn in. When it finishes, instructions are displayed on the touch screen.

It takes about 5-6 minutes for ink to be drawn into the system.

Replacing print head

1. Open top cover.

The print head replacement procedure appears on the touch screen.

2. If the print head locking cover and print head lock lever are dirty, use a damp cloth that
you have wrung out completely to wipe them clean.
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3»Important

» Never touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching may
damage them.

3. If ventilation duct (A) is dirty, use damp cloth that you have wrung out completely to wipe
it clean.

If the Carriage is obscuring the ventilation duct, move the Carriage manually before cleaning the duct.
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4. While pressing button (A) in center of print head lock lever, pull it forward to open it until it
stops.

5. Holding grip (A), open print head locking cover until it stops.

6. Remove print head by blue handle (A), and then tap OK.
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»P»Important

» Never touch the metal contacts of the Carriage. Furthermore, do not allow any dirt or debris to
become adhered to the metal contacts of the Carriage. These may damage the printer.

»P»Note

+ Dispose of the used print head in accordance with local regulations.

7. Remove print head that was in case from pouch.
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9. Lift print head by blue handle and remove orange protective cap (2).

»»Important

+ Always carry the print head by the blue handle. Never touch the nozzle (A) or metal contacts
(B). This may damage the print head and affect printing quality.

» Never touch the ink holes (C). This may affect printing quality.

» The inside surface of the protective cap is coated with ink to protect the nozzle. Be careful not
to touch these surfaces when removing the caps.

The print head contains ink to protect the nozzle. We recommend removing the protective cap
as you hold it over the print head case or safely out of the way to avoid spilling ink and staining
your clothes or the surrounding area. If ink accidentally spills, wipe off the ink with a dry cloth.

« If you need to put a print head somewhere temporarily before installation, return it to the case in
the same orientation. If placed face down, the nozzle or metal contacts may become damaged,
which may affect the printing quality.

» Do not reattach the removed protective cap. Dispose of these materials in accordance with local
regulations.

10. Carefully push print head firmly in, ensuring that nozzle, metal contacts, and ink holes do
not touch Carriage.
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13. Close top cover.
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Ink now fills the system. It takes about 18 or 19 minutes.

»P»Important

» While ink is being filled, definitely do not remove the ink tank or maintenance cartridge. Ink may
leak out.

»2»Note

* Print head position adjustment is executed when Print pattern after new head is set to ON.
Follow the instructions on the touch screen to load paper.

=p Auto maintenance settings
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Maintenance Cartridge

=$ Maintenance Cartridge

=) Replacing the Maintenance Cartridge

=$ Checking the Remaining Maintenance Cartridge Capacity

=$ \When to Replace the Maintenance Cartridge
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Maintenance Cartridge

When purchasing, check the Model number.

Shape Model number

MC-30

»2»Note

» For instructions on replacing the maintenance cartridge, see "Replacing the Maintenance Cartridge."
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Replacing the Maintenance Cartridge

Compatible Maintenance Cartridges

For details on compatible maintenance cartridge, see "Maintenance Cartridge."

Precautions When Handling Maintenance Cartridge

Take the following precautions when handling the maintenance cartridge.

&Caution

» For safety, keep maintenance cartridge out of the reach of children.

* If ink is accidentally ingested, contact a physician immediately.

»2»Important

» Do not remove the maintenance cartridge except to replace it. Ink may leak out.

» Do not remove a maintenance cartridge during initialization immediately after turning on the printer,
during print head cleaning, while ink is being drawn out, or during initialization immediately after
replacing the maintenance cartridge.

The maintenance cartridge may become damaged or ink may leak out.

» To prevent ink from leaking from a used maintenance cartridge, avoid dropping the cartridge or
storing it at an angle. Otherwise, ink may leak and cause stains.

+ Ink adheres to the top of the maintenance cartridge after it has been used. Handle the maintenance
cartridge carefully during replacement. The ink may stain clothing.

How to Replace a Maintenance Cartridge

If a message indicates you should replace a maintenance cartridge, check the message details and go to
step 2.

1. Selecting Maintenance Cartridge Replacement from Menu

2. Replacing Maintenance Cartridge

Selecting Maintenance Cartridge Replacement from Menu

1. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.

2. Tap Maintenance cartridge info.
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The Maintenance cartridge info screen appears.

3. Tap Replace.

Instructions appear on the touch screen.

Replacing Maintenance Cartridge

1. Open box, and remove plastic bag and maintenance cartridge.

»¥»Important

* Never touch the metal contacts (A). This may damage the maintenance cartridge.

2. Open maintenance cartridge cover.
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3. Hold the used maintenance cartridge by the grip (A) with one hand and put your other
hand under the maintenance cartridge to hold it firmly on the bottom, keeping it level as
you pull it out.

»P»Important

» A used maintenance cartridge is heavy. Always grasp the cartridge firmly and keep the cartridge
level during removal and storage. If you drop a used maintenance cartridge or store it at an
angle, ink may leak and cause stains.

4. Put used maintenance cartridge in supplied plastic bag and store on flat surface.

5. Check the top and bottom of the maintenance cartridge, place in the box, and store the
box on a flat surface.

374



»P»Important

» Always put the used maintenance cartridge back in the box and store the box on a flat surface.

»P»Note

+ Dispose of the used maintenance cartridge in accordance with local regulations.

6. Wipe away any soiling on the maintenance cartridge cover.

»2»Important

» Support the maintenance cartridge cover from underneath as you wipe it.

7. Keeping the new maintenance cartridge level, insert it all the way in.

The maintenance cartridge is initialized.

»2»Important

» Do not remove the maintenance cartridge during initialization immediately after replacing the
maintenance cartridge. The maintenance cartridge may become damaged.

8. Close maintenance cartridge cover.
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Checking the Remaining Maintenance Cartridge Capacity

The maintenance cartridge absorbs excess ink from print head cleaning. You can confirm the remaining
capacity of the maintenance cartridge by checking the touch screen.

1. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.

2. Tap Maintenance cartridge info.
The Maintenance cartridge info screen appears.
Maintenance cartridge info

Maintenance cartridge usage

Replace

If the touch screen indicates to replace the maintenance cartridge, replace the maintenance cartridge. If a
message appears indicating to check the remaining capacity of the maintenance cartridge, or before tasks
that deplete much of the capacity such as head cleaning or preparations to move the printer, check the
remaining maintenance cartridge capacity and prepare a new maintenance cartridge as needed.

=) Replacing the Maintenance Cartridge
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When to Replace the Maintenance Cartridge

Replace or prepare to replace the maintenance cartridge in the following situations.

If Maintenance Cartridge Confirmation Message Appears on Touch Screen

When the maintenance cartridge is almost empty, the Status lamp lights orange and a notification
message will appear on the touch screen. You can continue to print, but check the remaining maintenance
cartridge capacity and prepare to replace the maintenance cartridge with a new one.

=} Checking the Remaining Maintenance Cartridge Capacity

When the maintenance cartridge capacity is drastically depleted

Print head cleaning, print head replacement, and preparations to transfer the printer deplete much of the
maintenance cartridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)

Check the remaining maintenance cartridge capacity before this maintenance and replace the
maintenance cartridge if necessary.

If Message for Maintenance Cartridge Replacement Appears on Touch
Screen

When the maintenance cartridge runs out, the Status lamp blinks orange, a message regarding
maintenance cartridge replacement appears on the touch screen, and printing is disabled. Replace the
maintenance cartridge with a new one.
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Cutter Blade

=p Cutter Blade
=) Replacing the Cutter Blade
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Cutter Blade

When purchasing, check the Model number.

This cutter blade comes with a part for securing the cutter blade during installation.

Shape Model number

CT-07

»>»Note

* For instructions on replacing the cutter blade, see "Replacing the Cutter Blade."
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Replacing the Cutter Blade

Compatible cutter blade

For details on compatible cutter blade, see "Cutter Blade."

Selecting Menu for cutter blade Replacement

1. Flick Home screen and tap Maintenance.

=p Touch Screen

The Maintenance screen appears.

2. Tap Replace cutter blade unit.

A confirmation message appears.

3. Tap Yes.
The Carriage moves and after it stops moving, instructions appear on the touch screen.

»>»Note

« If you do not take action within 2 minutes, cutter blade replacement is canceled. In this case,
repeat the procedure.

Replacing cutter blade

1. Open top cover.

The cutter blade replacement procedure appears on the touch screen.

2. If cutter blade is dirty, use damp cloth that you have wrung out completely to wipe it clean.

32 Important

* Never touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching may
damage them.
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3. Turn hex screw with hex wrench until loose.

P, o

ar A ’
—_— T - P

&Caution

* Never touch any part other than A. This may stain your hands or cause injury. Additionally, this
may damage the printer.
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» Do not disassemble the cutter blade. Touching the blade may cause injury.

»P»Note

+ Dispose of the used cutter blade in accordance with local regulations.

5. Install new cutter blade while aligning A to B and C to D.

6. Install while aligning fixing part included with replacement cutter blade with center of
cutter blade.

7. Turn hex screw until securely fixed.
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»P»Important

 After the cutter blade is secured, check that the cutter blade does not come off. If the cutter
blade comes off, this may damage the printer.

8. Remove fixing part.

- -
o

»P»Important

» Always remove the fixing part. Operating with the part installed may damage the printer.

9. Close top cover.

10. A confirmation message will appear.

Tap Yes.
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Performing Maintenance Functions from Your Computer
(Windows)

» Cleaning the Print Heads

» Printing a Nozzle Check Pattern
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Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for print head cleaning is as follows::

©

N\

Print Head Cleaning

1. Open the printer driver setup window

2. Click Print Head Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the head cleaning to be performed from the
following:

* Cleaning

Perform Cleaning if printing is faint or a specific color fails to print, even though there is enough
ink.
» System Cleaning

System Cleaning is a more powerful cleaning function. Perform System Cleaning if there is no
improvement even after repeating Cleaning several times.

32 Important

+ System Cleaning consumes an extremely large amount of ink.
Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore,
execute system cleaning only when necessary.

3. Execute cleaning

Make sure that the printer is on and then click OK.

Print head cleaning starts.

»» Note

+ After Cleaning or System Cleaning is complete, perform Print Nozzle Check Pattern and check the
cleaning results.

Related Topic

= Printing a Nozzle Check Pattern
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Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

Nozzle Check

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.

3. Load paper in the printer

Select the paper feed position when the dialog box appears.

4. Print a nozzle check pattern

Make sure that the printer is on and click OK.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print results.

(A) (B)

(A) As long as the horizontal lines are in line, and not missing, the nozzle is working normally.
(B) Where the horizontal lines are not in line or are missing, the color nozzle is blocked.

»» Note

» Because CO is colorless, it is printed over a black ink pattern. Check whether the CO pattern
contains horizontal streaks (A) in the dark gray area.

‘cu‘
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» From the nozzle check pattern printing results, if it becomes patchy or there are areas that
cannot be printed, use Print Head Cleaning to clean the print heads.
Once cleaning is complete, print the nozzle check pattern again and check the results.

Related Topic

= Cleaning the Print Heads
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Cleaning the Printer

=P Cleaning the Printer Exterior

=} Cleaning Inside the Top Cover

=$ Cleaning the Roll Unit

=$ Cleaning the Print Head
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Cleaning the Printer Exterior

Clean the printer regularly to maintain better printing quality and help prevent problems.

To ensure a comfortable working environment, clean the printer exterior about once a month.

1. Turn printer off.

=¥ Turning the Printer On and Off

2. Unplug the power cord from the outlet.

&Caution

» Always turn off the printer and unplug the power cord before cleaning or maintenance.
Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

3. Wipe away any residue and paper dust with damp cloth that you have wrung out completely
and wipe dry with dry cloth.

» Clean the printer exterior and the power cord plug.
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L@\.Warning

* Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come
into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

»2»Important

« If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the output guide even if it does not appear dirty, because it may actually be covered with

paper dust.
= Cleaning Inside the Top Cover

4. Plug the power cord into the outlet.
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Cleaning Inside the Top Cover

Clean inside the top cover about once a month to maintain better printing quality and help prevent problems.
Also clean inside the top cover in the following situations to ensure optimal operation.

« If the printed surface or the underside of paper is dirty after printing

+ After you have used up a roll

+ After borderless printing

« After printing on small paper

+ After printing on paper that generates a lot of cutting debris

+ If you have replaced the roll

« After printing on paper that generates a lot of paper dust

»2»Important

« If the platen inside the top cover becomes dirty, it may soil the underside of paper. We recommend
cleaning the platen after borderless printing or printing on small paper.

« If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the output guide even if it does not appear dirty, because it may actually be covered with paper
dust.

1. Flick Home screen and tap Maintenance.

=$ Touch Screen

The Maintenance screen appears.

2. Tap Platen cleaning.

A confirmation message appears.

3. Tap Yes.

The Carriage moves and after it stops moving, instructions appear on the touch screen.

4. Open top cover.
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5. If paper dust has accumulated in vacuum holes (A) on platen or in borderless printing ink
grooves (B), use cleaning brush (C), provided with printer, to wipe it away.

2»2Important

» Never touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching may

damage them.

2»>Note

« If the cleaning brush is dirty, rinse it in water.

6. Using a damp cloth that you have wrung out completely, wipe inside the top cover to clean
it. Wipe away any ink residue and paper dust (debris from cutting) on top cover roller (A),
paper retainer (B), entire platen (C), borderless printing ink grooves (D), periphery of left
and right ink suction holes (E, F), and output guide (G), and so on.
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&Warning

» Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come
into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

»2Important

» Do not use a dry cloth to wipe inside the top cover. This may create a static charge, which may
attract dust and affect the printing quality.

7. Close top cover.
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Cleaning the Roll Unit

About once a month, clean the roll unit to ensure optimal operation.

1. Remove any roll paper loaded in roll unit.

=$ Removing the Lower Roll from the Roll Unit (Option)

2. Turn printer off.

=# Turning the Printer On and Off

3. Unplug power cord from outlet.

&Caution

» Always turn off the printer and unplug the power cord before cleaning or maintenance.
Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

4. Wipe away any residue and paper dust from areas (A, B) that come in contact with paper
with damp cloth that you have wrung out completely, and wipe dry with dry cloth.

&Warning

» Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come
into contact with electrical components inside the roll unit, there is a risk of fire or electrical shock.

5. Plug power cord into outlet.
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Other Maintenance
» Preparing to Transfer the Printer

*» Reinstalling the Printer
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Preparing to Transfer the Printer

To protect the internal parts in transit, always follow these steps before transferring the printer to a new
location.

For details on packing the printer and installing it after transfer, see "Reinstalling the Printer."

»2»Important

» Be sure to contact your Canon dealer before transferring the printer to a new location. Ink may leak and
damage the printer if you do not prepare the printer correctly and it is tipped or stood on end in transit.

»2Note

» The maintenance cartridges needs to be replaced when you execute the Prepare to transportation
menu. Prepare the maintenance cartridge in advance while referring to the table below. The number of
maintenance cartridge required varies depending on the amount remaining in the maintenance
cartridge being used.

« If you can move the printer in a level state using casters or something similar, you do not need to
execute Prepare to transportation.

» Always follow the instructions of the service representative when preparing to transfer the printer.

Prepare to Usage Examples Transport Permitted Angle |Required
transportation and Storage | of Inclination Mainte-
Menu In Low Tem- nance Car-
perature En- tridges
vironments
Move indoors on | Move indoors by carry- | No All directions: with- | 1-3
the same floor ing in 30°
Move indoors to a | Moving the printer No All directions: with- | 1-3
different floor while temporarily tilting in 90°
it such as when using
the stairs
Transport out- Transport By Vehicle Yes All directions: with- |3
doors in 90°

Remove paper

1. Remove the paper.

* Rolls

-p Removing the Upper Roll from the Printer

=$ Removing the Lower Roll from the Roll Unit (Option)

e Sheet

=$ Removing Sheets
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Selecting Menu for Prepare to transportation

1. If touch screen indicates to replace maintenance cartridge, replace maintenance
cartridge.

=p Replacing the Maintenance Cartridge

2. Flick Home screen and tap Maintenance.

=p Touch Screen

The Maintenance screen appears.
3. Tap Prepare to transportation.

4. Select and tap transfer level.

Displays the confirmation screen.

5. Tap Yes.

The printer is now prepared for transfer.
When the preparation is finished, instructions appear on the touch screen.

Remove the ink tanks before packing the printer.

323 Important

« If consumables must be replaced, a message appears on the touch screen, and preparation is
disabled. If the message appears, tap OK and contact your Canon dealer for assistance.

Removing Ink Tanks

1. Open left and right ink tank covers to remove all ink tanks.

= Replacing Ink Tanks

2. Push down release lever (A) as shown as you gently return all ink tank lock levers to their
original positions.
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3. Close ink tank covers.

At this point, ink is drawn out from inside the tubes.

A confirmation message will appear when the process is finished.

»P¥Important

* Do not remove the maintenance cartridge except when the message indicating replacement is
displayed.

If you remove the maintenance cartridge while ink is being removed, the ink may leak out.

4. Replace maintenance cartridge currently being used with new maintenance cartridge.

=$ Replacing the Maintenance Cartridge

5. Press ON button and turn off printer.

Pack the printer

1. Disconnect power cord and interface cable.

2»2Important

» Turn off the printer before you unplug it. Unplugging the printer before it is off and moving it may
damage the printer. If you accidentally unplug the printer, plug it in again, reinstall the ink tanks,
and follow this procedure again.

2. Open top cover.
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3. Grasp Belt and insert Belt Stopper into position shown.

2»2Important

« Attach the Belt Stopper that was removed and stored after initial installation. Neglecting to
attach the Belt Stopper may damage the printer.

» Never touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching may
damage them.
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5. Tape down printer covers to secure them, in the reverse order of tape removal during
installation.

6. Remove basket by reversing installation procedure.

7. Remove the Stand by reversing the installation procedure, when it was attached to the
printer.

8. Disassemble and repackage the Stand by following the installation procedure in reverse.
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9. Repack Roll Holder, holder stopper, and printer in shipping materials, and then package
them in shipping box.
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Reinstalling the Printer

The basic workflow for reinstalling the printer is as follows.
For detailed instructions, see the Setup Guide.
Assemble the stand

1. Referring to the Printer Stand Setup Guide, assemble the Stand.

l_ﬂ;\nCaution

* The Stand must be assembled by at least two people on a flat surface. Attempting assembly by
yourself poses a risk of injury or bending the Stand.

* When assembling the Stand, lock the casters. In addition, always unlock the casters before
moving the assembled Stand. Attempting to move the stand when the casters are locked poses
a risk of injury or damage to the location site.

Install the printer

1. Mount the printer on the assembled Stand and tighten the screws firmly.

/_ﬁCaution

» Moving the printer requires at least six people, holding it on both sides. Be careful to avoid back
strain and other injuries.

* When carrying the printer, hold it securely by the carrying grips on the bottom left, right, and
rear. The printer may be unsteady if you hold it at other positions, which poses a risk of injury
from dropping the printer.
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2. Remove tape and packaging material attached to the printer. Also open the top cover and
remove stoppers and spacers inside the printer.

Stand.

4. Refer to Printer Stand Setup Guide and attach basket to Stand.
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6. Plug the power cord into the outlet.

7. Press the power button to turn the printer on.

When "Do you want to install the transported printer? Do not install the ink tanks yet." appears,
tap Yes.

8. When instructions for loading ink tank appear on touch screen, open ink tank cover and
load ink tank.
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9. Attach the Roll Holder to the Roll Media.

(See "Loading Rolls on the Roll Holder.")

10. Load the Roll Media in the printer.

(See "Loading the Upper Roll on the Printer.")

11. Install the software.

Note that the driver installation procedure varies depending on the type of connection.

(See "Installing the Printer Driver" (Windows).)
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(See "Installing the Printer Driver" (Mac OS).)
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Specifications
» Printer Specifications
« Specifications

@ Print Area
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Specifications

»2»Important

» The following values may vary depending on the operating environment.

Printer

Power supply

100-240 V AC (50/60 Hz)

Power consumption

When printing

Approx. 88 W

In Sleep mode

Approx. 1.8 W(*1)

When power is off

Approx. 0.5 W(*1) (*2)

Operating environment

Temperature

59 to 86°F (15 to 30°C)

Humidity

10 to 80% RH (with no conden-
sation)

Dimensions (W x D x H)

Main unit only

Approx. 43.8 x 28.9 x 24.8 in
(1110 x 734 x 628 mm)

Main unit and Stand (when basket is
not used)

Approx. 43.8 x 30.2 x 46 in
(1110 x 766 x 1168 mm)

Main unit and Stand (when using bas-
ket: basket Position 1)(*3)

Approx. 43.8 x 38.8 x 46 in
(1110 x 984 x 1168 mm)

Main unit and Stand (when using bas-
ket: basket Position 2/4/5)(*3)

Approx. 43.8 x 48.2 x 46 in
(1110 x 1222 x 1168 mm)

Main unit and Stand (when using bas-
ket: basket Position 3)(*3)

Approx. 43.8 x 56.5 x 46 in
(1110 x 1434 x 1168 mm)

Weight

Main unit only (does not include print
head and ink tanks)

Approx. 185 Ib (84 kg)

Stand

Approx. 37 Ib (17 kg)

Roll unit

Approx. 35 Ib (16 kg)

Space for installation (W x D x H)

When not using Stand

Approx. 59.5 x 56.5 x 40.2 in
(1510 x 1434 x 1020 mm)

When using Stand

Approx. 59.5 x 66.3 x 61.5in
(1510 x 1684 x 1560 mm)

Related standards

International ENERGY STAR Program

*1:When using USB connection

*2:The printer uses a trace amount of power even when turned off. To stop all power consumption, turn off the printer

and unplug the power cord.
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*3:For details on the basket position, see "Example Basket Configurations."

Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi (horizontally) (*1) x 1200 dpi (vertically)
Print head PF-10

Number of nozzles 18432 nozzles (1536 nozzles per color)

*1:Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Memory and hard disk

Memory 3GB

Hard disk capacity 320 GB

Personal mail boxes (Permanent | 140 GB
storage area)

Print job storage capacity Common Box 100 jobs

Personal Boxes 100 jobs

Interface
You can use both USB and LAN at the same time.

You cannot use wireless LAN and wired LAN at the same time.

usB Hi-Speed USB(*1)
USB memory USB flash drive
LAN Wired LAN IEEE802.3ab (1000BASE-T) / IEEE802.3u (100BASE-
TX) / IEEE802.3 (10BASE-T)
Wireless LAN IEEE802.11n / IEEE802.11g / IEEE802.11b (*2)

*1:To use Hi-Speed USB, your computer must support Hi-Speed USB.
Additionally, the Hi-Speed USB interface is completely backward compatible with USB 1.1, so the printer can be
connected even if the computer interface is USB 1.1.

*2:A connection can be established by configuring Standard setup, WPS (Wi-Fi Protected Setup), WCN (Windows
Connect Now), Cableless setup.

Network Specifications

Communication protocols | SNMP (Canon-MIB compatible), HTTP, TCP/IP (IPv4/IPv6)
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Wired LAN specifications

Compliance standards

IEEE802.3ab (1000BASE-T) / IEEE802.3u (100BASE-
TX) / IEEE802.3 (10BASE-T)

Transmission speed

10 Mbps / 100 Mbps / 1000 Mbps (automatically selec-
ted)

Wireless LAN specifica-
tions

Compliance standards

IEEE802.11n / IEEE802.11g / IEEE802.11b

Frequency range

2.4 GHz

Channels

1to11or1to13

Varies by country and region.

Effective range

Indoor 164 feet (50 m)

Varies according to environmental conditions.

Security

WEP (64/128 bit)
WPA-PSK (TKIP/AES)
WPA2-PSK (TKIP/AES)

Setup

Standard setup
WPS (push button method/PIN code method)
WCN (WCN-NET)

Cableless setup

Other

Admin password

Operating Conditions

If operating conditions of the operating system are high, follow those.

Windows

Compatible Operating Sys-
tem

(Standard supplied printer
driver)

32-bit version Windows 10

Windows 8.1, Windows 8
Windows 7

Windows Vista

Windows Server 2008

Use the latest Service Pack avail-
able.

64-bit version Windows 10

Windows 8.1, Windows 8
Windows 7

Windows Vista

Windows Server 2008, Windows
Server 2008 R2

Windows Server 2012, Windows
Server 2012 R2
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Use the latest Service Pack avail-
able.

Windows RT (Windows 8 ARM
architecture) not supported.

Recommended operating
environment(*1)

CPU Pentium 4 or later, or Athlon 64 or
later processor
Memory 1 GB or more

Free hard disk space

20 GB or more

Mac OS

Compatible Operating Sys-
tem

(Standard supplied printer
driver)

OS Xv10.7.5 to OS X v10.11

Recommended operating
environment(*1)

CPU

Intel multi-core processor or later

Memory

2 GB or more

Free hard disk space

20 GB or more

*1:Depending on the application software and data being used, the printer may not output correctly even with the
above environmental conditions.

» An Internet connection is required to use the Online Manual.

+ To install the software while using Windows, you must have a CD-ROM drive or a network connection.

* To install the software while using Mac OS, you must have a network connection.

Ink

For information on the ink the printer supports, see "Ink Tanks."

Paper

For details on the compatible media types, see "Paper Information List."

Paper width For details on the paper widths supported by the printer, see "Paper
Sizes."

Minimum paper length 8.00 in (203.2 mm)

Maximum printable length Rolls(*1) 59 feet (18 m)
Sheets 5.2 feet (1.6 m)(*2)

Thickness Rolls 3-31 mil (0.07-0.8 mm)
Sheets 3-31 mil (0.07-0.8 mm)

Roll maximum outer diameter

6.7 in (170 mm) or shorter
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Supported paper core inner diameter 2in/3in (50.8 mm/76.2 mm)

Print area

For details about Print Area, see "Print Area."

*1:Varies depending on the operating system or application.

*2:When using stand
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Print Area

A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in
borderless printing, the actual printing area corresponds to the paper size minus the space for this margin.

»»Note

 Printable Area: The area that can be printed.
» For borderless printing with roll paper, the margin is 0 in (O mm).
However, depending on the paper size, minor margins may be available.

=¥ Prints without Edges Based on the Scenarios(Windows)

= Prints without Edges Based on the Scenarios(Mac OS)
+ Recommended Print Area: We recommend printing within this area.

» To match the document size with the actual printing area, print on oversize paper with the required
margin added.

=} Printing to Oversized Paper Sizes(Windows)

=} Printing to Oversized Paper Sizes(Mac OS)

Margins of Printable Area Margins of Recommended Print Area

Top Edge Bottom Edge | Sides Top Edge Bottom Edge | Sides

Sheets [ 0.2 in (3 mm) | 0.8 in (20 mm) (0.2 in (3 mm) | 0.8 in (20 mm) [ 0.8 in (20 mm) | 0.2 in (3 mm)

Rolls [0.2in (3 mm)|[0.2in (3 mm) [0.2in (3 mm)[0.8in (20 mm)|0.2in (3 mm) |0.2in (3 mm)

Sheets

A i

s 4

¥

A. Top Edge

B. Bottom Edge
C. Left Edge
D. Right Edge

* Printable Area:
A margin of 0.2 in (3 mm) on top, 0.8 in (20 mm) on bottom, and 0.2 in (3 mm) on left and right sides

is required.

¢ Recommended Print Area:

415



A margin of 0.8 in (20 mm) on top, 0.8 in (20 mm) on bottom, and 0.2 in (3 mm) on left and right sides
is required.

Rolls

o i
Y

A. Top Edge

B. Bottom Edge
C. Left Edge
D. Right Edge

* Printable Area:
A margin of 0.2 in (3 mm) on top and bottom and 0.2 in (3 mm) on left and right sides is required. For
borderless printing, the margins on top, bottom, left, and right are 0 in (0 mm). For paper that supports
borderless printing, see "Paper Information List."

* Recommended Print Area:
A margin of 0.8 in (20 mm) on top, 0.2 in (3 mm) on bottom, and 0.2 in (3 mm) on left and right sides
is required.
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Safety

» Safety Precautions
» Regulatory Information

» WEEE (EUEEA)
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Safety Precautions

Choosing a location

Never install the printer on an unstable or vibrating surface.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close
to a heating source.

To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specifications.

Do not place the printer on a thick rug or carpet.

Do not place the printer with its back attached to the wall.

We recommend ensuring ample space for installation.

Do not install the printer near sources of strong electromagnetic fields, whether equipment that
generates such fields or places where such fields occur.

Power Supply

Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

Do not use an extension lead/cord.

Working Around the Printer

Never put your hands or fingers in the printer while it is printing.

Moving the printer requires at least six people, holding it on both sides. Be careful to avoid back strain
and other injuries.

When moving the printer, firmly grasp the Carrying Handles under each side. The printer may be
unsteady if you hold it at other positions, which poses a risk of injury from dropping the printer.

Do not place any object on the printer. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

Do not transport or use the printer on a slant, vertically or upside-down, as the ink may leak and
damage the printer.

Print Heads/Ink Tanks/Maintenance Cartridges

Keep ink tanks out of the reach of children. In case ink is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

Never touch the electrical contacts on a print head after printing.

The metal parts may be very hot and could cause burns.

Do not throw ink tanks and maintenance cartridges into fire.

Do not attempt to disassemble or modify the print head, ink tanks, and maintenance cartridges.
Avoid dropping or shaking print head, ink tanks, and maintenance cartridges.
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Regulatory Information

Lithium Battery

» Dispose of used batteries according to the local regulations.
 Risk of explosion if battery is replaced by an incorrect type.

Users in the U.S.A.

FCC Notice (U.S.A. Only)

For 120V, 60Hz model

Model Number: K10438 (Contains FCC Approved WLAN Module K30357)
Optional parts: Roll Unit RU-21

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

FCC ID:AZDK30357

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A,, Inc.
One Canon Park
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Melville, New York 11747
1-800-652-2666

Users in Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the
following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment and
meets RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and
operated keeping the radiator at least 20cm or more away from person's body (excluding extremities:
hands, wrists, feet and ankles).

Pour les usagers résidant au Canada

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit accepter tout brouillage
radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
environnement non contrdlé et respecte les régles d'exposition aux fréquences radioélectriques (RF)
CNR-102 de I'IC. Cet équipement doit étre installé et utilisé en gardant une distance de 20 cm ou plus
entre le dispositif rayonnant et le corps (a I'exception des extrémités : mains, poignets, pieds et chevilles).

EMERGY STAR

C€
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WEEE (EU&EEA)

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

B X

_ EURDOPE ONLY

These symbols indicate that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national legislation
implementing those Directives. If a chemical symbol is printed beneath the symbol shown above, in
accordance with the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb
= Lead) is present in this battery or accumulator at a concentration above an applicable threshold
specified in the Battery Directive. This product should be handed over to a designated collection point,
e.g., on an authorized one-for-one basis when you buy a new similar product or to an authorized
collection site for recycling waste electrical and electronic equipment (EEE) and batteries and
accumulators. Improper handling of this type of waste could have a possible impact on the environment
and human health due to potentially hazardous substances that are generally associated with EEE. Your
cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about the recycling of this product, please contact your local city office,
waste authority, approved scheme or your household waste disposal service or visit www.canon-
europe.com/weee, or www.canon-europe.com/battery.

Nur fiir Europaische Union und EWR (Norwegen, Island und Liechtenstein)

i ¢

— EURDPE ONLY

Diese Symbole weisen darauf hin, dass dieses Produkt gemafls WEEE-Richtlinie (2012/19/EU; Richtlinie
Uber Elektro- und Elektronik-Altgerate), Batterien-Richtlinie (2006/66/EG) und nationalen Gesetzen zur
Umsetzung dieser Richtlinien nicht tber den Hausmull entsorgt werden darf. Falls sich unter dem oben
abgebildeten Symbol ein chemisches Symbol befindet, bedeutet dies gemaR der Batterien-Richtlinie,
dass in dieser Batterie oder diesem Akkumulator ein Schwermetall (Hg = Quecksilber, Cd = Cadmium, Pb
= Blei) in einer Konzentration vorhanden ist, die Gber einem in der Batterien-Richtlinie angegebenen
Grenzwert liegt. Dieses Produkt muss bei einer dafiir vorgesehenen Sammelstelle abgegeben werden.
Dies kann z. B. durch Rickgabe beim Kauf eines neuen &hnlichen Produkts oder durch Abgabe bei einer
autorisierten Sammelstelle fir die Wiederaufbereitung von Elektro- und Elektronik-Altgeraten sowie
Batterien und Akkumulatoren geschehen. Der unsachgemale Umgang mit Altgeraten kann aufgrund
potenziell gefahrlicher Stoffe, die generell mit Elektro- und Elektronik-Altgeraten in Verbindung stehen,
negative Auswirkungen auf die Umwelt und die menschliche Gesundheit haben. Durch Ihre Mitarbeit bei
der umweltgerechten Entsorgung dieses Produkts tragen Sie zu einer effektiven Nutzung nattirlicher
Ressourcen bei. Um weitere Informationen Uber die Wiederverwertung dieses Produkts zu erhalten,
wenden Sie sich an Ihre Stadtverwaltung, den 6ffentlich-rechtlichen Entsorgungstrager, eine autorisierte
Stelle fur die Entsorgung von Elektro- und Elektronik-Altgeraten oder lhr ortliches
Entsorgungsunternehmen oder besuchen Sie www.canon-europe.com/weee, oder www.canon-
europe.com/battery.
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Union Européenne, Norvége, Islande et Liechtenstein uniquement.

i9:¢

_ EURDPE ONLY

Ces symboles indiquent que ce produit ne doit pas étre mis au rebut avec les ordures ménagéres, comme
le spécifient la Directive européenne DEEE (2012/19/UE), la Directive européenne relative a I'élimination
des piles et des accumulateurs usagés (2006/66/CE) et les lois en vigueur dans votre pays appliquant ces
directives. Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus
conformément a la Directive relative aux piles et aux accumulateurs, il indique la présence d'un métal
lourd (Hg = mercure, Cd = cadmium, Pb = plomb) dans la pile ou I'accumulateur a une concentration
supérieure au seuil applicable spécifié par la Directive. Ce produit doit étre confié au distributeur a chaque
fois que vous achetez un produit neuf similaire, ou a un point de collecte mis en place par les collectivités
locales pour le recyclage des Déchets des Equipements Electriques et Electroniques (DEEE). Le
traitement inapproprié de ce type de déchet risque d'avoir des répercussions sur l'environnement et la
santé humaine, du fait de la présence de substances potentiellement dangereuses généralement
associées aux équipements électriques et électroniques. Votre entiére coopération dans le cadre de la
mise au rebut correcte de ce produit favorisera une meilleure utilisation des ressources naturelles. Pour
plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-
organisme ou les autorités locales compétentes, ou consultez le site www.canon-europe.com/weee, ou
www.canon-europe.com/battery.

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen, IJsland en
Liechtenstein)

B X

_ EURDPE ONLY

Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn
(2012/19/EU), de richtlijn 2006/66/EG betreffende batterijen en accu's en/of de plaatselijk geldende
wetgeving waarin deze richtlijnen zijn geimplementeerd, niet bij het normale huisvuil mag worden
weggegooid. Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft dit
in overeenstemming met de richtlijn betreffende batterijen en accu's aan dat deze batterij of accu een
zwaar metaal bevat (Hg = kwik, Cd = cadmium, Pb = lood) waarvan de concentratie de toepasselijke
drempelwaarde in overeenstemming met de genoemde richtlijn overschrijdt. Dit product dient te worden
ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te leveren bij een hiertoe erkend
verkooppunt bij aankoop van een gelijksoortig product, of bij een officiéle inzameldienst voor de recycling
van elektrische en elektronische apparatuur (EEA) en batterijen en accu's. Door de potentieel gevaarlijke
stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van dit type afval mogelijk
nadelige gevolgen hebben voor het milieu en de menselijke gezondheid. Uw medewerking bij het op juiste
wijze weggooien van dit product draagt bij tot effectief gebruik van natuurlijke hulpbronnen. Voor verdere
informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke gemeente,
afvaldienst, officiéle dienst voor klein chemisch afval of afvalstortplaats, of kunt u terecht op www.canon-
europe.com/weee, of www.canon-europe.com/battery.
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Sélo para la Unién Europea y el Area Econémica Europea (Noruega,
Islandia y Liechtenstein)

i9:¢

_ EURDPE ONLY

Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo con
la Directiva sobre RAEE (2012/19/UE) y la Directiva sobre Pilas y Acumuladores (2006/66/CE) y/o la
legislacion nacional. Si aparece un simbolo quimico bajo este icono, de acuerdo con la Directiva sobre
Pilas y Acumuladores, significa que la pila o el acumulador contiene metales pesados (Hg = Mercurio, Cd
= Cadmio, Pb = Plomo) en una concentracién superior al limite especificado en dicha directiva. Este
producto debera entregarse en un punto de recogida designado, por ejemplo, entregandolo en el lugar de
venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de residuos de
aparatos eléctricos y electronicos (RAEE), baterias y acumuladores. La gestion incorrecta de este tipo de
residuos puede afectar al medio ambiente y a la salud humana debido a las sustancias potencialmente
nocivas que suelen contener estos aparatos. Su cooperacion en la correcta eliminacién de este producto
contribuira al correcto aprovechamiento de los recursos naturales. Los usuarios tienen derecho a
devolver pilas, acumuladores o baterias usados sin coste alguno. El precio de venta de pilas,
acumuladores y baterias incluye el coste de la gestion medioambiental de su desecho, y no es necesario
mostrar la cuantia de dicho coste en la informacion y la factura suministradas a los usuarios finales. Si
desea mas informacién sobre el reciclado de este producto, pdngase en contacto con su municipio, el
servicio o el organismo encargado de la gestion de residuos domésticos o visite www.canon-europe.com/
weee, 0 www.canon-europe.com/battery.

Només per a la Unié Europea i a I’Espai Economic Europeu (Noruega,
Islandia i Liechtenstein)

i ¢

— EURDPE ONLY

Aquests simbols indican que aquest producte no s’ha de llengar amb les escombraries de la llar, d’acord
amb la RAEE (2012/19/UE), la Directiva relativa a piles i acumuladors (2006/66/CE) i la legislacio
nacional que implementi aquestes directives. Si al costat d’aquest simbol hi apareix imprés un simbol
quimic, segons especifica la Directiva relativa a piles i acumuladors, significa que la bateria o
I'acumulador conté un metall pesant (Hg = mercuri, Cd = cadmi, Pb = plom) en una concentracié superior
al limit aplicable especificat en la Directiva. Aquest producte s’hauria de lliurar en un dels punts de
recollida designats, com per exemple, intercanviant un per un en comprar un producte similar o lliurant-lo
en un lloc de recollida autoritzat per al reciclatge de residus d’aparells eléctrics i electronics (RAEE) i piles
i acumuladors. La manipulacié inadequada d’aquest tipus de residus podria tenir un impacte negatiu en
’entorn i en la salut humana, a causa de les substancies potencialment perilloses que normalment estan
associades a I'RAEE. La vostra cooperacié a I'hora de rebutjar correctament aquest producte contribuira
a la utilitzacié efectiva dels recursos naturals. Els usuaris tenen dret a retornar les bateries o els
acumuladors usats sense cap carrec. El preu de venda de les bateries i els acumuladors inclou el cost de
la gestié ambiental dels residus i no es necessari mostrar I'import d’aquest cost en aquest fullet o en la
factura que es lliuri a I'usuari final. Per a més informacié sobre el reciclatge d’aquest producte, contacteu
amb l'oficina municipal, les autoritats encarregades dels residus, el pla de residus homologat o el servei
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de recollida d’escombraries domeéstiques de la vostra localitat o visiteu www.canon-europe.com/weee, 0
www.canon-europe.com/battery.

Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

B X

_ EURDPE ONLY

Questi simboli indicano che il prodotto non puo essere smaltito con i rifiuti domestici, ai sensi della
Direttiva RAEE (2012/19/UE), della Direttiva sulle Batterie (2006/66/CE) e/o delle leggi nazionali che
attuano tali Direttive. Se sotto il simbolo indicato sopra é riportato un simbolo chimico, in osservanza della
Direttiva sulle batterie, tale simbolo indica la presenza di un metallo pesante (Hg = Mercurio, Cd =
Cadmio, Pb = Piombo) nella batteria o nell'accumulatore con un livello di concentrazione superiore a una
soglia applicabile specificata nella Direttiva sulle batterie. Il prodotto deve essere conferito a un punto di
raccolta designato, ad esempio il rivenditore in caso di acquisto di un nuovo prodotto simile oppure un
centro di raccolta autorizzato per il riciclaggio di rifiuti di apparecchiature elettriche ed elettroniche (RAEE)
nonché di batterie e accumulatori. Un trattamento improprio di questo tipo di rifiuti pud avere
conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze potenzialmente nocive
solitamente contenute in tali rifiuti. La collaborazione dell'utente per il corretto smaltimento di questo
prodotto contribuira a un utilizzo efficace delle risorse naturali ed evitera di incorrere in sanzioni
amministrative ai sensi dell'art. 255 e successivi del Decreto Legislativo n. 152/06. Per ulteriori
informazioni sul riciclaggio di questo prodotto, contattare le autorita locali, I'ente responsabile della
raccolta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure visitare il
sito www.canon-europe.com/weee, 0 www.canon-europe.com/battery.

Apenas para a Uniao Europeia e AEE (Noruega, Islandia e Liechtenstein)

i ¢

— EURDPE ONLY

Estes simbolos indicam que este produto ndo deve ser eliminado juntamente com o seu lixo doméstico,
segundo a Diretiva REEE de 2012/19/UE, a Diretiva de Baterias (2006/66/CE) e/ou a sua legislagao
nacional que transponha estas Diretivas. Se houver um simbolo quimico impresso como mostrado
abaixo, de acordo com a Diretiva de Baterias, isto indica que um metal pesado (Hg = Mercurio, Cd =
Cadmio, Pb = Chumbo) esta presente nesta pilha ou acumulador, numa concentragdo acima de um limite
aplicavel especificado na Diretiva. Este produto deve ser entregue num ponto de recolha designado, por
exemplo num local autorizado de troca quando compra um equipamento novo idéntico, ou num local de
recolha autorizado para reciclar equipamento elétrico e eletrénico (EEE) em fim de vida, bem como pilhas
e baterias. O tratamento inadequado deste tipo de residuos pode ter um impacto negativo no ambiente e
na saude humana, devido a substancias potencialmente perigosas que estdo associadas com
equipamentos do tipo EEE. A sua cooperagao no tratamento correto deste produto ira contribuir para a
utilizacdo mais eficaz dos recursos naturais. Para obter mais informagdes acerca de como reciclar este
produto, por favor contacte as suas autoridades locais responsaveis pela matéria, servigo de recolha
aprovado para pilhas e baterias ou servigo de recolha de residuos solidos domésticos da sua
municipalidade, ou visite www.canon-europe.com/weee, ou www.canon-europe.com/battery.
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Galder kun i Europaiske Union og EGS (Norge, Island og Liechtenstein)

i9:¢

_ EURDPE ONLY

Disse symboler betyder, at produktet ikke ma bortskaffes sammen med dagrenovation i henhold til WEEE-
direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller den lokale lovgivning, som disse direktiver
er gennemfart i. Hvis der i overensstemmelse med batteridirektivet er trykt et kemisk symbol under det
symbol, der er vist ovenfor, betyder det, at batteriet eller akkumulatoren indeholder tungmetaller (Hg =
kviksglv, Cd = cadmium, Pb = bly) i en koncentration, som ligger over de greenseveerdier, der er beskrevet
i batteridirektivet. Produktet skal afleveres pa et godkendt indsamlingssted, f.eks. i overensstemmelse
med en godkendt én-til-én-procedure, nar du indkgber et nyt tilsvarende produkt, eller pa et godkendt
indsamlingssted for elektronikaffald samt for batterier og akkumulatorer. Forkert handtering af denne type
affald kan medfere negative konsekvenser for miljget og menneskers helbred pa grund af de potentielt
sundhedsskadelige stoffer, der generelt kan forefindes i elektrisk og elektronisk udstyr. Nar du foretager
korrekt bortskaffelse af produktet, bidrager du til effektiv brug af naturressourcerne. Kontakt din kommune,
den lokale affaldsmyndighed, det lokale affaldsanlaeg, eller besag www.canon-europe.com/weee, eller
www.canon-europe.com/battery for at fa flere oplysninger om genbrug af dette produkt.

Mévo yia Tnv EupwTtraiki ‘Evwon kai Tov EOX (NopBnyia, IoAavdia kai
AixtevoTdiv)

i ¢

— EURDPE ONLY

AuTd Ta cUpBoAa uTTOdEIKVUOUV OTI AUTO TO TTPOIOV BEV TTPETTEI VA ATTOPPITITETAI HAli JE TO OIKIAKA
aTroppiypaTa, cuupwva pe Tnv Odnyia yia Ta ATToRANTa HAekTpIKOU Kal HAekTpovikoU EEoTTAIGHOU
(AHHE) (2012/19/EE), Tnv Odnyia yia 1ig HAekTpIkéG ZTrAEG (2006/66/EK) A/kai Tnv €BVIKY vopoBeaia TTou
e@apuodel Tig Odnyieg ekeiveg. EAv kKATTOI0 XNUIKO OUMBOAO gival TUTTWHEVO KATW aTT TO UHBOAO TTOU
@aiveTal TTapatmdvw, ocupewva pe Tnv Odnyia yia Tig HAeKTPIKEG ZTrAEG, uTTodNAWVEl OTI KATTOI0 BapU
péTaAAo (Hg = Ydpdpyupog, Cd = Kadpio, Pb = MOAUBBOG) uTTapxEl OTNV WTTATAPIO 1) TOV CUCCWPEUTH O€
OUYKEVTPWON PEYAAUTEPN aTTO TO IoYUOV £TTITTEDO TTOU KaBopiletal aTnv Odnyia yia TiI¢ HAEKTPIKEG ZTAAEG.
AUTO TO TTPOIOV TTPETTEI Va TTapadideTal o€ KaBopPIoPEVO anueio GUAAOYAG, TT.X. O€ HIa €E0UCIOdOTNUEVN
Baon avraAAaynig 6tav ayopdadeTte £va vEO TTAPOUOIO TTPOIOV 1 a€ pia eEoualodoTnuévn BEan acuAloyng yia
TNV avakUKAwon Twv ammoBAATWY NAEKTPIKOU Kal NAEKTPOVIKOU eE0TTAIONOU (HHE) kal Twv NAEKTPIKWV
OTNAWYV Kal cUoOWPEUTWY. O akaTdAANAOG XEIPIGPOG auToU TOU TUTTOU ATTORANTWY UTTOPEI va £XEI
apvnTIKG avTiKTUTTO OTO TTEPIBAAAOV Kal TNV uyEia Tou avBpwTrou, Adyw duvnTIKA ETTIKIVOUVWY OUCIWV TTOU
yevikd ouvdéovtal ye Tov HHE. H ouvepyaaoia oag yia Tn owoTr] atréppiyn autou Tou TpoidvTog Ba
OUMBAAEI OTNV ATTOTEAEOUATIKA XPHoN TWV QUOIKWY TTOpwWV. MNa TEPIcTETEPES TTANPOPOPIEG OXETIKA PE
AvaKUKAWGN auToU TOU TTPOIGVTOG, ETTIKOIVWVACTE WE TO TOTTIKO Ypageio TNG TTOANG 0AG, TNV UTTNPETia
ATTOPPIUUATWYV, TO EYKEKPIPMEVO OXANA 1} TV UTTNPECIA ATTOPPIYPNGS OIKIOKWY aTTOBAATWV 1) ETTICKEPOEITE TN
d1eUBuvan www.canon-europe.com/weee r; www.canon-europe.com/battery.
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Gjelder kun den europeiske union og E@S (Norge, Island og Liechtenstein)

i9:¢

_ EURDPE ONLY

Disse symbolene indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i henhold
til WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller nasjonal lov som har
implementert disse direktivene. Hvis et kjemisk symbol vises under symbolet vist ovenfor, i samsvar med
batteridirektivet, indikerer dette at et tungmetall (Hg = kvikksglv, Cd = kadmium, Pb = bly) finnes i batteriet
eller akkumulatoren i en konsentrasjon over en gjeldende gvre grense som er spesifisert i batteridirektivet.
Produktet ma leveres til et dertil egnet innsamlingspunkt, det vil si pa en autorisert en-til-en-basis nar en
kjgper et nytt lignende produkt, eller til et autorisert innsamlingssted for resirkulering av avfall fra elektrisk
og elektronisk utstyr (EE-utstyr) og batterier og akkumulatorer. Feil handtering av denne typen avfall kan
vaere miljg- og helseskadelig pa grunn av potensielt skadelige stoffer som ofte brukes i EE-utstyr. Din
innsats for korrekt avhending av produktet vil bidra til effektiv bruk av naturressurser. Du kan fa mer
informasjon om resirkulering av dette produktet ved a kontakte lokale myndigheter,
avfallsadministrasjonen, et godkjent program eller husholdningens renovasjonsselskap, eller ga til
www.canon-europe.com/weee, eller www.canon-europe.com/battery.

Vain Euroopan unionin seka ETA:n (Norja, Islanti ja Liechtenstein) alueelle.

i ¢

— EURDPE ONLY

Nama tunnukset osoittavat, ettd sdhko- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EV), paristoista ja akuista annettu direktiivi (2006/66/EY) seka kansallinen lainsaadanto kieltavat
tuotteen havittamisen talousjatteen mukana. Jos ylla olevan symbolin alapuolelle on paristodirektiivin
mukaisesti painettu kemiallisen aineen tunnus, kyseinen paristo tai akku sisaltda raskasmetalleja (Hg =
elohopea, Cd = kadmium, Pb = lyijy) enemman kuin paristodirektiivin salliman maaran. Tuote on vietava
asianmukaiseen kerayspisteeseen, esimerkiksi kodinkonelilkkkeeseen uutta vastaavaa tuotetta ostettaessa
tai viralliseen sahko- ja elektroniikkalaiteromun tai paristojen ja akkujen kerayspisteeseen. Sahko- ja
elektroniikkalaiteromun virheellinen kasittely voi vahingoittaa ymparistéa ja ihmisten terveytta, koska
laitteet saattavat sisaltaa ymparistolle ja terveydelle haitallisia aineita. Tuotteen asianmukainen
havittdminen sdastda myos luonnonvaroja. Jos haluat lisatietoja tdman tuotteen kierratyksesta, ota yhteys
kunnan jatehuoltoviranomaisiin tai kayttamaasi jatehuoltoyhtioon tai kay osoitteessa www.canon-
europe.com/weee, tai www.canon-europe.com/battery.

Endast for Europeiska unionen och EES (Norge, Island och Liechtenstein)

B H

_ EURDPE ONLY

De har symbolerna visar att produkten inte far sorteras och slangas som hushallsavfall enligt WEEE-
direktivet (2012/19/EU), batteridirektivet (2006/66/EG) och/eller nationell lagstiftning som implementerar
dessa direktiv. Om en kemisk symbol forekommer under ovanstaende symbol innebar detta enligt
Batteridirektivet att en tungmetall (Hg = Kvicksilver, Cd = Kadmium, Pb = Bly) férekommer i batteriet eller
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ackumulatorn med en koncentration som overstiger tillamplig grans som anges i Batteridirektivet.
Produkten ska lamnas in pa en avsedd insamlingsplats, t.ex. pa en atervinningsstation auktoriserad att
hantera elektrisk och elektronisk utrustning (EE-utrustning) samt batterier och ackumulatorer eller hos
handlare som &r auktoriserade att byta in varor da nya, motsvarande képs (en mot en). Olamplig
hantering av avfall av den har typen kan ha negativ inverkan pa miljén och manniskors halsa pa grund av
de potentiellt farliga @&mnen som kan aterfinnas i elektrisk och elektronisk utrustning. Din medverkan till en
korrekt avfallshantering av produkten bidrar till effektiv anvandning av naturresurserna. Om du vill ha mer
information om var du kan |ldmna in den har produkten, kontakta ditt lokala kommunkontor, berérd
myndighet eller foretag for avfallshantering eller se www.canon-europe.com/weee, eller www.canon-
europe.com/battery.

Pouze Evropska unie a EHP (Norsko, Island a Lichtenstejnsko)

B X

_ EURDPE ONLY

Tento symbol znamena, ze podle smérnice OEEZ (2012/19/EU), smérnice o bateriich (2006/66/ES) a/
nebo podle vnitrostatnich pravnich provadécich predpist k témto smérnicim nema byt tento vyrobek
likvidovan s odpadem z domacnosti. Je-li v souladu s poZadavky smérnice o bateriich vyti§té€na pod vyse
uvedenym symbolem chemicka znacka, udava, ze tato baterie nebo akumulator obsahuje tézké kovy (Hg
= rtut, Cd = kadmium, Pb = olovo) v koncentraci vy$si, nez je pfislusna hodnota pfedepsana smérnici.
Tento vyrobek ma byt vracen do ur¢eného sbérného mista, napf. v ramci autorizovaného systému odbéru
jednoho vyrobku za jeden nové prodany podobny vyrobek, nebo do autorizovaného sbérného mista pro
recyklaci odpadnich elektrickych a elektronickych zafizeni (OEEZ), baterii a akumulator. Nevhodné
nakladani s timto druhem odpadu by mohlo mit negativni dopad na Zivotni prostfedi a lidské zdravi,
protoze elektricka a elektronicka zafizeni zpravidla obsahuji potencialné nebezpecéné latky. Vase
spoluprace na spravné likvidaci tohoto vyrobku napomuze efektivnimu vyuzivani pfirodnich zdroja.
Chcete-li ziskat podrobné informace tykajici se recyklace tohoto vyrobku, obratte se prosim na mistni
Ufad, organ pro nakladani s odpady, schvaleny systém nakladani s odpady &i spole€nost zajistujici
likvidaci domovniho odpadu, nebo navstivie webové stranky www.canon-europe.com/weee nebo
www.canon-europe.com/battery.

Csak az Eurdpai Unié és az EGT (Norvégia, Izland és Liechtenstein)
orszagaiban

B H

_ EURDPE ONLY

Ezek a szimbdlumok azt jelzik, hogy a termék hulladékkezelése a haztartasi hulladéktél kilonvalasztva,
az elektromos és elektronikus berendezések hulladékairdl (WEEE) sz6l6 (2012/19/EU) iranyelvnek és az
elemekrdl és akkumulatorokrol, valamint a hulladék elemekrél és akkumulatorokrél szolo (2006/66/EK)
irdnyelvnek megfeleléen és/vagy ezen iranyelveknek megfelel§ helyi el6irdsok szerint torténik.
Amennyiben a fent feltlintetett szimbolum alatt egy vegyjel is szerepel, az elemekrél és akkumulatorokrol
sz06l6 iranyelvben foglaltak értelmében ez azt jelzi, hogy az elem vagy az akkumulator az irdnyelvben
meghatarozott hatarértéknél nagyobb mennyiségben tartalmaz nehézfémet (Hg = higany, Cd = kadmium,
Pb = 6lom). E terméket az arra kijeldlt gy(ijtéhelyre kell juttatni — pl. hasonlé termék vasarlasakor a régi
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becserélésére vonatkozé hivatalos program keretében, vagy az elektromos és elektronikus berendezések
(EEE) hulladékainak gyUjtésére, valamint a hulladék elemek és hulladék akkumulatorok gydijtésére kijelolt
hivatalos gy(jtéhelyre. Az ilyen jelleg(i hulladékok nem el8irasszeri kezelése az elektromos és
elektronikus berendezésekhez (EEE) altaldnosan kapcsolhatd potencialisan veszélyes anyagok révén
hatassal lehet a kérnyezetre és az egészségre. E termék megfeleld leselejtezésével On is hozzajarul a
természeti forrasok hatékony hasznalatdhoz. A termék Ujrahasznositésat illetéen informalédjon a helyi
polgarmesteri hivatalnal, a helyi kozterllet-fenntartd vallalatnal, a hivatalos hulladékleraké telephelyen
vagy a haztartési hulladék begyjtését végzd szolgaltatdnal, illetve latogasson el a www.canon-
europe.com/weee, vagy www.canon-europe.com/battery internetes oldalra.

Tylko dla krajow Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

i ¢

— EURDPE ONLY

Te symbole oznaczajg, ze produktu nie nalezy wyrzuca¢ razem z odpadami gospodarstwa domowego,
zgodnie z dyrektywg WEEE w sprawie zuzytego sprzetu elektrycznego i elektronicznego (2012/19/UE) lub
dyrektywg w sprawie baterii (2006/66/WE) badz przepisami krajowymi wdrazajgcymi te dyrektywy. Jesli
pod powyzszym symbolem znajduje sie symbol chemiczny, zgodnie z dyrektywag w sprawie baterii
oznacza to, ze bateria lub akumulator zawiera metal ciezki (Hg = rte¢, Cd = kadm, Pb = otéw) w stezeniu
przekraczajgcym odpowiedni poziom okreslony w dyrektywie w sprawie baterii. Uzytkownicy baterii i
akumulatoréw majg obowigzek korzysta¢ z dostepnego programu zwrotu, recyklingu i utylizacji baterii
oraz akumulatoréw. Niewtasciwe postepowanie z tego typu odpadami moze mie¢ wptyw na srodowisko i
zdrowie ludzi ze wzgledu na substancje potencjalnie niebezpieczne, zwigzane ze zuzytym sprzetem
elektrycznym i elektronicznym. Panstwa wspotpraca w zakresie wiasciwej utylizacji tego produktu
przyczyni sie do efektywnego wykorzystania zasobéw naturalnych. W celu uzyskania informaciji o
sposobie recyklingu tego produktu prosimy o kontakt z wiasciwym urzedem miejskim lub zaktadem
gospodarki komunalnej bgdz zapraszamy na strone www.canon-europe.com/weee, lub www.canon-
europe.com/battery.

Plati len pre staty Eurdopskej unie a EHP (N6rsko, Island a Lichtenstajnsko)

B H

_ EURDPE ONLY

Tieto symboly oznacuju, Ze podla Smernice o odpade z elektrickych a elektronickych zariadeni (OEEZ)
2012/19/EU, Smernice o batériach (2006/66/ES) a podla platnej legislativy Slovenskej republiky sa tento
produkt nesmie likvidovat spolu s komunalnym odpadom. Ak je chemicka znacka vytlaéenda pod vys$Sie
uvedenym symbolom, znamena to, Ze tato batéria alebo akumulator obsahuje tazky kov (Hg = ortut, Cd =
kadmium, Pb = olovo) v koncentracii vys$sej, ako je prisluSsna povolena hodnota stanovena v Smernici o
batériach. Produkt je potrebné odovzdat do uréenej zberne, napr. prostrednictvom vymeny za kupu
noveho podobného produktu, alebo na autorizované zberné miesto, ktoré spracuva odpad z elektrickych
a elektronickych zariadeni (EEZ), batérii a akumulatorov. Nespravna manipulacia s takymto typom
odpadu méze mat negativny vplyv na Zivotné prostredie a fudské zdravie, pretoZe elektrické a
elektronické zariadenia obsahuju potencialne nebezpecéné latky. Spolupracou na spravnej likvidacii tohto
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produktu prispejete k uginnému vyuzivaniu prirodnych zdrojov. Dalsie informécie o recyklacii tohto
produktu ziskate od miestneho uradu, uradu Zivotného prostredia, zo schvaleného planu OEEZ alebo od
spolo¢nosti, ktora zaistuje likvidaciu komunalneho odpadu. Viac informacii najdete aj na webovej stranke:
www.canon-europe.com/weee, alebo www.canon-europe.com/battery.

Uksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

B X

_ EURDPE ONLY

Antud simbolid viitavad sellele, et vastavalt elektri- ja elektroonikaseadmete jaatmeid kasitlevale
direktiivile (2012/19/EL), patareisid ja akusid ning patarei- ja akujaatmeid kasitlevale direktiivile
(2006/66/EU) ja/vdi nimetatud direktiive rakendavatele riiklikele digusaktidele ei voi seda toodet koos
olmejaatmetega ara visata. Kui keemiline simbol on triikitud eespool toodud simboli alla, siis tdhendab
see, et antud patareis voi akus leiduva raskemetalli (Hg = elavhébe, Cd = kaadmium, Pb = plii)
kontsentratsioonitase on kdrgem kui patareisid ja akusid ning patarei- ja akujaatmeid kasitlevas direktiivis
satestatud piirmaar. Antud tootest tekkinud jaadtmed tuleb anda vastavasse kogumispunkti, nt
muugipunkti, mis on volitatud ks Uhe vastu vahetama, kui ostate uue sarnase toote, vdi vastavasse
elektri- ja lektroonikaseadmete jaadtmete ning patareide ja akude imbertddtlemiseks mdeldud
kogumispunkti. Antud liiki jaatmete vale kaitlemine voib kahjustada keskkonda ja inimeste tervist elektri- ja
elektroonikajaatmetes tavaliselt leiduvate potentsiaalselt ohtlike ainete tottu. Antud tootest tekkinud
jaatmete nduetekohase korvaldamisega aitate kasutada loodusvarasid efektiivselt. Taiendava teabe
saamiseks elektri- ja elektroonikaseadmetest tekkinud jadatmete ning patarei- ja akujaatmete tagastamise
ja Umbert66tlemise kohta votke Ghendust kohaliku omavalitsusega, asjakohase valitsusasutusega,
asjakohase tootjavastutusorganisatsiooniga voi olmejaatmete kaitlejaga. Lisateavet leitate ka Interneti-
lehekduljelt www.canon-europe.com/weee vdi www.canon-europe.com/battery.

Tikai Eiropas Savienibai un EEZ (Norvégijai, Islandei un Lihtensteinai)

i ¢

— EURDPE ONLY

Sie simboli norada, ka atbilstosi ES Direktivai (2012/19/ES) par elektrisko un elektronisko iekartu
atkritumiem (EEIA), Direktivai (2006/66/EK) par baterijam un akumulatoriem, un akumulatoru atkritumiem,
ar ko atce| Direktivu 91/157/EEK, un viet&jiem tiesibu aktiem So izstradajumu nedrikst izmest kopa ar
sadzives atkritumiem. Ja zem iepriek$ noradita simbola ir uzdrukats kimiskais simbols, saskana ar
direktivu par baterijam un akumulatoriem tas nozimé, ka $is baterijas vai akumulatori satur smagos
metalus (Hg = dzivsudrabs, Cd = kadmijs, Pb = svins) un to koncentracijas limenis parsniedz direktiva par
baterijam un akumulatoriem minéto piemérojamo slieksni. Sis izstradajums ir janodod piemérota
savak8anas vieta, pieméram, apstiprinata veikala, kur iegadajaties I1dzigu jaunu produktu un atstajat
veco, vai apstiprinata vieta izlietotu elektrisko un elektronisko iekartu un bateriju un akumulatoru
parstradei. Nepareiza $ada veida atkritumu apsaimnieko$ana var apdraudét vidi un cilvéka veselibu tadu
iesp&jami bistamu vielu dél, kas parasti ir elektriskajas un elektroniskajas iekartas. Jusu atbalsts pareiza
§ada veida atkritumu apsaimnieko$Sana sekmés efektivu dabas resursu izmanto$anu. Lai sanemtu
pilnigaku informaciju par $ada veida izstradajumu nodoSanu otrreiz€&jai parstradei, sazinieties ar vietéjo
pasvaldibu, atkritumu savak8anas atbildigo dienestu, pilnvaroto organizaciju vai iestadi, kas veic sadzives
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atkritumu apsaimniekosanu, vai apmeklgjiet timek|a vietni www.canon-europe.com/weee, vai www.canon-
europe.com/battery.

Tik Europos Sajungai ir EEE (Norvegijai, Islandijai ir Lichtensteinui)

B X

_ EURDPE ONLY

Sie simboliai reiskia, kad $io gaminio negalima i$mesti j buitines atliekas, kaip reikalaujama WEEE
Direktyvoje (2012/19/ES) ir Baterijy direktyvoje (2006/66/EB) ir (ar) jasy Salies nacionaliniuose
jstatymuose, kuriais ios Direktyvos yra jgyvendinamos. Jeigu cheminio Zenklo simbolis yra nurodytas
Zemiau Sio zZenklo, tai reiskia, kad vadovaujantis Baterijy direktyva, baterijy ar akumuliatoriy sudétyje yra
sunkiyjy metaly (Hg = gyvsidabrio, Cd = kadmio, Pb = Svino), kuriy koncentracija virsija Baterijy
direktyvoje nurodytas leistinas ribas. Sj gaminj reikia pristatyti j specialyjj surinkimo punkta, pavyzdZiui,
mainais, kai jus perkate naujg panasy gaminj, arba j specialigjg surinkimo vietg, kurioje perdirbamos
elektrinés ir elektroninés jrangos atliekos bei naudotos baterijos ir akumuliatoriai. Dél netinkamo Sio tipo
atlieky tvarkymo gali nukentéti aplinka ir iSkilti grésmé Zmogaus sveikatai dél galimai kenksmingy
medziagy, i$ esmés susijusiy su elektrine ir elektronine jranga. Bendradarbiaudami ir teisingai
utilizuodami Siuos gaminius, jis padésite efektyviai naudoti gamtinius iSteklius. Daugiau informacijos apie
gaminio perdirbima jums gali suteikti vietinis biuras, atlieky tvarkymo bendrové, sertifikuoti organai ar
buitiniy atlieky surinkimo jmonés. Taip pat sitloma apsilankyti interneto svetainéje www.canon-
europe.com/weee, arba www.canon-europe.com/battery.

Samo za Evropsko unijo in EGP (Norveska, Islandija in Lihtenstajn)

i ¢

— EURDPE ONLY

Ti simboli pomenijo, da tega izdelka skladno z Direktivo OEEO (2012/19/EU), Direktivo 2006/66/ES in/ali
nacionalno zakonodajo, ki uvaja ti direktivi, ne smete odlagati z nesortiranimi gospodinjskimi odpadki. Ce
je pod zgoraj prikazanim simbolom natisnjen kemijski simbol, to v skladu z Direktivo pomeni, da je v tej
bateriji ali akumulatorju prisotna tezka kovina (Hg = zivo srebro, Cd = kadmij, Pb = svinec), in sicer v
koncentraciji, ki je nad relevantno mejno vrednostjo, dolo¢eno v Direktivi. Ta izdelek je potrebno odnesti
na izbrano zbirno mesto, t. j. pooblas€eno trgovino, kjer ob nakupu novega (podobnega) izdelka vrnete
starega, ali na pooblas€eno zbirno mesto za ponovno uporabo odpadne elektri¢ne in elektronske opreme
(EEO) ter baterij in akumulatorjev. Neustrezno ravnanje s to vrsto odpadkov lahko negativno vpliva na
okolje in Clovesko zdravje zaradi potencialno nevarnih snovi, ki so pogosto povezane z EEO. Vase
sodelovanje pri pravilnem odlaganju tega izdelka predstavlja pomemben prispevek k smotrni izrabi
naravnih virov. Za vec informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad,
pristojno sluzbo za odpadke, predstavnika pooblad€enega programa za obdelavo odpadkov ali na lokalno
komunalo. Lahko pa tudi obiS¢ete naSo spletno stran www.canon-europe.com/weee, ali www.canon-
europe.com/battery.
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Cawmo 3a EBponeinckus cbio3 u EUN (Hopeernsa, UcnaHamsa n JinxteHwamnH)

_ EURDPE ONLY

Te3n cMMBOnM Nokaseart, Ye To3u NPoAyKT He TpsibBa Aa ce u3xXBbpns 3aedHo ¢ buToBuTe oTNagbLm
cbrnacHo Oupektuata 3a MYEEO (2012/19/EC), AnpekTnaTa 3a 6atepum (2006/66/EO) n/unun BaweTo
HaUMOHanHO 3aKoHO4ATENCTBO, Npunarawlo Te3n OQupekTneu. AKO Nofg nokasaHus rope CUMBON €
oTnevaTtaH CUMBOI 3a XMMUYECKM EMNIEMEHT, CbINacHo pasnopeadbuTte Ha [upekTusarta 3a 6atepun, To3n
BTOPW CMMBOJT O3Ha4YaBa Hanu4mMeTo Ha Texxbk metan (Hg = xwneak, Cd = kagmuin, Pb = onoso) B
Oatepusita Uy akymyrnatopa B KOHLEHTpauus Hag ykaszaHarta rpaHuua 3a CbOTBETHUS €NTEMEHT B
OvpektuBata. To3u npoaykT Tpsabea ga 6bae NpegageH B NpegHa3HadeH 3a Lenta NyHKT 3a cbbupaHe,
Hanpumep Ha 6asa pa3MsiHa, KoraTto KyrnyBaTe HOB NOAOOEH NpoayKT, unn B o4o0peH cbOmpaTteneH nyHKT
3a peuuKnupaHe Ha 13nasno ot ynotpeba enekTpnyecko u enekTpoHHo obopyasaHe (MYEEO), 6atepun n
akymynatopu. HenpaBunHoTo TpeTupaHe Ha To3u TUN OTNagbLM MOXe Aa AOBEAE 00 EBEHTYarHM
oTpuvuaTenHM NocrneacTBMs 3a OKOnHaTa cpefa M YOBELLKOTO 3apaBe nopaaw NoTeHUnanHo onacHuTe
BeELLEeCTBa, KOUTO 0OUKHOBEHO ca cBbp3aHu ¢ EEO. B cbLyoTo Bpeme BalleTto cbaelicteue 3a
NPaBUINHOTO U3XBbPsHE Ha TO3U NPOAYKT e AonpuHece 3a ePeKTMBHOTO M3MNON3BaHe Ha NpUpogHUTe
pecypcu. 3a noBeve nHMOpPMaLMa OTHOCHO TOBa Kbe MOXETe Aa npeAafeTe 3a peunknupaHe Ha To3u
NpoayKT, MOMs CBbpXeTe ce ¢ BawuTte mecTHM Bnactu, ¢ opraHa, OTTOBOPEH 3a OTnagbuuTe, ¢
opobpeHata cuctema 3a UYEEO unu ¢ Bawara mectHa cnykba 3a 6utoBM oTnagbLm, Unm nocetete
www.canon-europe.com/weee, unn www.canon-europe.com/battery.

Doar pentru Uniunea Europeana si EEA (Norvegia, Islanda si Liechtenstein)

— EURDPE ONLY

Aceste simboluri indica faptul ca acest produs nu trebuie aruncat impreuna cu deseurile menajere, in
conformitate cu Directiva DEEE (2012/19/UE), Directiva referitoare la baterii (2006/66/CE) si/sau legile
dvs. nationale ce implementeaza aceste Directive. Daca un simbol chimic este imprimat sub simbolul de
mai sus, in conformitate cu Directiva referitoare la baterii, acest simbol indica prezenta in baterie sau
acumulator a unui metal greu (Hg = Mercur, Cd = Cadmiu, Pb = Plumb) intr-o concentratie mai mare
decét pragul admis specificat in Directiva referitoare la baterii. Acest produs trebuie inméanat punctului de
colectare adecvat, ex: printr-un schimb autorizat unu la unu atunci cand cumparati un produs nou similar
sau la un loc de colectare autorizat pentru reciclarea reziduurilor de echipament electric si electronic
(EEE) si baterii si acumulatori. Administrarea neadecvata a acestui tip de deseuri, ar putea avea un
impact asupra mediului si asupra sanatatii umane datorita substantelor cu potential de risc care sunt in
general asociate cu EEE. Cooperarea dvs. in directia reciclarii corecte a acestui produs va contribui la o
utilizare eficienta a resurselor naturale. Pentru mai multe informatii despre reciclarea acestui produs, va
rugam sa contactati biroul dvs. local, autoritatile responsabile cu deseurile, schema aprobata sau serviciul
dvs. responsabil cu deseurile menajere sau vizitati-ne la www.canon-europe.com/weee, sau www.canon-
europe.com/battery.
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Samo za Europsku uniju i EEA (Norveska, Island i Lihtenstajn)

i9:¢

_ EURDPE ONLY

Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u skladu
s direktivom WEEE (2012/19/EC), Direktivom o baterijama (2006/66/EC) i Pravilnikom o gospodarenju
otpadnim baterijama i akumulatorima te Pravilnikom o gospodarenju otpadnim elektri¢nim i elektronic¢kim
uredajima i opremom. Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s
Direktivom o baterijama, to znaci da se u ovoj bateriji ili akumulatoru nalazi teSki metal (Hg = ziva, Cd =
kadmij, Pb = olovo) i da je njegova koncentracija iznad razine propisane u Direktivi o baterijama. Ovaj bi
proizvod trebalo predati ovlaSenom skupljacu EE otpada ili prodavatelju koji je duzan preuzeti otpadni
proizvod po sistemu jedan za jedan, ukoliko isti odgovara vrsti te je obavljao primarne funkcije kao i
isporuc¢ena EE oprema. Otpadne baterije i akumulatori predaju se ovlastenom skupljacu otpadnih baterija
ili akumulatora ili prodavatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuce
rukovanje ovom vrstom otpada moze utjecati na okolis i ljudsko zdravlje zbog potencijalno opasnih
supstanci koje se najcesce nalaze na takvim mjestima. Vasa suradnja u pravilnom zbrinjavanju ovog
proizvoda pridonijet ¢e djelotvornom iskoristavaniju prirodnih resursa. Dodatne informacije o recikliranju
ovog proizvoda zatrazite od svog lokalnog gradskog ureda, sluzbe za zbrinjavanje otpada, odobrenog
programa ili komunalne sluzbe za uklanjanje otpada ili pak na stranicama www.canon-europe.com/weee
ili www.canon-europe.com/battery.

Korisnici u Srbiji

B X

_ EURDPE ONLY

Ovaj simbol oznac¢ava da ovaj proizvod ne sme da se odlaze sa ostalim kuénim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU), Direktivom o baterijama (2006/66/EC) i nacionalnim zakonima. Ukoliko
je ispod gore navedenog simbola odStampan hemijski simbol, u skladu sa Direktivom o baterijama, ovaj
simbol ozna¢ava da su u ovoj bateriji ili akumulatoru prisutni teSki metali (Hg — ziva, Cd — kadmijum, Pb -
olovo) u koncentracijama koje premasuju prihvatljivi prag naveden u Direktivi o baterijama. Ovaj proizvod
treba predati odredenom centru za prikupljanje, npr. po principu ,jedan-za-jedan“ kada kupujete sli¢an
novi proizvod, ili ovla8éenom centru za prikupljanje za reciklazu istroSene elektrine i elektronske opreme
(EEE), baterija i akumulatora. Nepravilno rukovanje ovom vrstom otpada mozZe imati negativne posledice
po Zivotnu sredinu i ljudsko zdravlje usled potencijalno opasnih materijala koji se uglavnom vezuju za
EEE. Va$a saradnja na ispravhom odlaganju ovog proizvoda ¢e doprineti efikasnom kori§¢enju prirodnih
resursa. VisSe informacija o tome kako moZete da reciklirate ovaj proizvod potraZite od lokalnih gradskih
vlasti, komunalne sluzbe, odobrenog plana reciklaze ili servisa za odlaganje ku¢nog otpada, ili posetite
stranicu www.canon-europe.com/weee, ili www.canon-europe.com/battery.
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Basic Printing Workflow

=p Printing procedure

=p Canceling print jobs

=$ Pausing Printing
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Printing procedure

=} Printing Options Using Rolls and Sheets

=p Turning the Printer On and Off

= | oading and Printing on Rolls

= | oading and Printing on Sheets

= Printing in Windows

=$ Printing from Mac OS
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Printing Options Using Rolls and Sheets

The printer supports both rolls and sheets.

This section introduces the main features of each, as well as the main printing methods available. Select
rolls or sheets to suit your particular printing application.

»>»Note

» For information on the types of paper the printer supports, see "Types of Paper."

+ A variety of other ways to print are available besides those introduced here. For details, see "Enhanced
Printing Options."

Roll printing

Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn
loaded in the printer.

Rolls can be used to print large photos or create posters or banners that cannot be printed on regular
sheets.

» Large-format printing

Easily print vertical or horizontal banners from familiar applications such as Microsoft Office
applications.

(See "Printing Hanging and Horizontal Banners (Large-Format Printing)" (Windows).)
(See "Printing Hanging and Horizontal Banners (Large-Format Printing)" (Mac OS).)
» Borderless printing

Print without a margin (border) around posters or photos.

(See "Prints without Edges Based on the Scenarios" (Windows).)
(See "Prints without Edges Based on the Scenarios" (Mac OS).)
* Banner printing

You can print multiple pages as a single continuous image, without margins between pages.

(See "Printing by Connecting Multiple Pages" (Windows).)
(See "Printing by Connecting Multiple Pages" (Mac OS).)
» 90-degree rotation before printing

Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.

(See "Saving Roll Paper by Rotating Document 90 Degrees” (Windows).)
(See "Saving Roll Paper by Rotating Document 90 Degrees" (Mac OS).)
» Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
(See "Scaled Printing" (Windows).)
(See "Scaled Printing" (Mac OS).)
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» Free Layout (Windows) and imagePROGRAF Free Layout (Mac OS)

Print multiple documents from multiple applications (such as word-processing programs, spreadsheet
programs, and so on) next to each other.

(See "Lining Up and Printing Multiple Documents" (Windows).)

(See "Lining Up and Printing Multiple Documents" (Mac OS).)

»>»Note

+ Setting the optional roll unit to feed mode and loading roll paper in both the Roll 1 (Upper) and Roll 2
(Lower) holders offers the following advantages.

» Save the time and effort of switching paper

By loading roll paper of different media types or paper sizes on the upper and lower rolls, you can
select the roll paper in Paper Source in the printer driver when printing, eliminating the effort it
takes to replace the roll.

(See "Page Setup Tab Description" (Windows).)
(See "Quality & Media" (Mac OS).)

» Automatic selection of the right paper for the print job

Selecting Roll Paper (Auto) in Paper Source in the printer driver enables automatic selection and
printing on the roll that suits the print job from the loaded rolls.

(See "Printing by Automatically Switching Upper-level and Lower-level Roll Papers" (Windows).)

(See "Printing by Automatically Switching Upper-level and Lower-level Roll Papers" (Mac OS).)

Sheet printing
Sheets refer to individual sheets of paper.
Insert the sheet between the platen and the paper retainer.
» Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
(See "Scaled Printing" (Windows).)
(See "Scaled Printing" (Mac OS).)
» Free Layout (Windows) and imagePROGRAF Free Layout (Mac OS)

Print multiple documents from multiple applications (such as word-processing programs, spreadsheet
programs, and so on) next to each other.

(See "Lining Up and Printing Multiple Documents" (Windows).)

(See "Lining Up and Printing Multiple Documents" (Mac OS).)
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Turning the Printer On and Off

Turning the printer on

1. Press ON button to turn on printer.

The printer will now start up.

The Canon logo appears on the touch screen, and then "Starting the system Please wait." appears.

2. When startup is finished, ON button lights up, and printer enters standby mode.
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Ready to print.

Tl 1 T I .
PM R C PGYMEK PBK B COGY Y M PC =
(®1 Plain Paper

(©z Plain Paper

I Plain Paper

Maintenance

The printer will not enter standby mode in the following situations. Take action as necessary.

» The top cover is open
Close the top cover.

» The ink tank cover is open
Close the ink tank cover.

» The print head is not installed
= Replacing the Print Head

« The ink tank is not installed
= Replacing Ink Tanks

* Error appears on touch screen
Check the message on the touch screen and take action as necessary.

* The ON button and Status lamp never light up, and nothing appears on the touch screen
Make sure the printer is plugged in correctly. Check the connection at the plug and electrical
outlet.

* No paper is loaded
Load paper. (See "Loading and Printing on Rolls.") (See "Loading and Printing on Sheets.")

Turning the printer off
»2»Important

» Never disconnect the printer's power supply or unplug it during a print job. This may damage the
printer.

1. Make sure no print jobs are in progress.

While the Status lamp is flashing, the printer is running. The color of the lamp indicates the following
states.
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If the Status lamp is flashing orange, check the message on the touch screen and take action as
necessary.

If the Status lamp is flashing white, the printer is receiving a print job. Turn off the printer after printing
is finished.

2. Hold down the ON button for more than a second.

"Ending Please wait a while." appears on the touch screen, and the printer turns off.
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Loading and Printing on Rolls

These are the basic steps for loading and printing on rolls.

Follow these steps to load and print on rolls.

»2»Note

+ For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information
List".

+ To wait until the ink dries after printing before cutting the roll, set Drying Time in the printer driver. (See
"Specifying the Ink Drying Time for Rolls.")

» Once you have used all the paper on a roll, clean the platen. If the platen inside the top cover becomes
dirty, it may soil the underside of paper. (See "Cleaning Inside the Top Cover.")

1. Turn the printer on. (See "Turning the Printer On and Off.")

2. Load a roll on the Roll Holder. (See "Loading Rolls on the Roll Holder.")

s — ~

\

3. Load roll paper in printer or roll unit. (See "Loading the Upper Roll on the Printer.") (See
"Loading the Lower Roll on the Roll Unit (Option).")
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4. Select the type of paper. (See "Changing the Type of Paper.")
»>»Note

* If no barcode has been printed on the roll paper and you have set Manage remaining roll
amount to Enable, specify the roll length after selecting the media type. (See "Specifying the

Paper Length.")

5. Complete settings in the printer driver for the type of paper and other details.

» How to Open the Printer Driver Setup Window (Windows)

* How to Open the Printer Driver Setup Window (Mac OS)
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6. Send the print job.

¢ Printing in Windows

¢ Printing from Mac OS

The printer now starts printing the print job.
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Loading and Printing on Sheets

These are the basic steps for loading sheets and then printing.

Follow the steps below to load and print on sheets.

»2»Note

» For details on paper sizes and types that can be loaded, see "Paper Sizes" or "Paper Information List".

» Borderless printing is not supported on sheets. For the features and the main printing methods
available for sheet printing, see "Printing Options Using Rolls and Sheets."

1. Turn the printer on. (See "Turning the Printer On and Off.")

2. Complete settings in the printer driver for the type of paper and other details.

» How to Open the Printer Driver Setup Window (Windows)

* How to Open the Printer Driver Setup Window (Mac OS)
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3. Send the print job.

¢ Printing in Windows

¢ Printing from Mac OS

4. Load the sheet. (See "Loading Sheets in the Printer.")

Start printing.
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Printing in Windows

Print from the application menu.

»2»Important

» We recommend exiting unnecessary applications before printing. Running several applications while
printing may interrupt the transfer of print data and affect printing quality.

1. In the source application, select Print from the File menu to display the dialog box for
printing conditions.

2. After confirming that the printer is selected in the dialog box, click Print or OK to start
printing.

2»2»Note

* The appearance of the dialog box varies depending on the software application. In most cases,
the dialog box includes basic printing options and enables you to choose the printer, specify the
range of pages, number of copies, and so on.

Example: Print dialog box displayed by the application

P 1

) Print =
General | Options

Select Printer

% Add Printer
= Fax
= Canon

Status: R ady Frint o fle | Preferances

Lozation:

Comment; Find Printer..

Fage Ranege

4 |r

@ Al Mumber of copies: 1
Selaction Current Page
Fages: 1 Collate

Enter either a single page number or a single ]_.1 2,2 3,3
page range . For example, 5-172

[ Print ] | Can el | Apply

« If another printer is selected, select the printer you want to use under Select Printer or in the
dialog box displayed after clicking Printer.

You can use the printer driver dialog box to configure various printing settings such as for enlarged or
reduced printing and borderless printing. You can open the printer driver dialog box from the application
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software or from the operating system menu. For details, see "How to Open the Printer Driver Setup
Window" (Windows) or "How to Open the Printer Driver Setup Window" (Mac OS).
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Printing from Mac OS

Print from the application menu after registering the printer.

»2»Important

» We recommend exiting unnecessary applications before printing. Running several applications while
printing may interrupt the transfer of print data and affect printing quality.

Registering the printer

The printer needs to be registered in Print & Scan (identified as Printers & Scanners or Print & Fax in
other versions of Mac OS X) in System Preferences before printing.

For instructions on registering printers, see "Sharing the Printer on a Network (Mac OS)."

»2»Important

+ During this setup process, the printer will not be listed among available printers if it is off or
disconnected.

Printing from the application software

1. In the application software, select Print from the File menu to display the dialog box for
printing conditions.

»P»Note

« This dialog box includes basic printing options and enables you to choose the printer, specify
the range of pages, number of copies, and so on.

2. Select the printer in the Printer list.
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Presets: Default Settings

Printer:} Canon EI

Copies: [1 |
Pages: © Al
“From: 1 to: 1
Paper Size: A4 210 by 287 mm
Qrientation: Iﬂ 1!: Scale: 100 %

MNotes E

Print header and footer
Rewrap contents to fit page

1of1

? | poF | | Hide Details Cancel

3. Click Print to start printing.

As shown in the following illustration, you can switch to other panes in this dialog box to complete

settings for various methods of printing, including enlarged and reduced printing, borderless printing,
and so on.

Printer: Canon

(oo

Presets: Default Settings

Copies: [1 |
Pages: © Al
From: 1 to: 1
Paper Size: A4 210 by 287 mm
QOrientation: tﬁ tl: Scale: 100 %
¥ Notes E
Layout

Color Matching
Paper Handling

Cover Page
1of1
Color Options
2. PoF §J | Hide Details Paper Detailed Settings hel

Page Processing
Additional Settings
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Canceling print jobs

=P Canceling Print Jobs from the Control Panel

=p Canceling Print Jobs from Windows

=$ Canceling Print Jobs from Mac OS
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Canceling Print Jobs from the Control Panel

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

When you press the Stop button during printing, the printer operation varies depending on the current
status.

* You press the Stop button before printing starts
Pressing the Stop button before printing starts displays a confirmation message. To cancel the print job,
select Yes.

G
The Printer does not print,

* You press the Stop button during printing
Pressing the Stop button during printing displays a confirmation message. To cancel the print job
immediately, select Yes.

The printer stops immediately.
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Canceling Print Jobs from Windows

In the printer window, you can cancel jobs that are being sent to the printer.

Using Canon |J Status Monitor, you can cancel print jobs that have already been received by the printer or
that are currently being printed.

1. Click the printer icon in the taskbar to display the printer window.

2»>Note

* You can proceed from the folder for configuring the printer settings in the OS you are using.

For example, in Windows 7, open the Devices and Printers window from the start menu and
double-click the printer icon.

2. Right-click the job to cancel and select Cancel.

i )

=0 Caneon iPFoce: - Offline == @
Printer Document View
Document Mame Status Chamer Pages Size
5: S NN K 3. ME o % MB
Pause
Restart
Cancel
4 F
Cancels the selected ¢ Properties

3. If job to be canceled is not shown in printer window (that is, if print data has already been
received by printer), click taskbar icon to display Canon |J Status Monitor.

4. Click Cancel Printing.
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2»>»Note

» The screen may differ slightly depending on the model you are using.
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Canceling Print Jobs from Mac OS

In the printer window, you can cancel jobs that are being sent to the printer.

»>Note

* Print jobs are shown in the printer window while they are being sent from the computer. After
transmission, jobs are not displayed even during printing.

1. Click the printer icon in the Dock to display the printer window.

2. Either click x for the job to cancel printing or select the job to cancel printing and then click
Delete to delete the job.

e0o ) -1Job

Pause Settings

sample

raF

2»»Note

+ If the job to be canceled is not shown in the printer window (that is, if the print data has already
been received by the printer), you can cancel printing from the operation panel on the printer or
from RemoteUl. For details, "Canceling Print Jobs from the Control Panel" or see "Changing
Settings Using Web Browser."
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Pausing Printing

=p Pausing Printing
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Pausing Printing

During printing, if you set Pause printing to Enable, the printer enters a state in which printing is paused,
after the completion of the printing process when this setting was made.

Printing from the job queue is not possible in this state.

To restore normal operation after pausing printing, set Pause printing to Disable.

»>Note

* In the following cases, the status is cleared even if you do not set Pause printing to Disable, and
printing from the job queue resumes.

* When paper is advanced

* If you changed the media type from the paper settings display area

1. Tap Job management on Home screen during printing.

Printing...

‘ B Job management \

e Print from USE flash drive

»>»Note

« If the Home screen does not appear, press the Home button.

2. Tap Pause printing.

3. Tap Enable or Disable.
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Enhanced Printing Options
» Printing from Your Computer (Windows)
a Printing with Easy Setup ¥Basics
Changing the Type of Paper
a Setting the Number of Copies and Printing Order
a Using Roll Unit to Use 2-Level Rolls
About 2-Level Roll Switching
Setting the Paper Rolls in the Printer According to the Intended Use
Printing by Automatically Switching Upper-level and Lower-level Roll Papers
How to Switch Paper Rolls
Reflect Roll Unit Settings in the Printer Driver
a Printing Photos and Business Documents
Printing By Setting Print Purpose
Edit in PosterArtist and Print
a Changing the Print Quality and Correcting Image Data
Adjusting Color Balance
Setting the Print Quality Level (Custom)
Printing a Color Document in Monochrome
Adjusting Tone
Specifying Color Correction
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Interpreting the ICC Profile
Adjusting Brightness
Adjusting Contrast

Printing Using Detailed Setting Mode
@ Scaled Printing

@ Printing to Oversized Paper Sizes
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a Setting Paper Dimensions (Custom Size)
@ Prints without Edges Based on the Scenarios

Printing without Margins to Match Paper Size
Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins
@ Changing the Clear Coating Settings
@ Printing Hanging and Horizontal Banners (Large-Format Printing)
@ Printing by Dividing/Joining Documents

Lining Up and Printing Multiple Documents

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page

Dividing and Printing Posters
@ Printing Document in Center of Paper
@ Printing by Saving Roll Paper
Saving Roll Paper by Rotating Document 90 Degrees
Saving Roll Paper by Eliminating Upper and Lower Margins on Document
a Switching the Paper Source to Match the Purpose
a Displaying the Print Results before Printing
a Other Convenient Settings
Stamp Printing
Registering a Stamp
Setting a Page Size and Orientation
Registering a Frequently Used Printing Profile

Cutting Roll Paper after Printing
» Printing from Computer (Mac OS)
a Printing with Easy Setup JBasics
Changing the Type of Paper

a Setting the Number of Copies and Printing Order
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a Using Roll Unit to Use 2-Level Rolls
About 2-Level Roll Switching
Setting the Paper Rolls in the Printer According to the Intended Use
Printing by Automatically Switching Upper-level and Lower-level Roll Papers
How to Switch Paper Rolls
Reflect Roll Unit Settings in the Printer Driver
a Changing the Print Quality and Correcting Image Data
Adjusting Color Balance
Setting the Print Quality Level (Custom)
Printing a Color Document in Monochrome
Adjusting Tone
Specifying Color Correction
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles (Specifying an ICC Profile from the Application Software)

Printing with ICC Profiles (Specifying an ICC Profile from the Printer Driver)

Interpreting the ICC Profile
Adjusting Brightness

Adjusting Contrast
@ Scaled Printing
a Printing to Oversized Paper Sizes
a Setting Paper Dimensions (Custom Size)
@ Print Area
@ Prints without Edges Based on the Scenarios

Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins
@ Changing the Clear Coating Settings
@ Printing Hanging and Horizontal Banners (Large-Format Printing)

@ Printing by Dividing/Joining Documents
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Lining Up and Printing Multiple Documents
Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page
& Printing Document in Center of Paper
@ Printing by Saving Roll Paper
Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document
a Switching the Paper Source to Match the Purpose
@ Cutting Roll Paper after Printing
» Printing from Printer
@ Printing from USB Flash Drive

Printing Data Saved on USB Flash Drive

Setting ltems for Printing Using Operation Panel
» Printing from Smartphone/Tablet

a Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct
Connection)
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Printing from Your Computer (Windows)
» Printing with Easy Setup 7Basic
» Setting the Number of Copies and Printing Order
*» Using Roll Unit to Use 2-Level Rolls
*» Printing Photos and Business Documents
» Changing the Print Quality and Correcting Image Data
» Scaled Printing
» Printing to Oversized Paper Sizes
» Setting Paper Dimensions (Custom Size)
» Prints without Edges Based on the Scenarios
» Changing the Clear Coating Settings
» Printing Hanging and Horizontal Banners (Large-Format Printing)
» Printing by Dividing/Joining Documents
» Printing Document in Center of Paper
» Printing by Saving Roll Paper
» Switching the Paper Source to Match the Purpose
» Displaying the Print Results before Printing

» Other Convenient Settings
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Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

Printing with Easy Setup

1. Check that the printer is turned on

2. Load paper on the printer
Set roll paper or cut paper to a printer.

3. Open the printer driver setup window

4. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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32 Important

» See "Paper Information List" for Canon authentic paper or Canon output check paper.

»» Note

* Click Get Information... to display the Paper Information on Printer dialog box. The Paper
Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.

« For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."

5. Select print target
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From the pull-down menu, select Easy Settings, and then select the setting that matches your
purpose from the Print Target list.
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6. Select the print quality

For Print Quality, select Highest, High or Standard according to your purpose.
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22 Important

» The print quality settings that can be selected may differ depending on a printing profile.

7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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8. Select the paper source

For Paper Source, select the setting that matches your purpose.
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22 Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

9. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.
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10. Complete the setup

Click OK.
When you execute print, the document is printed with settings that match your purpose.
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»>» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.

Checking Printer Settings and Applying Settings to Printer Driver

1. Open printer driver setup window
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2. Click Get Information... on Main tab
The Paper Information on Printer dialog box appears.

3. Select the paper source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Roll Width.

4. Apply settings
To apply the printer settings to the printer driver, click OK.
3> Note

+ If the media type and the output paper size are not set on the printer, OK will be grayed out and
cannot be clicked.

« If communication with the printer is disabled, the Get Information... does not appear or printer
media information from the printer cannot be obtained.

« If the paper information in the printer driver is not the latest information, a message appears,
and the Paper Information on Printer dialog box cannot be displayed.
Update the paper information in the printer driver.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Layout tab, specify the number of copies to be printed.
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3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

22 Important

* When the application software that you used to create the document has the same function, specify the
settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.
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Using Roll Unit to Use 2-Level Rolls
» About 2-Level Roll Switching
» Setting the Paper Rolls in the Printer According to the Intended Use
» Printing by Automatically Switching Upper-level and Lower-level Roll Papers
» How to Switch Paper Rolls

» Reflect Roll Unit Settings in the Printer Driver
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About 2-Level Roll Switching

This printer allows you to load roll paper in two levels, the upper level (Roll 1) and the lower level (Roll 2)
and to automatically switch between Roll 1 and Roll 2 depending on the print job.

Printing by automatically switching Roll 1 and Roll 2 in this way is called "2-level roll switching."

* For instructions on setting the paper, see "Setting the Paper Rolls in the Printer According to the
Intended Use."

* For the 2-level roll switching procedure, see "Printing by Automatically Switching Upper-level and Lower-
level Roll Papers."

» Guidelines on how to switch Roll 1 and Roll 2 for certain cases are summarized in "How to Switch Paper
Rolls."

Refer to this section if a document cannot be printed as intended or as necessary.
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Setting the Paper Rolls in the Printer According to the Intended
Use

If you want to switch the 2-level rolls, set the paper rolls on the upper and lower level of the printer in one of
the ways described below depending on the intended use.

* When automatically switching from paper roll 1 to paper roll 2 to match the paper size specified for the
print job

Set two paper rolls of the same type of paper but of different width on the upper and on the lower trays.

Example of how to set the paper

Paper-feeding tray Roll Width Media Type
Upper-level 36 in Roll (914.4mm) | Plain Paper
Lower-level A1/A2 Roll (594.0mm) | Plain Paper

* When automatically switching from paper roll 1 to paper roll 2 role to match the paper type specified for
the print job

Set two paper rolls of the same width but of different types of paper on the upper and on the lower trays.
Alternatively, set two paper rolls of different width and different types of paper on the upper and on the
lower trays.

Setting the paper (Example 1)

Paper-feeding tray Roll Width Media Type
Upper-level A1/A2 Roll (594.0mm) | Plain Paper
Lower-level A1/A2 Roll (594.0mm) [ Canon Coated Paper

Setting the paper (Example 2)

Paper-feeding tray Roll Width Media Type

Upper-level 36 in Roll (914.4mm) | Plain Paper

Lower-level A1/A2 Roll (594.0mm) [ Canon Coated Paper
32 Important

+ 2-level roll switching is not possible when the paper rolls being fed on the platen are not compatible
with automatic cut-off. For checking which types of paper are compatible with automatic cut-off, look
up the paper you want to use on the "Paper Information List."

»» Note

» For information on how to set the paper rolls in the printer, see "Handling rolls"
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* When rolls of different types of paper and of different width are set in the upper and lower trays, the
paper roll matching the type of paper specified for the print job will be used.
Depending on the settings, an error may occur causing the wrong paper roll to be used; in such
cases, it is recommended that, instead of using 2-level roll switching, you specify which one is best
between paper roll 1 and paper roll 2 and print.

A3
-'_lﬂ ......
) —
Document Roll 1: Roll 2:
Size: A3 ISO A1/A2 ISO A3/A4
Media Type: Plain Paper Plain Paper Glossy Paper

» To learn how to switch paper- feeding trays, see "How to switch paper rolls."

470



Printing by Automatically Switching Upper-level and Lower-level
Roll Papers

You can print by automatically switching Roll 1 and Roll 2 depending on the media type or your purpose.

The procedure for printing by switching the roll papers is as follows:

1. Load roll papers in upper and lower levels of printer

2. Open the printer driver setup window

3. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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4. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

5. For Paper Source, select Roll Paper (Auto)
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6. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

7. Selecting the printing method for the roll paper

When performing enlarged/reduced printing in accordance with the roll width, place a checkmark next
to Enlarged/Reduced Printing and select the Fit Roll Paper Width.

8. Set the other items

To rotate the document 90 degrees and print it, select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

»» Note

+ If you rotate a portrait document 90 degrees and print it at that horizontally, you may be able to
save paper depending on the paper size.

32 Important

* When you select the Rotate Page 90 degrees check box and print the document, the
document will be rotated 90 degrees only if the vertical length of the document fits in the width
set in Roll Width.

Therefore to use this function, correctly set Roll Width to the width of one of the roll papers
loaded in the printer.

Roll Width:

D t
ocumen ISO A1/A2 Roll (594.0 mm)
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« If the roll papers loaded in the upper and lower levels are different media types, the document is
printed on the roll paper that matches the media type specified in the print job.
If the document is being rotated 90 degrees for printing and the roll papers loaded in the upper
and lower levels have different widths and different media types, set the correct combination of
width and media type so that they match one of the roll papers loaded in the printer.

9. Complete the setup

Click OK.
When you print, the paper source is switched automatically to roll paper.

32 Important

» On the operation panel, if Device settings -> Paper-related settings -> Roll paper auto switching
is set to Do not identify size, the document may be printed on the unintended roll paper. Canon
recommends that you set this setting to Identify size before you print.

» 2-level roll switching is not possible when the paper rolls being fed on the platen are not compatible
with automatic cut-off. For checking which types of paper are compatible with automatic cut-off, look
up the paper you want to use on the "Paper Information List."

»>» Note

» For details about how to switch the source levels depending on the print job, see "How to Switch
Paper Rolls."

Printing by Saving Paper
Depending on the paper size that was specified in the print job, the printer automatically identifies the roll
paper that will produce the smaller margins.

Whether or not the page is rotated 90 degrees, the printer prints using conditions that produce the
smallest paper margins from among the Roll1 and Roll2 combinations.

Document
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Roll 1: 1SO A1/A2 Roll 2: 1SO A3/A4

1. Select as described below:

+ If you are using Windows 10, right-click the Start menu, and select Control Panel ->
Hardware and Sound -> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server
2012, from the Desktop charms, select Settings -> Control Panel -> Hardware and Sound
(Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

« If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

+ If you are using Windows Vista or Windows Server 2008, select the Start menu -> Control
Panel -> Hardware and Sound -> Printers.

The Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties (in Windows 10, Windows
8.1, Windows 8, or Windows 7) or Properties (in Windows Vista).
The printer's Properties window appears.

3. Set automatic paper source switching

On the Device Settings tab, select the Automatically switch paper sources (paper size priority)
check box.

474



10.

= Canon Properties x

Garrsl  Shacng Pods  Adverced  Color Management  Secoty  Devios Setrgs

Ot
A Bl Ut
I A Automancaly gwtch paper scores fager size peorty] I

Tz ol papeer that grves the smalest margin ansa on paper for the
prnted paper sz i sulomatcaly sslacted

Even rmors pager can B aveed] By humng on Ratate Page 30

Segret inthe prber dtver

Rl Paper WWickh 1 24 Al (1117 Gemm) b

Fsl Paper Wisth 2 44 in Al (1117 6] L
Lindate: Madis infomation Acogunting Agguine Status Aot

. Click Acquire Status

When the confirmation message appears, click Yes.
Your computer gets the paper size information from the printer and displays the width of the roll
paper that is actually loaded in the printer.

32 Important

* When you replace the roll paper loaded in the printer, always click Acquire Status to obtain
the roll paper width information. If the roll paper width is not set correctly, you may not be able
to print the document as intended.

Open the printer driver setup window

Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.

Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that
was created with the application software.

For Paper Source, select Roll Paper (Auto)

Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

Set the other items

To rotate the document 90 degrees and print it, select the Rotate Page 90 degrees check box.
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11. Complete the setup

Click OK.
When you print, the paper source is switched automatically to roll paper.

32 Important

» This method switches the upper and lower levels depending on the paper size specified in the print
job. Always load the same media type for the roll papers in the upper and lower levels of the
printer.

If different types of paper are loaded, an error could occur and you may not be able to print the
document as intended.

If roll papers of the same width and type are loaded in the upper and lower levels and the
Automatically switch paper sources (paper size priority) check box is selected on the Device
Settings tab, Roll 1 (upper level roll paper) will always be used for printing. If roll papers of the
same width and type are loaded in the upper and lower levels and you want to automatically switch
the roll papers, clear the Automatically switch paper sources (paper size priority) check box.

»» Note

+ If Roll 1 and Roll 2 produce the same margins, Roll 1 is used for printing.
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How to Switch Paper Rolls

Here we will explain how, in certain situations, paper roll 1 and paper roll 2 are switched. Refer to this
information when necessary, for example, when documents will not print as expected, etc.

If you select Roll Paper (Auto) under Paper Source in the Page Setup tab, of the two paper rolls loaded in
the lower and upper trays of the printer, the one best suited for the print job will be automatically selected.

Whether paper roll 1 or paper roll 2 will be used, is determined through a sequence of judgment based on
the 7 conditions in the table below.

At such times, the Device settings -> Paper-related settings -> Detect paper setting mismatch in the
Printer unit's Control panel will switch to the result of the judgment based on the process described below.

« |If the Detect paper setting mismatch setting is set on Pause or Hold job

« If the Detect paper setting mismatch setting is Display warning or Do not detect

3% Important

« If the lower roll paper unit is not loaded or if the roll unit that was set as the take-up unit is loaded,
the roll paper cannot be switched automatically.

»» Note

« If Error or On hold are displayed, replace the paper to match the requirements of the print job.
* In order to minimize paper waste, it is recommended that you configure the control panel on the
Printer unit as indicated below.
* In Device settings -> Paper-related settings, set Roll paper auto switching to Identify size
* In Paper settings display area -> (Each paper type) -> Paper settings -> Advanced, set
Detect paper width to Enable

« If, on the Device Settings tab, a checkmark appears next to Automatically switch paper sources
(paper size priority), do not follow the table below.

If the Detect paper setting mismatch setting is set on Pause or Hold job

Condition Situation Judgment result

Select the paper
roll of sufficient
length

Only one of either paper roll 1 or
paper roll 2 is long enough

Neither paper roll 1 nor paper roll
2 are long enough

Error
Whether the paper roll loaded on the printer is

Condi-
tion 1

long enough to print the paper size specified for
the print job.

Both paper roll 1 and paper roll 2
are long enough

On the Printer's menu, Manage To Condition 2
remaining roll amount is set on
Disable (length of the paper roll
cannot be determined)

477



Whether the paper roll loaded on the printer

Only one of either paper roll 1 or
paper roll 2 matches the paper

type

Select the paper
roll matching the

paper type

Condi- matches the paper type specified for the print Neither roll 1 nor roll 2 match the
tion2 |. Error / On hold
job. paper type
Both paper roll 1 and paper roll 2
pap pap To Condition 3
match the paper type
Select the paper
It has changed to Do not identify | roll currently being
Condi- |!n the Printer menu, how has the Roll paper size fed into the platen
tion 3 |auto switching setting changed? *1
It has changed to Identify size To Condition 4
. Select the paper
Only one of either paper roll 1 or i
aper roll 2 is compatible with roll compatible
i ible wi
pap . P with borderless
borderless printing L
printing
Condi- |!f borderless printing has been indicated for the | Neither paper roll 1 nor paper roll
tion 4 | printjob (if it has not, on to condition 5) 2 are compatible with borderless | Error
printing
Both paper roll 1 and paper roll 2
are compatible with borderless To Condition 5
printing
Only one of either paper roll 1 or | Select the paper
paper roll 2 has the width speci- | roll of the match-
fied for the print job ing width
Neither paper roll 1 nor paper roll
Whether the width of the paper roll loaded on 2 have a width matching the one | Error / On hold
Condi- |the printer matches the paper width specified specified for the print job
tion 5 |for the print job (only when printing borderless
or enlarging/reducing) Both paper roll 1 and paper roll 2
have a width matching the one
specified for the print job To Condition 6
Paper roll width has not been
specified for the print job
. . . | Select the paper
The width of the paper size speci- . .
i . i ... | roll in which the
fied for the print job only fits within idth of the paper
; ; £ wi
Condi. Whether the width of the paper size specified | 6 width of paper roll 1 or paper | : Ff) p
for the print job fits within the width of the paper || 2 size fits comforta-
tion 6

roll loaded on the printer.
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The width of the paper size speci-
fied for the print job does not fit

Error




within the width of either paper
roll 1 or paper roll 2

The width of the paper size speci-
fied for the print job fits within the
width of both paper roll 1 and pa-
per roll 2

To Condition 7

Condi-
tion7

Is the width of paper roll 1 different from the
width of paper roll 2?

Roll width is different

Select the paper
roll whose width is
closer to the width
specified for the
print job

Roll width is the same

Select the paper
roll currently being
fed into the platen
*1

*1 In the following cases, neither roll 1 nor roll 2 are being fed onto the platen. In such cases, paper roll 1 is

selected.

* When the printer has switched to sleep mode and has returned to the initial position
* When the printer has been turned on
* When cut paper has been fed into the printer and has exited it

If the Detect paper setting mismatch setting is set on Display warning or Do not detect

Condition

Situation

Judgment result

Condi-
tion 1

Whether the paper roll loaded on the printer is
long enough to print the paper size specified for
the print job.

Only one of either paper roll 1 or
paper roll 2 is long enough

Select the paper
roll of sufficient
length

Neither paper roll 1 nor paper roll
2 are long enough

Error

Both paper roll 1 and paper roll 2
are long enough

On the Printer's menu, Manage

remaining roll amount is set on
Disable (length of the paper roll

cannot be determined)

To Condition 2

Condi-
tion 2

Whether the paper roll loaded on the printer
matches the paper type specified for the print
job.
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Only one of either paper roll 1 or
paper roll 2 matches the paper

type

Select the paper
roll matching the

paper type

Neither roll 1 nor roll 2 match the
paper type

To Condition 3




Both paper roll 1 and paper roll 2
match the paper type

It has changed to Do not identify

Select the paper
roll currently being

Condi- |In the Printer menu, how has the Roll paper size fed into the platen
tion 3 |auto switching setting changed? *1
It has changed to Identify size To Condition 4
Select the paper
Only one of either paper roll 1 or p P
. . . roll compatible
paper roll 2 is compatible with .
o with borderless
borderless printing L
printing
Condi- |If borderless printing has been indicated for the | Neither paper roll 1 nor paper roll
tion 4 | print job (if it has not, on to condition 5) 2 are compatible with borderless | Error
printing
Both paper roll 1 and paper roll 2
are compatible with borderless To Condition 5
printing
Only one of either paper roll 1 or [ Select the paper
paper roll 2 has the width speci- | roll of the match-
fied for the print job ing width
Neither paper roll 1 nor paper roll
Whether the width of the paper roll loaded on 2 have a width matching the one
Condi- |the printer matches the paper width specified specified for the print job
tion 5 |for the print job (only when printing borderless
i i Both paper roll 1 and paper roll 2
or enlarging/reducing) p p. . pap To Condition 6
have a width matching the one
specified for the print job
Paper roll width has not been
specified for the print job
Select the paper
The width of the paper size speci- . ) pap
) e ) ... |rollin which the
fied for the print job only fits within |
. width of the paper
the width of paper roll 1 or paper o
size fits comforta-
roll 2
bly
. Whether the width of the paper size specified The width of the paper size speci-
Condi- for the print job fits within the width of the paper | fied for the print job does not fit
tion 6

roll loaded on the printer.

within the width of either paper
roll 1 or paper roll 2

The width of the paper size speci-
fied for the print job fits within the
width of both paper roll 1 and pa-
per roll 2

To Condition 7
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Condi-
tion7

Is the width of paper roll 1 different from the
width of paper roll 2?

Roll width is different

Select the paper
roll whose width is
closer to the width
specified for the
print job

Roll width is the same

Select the paper
roll currently being
fed into the platen
*1

*1 In the following cases, neither roll 1 nor roll 2 are being fed onto the platen. In such cases, paper roll 1 is

selected.

* When the printer has switched to sleep mode and has returned to the initial position

* When the printer has been turned on
» When cut paper has been fed into the printer and has exited it
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Reflect Roll Unit Settings in the Printer Driver

Reflect printer unit's Roll Unit settings in the printer driver.

If the printer unit settings are reflected in the printer driver, the paper that can be set in the printer driver
settings will change to a status suitable to the printer unit status.

The following explains the procedure to reflect Roll Unit settings in the printer driver.

1. Select as described below:

* If you are using Windows 10, right-click the Start menu, and select Control Panel -> Hardware
and Sound -> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server 2012,
from the Desktop charms, select Settings -> Control Panel -> Hardware and Sound
(Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

« If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

+ If you are using Windows Vista or Windows Server 2008, select the Start menu -> Control
Panel -> Hardware and Sound -> Printers.

The Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties (in Windows 10, Windows 8.1,
Windows 8, or Windows 7) or Properties (in Windows Vista).
The printer's Properties window appears.

3. Click the Device Settings tab's Acquire Status

Once the dialog box is displayed, click Yes.
Printer unit settings will be reflected in the printer driver.

32 Important

* In the event the lower roll unit is not set or the roll unit is being used as a wrapping device, Roll Unit
will be unchecked. If the Roll Unit is unchecked, Automatically switch paper sources (paper size
priority) will be greyed out and cannot be selected. Also, the Paper Source items that can be
selected in the Page Setup tab will change.
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Printing Photos and Business Documents
» Printing By Setting Print Purpose

» Edit in PosterArtist and Print
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Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose

For Print Target, select the setting that matches the document.
+ Default Settings

Select this setting to print a general document such as an business documents.
* Photo (Color)

Select this setting to print a color illustration or a photo.
* Photo (Monochrome)

Select this setting to print an illustration or a photo in monochrome.
* Poster

Select this setting to print a poster.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

22 Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed to match the specified print purpose.
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Edit in PosterArtist and print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterArtist Lite.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist Lite and printing in a poster layout.

1. Open Printer Driver Settings Screen

2. Select edit in PosterArtist

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.
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> Note

» Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist Lite

Click OK.
When printing is executed, PosterArtist Lite starts up and PageCapture window opens.

4. Select page to get in PosterArtist Lite

5. Edit page in PosterArtist Lite

Image editing and sorting is implemented in PosterArtist Lite.

By repeating steps 1 through 4 without closing the PosterArtist Lite window, documents made in
multiple application software can be arranged on one page.

After editing is complete, please print from PosterArtist Lite menu.
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»» Note

» For instructions on how to edit and rearrange images, refer to the PosterAtrtist Lite manual.
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Changing the Print Quality and Correcting Image Data
» Adjusting Color Balance
» Setting the Print Quality Level (Custom)
» Printing a Color Document in Monochrome
» Adjusting Tone
» Specifying Color Correction
» Adjusting Brightness
» Adjusting Contrast

» Printing Using Detailed Setting Mode
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Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window

2. Select the Advanced Settings

Select Advanced Settings from the pull-down menu on the Main tab.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.
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4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red

becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.

When you execute print, the document is printed with the adjusted color balance.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select the print quality

For Print Quality, select Custom.
The Custom dialog box opens.
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4. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.
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3% Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Monochrome or Monochrome (Photo).

»» Note

» Depending on the media type selected for Media Type on the Main tab, either Monochrome or
Monochrome (Photo) appears.

4. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.
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3% Important

* When Monochrome or Black and White Photo Print are selected, the printer driver processes image
data as sRGB data. In this case, actual colors printed may differ from those in the original image data.

When using the grayscale printing function to print Adobe RGB data, convert the data to SRGB data
using an application software.

»» Note

+ With Monochrome or Black and White Photo Print inks other than black ink may be used as well.

Related Topic

= Adjusting Tone
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Adjusting Tone

When printing black and white photos, you can produce the cooling effects of cool colors and the warming
effects of warm colors.

Cool Tone is selected  Black and White is selected Warm Tone is selected

The procedure for adjusting tone is as follows:

1. Open the printer driver setup window

2. Selecting Media Type from the Main tab.
For paper for which the black and white tone can be adjusted, select the paper you want to
use from "Paper Information List" and check the information.

3. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

5. Adjusting monochrome tones
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From the Tone pull-down menu on the Gray Adjustment tab, specify any of the following items.
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Cool Tone

This item adjusts color tones to cool shades of gray (cool black). When you select this item, a value
of -30 is entered for X, and a value of O for Y.

Black and White
This item adjusts color tones to neutral shades of gray. When you select this item, a value of 0 is

entered for X, and a value of O for Y.

Warm Tone
This item adjusts color tones to warm shades of gray (warm black). When you select this item, a

value of 30 is entered for X, and a value of O for Y.

Custom
You can adjust the color tones by using the horizontal and vertical sliders while checking the colors

in the center adjustment area.

Adjust the horizontal and vertical sliders by dragging them to the left/right or up/down, respectively.
You can also adjust color tones by clicking or dragging the center adjustment area with the mouse.
You can also directly enter values that are linked to the sliders. When you enter values, set values in
the range of -100 to 100 for X, and -50 to 50 for Y.

»» Note

» Custom cannot be selected since it is displayed automatically when the adjustment value is
directly entered.

X, Y (Monochromatic adjustment value)
If necessary, you can adjust monochromatic colors manually.
To adjust the color tones, either enter values directly or click the up/down arrows.
You can also adjust the color tones by clicking or dragging the adjustment area with the mouse.
The value is also linked to the horizontal and vertical sliders.
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When you enter values, set values in the range of -100 to 100 for X, and -50 to 50 for Y.
The selected value will be shown in the preview on the left side.

After adjusting the tones, click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the color document is converted to grayscale data with adjusted tones. It allows
you to print the color document in monochrome.

Related Topics

= Printing a Color Document in Monochrome
= Adjusting Brightness
= Adjusting Contrast
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select None.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.

== Canon Printireg Freferences *

Mer  Page Sehup  Leyoul  Favodlies  Lbdey

Meda Type : | Flan Pager |
_1* Get Iriprrragion apecty
: I Advanced Semrge -

Pk Qraity Sandard -

Letier (B 5%11%) (Calor Miods Cober e
BHex 11 0

& Achusl S Sl

Leter (B 55115
E¥mx 1100 e

) Thickosn Fine Lines

[ Frevusy befove partng
Seatery Mondeg o Die{its

ok ]| comd || oo o

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Color Settings x
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Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose this
mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

»» Note

* You cannot use ICM when using an XPS printer driver.

None
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

22 Important

* When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.
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Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles

= |nterpreting the ICC Profile
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

»>» Note

* Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a
format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver
This section describes the procedure for printing data by using the color correction function of the

printer driver.
Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.

Related Topic

= |nterpreting the ICC Profile
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Adjusting Colors with the Printer Driver

To use driver matching when printing, turn on the printer driver's color correction function. Driver matching
accurately applies the characteristics of data displayed on the monitor and allows you to obtain print results
of impressions that are close to those displayed on the monitor.

32 Important

» When printing using driver matching, Canon recommends that you set the monitor and the environment
light as follows:

» Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

» Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

»>» Note

* When printing from an application software that can identify ICC profiles and allows you to specify them,
use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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5. Select the rendering intent
Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces a tint close to the display of the monitor. Select this when you wish to print a photo.

Saturation (Poster)
Reproduces a tint that people feel to be pleasing. Select this when you wish to print a poster or

business document.

6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

= Setting the Print Quality Level (Custom)
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= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself or one for special Canon paper, be
sure to select color management items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.

== Cancn Printineg Pred erences s

Mo Page Sshp  Layout  Favodes  Lbey

Media Tipe : | Flan Peper -]
L Gt bdgraeen Sty
I R — - I
Port Qs Stendard -

Leter (B 5117} Codor Moda Coder e
50 o 11 00 i

& achul Sze Colar Spttnge

Letier (B 5%117)
BXmx 11 MR

] Theckoen Fine Lines:

[ Erewey befere pring

St Mandeg el Dl muits

ok ][ coned fpoly Heo

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select None for Color Correction.
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Color Settings
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5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.
6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print

When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select ICC Profile Matching for Color Correction.
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5. Select For Input Profile

Select the input profile you want to use.
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32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

6. Select the printer profile

Select Printer Profile as follows:
* To set the printer profile automatically:

Select Auto Settings.
+ To set the printer profile manually:

Select a printer profile that matches the media type to be used.

7. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.
* Perceptual

Reproduces a tint close to the display of the monitor. Select this when you wish to print a photo.

3% Important

* When you select Perceptual to print images, Canon recommends that you set the monitor
and the environment light as follows:

* Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

* Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color
rendering properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

« Saturation

Reproduces a tint that people feel to be pleasing. Select this when you wish to print a poster or
business document.
* Relative Colorimetric

When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

* Absolute Colorimetric

When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

3% Important

» Depending on the media type, you may obtain the same print results even when you change
the Rendering Intent setting.
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8. Set the other items

If necessary, click Color Adjustment tab, and adjust Cyan, Magenta, Yellow, Brightness, and
Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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Interpreting the ICC Profile
When specifying an ICC profile for this printer, specify an ICC profile according to the print output media.

The ICC profiles installed for this printer appear as follows.

Canon XXXXX Photo Paper Plus Glossy T
(1 (@

* (1) : Printer model
* (2) : Media type
For the names of compatible paper, check the information for the paper you want to use from "Paper

Information List."

»>» Note

» For ICC profiles that display "-P" at the end of the media type, the print results are the same when you
set Rendering Intent to Perceptual or Relative Colorimetric.
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Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Adjust brightness

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Contrast
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Adjusting Contrast

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings... dialog box appears.

4. Adjust the contrast

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
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Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions
Set the following items as necessary.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
Prints thin lines thicker for easy viewing.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was

created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source
For Paper Source, select the setting that matches your purpose.

32 Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup
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Click OK.
When you print, the document is printed with the print conditions you set.

Related Topics

= Adjusting Color Balance

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

3. Select the paper source

For Paper Source, select the setting that matches your purpose.

3% Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

4. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing

Check the Enlarged/Reduced Printing check box.
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6. Set one of scaling methods described below

From the items listed below, select the setting that matches your purpose and select the corresponding
check box.
The current settings are displayed in the settings preview on the left side of the window.
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» Fit Paper Size

— o ] TTE

Scales the document to match the paper size.
* Fit Roll Paper Width

| A

L

i
| S \|
\ L

Scales the document to match the roll paper width.
» Scaling

80%

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.

The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup
Click OK.

When you execute print, the document will be printed with the specified scale.

32 Important

* When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in the
printer driver.

« If you are performing enlarged/reduced printing when Automatically switch paper sources (paper
size priority) is enabled, Fit Roll Paper Width is selected for Enlarged/Reduced Printing on the

520



Page Setup tab, and Roll Paper (Auto) is selected for Paper Source, Roll 1 (upper level roll paper) is
always used for printing.

»» Note

+ Selecting Enlarged/Reduced Printing changes the printable area of the document.
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Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after

printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...
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The Paper Size Options dialog box opens.

4. Select oversize

Select the Oversize check box, and click OK.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

3% Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.
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6. Select roll paper width
If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed using oversize.

3% Important

* When printing to oversized paper sizes, use paper that has the following necessary margins added to
the document size.
» Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
* Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

> Note

» An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.

» To set an oversized paper size for a non-standard paper size, register the paper size in the Paper
Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.
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Setting Paper Dimensions (Custom Size)
You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:
Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab
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The Paper Size Options dialog box opens.

3. Set user-defined paper

Set Custom Paper Size Name, Units, and Size, and then click Add.
For Size, specify an size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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»» Note

» By selecting the Borderless Printing Size check box for Size, you can select a size from the
paper sizes that support Borderless Printing. By selecting the Fix the Ratio of the Width to
Height check box, you can change the size while keeping the Width and Height ratio.

4. Set user-defined paper

Click OK, then it returns to Page Setup tab.
The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of
Page Size and can be selected at any time.

Setting from Custom Size

1. Open the printer driver setup window

2. Select the paper size

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.
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The Custom Size Settings dialog box opens.
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3. Set the custom paper size
Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

32 Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver

to set the values.
 Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Paper Sizes."
» Any paper size that was set by using Custom Size can no longer be used after the application software

is closed.
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»» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can still print but you may not be able

to obtain correct print results.
* The maximum configurable size with Custom Size is 3.2m.
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Prints without Edges Based on the Scenarios
» Printing without Margins to Match Paper Size
* Printing without Margins to Match Roll Paper Width

» Printing Full-Size without Margins

529



Printing without Margins to Match Paper Size

Procedure for printing borderless (without white margins around the edges) by enlarging/reducing
documents to match paper size.

1. In the printer driver, open the settings screen

2. Select a feeding method

In Paper Source, choose the best option for your purposes between Roll Paper (Auto), Roll 1 and Roll
2.

2 Important

» The feeding methods you can choose from vary depending on paper and lower tray (paper roll 2)
settings, or on roll unit option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Width, select the same paper width as that of the
paper roll loaded in the printer and click OK.

5. Determine by how much you want the image to exceed the size of the paper

Adjust Amount of Extension as needed.

When clicking on Borderless Setting, the Borderless Setting dialog box will appear.

Dragging the slide bar to the right will increase overflow, while dragging it to the left will reduce it.
The second position from the right is recommended for most cases.

2% Important

« If the Amount of Extension slide bar is set to the far right position, the back of the paper may
come out stained.

6. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Fit Paper Size option.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

7. Complete the setting process

Click OK.
If you print now, the document will be printed without margins to fit the paper size.

32 Important

+ If you choose a paper size not compatible with borderless printing, it will be replaced with a size
compatible with whole-surface borderless printing.

« If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
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» Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

* When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Auto Cut... list. When you do so, the document will be printed
without the left and right margins. After the printed material has exited the printer and has been cut, cut
the upper and lower edges with a pair of scissors.

* When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

« If you print borderless while Automatically switch paper sources (paper size priority) is on, in the
Page Setup tab, under Borderless Printing Method, you will only be able to select Scale to fit Roll
Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray) will be normally used for
printing. If the size, or the type, of the paper set in roll 1 is not compatible with borderless printing, you
will not be able to print borderless.

« If the following paper is selected for Roll Width, margins may be formed on the left and right of the
document even when borderless printing is set.

+ A2/A3 Roll (420.0mm)
* 16 in Roll (406.4mm)

+ A3+ Roll (329.0mm)

+ 300mm Roll (300.0mm)
» A3/A4 Roll (297.0mm)
* B4 Roll (257.0mm)

» 8in Roll (203.2mm)

Also, stains may appear on the back of the paper.

»>» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing without Margins to Match Roll Paper Width

Procedure for printing borderless (without white margins around the edges) by enlarging/reducing
documents to match roll paper width.

1. In the printer driver, open the settings screen

2. Select a feeding method

In Paper Source, choose the best option for your purposes between Roll Paper (Auto), Roll 1 and Roll
2.

2% Important

» The feeding methods you can choose from vary depending on paper and lower tray (paper roll 2)
settings, or on roll unit option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Width, select the same paper width as that of the
paper roll loaded in the printer and click OK.

5. Determine by how much you want the image to exceed the size of the paper

Adjust Amount of Extension as needed.

When clicking on Borderless Setting, the Borderless Setting dialog box will appear.

Dragging the slide bar to the right will increase overflow, while dragging it to the left will reduce it.
The second position from the right is recommended for most cases.

2% Important

« If the Amount of Extension slide bar is set to the far right position, the back of the paper may
come out stained.

6. Select a method for printing borderless

Place a checkmark next to Scale to fit Roll Paper Width in Borderless Printing Method.

7. Complete the setting process

Click OK.
Job will print to the entire roll width without a white border.

32 Important

+ If you choose a paper size not compatible with borderless printing, it will be replaced with a size
compatible with whole-surface borderless printing.

« If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.

» Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.
When this happens, crop the image with the application software to match paper size.
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* When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Auto Cut... list. When you do so, the document will be printed
without the left and right margins. After the printed material has exited the printer and has been cut, cut
the upper and lower edges with a pair of scissors.

* When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

« If you print borderless while Automatically switch paper sources (paper size priority) is on, in the
Page Setup tab, under Borderless Printing Method, you will only be able to select Scale to fit Roll
Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray) will be normally used for
printing. If the size, or the type, of the paper set in roll 1 is not compatible with borderless printing, you
will not be able to print borderless.

+ If the following paper is selected for Roll Width, margins may be formed on the left and right of the
document even when borderless printing is set.

+ A2/A3 Roll (420.0mm)
* 16 in Roll (406.4mm)

* A3+ Roll (329.0mm)

* 300mm Roll (300.0mm)
+ A3/A4 Roll (297.0mm)
* B4 Roll (257.0mm)

* 8in Roll (203.2mm)

Also, stains may appear on the back of the paper.

»» Note

* When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing Full-Size without Margins
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Procedure for printing borderless (without white margins around the edges) images in the same size as the
original document without enlarging/reducing themRecommended if you prize quality.

. In the printer driver, open the settings screen

. Select a feeding method

In Paper Source, choose the best option for your purposes between Roll Paper (Auto), Roll 1 and Roll
2.

2% Important

» The feeding methods you can choose from vary depending on paper and lower tray (paper roll 2)
settings, or on roll unit option settings.

. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Width.

. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Width, select the same paper width as that of the
paper roll loaded in the printer and click OK.

5. Determine by how much you want the image to exceed the size of the paper
Adjust Amount of Extension as needed.
When clicking on Borderless Setting, the Borderless Setting dialog box will appear.
Dragging the slide bar to the right will increase overflow, while dragging it to the left will reduce it.
The second position from the right is recommended for most cases.
2% Important
« If the Amount of Extension slide bar is set to the far right position, the back of the paper may
come out stained.
6. Select a method for printing borderless
Place a checkmark next to Print Image with Actual Size in Borderless Printing Method.
7. Complete the setting process
Click OK.
Job will print to original size without white border.
3% Important
 Create the source document with a size 3mm larger on each of the top, bottom, left and right
sides from the size of the paper you wish to print.
22 Important

If you choose a paper size not compatible with borderless printing, it will be replaced with a size
compatible with whole-surface borderless printing.

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Auto Cut... list. When you do so, the document will be printed
without the left and right margins. After the printed material has exited the printer and has been cut, cut
the upper and lower edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you print borderless while Automatically switch paper sources (paper size priority) is on, in the
Page Setup tab, under Borderless Printing Method, you will only be able to select Scale to fit Roll
Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray) will be normally used for
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printing. If the size, or the type, of the paper set in roll 1 is not compatible with borderless printing, you
will not be able to print borderless.
« If the following paper is selected for Roll Width, margins may be formed on the left and right of the
document even when borderless printing is set.
» A2/A3 Roll (420.0mm)
* 16 in Roll (406.4mm)
A3+ Roll (329.0mm)
* 300mm Roll (300.0mm)
» A3/A4 Roll (297.0mm)
* B4 Roll (257.0mm)
» 8in Roll (203.2mm)

Also, stains may appear on the back of the paper.

»>» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Changing the Clear Coating Settings

When you execute clear coating, the printer applies chroma optimizer (CO) ink onto the printing surface and
allows you to adjust the glossiness.

f

document Clear Coating print result

This section explains procedures for changing the clear coating settings.

1. Open the printer driver setup window

2. Select Advanced Settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Set clear coating area
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Click the Clear Coating tab, select the Clear Coating Area item that matches your purpose (see below
for the selections), and then click OK.

Color Settings =
Cobor Acsimentt Matching  Tear Cosling
Clear Coting Aea Ao o
Defauiks
.

Auto
The printer automatically sets the areas to be clear-coated and whether clear coating is to be
executed.
It may be possible to reduce the ink consumption of the chroma optimizer (CO) or to accelerate the
print speed.

Overall
The printer clear-coats the entire print area.
If selecting Auto produced unsatisfactory clear coating effects, selecting Overall may improve the
results.

2» Important

» Depending on the type of paper selected from Media Type on the Main tab, you may not be able
to select Overall tab.
For paper for which Overall can be used, select the paper you want to use from "Paper
Information List" and check the information.

+ If Overall is selected and the media type is changed to one that cannot use Overall, the clear
coating area setting is changed to Auto.

5. Complete the setup

Click OK on the Main tab.
When printing is executed, the clear coating effect that was set is added when the document is printed.
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Printing Hanging and Horizontal Banners (Large-Format Printing)

A drapery or banner up to 18.0m can be made by enlarging or reducing original documents made on
application software.

However, there are cases in which an 18.0 meter banner cannot be printed because the application software
used has limits on the document size that can be set.

The procedure for printing hanging and horizontal banners is as follows:
Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

Select the same original paper size created in the application soft in the Page Setup tab's Page Size.
In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width

Select the equivalent to the paper width of the roll set in the printer under Roll Width.

5. Set Enlarged/Reduced Printing

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in
the printer.
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6. Complete the setup

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

»» Note

» Please set user-defined paper 2 to the same aspect ration as user-defined paper 1. If the

aspect ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.
For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.
(when setting length to 1/6 the user-defined paper)

 User-defined paper 1: Width600mm, Height3,000mm

» User-defined paper 2: Width100mm, Height500mm

2. Create original document in application software

Use registered user-defined paper 2 to create original document in application software.

3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in Page Setup tab's Page Size.

5. Complete the setup

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

»» Note

» Maximum printable length is 18.0m. In the event the enlarged length exceeds 18.0m, the part of the
image exceeding the length will not be printed.

« If printing cannot be performed correctly, you may be able to improve printing by using Special
Settings on the Layout tab to change FineZoom Settings to Yes.
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Printing by Dividing/Joining Documents
*» Lining Up and Printing Multiple Documents
» Printing by Connecting Multiple Pages
» Printing Multiple Pages All on One Page

» Dividing and Printing Posters
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Lining Up and Printing Multiple Documents

You can line up multiple documents that were created separately and print them together on one page.
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The procedure for lining up and printing multiple documents is as follows:

1. Open the printer driver setup window

2. Select Free Layout

On the Layout tab, select the Page Layout check box, and then from the pull-down menu, select Free

Layout.
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3. Complete the setup

Click OK.
When you print, Canon imagePROGRAF Free Layout starts. Canon imagePROGRAF Free Layout
allows you to edit and rearrange images.

»» Note

 To lay out multiple application software documents onto one page, repeat steps 1 to 3 without
closing the Canon imagePROGRAF Free Layout window.
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Printing by Connecting Multiple Pages

You can eliminate the blank spaces between pages in a document that extends over multiple pages and
print the document as one continuous document.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.
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32 Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

3. Set roll paper options

Click Roll Paper Options to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.
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4. Complete the setup
Click OK on the Page Setup tab.

When you print, the document is printed with the print conditions you set.
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Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of pages to be printed per sheet

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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» Note

» 8 Pages/Sheet cannot be used when the XPS printer driver is used.

4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.
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Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

5. Complete the setup

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.
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2% Important

» When there is a checkmark attached to Banner Printing on the Page Setup tab, Page Layout is
grayed out and cannot be set.
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Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like

a poster.

="

The procedure for dividing and printing posters is as follows:
Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of divisions
On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1

x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.
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4. Complete the setup

Click OK on the Page Setup

When you execute print, the document will be divided into several pages during printing.

3% Important

tab.

* When there is a checkmark attached to Banner Printing on the Page Setup tab, Page Layout

is grayed out and cannot be set.

Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the

procedure below:

1. Display Pages to Print dialog box

For Page Layout, click Set to display the Pages to Print dialog box.

. Set print range

Clear the check boxes of the pages you do not want to print.

In the setting view, the pages that you cleared are deleted and only the pages to be printed are

displayed.

Check the pages to be printed, and then click OK.
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»» Note

* In the setting view on the left side of the Pages to Print dialog box, you can also clear the
display by clicking the pages you do not want to print.
To redisplay a cleared page, click that page again.

+ To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.
When you print, only the specified pages are printed.

32 Important

« If you partition and print as a poster, the source document will be printed in enlarged form, so the
print results may become rough.
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Printing Document in Center of Paper

When you want to position the source document in the middle of the cut paper and print, or print with even
margins on the right and left in relation to the width of the roll paper, use the Print Centered function.

The print results when setting with Print Centered are as follows. Normally, if Print Centered is set when
printed as in (A), it will be printed as in (B) for cut paper and (C) for roll paper.
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* When setting the magnification using Scaling from Enlarged/Reduced Printing on the Page Setup
tab and printing, the start point for enlarge/reduce will always be fixed based on the top left corner of
that page. For that reason, for reduced printing, the bottom and right margins of the paper will increase.
At this time, if you place a checkmark next to Print Centered on the Layout tab, the top, bottom, left
and right margins can all be printed evenly.

The procedure for printing in the center of the paper is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the paper size

Select the size of the paper you want to print from Page Size on the Page Setup tab.
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4. Set magnification as necessary

Where necessary, attach a checkmark next to Enlarged/Reduced Printing, and set according to the

objective.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

32 Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

6. Select roll paper width
If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper

loaded in the printer.

7. Print document in the center of paper

Select the Print Centered check box on the Layout tab.
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8. Complete the setup

Click OK.
When you print, the document is printed in the center of the paper.
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Printing by Saving Roll Paper
» Saving Roll Paper by Rotating Document 90 Degrees

» Saving Roll Paper by Eliminating Upper and Lower Margins on Document
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Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

4. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.

3% Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

5. Selecting Paper Saving

Select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.
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7. Complete the setup

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

22 Important

* When there is a checkmark attached to Banner Printing on the Page Setup tab, Rotate Page 90
degrees is grayed out and cannot be set.
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* When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in
the vertical direction is longer than the width selected in Roll Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.
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Saving Roll Paper by Eliminating Upper and Lower Margins on
Document

When printing on roll paper, you can save paper by eliminating the upper and lower margins when printing.

The procedure for saving paper by eliminating the upper and lower margins is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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4. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.

3% Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

5. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

6. Selecting Paper Saving

On the Layout tab, select the No Spaces at Top or Bottom check box.
The current settings are displayed in the settings preview on the left side of the window.
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7. Complete the setup

Click OK.
When you print, the upper and lower margins are eliminated so that you can save paper.
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Switching the Paper Source to Match the Purpose

This printer has three paper sources: Roll 1, Roll 2, and Cut Sheet.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.

3. Select the paper source

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.
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Roll Paper (Auto)
Feeds paper by automatically switching between Roll 1 and Roll 2 according to the print job.

Roll 1
Feeds paper from Roll 1.

Roll 2
Feeds paper from Roll 2.

Cut Sheet
Feeds paper using the cut paper.

32 Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

4. Complete the setup
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Click OK.
When you execute print, the printer uses the specified paper source to print the data.

»» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer,
an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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Displaying the Print Results before Printing

You cannot use this function if you are using the XPS printer driver.

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup

Click OK.
When you execute print, theCanon imagePROGRAF Preview opens and displays the print results.

Related Topic
= Canon imagePROGRAF Preview
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Other Convenient Settings
» Stamp Printing
» Setting a Page Size and Orientation
» Registering a Frequently Used Printing Profile

» Cutting Roll Paper after Printing
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Stamp Printing

This feature may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name.
"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.
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3. Complete the setup

Click OK.
When you execute print, the data is printed with the specified stamp.
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:
Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
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The Define Stamp dialog box opens.
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3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.

In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.

Change the Font, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.

Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed

From Watermark List, select the title of the stamp you want to change the settings for.

3. Configure each setting while viewing the preview

4. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

»» Note

» The stamp registered as the default setting cannot be changed.

Deleting an Unnecessary Stamp

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted

Select the title that you wish to delete from the Watermark List and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup
Click OK to return to the Layout tab.
2> Note

» The stamp registered as the default setting cannot be deleted.
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you
want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:
Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box

On the Favorites tab, click Add....
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4. Register favorite setting
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then

click OK.
The name and the icon appear in the Favorites list.
To check the settings of the registered favorite, click Settings Details.

»» Note

+ To save the settings of the favorite to a file, click Export... on the Favorites tab.

Printing Using Favorite Settings

1. Open the printer driver setup window

2. Apply favorite

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup

Click OK.
When you print, the document is printed with the settings of the registered favorite.

Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

»>» Note

« Printing profiles that are registered in the initial settings cannot be deleted.

» The settings of the favorite being applied to the current print settings cannot be deleted. To delete
that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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Cutting Roll Paper after Printing

The procedure for cutting roll paper automatically and printing cut guidelines is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.
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2» Important

» The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or
roll unit option settings.

3. Display Roll Paper Options dialog box

Click Roll Paper Options to display the Roll Paper Options dialog box.
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4. Set auto cut

From Automatic Cutting, select the item that matches your purpose.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

* Yes

The roll paper is cut automatically after printing.
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* No

The roll paper is not cut after printing.
* Print Cut Guideline

Cut guidelines are printed for cutting the roll paper manually after printing.

»» Note

» The default setting for automatic cutting is Yes.

After completing the setting, click OK to return to the Page Setup tab.

5. Complete the setup

Click OK on the Page Setup tab.
When you print, the roll paper is cut automatically after printing or cut guidelines are printed.
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Printing from Computer (Mac OS)

» Printing with Easy Setup

Changing the Type of Paper

» Setting the Number of Copies and Printing Order

*» Using Roll Unit to Use 2-Level Rolls

About 2-Level Roll Switching

Setting the Paper Rolls in the Printer According to the Intended Use

Printing by Automatically Switching Upper-level and Lower-level Roll Papers
How to Switch Paper Rolls

Reflect Roll Unit Settings in the Printer Driver

» Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)
Printing a Color Document in Monochrome
Adjusting Tone

Specifying Color Correction

Adjusting Brightness

Adjusting Contrast

» Scaled Printing

» Printing to Oversized Paper Sizes

» Setting Paper Dimensions (Custom Size)

» Print Area

» Prints without Edges Based on the Scenarios

Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins

» Changing the Clear Coating Settings

» Printing Hanging and Horizontal Banners (Large-Format Printing)
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Printing by Dividing/Joining Documents
@ Lining Up and Printing Multiple Documents
@ Printing by Connecting Multiple Pages
@ Printing Multiple Pages All on One Page
Printing Document in Center of Paper
Printing by Saving Roll Paper
@ Saving Roll Paper by Rotating Document 90 Degrees
« Saving Roll Paper by Eliminating Upper and Lower Margins on Document
Switching the Paper Source to Match the Purpose

Cutting Roll Paper after Printing
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Printing from Printer

» Printing from USB Flash Drive
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Printing from USB Flash Drive
» Printing Data Saved on USB Flash Drive

» Setting Items for Printing Using Operation Panel
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Printing Data Saved on USB Flash Drive

You can print photo data (JPEG file) or document data (PDF file) saved on the USB flash drive easily.
3> Note

* Restrictions on printable PDF/JPEG files
* PDF file:
Files which conforms to V 1.7
-Does not support overprint or some of transparent processing.

-Font embedding is recommended. If a font is not embedded, it is replaced with one of the built-in
fonts below.

Times-Roman, Helvetica, Courier, Symbol, Times-Bold, Helvetica-Bold, Courier-Bold, ZapfDingbats,
Times-lItalic, Helvetica-Oblique, Courier-Oblique, Times-Boldltalic, Helvetica-BoldOblique, Courier-
BoldOblique

+ JPEG file:
Files which conforms to JFIF 1.02
Supports the files with the following conditions.
-Processing method: Basic DCT
-Color mode: RGB/GrayScale
-Number of colors: 24bit/8bit
-Number of pixels: 19200 or less vertically and horizontally

Does not support some samplings

1. Make sure printer is turned on.

2. Load paper.

= |oading Rolls on the Roll Holder
= | oading the Upper Roll on the Printer
= | oading Sheets in the Printer

3. Insert USB flash drive into USB flash drive port.

H -2
4. Flick HOME screen and tap . Print from USB flash drive.

= Menu Operations

> Note

* When the message informing you that the operation restriction is enabled, ask the administrator of
the printer you are using.

« If no printable data is saved on the USB flash drive, There are no files that can be printed. is
displayed on the touch screen.
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5. Tap folder or data to print on displayed screen.

Tapping a folder displays the data list. Tap the data to print.
2> Note

* If no printable data is saved on the folder you tapped, There are no files that can be printed. is
displayed on the touch screen.

The screen below appears.

A
| 1‘|— ;
AUT 0001.0PG
[ Settings . Start print
c

A. Number of copies

Tap to display the screen below and specify the number of copies.

AUT_0D

B. Preview

Tap to preview an image of the printout on the preview screen.
C. Settings

Tap to display the Settings screen.

You can change the print settings.
Print settings
Color Color
Print glty High
Paper src Auto select

Patatn N dAefrppe

Apply

For more on the setting items:
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= Setting ltems for Printing Using Operation Panel

6. Tap Start print.
The printer starts printing.
2> Note

» Tapping Yes on the displayed screen returns to step 5. Tap a folder or data to print.

» Tapping No returns to HOME screen.
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Setting Items for Printing Using Operation Panel

You can specify the print settings to print data saved on the USB flash drive.

Print settings Print settings

Color Color FIIL Qily ngn

Print glty High 2 Paper src Auto select

Paper src Auto select ks Rotate 0 degrees 4

Potate N dearess Fit paper  ON

Apply [ ooy S

A
Flick vertically or tap . to display setting items and tap the setting item to display the settings.
Tap to specify the setting.

1.

Color

Select color or black and white printing.

. Print qglty (Print quality)

Select print quality according to the photo.

. Paper src (Paper source)

Select where to feed paper.

. Rotate

The image is printed rotated by 90 degrees if you select 90 degrees.

. Fit paper

Select whether to print to fit the loaded paper.

. Tap to specify the print settings.
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Printing from Smartphone/Tablet

For more on printing from a device via wireless LAN, refer to the device's or application's instruction manual.

» Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct
Connection)
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Connecting Smartphone/Tablet to Printer Directly via Wireless LAN
(Direct Connection)

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

» Wireless connection (connecting devices via a wireless router)
+ Direct wireless connection (connecting devices using direct connection)

This section describes direct connection, which allows you to print by connecting the devices to the printer
directly.

Follow the procedure below to use direct connection.

1. Enable direct connection.

2. Connect devices to printer.

This section also describes changing direct connection to wireless LAN.

= Changing Printer Setting to Use Wireless LAN

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

+ If a device has already been connected to the printer via wireless LAN and you want to add a device to
connect, connect it to the printer directly. You can connect up to 5 devices to the printer at the same
time.

» Check the usage restrictions and switch the printer to the direct connection.

= Restrictions

Preparing for Connection
Change settings below to prepare for direct connection.
* Printer's LAN settings

= Changing Printer Setting

» Settings of a device to connect

= Connecting Smartphone/Tablet to Printer

Changing Printer Setting

1. Make sure printer is turned on.

2. Flick HOME screen and tap LAN settings.

= Menu Operations

3. Tap Activate direct connect..

4. Tap Yes.
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The identifier (SSID) for direct connection appears.

The device detects the printer by the identifier (SSID).
»>» Note

* If you tap Details and tap Yes, the following items appear.

» Security setting
» Password
 Printer's name which appears on a Wi-Fi Direct compatible device

The password is required when connecting a device to the printer. Depending on the device
you are using, no password is required.

When you connect a Wi-Fi Direct compatible device to the printer, select the device name
displayed on the touch screen from your device.

» The identifier (SSID) and the security setting are specified automatically. To update them, see
below.

= Changing Direct Connection Setting

5. Tap OK.

The direct connection is enabled and a device can be connected to the printer wirelessly.

Connecting Smartphone/Tablet to Printer

1. Turn on wireless communication on your device.

Enable "Wi-Fi" on your device's "Setting" menu.

For more on turning on wireless communication, see your device's instruction manual.

2. Select "DIRECT-XXXX-PRO-2000" ("X" represents alphanumeric characters) from list
displayed on device.

»» Note

« If "DIRECT-XXXX-PRO-2000" does not appear on the list, direct connection is not enabled.

See Changing Printer Setting to enable direct connection.

3. Enter password.

Your device is connected to the printer.

»» Note

» Check the password for the direct connection.
Check by one of the following methods.
« Display on the touch screen.

= | AN settings

* Print the network settings.
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= Printing Network Settings

+ Depending on the device you are using, entering the password is required to connect a
device to the printer via wireless LAN. Enter the password specified for the printer.

« If your Wi-Fi Direct compatible device is set to prioritize using Wi-Fi Direct and it is connecting
to the printer, the printer displays a confirmation screen asking if you allow the device to
connect to the printer.

Make sure the name on the touch screen is the same as that of your wireless communication
device and tap Yes.

Changing Printer Setting to Use Wireless LAN

Follow the procedure below to change the printer setting to use wireless LAN.

1. Flick HOME screen and tap LAN settings.

= Menu Operations

2. Tap Change LAN.

3. Tap Activate wireless LAN.

If you do not use the printer over wireless LAN, select Activate wired LAN or Disable LAN.

Changing Direct Connection Setting

Change the settings for the direct connection following the procedure below.

1. Make sure printer is turned on.

2. Flick HOME screen and tap LAN settings.

= Menu Operations

3. Tap LAN settings.

4. Tap Other settings.

5. Tap Direct connection settings.

6. Change settings as necessary.
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Direct connection settings

Update SSID/password A
Direct connection device name B

Connection request confirmation c

» To update the identifier (SSID) and the password for direct connection

Tap A to display the confirmation screen. To update the identifier (SSID) and the password, tap
Yes.

To check the security setting and the updated password, tap Details and tap Yes on the screen
displayed next.

» To change the printer's name displayed on the Wi-Fi Direct compatible device
Tap B to display the printer's name (device name) displayed on a Wi-Fi Direct compatible device.
Follow the procedure below to change the name.
1. Tap touch screen.
2. Enter device name (up to 32 characters).
3. Tap OK to finish entering device name.
4. Tap OK to finish specifying device name.

 To change the confirmation screen setting when a Wi-Fi Direct compatible device is connecting
to the printer

Tap C to display the confirmation screen. If you want the printer to display the screen to inform
you a Wi-Fi direct compatible device is connecting to the printer, tap Yes.

3% Important

» To prevent an unauthorized access, we recommend you should not change the setting from
the default.

When you finished performing the settings, the printer returns to the Direct connection settings
screen.

7. Touch HOME button.
The HOME screen appears.
3> Note

* If you change the direct connection setting of the printer, also change the wireless router setting of
the device.
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Windows Software

» Printer Driver
@« Overview of the Printer Driver
@ Printer Driver Description
« Updating the Printer Driver

» Printing Using Canon Application Software
@« Preview Guide
@« Free Layout Guide
@ Print Plug-In for Office Guide
« Direct Print & Share Guide
@ Quick Utility Toolbox Guide
« Print Studio Pro Guide
« Digital Photo Printing Guide
« |J Network Device Setup Utility
@« Media Configuration Tool Guide
@« Device Management Console Guide

@« Accounting Manager Guide
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Printer Driver
» Overview of the Printer Driver
» Printer Driver Description

» Updating the Printer Driver
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Overview of the Printer Driver

>

>

Canon lJ Printer Driver

Changing the Print Options

Canon imagePROGRAF Preview

How to Open the Printer Driver Setup Window
Updating Media Information in Printer Driver
Setting Accounting information

Deleting the Undesired Print Job

Canon IJ Status Monitor

Checking the Ink Status from Your Computer

Instructions for Use (Printer Driver)
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Canon |IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific model
you are using.

Printer Driver Types

You can install the XPS printer driver in addition to the regular printer driver.
The XPS printer driver is suited to print from an application software that supports XPS printing.

32 Important

» To use the XPS printer driver, the standard printer driver must already be installed on your computer.

Installing the Printer Driver

 To install the regular printer driver, load the Setup CD-ROM that comes with the printer, and then
install the driver from Start Setup Again.

 To install the XPS printer driver, load the Setup CD-ROM that comes with the printer, and then select
XPS Driver from Add Software.

Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name) to specify the regular printer driver or select "XXX XPS"
(where "XXX" is your model name) to specify the XPS printer driver.

Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic

= How to Open the Printer Driver Setup Window
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab
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The Special Settings dialog box opens.
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»» Note

* When you use the XPS printer driver, the functions available to you are different.

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.
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The Layout tab is displayed again.
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Canon imagePROGRAF Preview

This feature may be unavailable when certain printer drivers or operating environments are used.

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.
Related Topic

= Displaying the Print Results before Printing
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

« If you are using Windows 10, right-click the Start menu, and select Control Panel -> Hardware
and Sound -> Devices and Printers.

* If you are using Windows 8.1 or Windows 8, from the Desktop charms, select Settings ->
Control Panel -> Hardware and Sound -> Devices and Printers.

* If you are using Windows 7, select the Start menu -> Devices and Printers.

« If you are using Windows Vista, select the Start menu -> Control Panel -> Hardware and

Sound -> Printers.

2. Right-click your model name icon, and then select Printing preferences from the

displayed menu
The printer driver setup window appears.

3% Important

* Opening the printer driver setup window through Printer properties (Windows 10, Windows
8.1, Windows 8, Windows 7) or Properties (Windows Vista) displays such tabs regarding the
Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening
through Printing preferences or application software. For tabs regarding Windows functions,
refer to the user's manual for the Windows.
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Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the
printer driver.

When the media information is updated, the media displayed for Media Type on the Main tab is updated to
the latest information.

The procedure for updating media information is described below.

1. Select as described below:

« If you are using Windows 10, right-click the Start menu, and select Control Panel -> Hardware
and Sound -> Devices and Printers.

The Devices and Printers window is displayed.

« If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server 2012,
from the Desktop charms, select Settings -> Control Panel -> Hardware and Sound
(Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

+ If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows Vista or Windows Server 2008, select the Start menu -> Control
Panel -> Hardware and Sound -> Printers.

The Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties (in Windows 10, Windows 8.1,
Windows 8, or Windows 7) or Properties (in Windows Vista).
The printer's Properties window appears.

3. Update media information

Click Update Media Information the Device Settings tab.

When a confirmation message appears, click Execute.

If the paper information on the driver cannot be updated, click Initial Check Items Items and check
the displayed information.

The printer driver media information will update.

32 Important

* |t may take some time to update the media information.

4. Finish updating media information

When a confirmation message appears, click OK.
The media information will be updated.

32 Important

* Restart the printer driver after updating media information.
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» Do not change media information on the printer while you are updating media information on
the driver.

22 Important

» Ensure that a user with administrative privileges carries out the media information update.
Users other than administrators can check if a media information update is required, but cannot carry
out the update itself.

* When you have added, deleted, or edited media using administrative tools (the Media Configuration
Tool) but have not updated the media information, issues may arise such as the inability to print.
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Setting Accounting information

By setting accounting information, you add IDs to print jobs, and use the printer and cost management tool
to tabulate print history information for any ID.

The procedure for setting accounting information is described below.

1. Select as described below:

« If you are using Windows 10, right-click the Start menu, and select Control Panel -> Hardware
and Sound -> Devices and Printers.

The Devices and Printers window is displayed.

« If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server 2012,
from the Desktop charms, select Settings -> Control Panel -> Hardware and Sound
(Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

The Devices and Printers window is displayed.

* If you are using Windows Vista or Windows Server 2008, select the Start menu -> Control
Panel -> Hardware and Sound -> Printers.

The Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties (in Windows 10, Windows 8.1,
Windows 8, or Windows 7) or Properties (in Windows Vista).
The printer's Properties window appears.

3. Click Accounting on the Device Settings tab
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The Accounting dialog box opens.
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4. If necessary, complete the following settings:

Account ID
Enter the account ID to be set. Enter the ID by using up to 20 alphanumeric characters (0 to 9, a
to z, and A to Z).

Prohibits Account ID changes
Prohibits changes to account IDs that have already been set.
Check this check box to prevent other users from changing IDs.

5. Apply the settings

Click OK.
The Device Settings tab is displayed again.
The settings are enabled hereafter.

»>» Note

» Accounting can be set only by users with Administrator rights.
Users without Administrator rights may not be able to set Accounting information.
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Deleting the Undesired Print Job

If you are using the XPS printer driver, replace "Canon |J Status Monitor" with "Canon IJ XPS Status
Monitor" when reading this information.

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window

2. Display the Canon IJ Status Monitor

Click Status Monitor... on the Main tab.
The Canon |J Status Monitor appears.

3. Display the print jobs

Click Display Send Queue.
The print queue window opens.

4. Delete the print jobs

Select the print jobs you want to delete, and select Cancel from the Document menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

22 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

Click the button of the status monitor displayed on the task bar. The Canon IJ Status Monitor appears.
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»>» Note

» To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click View Printer Status on the Page Setup tab.

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

When Errors Occur

If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor
displays an error information dialog box.
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In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Main tab, click Status Monitor....
The Canon |J Status Monitor opens.
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3. Display Estimated ink levels

For Estimated ink levels, click & (the disclosure triangle) to display an image representation of the ink
status.

> Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver

Before installing, log on to Windows as user with administrator rights.
Always check the following before installing the software.
1. Quit the application software while it is running.
2. If you are printing a document, abort printing or wait for it to finish.
3. Close all the printer driver's dialog boxes.

If you can set the number of copies with the application software, set them either with the printer
driver or the application software.

If you can configure enlarging/reducing settings with the application software, set the normal size
(100%) in the printer driver, and then configure the magnification factor with the application software.
Depending on the application software used, it may be possible to print collated copies; however,
please do not use this feature when configuring layout printing with the Page Layout option in the
Layout tab.

This may cause incorrect layout.

When printing enlarged/reduced documents, printed results may come out different due to a
discrepancy between the image data resolution and the enlarging/reducing ratio.

When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
Depending on the application software, lines drawn at almost horizontal angles may not print correctly.
If that should happen, re-draw the line horizontally and print one more time.

Immediately after installing (or updating) the printer driver, you might not be able to visualize new
features in some of the application software.

In all application software provided with printing features, choose Print from the File menu and, after
selecting the printer you are using, click the Properties button.

After the Properties dialog box has opened, immediately close it by clicking OK.

If characters strings specified as stamps have a large number of characters, or if the characters have
a large point size, you may not be able to print stamp strings.

If characters strings specified as stamps contain external characters after F040, you will not be able to
print the stamp strings.

If you update the model name of your printer through the General tab in the printer's Properties, the
Favorites settings registered in the printer driver will be disabled.

In such cases, save the Favorites settings as a file before changing the name of the printer and reload
the saved file after you have updated the printer's name.

Printing at high resolution requires a large amount of memory on your computer.

When your computer is low on memory or you are using a large number of application software, the
application software may not work correctly.

In such cases, re-start Windows and, before resuming printing, close all the applications you are not
using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab
to a lower resolution.

When using a local connection, if you do not see a check mark next to the Enable bidirectional
support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and
device information correctly.
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* If you are you are using your printer with a USB connection, refrain from using standby mode. You can
set standby mode through the Power Options on the Control Panel.
* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, in the Advanced tab in the printer's Properties, choose Spool print documents so
program finishes printing faster and place a check mark next to Start printing after last page is
spooled.
 Fine lines and gradients may not print correctly.
In such cases, choose Print from the File menu of application software and, after opening from there
the property dialog box of the printer driver, follow the procedure below and then run printing.
1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, in the Layout tab, click on Special Settings to open the Special
Settings dialog box and turn off Fast Graphic Process.

* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.

In such cases, you may be able to print by increasing the time set in Job timeout in the printer's
control panel.

» Depending on the application used, if you print using features like enlarging/reducing, layout printing,
page borders and so on, some of the data in the resulting printed document, for example graphics,
may differ from the source document.

« If you print very large images from your computer when it's running low on memory, you may not be
able to print correctly; for example, it may take a very long time to print or parts of the image may end
up missing.

In such cases, try printing after following the procedure indicated below.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings.
Turn off Fast Graphic Process.
o Increase your computer memory.
o Increase the virtual memory of your operating system.

* Do not change the Print Processor... settings in the Advanced tab in the printer Properties.
If you change them, you will not be able to use the following features correctly.
> The Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab
o The Canon imagePROGRAF Preview feature

* In the cases described below, you will not be able to use the Free Layout and the Edit Using
PosterArtist features of Page Layout in the Layout tab as well as the Canon imagePROGRAF
Preview feature.

> When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause
Printing, or when right-clicking on the printer icon and choosing Pause Printing

> When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use
Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline

o When printing during hours other than those set in Available from and To in the Advanced tab in
the printer's Properties

o When printing with the Enable advanced printing features turned off in the Advanced tab in the
printer's Properties

o When printing with Print directly to the printer enabled in the Advanced tab in printer's
Properties
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o When printing after the printing port in the Ports tab in the printer's Properties has changed to
FILE:
o When printing after choosing Output to file in the Print dialog box in the application software

« If you perform a point-and-print installation, you will not be able to use the Free Layout and the Edit
Using PosterArtist features of Page Layout in the Layout tab as well as the Canon
imagePROGRAF Preview feature.

« If you print after setting Free Layout and Edit Using PosterArtist, refrain from printing from other
drivers.

« If you combine specific Print Quality with large paper sizes, you may not be able to correctly print
stamps and borders.

* In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may
look differ from printed results. In such cases, try choosing the Layout tab, opening the Special
Settings dialog and turning on Preview Switching.

* If you are using a model supporting Automatically switch paper sources (paper size priority) in
the Device Settings tab, or if you have chosen Automatically switch paper sources (paper size
priority), you may not be able to get the desired printing results.

In such cases, uncheck Automatically switch paper sources (paper size priority).

Points to Note About Applications with Restrictions

« If, in Microsoft Excel, you tick Collate and then you print more than one copy, or if you do Entire
workbook after configuring different settings in each tab, you may not be able to perform layout
printing nor to get the intended printing results.

« If you try to print data on a very large-size paper through applications like Adobe lllustrator, you may
not be able to print.

In such cases, try printing after following the procedure indicated below.
o Open the Main tab and uncheck Preview before printing.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings.
Turn off Fast Graphic Process.
o Increase the virtual memory of your operating system.
o If you are using Adobe lllustrator, turn off/on Bitmap printing in the Print dialog box.

* In the cases described below, you will not be able to use the Free Layout and the Edit Using
PosterArtist features of Page Layout in the Layout tab.
o When printing from application software which do not allow EMF spooling, like Adobe Photoshop
LE, MS Photo Editor, Ace Draw and others.

* When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white
photographs.

* When printing data created with Microsoft Word using Enlarged/Reduced Printing or Borderless
Printing, you may not be able to print correctly.
In such cases, try printing after following the procedure indicated below.

o Open the printer folder from the start menu, right click on the printer icon and select Printing
preferences. Launch the application after setting, in the Page Setup tab, Page Size, Enlarged/
Reduced Printing and Borderless Printing.

o Open Microsoft Word's Page setup dialog box and close it by clicking OK.

o After configuring the printer driver, close momentarily the Print dialog box without printing. Then,
open the printer driver's set up screen once again, close it by clicking OK, and run printing.
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Printer Driver Description
» Main Tab Description
» Page Setup Tab Description
» Layout Tab Description
» Favorites Tab Description
» Maintenance Tab Description
» Device Settings Tab Description

» Canon IJ Status Monitor Description
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Main Tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Get Information...
Opens the Paper Information on Printer dialog box.
You can check the settings on the printer and apply the checked settings to the printer driver.

Specify...
Open the Paper Detailed Settings dialog box, and specify detailed print settings that match the media
type loaded in the printer.

Pull-down menu
Switches the Easy Settings and Advanced Settings.
Easy Settings
This mode allows you to print by using pre-registered print settings.
Print Target
Print settings that are generally used frequently are pre-registered as print purposes. By using
a print purpose to print, you can print by using settings that match the document.
Default Settings
Select this setting to print a general document such as an business documents.
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Photo (Color)
Select this when printing a color illustration or a photograph.

Photo (Monochrome)
Select this when printing an illustration or a photograph in monochrome.

Poster
Select this when printing a poster.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

32 Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

Highest
Prints with quality as the highest priority.

High
Gives priority to print quality over printing speed.
Standard

Prints with average speed and quality.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

View Settings
Opens the View Settings dialog box.

Advanced Settings
This mode allows you to print by specifying detailed settings that match your purpose.
Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

22 Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

Highest
Prints with quality as the highest priority.

High
Gives priority to print quality over printing speed.
Standard

Prints with average speed and quality. The resolution is set to 300dpi.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.
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Color Mode
Select the color to print.
Color

Prints with the number of colors in the document.

Monochrome

Prints a color document in monochrome.

Monochrome (Photo)

This mode is appropriate when printing an image such as a photo in monochrome.

Color Settings

Opens the Color Settings dialog box.

You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness, and
Contrast on the Color Adjustment tab, and select the Color Correction method on the

Matching tab.

You can also set clear coat settings on the Clear Coating tab.

Thicken Fine Lines

Prints thin lines thicker for easier viewing.

Preview before printing

You can start up the Canon imagePROGRAF Preview, and check what the printing results will be

before executing the print.

Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

About
Opens the About dialog box.

You can check information such as the version and copyright of the printer driver.

Defaults

Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory

settings).

Paper Detailed Settings dialog box

Drying Time

Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.

Between Pages

The wait time until outputting paper can be set after printing one page. Time is taken before
cutting roll paper to allow the ink to dry, so even when Automatic Cutting in the Roll Paper
Options of the Page Setup tab is set to Yes, page may be dropped into the basket with dried

ink.

Setting ltems

Content

Printer Default

Settings in printer unit control panel are applied.

None

Page will be output immediately after printing
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30sec. / 1min. / 3min. / 5min. / Page will be output after set amount of time has passed after
10min. / 30min. / 60min. printing.

Between Scans
The wait time until printing next line can be set after printing one line in page. Set in the event
smudging occurs in the page, unevenness occurs in borderless printing, etc., and you would like
to avoid this smudging and unevenness.

Setting ltems Content
Printer Default Settings in printer unit control panel are applied.
None Next line will be print immediately after first line is print.

Next line will be print after the set amount of time has passed after printing
one line.

1sec. / 3sec. / 5sec. /

7sec. / 9sec. . .
* If smudges and/or unevenness occur, please increase time.

Roll Paper Safety Margin
In order for heavily curling paper to absorb well in platen, length of margin established on edge of
paper can be selected.
Leading Edge Margin
Roll Leading Edge Margin length can be set.

Setting Items Content

Printer Default | Settings in printer unit control panel are applied.

3mm Will be print in standard size.
* Please select when there are no particular problems with printing.

Please select when rubbing of the print heads occurs, such as when heavily curling
paper is being used.

20mm

Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.

Setting ltems Content

Printer Default | Settings in printer unit control panel are applied.

Fast Select when cut is not smooth with Standard settings.

Standard Select when there are no particular problems with auto-cut.

If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and

Slow L L —_—
it will slow deterioration of the cutter's capabilities.
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Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Calibration Value
The results can be applied when printing in the event color calibration was set in printer unit. Please
select Use Value when applying calibration.

Mirror
Select whether to print reflected image or not. When box is checked and turned on, text and images
will be printed as if reflected in a mirror.

Custom dialog box

Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

22 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

»» Note

» The Highest, High, or Standard print quality modes are linked with the slider bar. Therefore
when the slider bar is moved, the corresponding quality and value are displayed on the left. This
is the same as when the corresponding radio button is selected for Print Quality on the Main
tab.

View Settings dialog box

Print Target
Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.

Details
Displays the settings of the print purpose that was selected for Print Target.

Color Settings dialog box
Color Adjustment Tab

This is displayed when Color is selected for Color Mode.
This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Tone, Brightness, and Contrast options.

»>» Note

* When Monochrome or Monochrome (Photo) is selected for Color Mode, the Color Adjustment
tab switches to the Gray Adjustment tab.
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Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

22 Important

* When Monochrome or Monochrome (Photo) is selected for Color Mode, the color balance
(Cyan, Magenta, and Yellow) cannot be set because the Color Adjustment tab switches to the
Gray Adjustment tab.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black. However,
the brightness of the colors between white and black can be changed. Colors become darker as you
drag the slider toward the right and brighter as you drag the slider toward the left. You can also
directly enter brightness values that are linked to the slider bar. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Gray Adjustment Tab

This is displayed when Monochrome is selected for Color Mode.
This tab allows you to adjust the color balance by changing the settings of the Tone, Brightness, and
Contrast options.

»>» Note

* When Color is selected for Color Mode, the Gray Adjustment tab switches to the Color
Adjustment tab.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
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Tone

Set the color tones for monochrome printing.
You can also select colors for monochrome color tones from the pull-down menu.
Cool Tone

This item adjusts color tones to cool shades of gray (cool black). When you select this item, a
value of -30 is entered for X, and a value of O for Y.

Black and White

This item adjusts color tones to neutral shades of gray. When you select this item, a value of 0 is
entered for X, and a value of O for Y.

Warm Tone

This item adjusts color tones to warm shades of gray (warm black). When you select this item, a
value of 30 is entered for X, and a value of 0 for Y.

Custom

You can adjust the color tones by using the horizontal and vertical sliders while checking the
colors in the center adjustment area.

Adjust the horizontal and vertical sliders by dragging them to the left/right or up/down,
respectively.

You can also adjust color tones by clicking or dragging the center adjustment area with the
mouse.

You can also directly enter values that are linked to the sliders. When you enter values, set
values in the range of -100 to 100 for X, and -50 to 50 for Y.

»» Note

+ Custom cannot be selected since it is displayed automatically when the adjustment value is
directly entered.

X, Y (Monochromatic adjustment value)

If necessary, you can adjust monochromatic colors manually.

To adjust the color tones, either enter values directly or click the up/down arrows.

You can also adjust the color tones by clicking or dragging the adjustment area with the mouse.
The value is also linked to the horizontal and vertical sliders.

When you enter values, set values in the range of -100 to 100 for X, and -50 to 50 for Y.

The selected value will be shown in the preview on the left side.

22 Important

+ This function is not available for certain Media Type settings.

Matching Tab

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM, ICC Profile Matching, or None to match the purpose of
the print operation.

32 Important

* When Monochrome or Monochrome (Photo) is selected for Color Mode, the Matching tab

does not appear.
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Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose
this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and
matching method in detail, and select when printing. You can use the digital camera or scanner
ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when
printing from an ICM function-compatible application.

»» Note

* You cannot use ICM when using an XPS printer driver.

None
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing using a profile creation tool or
color chart.

32 Important

* When setting not to use ICM in the application software, ICM and ICC Profile Matching of
Color Correction do not function. There are also times when it does not print correctly.

Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.

Printer Profile
Specifies the printer profile to be used when ICC Profile Matching is selected for Color Correction.
Normally Auto is selected but you can also select a printer profile manually.

Rendering Intent
Specifies the matching method to be used when you select Driver Matching, ICM, or ICC Profile
Matching for Color Correction.
Perceptual (Photo) / Perceptual
Reproduces a tint close to the display of the monitor. Select this when you wish to print a photo.

Saturation (Poster) / Saturation
Reproduces a tint that people feel to be pleasing. Select this when you wish to print a poster or
business document.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.
The white spots are reproduced as white spots (background color) on the paper.

Absolute Colorimetric
This method uses the white spot definitions in the input and output ICC profiles to convert the
image data.
Although the color and color balance of the white spots change, you may not be able to get the
desired output results because of the profile combination.
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3% Important

» Depending on the media type, you may obtain the same print results even when you change the
Rendering Intent setting.

+ If Driver Matching is selected for Color Correction, then Relative Colorimetric and Absolute
Colorimetric are not displayed.

Clear Coating Tab

Specify Clear Coating settings.
When you execute clear coating, the printer applies chroma optimizer (CO) ink onto the printing surface
and allows you to adjust the glossiness.

Clear Coating Area
Set the clear coating area.
Auto
The printer automatically sets the areas to be clear-coated and whether clear coating is to be
executed.
It may be possible to reduce the ink consumption of the chroma optimizer (CO) or to accelerate
the print speed.

Overall
The printer clear-coats the entire print area.
If selecting Auto produced unsatisfactory clear coating effects, selecting Overall may improve
the results.

22 Important

* The selection of Overall may be disabled depending on the media type and the print quality.
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Page Setup Tab Description

The Page Setup tab allows you to set borderless printing for a document and specify the scaling.

.|
= [ Reiate Fages 50 dagress

= anes Printireg Preferenices e
Mpn  PegeSew Loyou Favedes  Lbity
B puzo 5o Letter 155117
_f_ ] Barderass Prvtng
(] Erdmged Finsusnd Prnting
At o
Letter (£ 5%117) I : e
ASfimx 11 B - Fame o3 Poge Soe
& actusl Sige
Leber (B 5117} Onantation
BA0mx 1100 __J
A @ pora A} O Lansscape

Baper Sogoe Fol Paper (Autc)
P P With 44 Rall (1117 i)
Ryl Pagar Optana:
Outped Mathog Sige Cpliona Defmuits
G| [ [ W

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
When you select Custom Size from Custom Paper Size, the Custom Size Settings dialog box
appears, and you can specify any vertical and horizontal dimensions for the paper.

Borderless Printing
Chooses whether you are printing on a full page without any page margins or printing with page
margins.
In borderless printing, originals are enlarged to extend slightly off the paper. Thus, printing can be
performed without any margins (border).

32 Important

* When Cut Sheet is selected for Paper Source, Borderless Printing is grayed out and cannot be

set.

Borderless Setting
Select Borderless Printing to enable it for clicking.
Open the Borderless Setting dialog box, so that you can adjust Amount of Extension.

Borderless Printing Method
This appears when you select Borderless Printing.
Set the borderless printing method.
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Fit Paper Size
Enlarge or reduce the document to match the size of the paper to be printed, and then print the
document.

Scale to fit Roll Paper Width
You can enlarge or reduce the document to match the roll paper width and then print the document.

Print Image with Actual Size
Prints the document at its actual size.
When you select this check box, the Information dialog box appears, and you can select Roll
Width.

Fit Paper Size
When you select the Fit Paper Size check box, you can specify the setting.
Select the size of the paper to be printed.
The list displays the paper sizes that support borderless printing.

Enlarged/Reduced Printing
You can enlarge or reduce a document and then print it.
When you select Enlarged/Reduced Printing, you can then set Fit Paper Size, Scale to fit Roll
Paper Width, or Print Image with Actual Size.
Fit Paper Size
Enlarge/reduce the document to match the size of the paper to be printed, and then print the
document.

Scale to fit Roll Paper Width
You can enlarge/reduce the document to match the roll paper width and then print the document.

Print Image with Actual Size
Prints the document at its actual size.
When you select this check box, the Information dialog box appears, and you can select Roll
Width.

Fit Paper Size
When you select the Fit Paper Size check box, you can specify the setting.
Select the size of the paper to be printed.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Rotate Page 90 degrees
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print
the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90
degrees and print the document horizontally relative to the paper.
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Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Roll Paper (Auto)
Depending on the paper settings on the printer driver and the paper information registered to the
printer, the printer automatically determines which roll paper to use and then feeds that paper.

Roll 1
Paper is fed from Roll 1.

Roll 2
Paper is fed from Roll 2.

Cut Sheet
Feeds paper using the cut paper.

32 Important

» Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Width
Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer.

Roll Paper Options
Displays the Roll Paper Options dialog box.
You can specify auto cut, banner printing, and other settings for printing on roll paper.

Output Method...
Displays the Output Method dialog box.
You can select Output Method and specify save settings for saving documents to a box.

Size Options...
Displays the Paper Size Options dialog box.
The Paper Size Options dialog box allows you to create and register any user-defined paper.

Custom Size Settings dialog box
This dialog box allows you to specify the size (width and height) of the custom paper.
Paper Size

Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Units
Select the unit for entering a user-defined paper size.

Borderless Setting dialog box

Use Amount of Extension to adjust how much of the document extends off the paper during borderless
printing.

Amount of Extension
Adjusts how much of the document extends off the paper during borderless printing.
Moving the slider to the right increases the amount of extension and allows you to perform borderless
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printing with no problems.
Moving the slider to the left reduces the amount of extension and expands the range of the document

to print.

Roll Paper Options dialog box

You can specify settings for printing on roll paper.

Automatic Cutting
You can print cut guidelines for cutting the roll paper automatically or manually after printing.
Yes
Cut the roll paper automatically after printing.

No
Do not cut the roll paper automatically after printing.

Print Cut Guideline
Prints cut guidelines for cutting the roll paper manual after printing.

Banner Printing
Select this check box to print documents extending over several pages as one continuous document
without any spaces between the pages.

Output Method dialog box

You can select Output Method and specify save settings for saving documents to a box.

Output Method
Print
After print ends, the print job is saved to the printer's hard disk drive.

Save in Job Box
The print job is saved to the printer's hard disk drive. If you selected Save in Job Box, select an
individual box number as the save destination from the Job Box list.

Print after reception is complete
If you selected Print, you can specify this setting.
By selecting this check box, you can prevent the print quality from dropping if the print job
reception is cut off or if printing is interrupted.

Name of data to be saved
Use file name
The file name is used as-is.

Enter name
You can set a new name. Enter the save name in Name.

Job Box
The box list appears. If you selected Save in Job Box, select an individual box number as the save
destination from the list.
Acquire Job Box Name
When you click this, Job Box displays the box name that was obtained from the printer.
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Paper Size Options dialog box

You can create and register any user-defined paper. You can then select the defined paper size from
Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

»» Note

» Paper deletion is not possible in the following case:
* When a standard paper size of the printer driver is selected
* When an oversized paper size is selected
* When a paper size with a red circle is selected

Custom Paper Size Name
You can specify the name of a user-defined paper.

Units
You can specify the units for the height and width dimensions of the user-defined paper.

Page Size
You can specify the Width and Height settings of the paper.
Borderless Printing Size
When you select this check box, you can select a size from the paper sizes that support
Borderless Printing.

Fix the Ratio of the Width to Height
When you select this check box, you can change the size while keeping the Width and Height
ratio.

Width
Specify the paper width.
Height
Specify the paper height.
Register with the OS

Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user -defined

paper.
Add

You can register a user-defined paper that was set and overwrite the existing user-defined paper.
Display Series

You can narrow down the paper sizes to be displayed in Paper Size List.
Oversize

Add appropriate margins so that the document contents will not get cut off, and then print the
document.
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Layout Tab Description

The Layout tab allows you to specify how to arrange the document onto the paper. You can also set the
number of copies to be printed and the print sequence. If the application software that you used to create
the document features the same functions, specify the settings from the application software.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Layout
Selects the size of the document you want to print and the type of printing.

Poster (1 x 2) / Poster (2 x 2)
Poster printing is performed.
The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number of
divisions increases, the number of sheets used for printing increases. If you are pasting pages together
to create a poster, increasing the number of divisions allows you to create a larger poster.
Set...
Opens the Pages to Print dialog box.
Specify this setting when you want to print only specific pages

Free Layout
You can freely position and print any document created with an application software.
Set...
Opens the Free Layout Settings dialog box.
You can freely specify detailed settings for free layout.

2 Pages/Sheet / 4 Pages/Sheet / 6 Pages/Sheet /| 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet
Multiple pages are assigned to one sheet of paper and printed. The number presents the number of
pages assigned to one sheet.
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Set...
Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Stamp
The Stamp function prints a specific character string over the document pages. You can select the
characters to be printed from a list or use the Define Stamp dialog box to set any characters.
Define Stamp...
Opens the Define Stamp dialog box.

You can specify detailed stamp settings or register any stamp.

Print Centered
Prints document in center of paper.

Rotate 180 degrees
Rotates document 180 degrees and prints it.

No Spaces at Top or Bottom
When printing on roll paper, you can save paper by eliminating the upper and lower margins when
printing.
Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
32 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not
need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Page Options
Opens the Page Options dialog box.
You specify settings for printing information such as date, user name, and page number.

Special Settings
Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.

Pages to Print dialog box

When printing a poster that has been divided into several pages, you can specify which pages to print and
just print those pages.

Simply clear the check boxes of the pages you do not want to print.

In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are
displayed.

Invert
Switches the pages to be displayed or hidden.
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»» Note

» The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected
for Page Layout.

Free Layout Settings dialog box

You can specify detailed settings for free layout.

Paper Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Roll Paper Length
Sets the roll paper length.
Auto
Automatically determines the roll paper length and prints.

Manual Settings
Determines and specifies the roll paper length.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

»» Note

* The Free Layout Settings dialog box appears only when Free Layout is selected for Page
Layout.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.
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»» Note

» The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6
Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

Define Stamp dialog box

The Define Stamp dialog box allows you to specify settings for printing a stamp over the document
pages. In addition to the pre-registered ones, you can register and use your original stamp.

Watermark List
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name
Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style

Selects the font style for the stamp text string.
Size

Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Watermark List, and click this button.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the
stamp on the front.

Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical
slide bars to the left/right or up/down to change the coordinates.
Move to Center
Moves the stamp to the center of the paper.
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Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to
change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

Page Options dialog box
Specify the print settings, such as date, user name, and page number.
Print Date

Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box
Set the format to be used when printing the contents set in the Page Options dialog box.
Font

Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.

Special Settings dialog box

The Special Settings dialog box allows you to change the print processing method if you do not get the
print results you want.

Settings Summaries...
This is a list of items that you can set in the Special Settings dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
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Spooling at Printer Driver

Set whether print jobs are to be spooled in the print driver or whether PageComposer processing
is to be performed.
Setting Do Not Print or No (EMF Spooling) may improve the print results.
FineZoom Settings

Use this function to print on long paper.

Yes

The print problem may be corrected.

No
Image distortions may be corrected (for example, small lines may be eliminated).

Preview Switching
If you check the Preview before printing check box on the Main tab and then print,
PageComposer starts.

Application Color Matching Priority
You can assign higher priority to color management by the application software.

Fast Graphic Process
If image colors or line thicknesses are printed incorrectly, you may be able to get the print
results you want by setting this function to off.

Disable the color profile setting of the application software
If the color profile information set in the application software is output to the printer driver,
the printing results may include an unexpected tint. You can resolve the problem in this case
by setting Disable the color profile setting of the application software to On.

3% Important

» Even if this is set to On, it will only disable some of the color profile information, and it is
still possible to print using the color profile.
This should normally be set to Off when using.
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Favorites Tab Description

The Favorites tab allows you to register frequently used print settings as favorites.
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Favorites
A list of the registered favorite settings appears. The Default Settings are registered in the initial
settings.

Details
The settings of the favorite that you selected from Favorites appear.

Comment
The comment registered to the favorite appears.

Apply Favorite
You can change the print settings to the settings of the favorite that you selected from the Favorites list.

Delete
You can delete favorites that have become unnecessary.

Edit...
The Edit dialog box opens.
You can change the name and icon settings of the favorite that you selected from the Favorites list.

Add...
The Add dialog box opens.
You can register the current settings as a favorite.

Application Settings Priority
The setting in the application software will take priority over the favorites setting set on the printer driver.
The setting in the application software is only prioritized for Page Size, Orientation and Copies.
Place a checkmark to prioritize the settings for the application software.

Import...
You can read the settings of the favorite that was saved to a file.
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Export...
You can save the settings of a favorite to a file.

Edit dialog box
You can change the name and icon of the favorite that you selected from the Favorites list.
Name

Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

Add dialog box

You can save the current print settings as the settings of a favorite.
Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.
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Maintenance Tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.

== Cancn Frintireg Preferenices x
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Print Nozzle Check Pattern
Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, use Print Head
Cleaning to clean the print head.
Paper Source
Displayed using the Media Type, Page Size and Roll Width for each currently set paper feed
position.
&
\ Print Head Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.
There are two head cleaning functions, which are described below.
Cleaning

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink
levels are sufficiently high.

System Cleaning
System Cleaning is a more powerful cleaning function. Execute this function if the condition does
not improve even after you repeat Cleaning several times.
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3% Important

» System Cleaning consumes an extremely large amount of ink.
Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore,
execute system cleaning only when necessary.

Paper Feed Amount Adjustment
This function adjusts the paper feed amount if the print result is faint or contains streaks.

e

View Status
This function displays printer information and setting values.

Related Topics

= Cleaning the Print Heads
= Printing a Nozzle Check Pattern
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Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device
Settings tab is for specifying printer configuration-related settings and is part of the printer driver.
The Device Settings tab allows you to specify settings related to the printer unit.
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Roll Unit
There will be a checkmark here if the lower level roll unit is attached.
»>» Note

» Where the roll unit set in the winding device is attached, this checkmark will be removed.

Automatically switch paper sources (paper size priority)
Prints after automatically switching between roll paper 1 and roll paper 2 depending on the size of

the paper to be printed.
This will save paper as the roll paper that will give the smallest margin when printing is

automatically selected.

22 Important

» Make sure that the same type of paper is used in the upper level and lower level of the printer.
Printing is not possible when different types of paper are used.

» Be sure to click Acquire Status from the Device Settings tab to get information on the roll
paper width. You may not be able to print correctly if the roll paper width is not correctly set.

» Be sure to select Roll Paper (Auto) as Paper Source from Page Setup. This function cannot
be used unless Roll Paper (Auto) is selected.

Roll Paper Width 1
Sets the width of the roll paper loaded in the upper level (Roll 1).

Roll Paper Width 2
Sets the width of the roll paper loaded in the lower level (Roll 2).
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Update Media Information
Opens the Update Media Information dialog box.

Gets the latest media information from the printer and updates the media information in the printer
driver.

Accounting
Opens the Accounting dialog box.

By setting Accounting information, you add IDs to print jobs, and use the printer and cost management
tool to tabulate print history information for any ID.

»» Note

+ Accounting can be set only by users with Administrator rights.
Users without Administrator rights may not be able to set Accounting information.

Acquire Status

Acquire information on the attachment of the roll paper unit or roll paper 1 or roll paper 2 paper width
from the printer.

Based on this information, the Roll Unit and Automatically switch paper sources (paper size
priority), and roll width settings are automatically switched.

About
Allows you to check the version of the printer unit.

Accounting dialog box

Click Accounting to display the Accounting dialog box.

The Accounting dialog box allows you to add IDs to print jobs. You can then use the IDs, along with the
printer and cost management tool, to tabulate print history information.

Account ID
Enter the account ID to be set. Enter the ID by using up to 20 alphanumeric characters (0 to 9, a to z,
and A to Z).

Prohibits Account ID changes

Prohibits changes to account IDs that have already been set.
Check this check box to prevent other users from changing IDs.
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Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.
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Canon IJ Status Monitor Features
The Canon |J Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon |J Status Monitor Overview

Canon |J Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon |J Status Monitor shows an icon when a warning or error occurs to the printer.

! : A warning is being displayed.
6 : An operation error has occurred.
0 : You are being informed of remaining ink levels, etc.

0 : There has been an error which requires a service.

Document Name
Shows the name of the document to be printed.

635



Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Remaining Printing Time of Current Page
Displays the remaining print time of the pages being printed.

Display Send Queue
Shows the print window used to manage the print job that is being printed or being in the print
queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click \» (the disclosure triangle) to display a pictorial representation of the estimated ink level in
the ink tank.
Purchase Ink

A screen for purchasing ink appears. You can use this screen to purchase ink.

Ink Model Number
You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the
cartridge is full.

Click "» (the disclosure triangle) to display a pictorial representation of the estimated space
available in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder. It also allows you to check the
remaining amount of paper.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon |J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the
other windows when a low ink warning occurs.

When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon |J status
monitor starts automatically and appears in front of all other windows.
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Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically
and be displayed in front of other windows.

Start when Windows is Started
Starts the Canon |J Status Monitor automatically when you start Windows.

Remote Ul menu
You are able to open the printer's Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when
connected to and using it through a network.

»» Note

* When the printer is being used via USB connection Remote Ul will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and
remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job History window.

Job List
Displays the Print Job window.

HDD Information
Displays the Saved Job window.
This window allows you to check each box of the information saved on the printer's hard
disk.

Ink Supplier Display Settings
Displays the Ink Supplier Information window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and
disable warning displays.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and
you can check the version and copyright information.
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Updating the Printer Driver
» Obtaining the Latest Printer Driver
» Deleting the Unnecessary Printer Driver
» Before Installing the Printer Driver

» Installing the Printer Driver
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Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Main tab.

You can access our website and download the latest printer driver for your model.

22 Important

* You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.
+ Before installing the latest printer driver, delete the previously installed version.

Related Topics

= Before Installing the Printer Driver
= |nstalling the Printer Driver
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Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

* If you are using Windows 10, right-click the Start menu, and select Control Panel -> Programs ->
Uninstall a program.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

* If you are using Windows 8.1 or Windows 8, from the Desktop charms, select Settings -> Control
Panel -> Programs -> Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

* If you are using Windows 7 or Windows Vista, select Start menu -> Control Panel -> Programs ->
Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

The confirmation window for uninstalling the model appears.

32 Important

+ A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.

22 Important

* Printer driver and XPS printer driver will be deleted when you uninstall the Printer Driver.
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Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

Checking the Printer Status

» Turn off the printer.

Checking the Personal Computer Settings

» Terminate all running applications.
* Log on as a user who has the administrator account.

32 Important

» Before installing the latest printer driver, delete the previously installed version.

Related Topics

= QObtaining the Latest Printer Driver
= |nstalling the Printer Driver
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Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver and XPS printer
driver for your model.

The procedure for installing the downloaded printer driver is as follows:
1. Turn off the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

3% Important

« A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

4. Complete the installation
Click Complete.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

32 Important

* You can install the XPS printer driver with the same procedure for installing the printer driver. However,
when installing the XPS printer driver, first complete installation of the printer driver.

* You can download the printer driver and XPS printer driver for free, but any Internet access charges
incurred are your responsibility.

+ Before installing the latest printer driver, delete the previously installed version.

Related Topics

= Obtaining the Latest Printer Driver
= Deleting the Unnecessary Printer Driver
= Before Installing the Printer Driver

642



Mac OS Software

» Printer Driver
@« Overview of the Printer Driver
@« Description of Print Dialog
@« Updating the Printer Driver
» Printing Using Canon Application Software
@« Preview Guide
@« Free Layout Guide
@ Quick Utility Toolbox Guide
« Print Studio Pro Guide
« Digital Photo Printing Guide
@« Media Configuration Tool Guide
@« Device Management Console Guide

@« Accounting Manager Guide
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Managing Print Jobs

» Checking Print Job Information

» Accounting Manager Guide

» Basic Print Job Operations

]

]

Using Printer Hard Disk

Saving Print Jobs on Printer Hard Disk

Managing Job Queue (Deleting or Preempting Other Jobs)
Managing Pending Jobs (Printing or Deleting Jobs on Hold)
Printing Saved Jobs

Deleting Saved Jobs

Moving Saved Jobs

» Advanced Print Job Operations

]

Saving Print Jobs Sent from Sources Other than Printer Driver
Printing without Saving Jobs in Common Box

Setting Passwords for Personal Boxes

Naming Personal Boxes

Displaying List of Saved Jobs

Printing List of Saved Jobs

Displaying Details of Saved Jobs

Renaming Saved Jobs

Printer Hard Disk Operations

Checking Free Hard Disk Space
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Checking Print Job Information

Check print job details or print a specified job on the printer's hard disk using a web browser or operation
panel.
» Using web browser:
Log in to the printer using web browser.

= Changing Settings Using Web Browser

After logging on to the printer, select Job management and perform operations.

» Using operation panel:

Select Job management on the HOME screen and perform operations.
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Basic Print Job Operations
» Using Printer Hard Disk

» Saving Print Jobs on Printer Hard Disk

¥

Managing Job Queue (Deleting or Preempting Other Jobs)

¥

Managing Pending Jobs (Printing or Deleting Jobs on Hold)

¥

Printing Saved Jobs

¥

Deleting Saved Jobs

¥

Moving Saved Jobs
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Using Printer Hard Disk

The printer can save print jobs on the built-in hard disk.

Using print jobs stored on the printer enables you to print the jobs again as needed without using a
computer.

Send print jobs Print

Save print jobs

Saving print jobs offers the following benefits.

» Save the time spent using a computer
When you send a print job to the printer, you can save it on the printer after printing or simply save it on
the printer without printing it yet. Saved print jobs can be printed in the required quantity later without the
need to use a computer again.

» Simplify reprinting, if any errors occur
If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing
the error without resending the print job from a computer.

» Streamline printing work

Without using a computer, you can select print jobs and print in the desired quantity. You can also select
multiple print jobs to print during the same period. This enables unattended operation at night, for
example.

Output Method

To save print jobs on the printer's hard disk, configure the printer driver.
In Windows, this is set using the Output Method dialog box.

In Mac OS, this is set by selecting Additional Settings in the pop-up menu of the printer properties
dialog.
Print

Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not start
printing.

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.
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Storage Destination

The storage area on the printer's hard disk is divided into a temporary storage area and a permanent
storage area. The temporary storage area stores print jobs in the job queue or shared mailbox. The
permanent storage area stores jobs in personal boxes.
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Job queue

The job queue refers to print jobs that are being processed by the printer (saved, received, prepared
for processing, printed, deleted, or held). Up to 100 jobs can be stored in the temporary storage area.

However, the number of jobs available as queued jobs is up to 64.

Shared mailbox
Jobs for which you have specified Print in Output Method are saved in the shared mailbox and

classified as saved jobs.

There is one shared mailbox, numbered "00". A password cannot be set for the shared mailbox.

Up to 100 print jobs can be saved here. However, they will be deleted one after another starting with
the oldest job in the following situations.

* If there are over 101 jobs queued and saved in the shared mailbox combined
* If no more temporary storage space is available when jobs for which you have selected Print in

Output Method are received
« If there is not enough space in the temporary or permanent storage area when jobs for which you
have selected Save in Job Box in Output Method are received.

Personal boxes
Jobs are classified as saved jobs and saved in personal boxes in the following situations.

* When a saved job stored in the shared mailbox is moved to a personal box
» When you have selected Save in mail box as the option in Output Method

There are 29 personal boxes, numbered "01" to "29". You can specify a name and password for each

personal box.

Up to 100 print jobs can be saved in all personal boxes combined.
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Saving Print Jobs on Printer Hard Disk

To save print jobs on the printer's hard disk, configure the printer driver.

Print jobes

Configuring Printer Driver (Windows)

1. Open printer properties dialog box.

= How to Open the Printer Driver Setup Window

2. Access Page Setup sheet.
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3. Click Output Method to display Output Method dialog box.
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4. Make your selection in Output Method.
Print
Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not
start printing.
If you choose Save in Job Box, also specify the destination personal box in the Job Box list.

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.

> Note

* Click Acquire Job Box Name to display personal box names in the Job Box list, as acquired
from the printer.

5. In Name of data to be saved, specify how to name saved print jobs.

To use the file name, select Use file name.

Otherwise select Enter name and enter a name in Name.

6. Click OK to close Output Method dialog box.

Configuring Printer Driver (Mac OS)

1. Open printer properties dialog.

= How to Open the Printer Driver Setup Window
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2. Select Additional Settings in pop-up menu.
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3. Make your selection in Output Method.
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Print
Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not
start printing.

If you select Save in Job Box, select the personal box number from Job Box No..

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.
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Managing Job Queue (Deleting or Preempting Other Jobs)

Print jobs being processed by the printer are collectively called the job queue. You can delete or preempt
jobs in the job queue as needed.

This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

* Delete
Note that only jobs that are not currently being deleted can be deleted from the job queue.

Print
Jobs

* Preempting other jobs

You can preempt other jobs by printing jobs that are currently being received for processing first.

»>» Note

+ For information on managing jobs being held, see Managing Pending Jobs (Printing or Deleting Jobs on

Hold).

Using Operation Panel

1. Make sure printer is turned on.
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2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Print job.

4. Tap data to delete or perform preempt printing.

The screen below appears.

Details of print job

Document name
lobName 1

lear namea W
l&”” Priority printing |
A B

A. Tap to delete data.

B. Tap to perform preempt printing.
5. Check message that is displayed and tap Yes.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Print job.

The print job list appears.

4. Select print job and select Delete or Prioritize.
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Print job

Printer status
Litilities

Device settings
Job management

Security

System info and LAN settings

Language sslection

Manual (Online)

Document name

User namea
Status
Madia type

Page size

Paper source

job namea 15

job ewner 15

Matta

Tamplala
Legal
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Managing Pending Jobs (Printing or Deleting Jobs on Hold)

If the type or size of paper loaded does not match the settings in the print job received when you have set
Detect paper setting mismatch to Hold job in the operation panel, the print job is held on the printer as a
pending job in the job queue.

Manage held jobs such as these as follows.

This operation is available using the operation panel or Remote Ul.

»» Note

» As long as you do not manage held jobs from the operation panel, they will remain in the job queue. In
this case, the printer processes the next job in the queue without pausing.
« To print held jobs, replace the loaded paper with the paper specified in the print job.

= | oading the Upper Roll on the Printer
= | oading Sheets in the Printer

= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Print job.

The print job list appears.

4. Tap print job with - icon on left.

The screen below appears.

Details of print job

Document name
lobName 2

lear mamsa W
| Delete || Release hold J

A B
A. Tap to delete data.
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B. Tap to release hold.

5. Check message that is displayed and tap Yes.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Print job.

The print job list appears.

4. Select print job with ! icon on left and select Delete or Release.

Menu < Print job
Printer status Document name
jab mame 18
Uthlitles
Davice settings
— - User name
Job management job cwrer 18
Becurity Stalus
Hdding
System info and LAN settings
Media type
Language selection Mata
| Manual (Online) Fage size
Template

11717 26x43cm

Paper source
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Printing Saved Jobs

Print saved print jobs stored on the printer's hard disk as follows.

This operation is available using the operation panel or Remote Ul.

Print jobs
= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.
»» Note

» Enter the password if it is enabled.

5. Tap Job list.

6. Tap job to print.

7. Tap Start print on displayed screen.

The screen below appears.
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il

JobName 1

lobMNam:

Print tin

8. Tap Start print.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Saved job

Printer status
Utillities — Mumber of documents - T
oo 154 2
: : == common job bax
Device settings
Number of documents - 1
Job management o B Box Name 1
Security Mumber of documents - 1

A=)
System Info and LAN settings Untitled

M ber of do nts = 1
Language salection o 0 I.I::tl:; bl

Manual [Online) Mumber of documents - 1
= Untitled

Mumber of documents : 1
Unititled

Mumber of documents : 1

»» Note

 Enter the password if it is enabled for a saving box.

Printer status Enter a password.
Utilities
Device settings Password

Job management

System info and LAN settings

Manual (Online)

5. Select saved job and select Print.
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Administraior mode Log off

Saved job

Printer status

Utilities

Device setlings

Job management

Sacurity

Systern info and LAN setfings

Language selection

Manual (Online)

Document name

jobr nama 1
User name
jofy ovmer 1
Meadia type
Page size
Templals
A3
Paper source
Roll papar 1

Copies

S e —

6. Enter quantity to print in Copies and select Yes.

made  Log off

Printer status
. Litilities
. Device settings
..Iah management
. Security
I System Info and LAN settings
. Language selaction

© Manual (Online)

Start printing?

Copies 1
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Deleting Saved Jobs

Delete saved print jobs stored on the printer's hard disk as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.
2> Note

» Enter the password if it is enabled.

5. Tap Job list.

6. Tap job to delete.

7. Tap Delete.

8. Tap Yes on displayed screen.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Saved job

Printer status
Utillities — Mumber of documents - T
oo 154 2
: : == common job bax
Device settings
Number of documents - 1
Job management o B Box Name 1
Security Mumber of documents - 1

A=)
System Info and LAN settings Untitled

M ber of do nts = 1
Language salection o 0 I.I::tl:; bl

Manual [Online) Mumber of documents - 1
= Untitled

Mumber of documents : 1
Unititled

Mumber of documents : 1

»» Note

 Enter the password if it is enabled for a saving box.

Printer status Enter a password.
Utilities
Device settings Password

Job management

System info and LAN settings

Manual (Online)

5. Select saved job and select Edit.
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Adminisiater mode Log o

Saved job

Printer status Documant name

ot name 1
Ltilities
Device settings

| User mame
Jab managemant ol owmer 1
Sacurity Media type
System info and LAN settings Page size

| Tamplate
Language selection Al

Manual {Oniing) Faper source ;
Roll papar
Copies

6. Select Delete on displayed screen.

Administrater mode Log off
Saved job
Printer status Document name
| job name 1
Litilities
Device sellings
| . Change
Job management
| User mame
Security o owmer 1
System info and LAN settings Media type
Language selection Page size
| Template
Manual {Online) A3
Paper source
Roll papar 1
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Moving Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be moved from the current box to another box as
follows.

However, jobs saved in personal boxes cannot be moved to the shared mailbox.

This operation is available using Remote Ul.

Comman il box Parsonal mad bowss

Lt

32 Important

 Jobs stored in the shared mailbox may be automatically deleted under some conditions. To prevent jobs
from being deleted, move them from the shared mailbox to personal boxes.

= Using Printer Hard Disk

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

Saved job
Printer status
Utilities — Mumber of documents - 7
. k == common job box

Device settings

Humber of documents - 1
Job management o [ Box Nams 1
Security Mumber of documents : 1

=k
Syetem Info and LAN settings Untitled

Number of da nts - 1
Language salection o 0 I.I::tl:; otk

Manual (Online) Hurmber of documents - 1
W Untitled

Number of documents : 1
Unititled

Number of documents : 1

»» Note

 Enter the password if it is enabled for a saving box.
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Saved job

Printer status Enter a password.
Utilities
Device settings Fassword

Job management

System info and LAN settings

Manual [Online)

5. Select saved job and select Edit.

Administrator mode Log off

Saved job

Printer status Document name

| o name 1
Liilities
Device settings

| User name
Job management o owmer 1
Security Media type
System info and LAN settings Page size

| Templats
Language selection Al

Manual (Cmling) Paper source _
Roll paper
Copies

6. Select Move on displayed screen.

7. On Move job page, select Destination job box.
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o e Log) off

Move job

Printer status Select the destination job box
Ltilities. Current job box - 00
I Commen job box
Device sattings
Job management Destination job box - G0
[ Camman |ob box
Security
Sy=tem Info and LAN settings
Language selaction

. Manual (Onling) ]

8. Select name or number of destination personal box in Destination job box list and select
OK on displayed screen.

Administraier mode Log off
Mave job
Printer status Select the destination job box
Utilities Current job box = 00
I Common job box
Device sattings
Job management Destination job box - 00
i Commean |ab box
Security
System Info and LAN settings

Language selection

. Manual (Onling) .
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Advanced Print Job Operations

>

>

Saving Print Jobs Sent from Sources Other than Printer Driver
Printing without Saving Jobs in Common Box

Setting Passwords for Personal Boxes

Naming Personal Boxes

Displaying List of Saved Jobs

Printing List of Saved Jobs

Displaying Details of Saved Jobs

Renaming Saved Jobs

Printer Hard Disk Operations

Checking Free Hard Disk Space
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Saving Print Jobs Sent from Sources Other than Printer Driver

To save print jobs sent from software or systems other than the printer driver or applications provided with
the printer, specify the output method and select the setting to perform printing after saving printing data
using the operation panel.

Send print jobs Primt

Save print jobs

»>» Note

+ Contact the software or system developer for information about support for this printer function.

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

= Specifying Output Method
= Printing after Saving Printing Data

Specifying Output Method

Perform settings for printing or saving print job.

1. Make sure printer is turned on.

2. Flick HOME screen and tap n Device settings.

= Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap Output method.

Select the method below.

Print
Save print jobs automatically at the same time they are printed. (This is the default format.)

Print (auto delete)
Save print jobs temporarily at the same time they are printed and delete them after printing.
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Save to job box
Save print jobs on the printer.

Printing after Saving Printing Data
To save print jobs on the hard disk before printing, select ON for Save first and print.

Printing will start when Save first and print is set to ON, even if you have selected Save to job box for
Output method.

1. Make sure printer is turned on.

2. Flick HOME screen and tap n Device settings.

= Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap Save first and print.

6. Tap ON.
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Printing without Saving Jobs in Common Box

Jobs sent from a computer for which you have selected Print in Output Method in the printer driver are
saved in the shared mailbox.

= Using Printer Hard Disk

When Common job box setting is set to Print (auto delete) in the operation panel menu, print jobs for
which you have selected Print in Output Method in the printer driver are deleted from the shared mailbox
after printing.

Use this function when printing highly confidential documents.

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

1. Make sure printer is turned on.

2. Flick HOME screen and tap H Device settings.

= Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap Common job box setting.

6. Tap Print (auto delete).
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Setting Passwords for Personal Boxes

For greater security, you can specify a password for personal boxes. After you set a password, it will be
required to modify the personal box settings, as well as to display, print, delete, move, and modify jobs
saved in the personal box.

This operation is available using Remote Ul.

(Personal mail box)

Moty saltings
F (Prird joks i the parsonal mai box)

+ Disglay
+ Print
(gt &
* Mave
Erfter the password + Modify sattings

»» Note

» By default, no passwords are set for personal boxes.

» A password cannot be set for the shared mailbox.

» Enter a four-digit number as the password, in the range 0001?79999.

» Even if you have set passwords, they are not required to access personal boxes in Administrator Mode
in Remote UI.

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

5. Select Edit.
Saved job
Printer status Number of documents : 1
|, Untitled
Device seltings
Job management
jol» name 3
Security job owner 3

System info and LAN settings

Language selection

Manual {Online)

671



6. In Edit job box dialog box, specify password.

Edit job box

Printer status
Job box name
Utilities
Davice sattings Password({d characters)

LTy

Job management

Becurity
System info and LAN settings

Language selection

[ Manual [Qnline)

7. Enter password. (This field is limited to four digits in the range 0001 to 9999.)

8. Select OK.
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Naming Personal Boxes

For easier identification, you can assign names to personal boxes.

This operation is available using Remote Ul.

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

Saved job
Printer status
Utilities —, MWumber of documents : 7
: X Common job box

Device settings

Humber of documents - 4
Job management L =5 Box Name 1
Security Mumber of documents - 1

oz [k

System Info and LAN settings Untitled

Number of documents : 1

Language salection o3 e
: = Untitle

Manual [Online) Mumber of documents - 4
== Untitled

Number of documents - 1
— Untitled

Humber of documents : 1

> Note

» Enter the password if it is enabled for a saving box.
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Standard wser mode Loy ol

Saved job

Printer status Enter a password.
Utilities
Device settings Fassword

Job management

System info and LAN settings

Manual [Online)

5. Select Edit.

Saved job

Printer status Number of documents : 1
|, Untitled
Utilities 02

Device settings

Job management

jobr name 3
Security jab owner 3
System info and LAN settings

Language selection

Manual {Online)

6. In Edit job box dialog box, enter name in Job box name and select OK.
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Menu < Edit job box

Printer status
Job box name
Utilities
Device sattings Passwordid characters)

LTy

Job management

Becurity

System info and LAN settings
Language selection

Manual (Online)
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Displaying List of Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be listed by box as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.
2> Note

» Enter the password if it is enabled.

5. Tap Job list.

Saved job list for each box appears.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Saved job

Printer status
Utillities — Mumber of documents - T
oo 154 2
: : == common job bax
Device settings
Number of documents - 1
Job management o B Box Name 1
Security Mumber of documents - 1

A=)
System Info and LAN settings Untitled

M ber of do nts = 1
Language salection o 0 I.I::tl:; bl

Manual [Online) Mumber of documents - 1
= Untitled

Mumber of documents : 1
Unititled

Mumber of documents : 1

»» Note

 Enter the password if it is enabled for a saving box.

Printer status Enter a password.
Utilities
Device settings Password

Job management

System info and LAN settings

Manual (Online)

Jobs saved in the box are listed.
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Printing List of Saved Jobs

The list of print jobs stored on the printer's hard disk (saved jobs) can be printed by box as follows.

This operation is available using the operation panel.

1. Make sure printer is turned on.

2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.
2> Note

» Enter the password if it is enabled.

5. Tap Job list.

6. Tap Print the job list.

Saved job list for each box appears.
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Displaying Details of Saved Jobs

Details of print jobs stored on the printer's hard disk (saved jobs) can be displayed as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap . Job management.

= Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.
2> Note

» Enter the password if it is enabled.

5. Tap Job list.

Saved job list for each box appears.

6. Tap print job.

The print job details appears.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Saved job

Printer status
Utillities — Mumber of documents - T
oo 154 2
: : == common job bax
Device settings
Number of documents - 1
Job management o B Box Name 1
Security Mumber of documents - 1

A=)
System Info and LAN settings Untitled

M ber of do nts = 1
Language salection o 0 I.I::tl:; bl

Manual [Online) Mumber of documents - 1
= Untitled

Mumber of documents : 1
Unititled

Mumber of documents : 1

»» Note

 Enter the password if it is enabled for a saving box.

Printer status Enter a password.
Utilities
Device settings Password

Job management

System info and LAN settings

Manual (Online)

5. Select print job.

680



Administrator mode Log g

Saved job

Printer status Documant name

ot name 1
Ltilities
Device settings

| User mame
Jab managemant ol owmer 1
Sacurity Media type
System info and LAN settings Page size

1 Tamplate
Language selection Al

Manual {Oniing) Faper source ;
Roll papar
Copies

The details of the saved document appears.
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Renaming Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be renamed as follows.

This operation is available using Remote UI.

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

Saved job
Printer status
Utilities 00 —  Mumber of documents - 7
: ; == common job box
Device settings
Humber of documents - 4
Job management L =5 Box Name 1
Security = Mumber of documents - 1
A=
System Info and LAN settings Untitled
HNumber of do nts -4
Language salection o3 =) I_Iu:tl : bbb
: ntitle
Manual [Online) = Mumber of documents - 4
= Untitled
Humber of documents : 1
(11

B yntitled

Humber of documents : 1

> Note

» Enter the password if it is enabled for a saving box.
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Printer status Enter a password.

Litilities

Device settings Password

Job management

System info and LAN settings

Manual [Online)

5. Select saved job and select Edit.

Saved job

Printer status Document name

o name 1
Liilities
Device settings

| User name
Job management o owmer 1
Security Media type
System info and LAN settings Page size

| Templats
Language selection Al

Manual (Cmling) Paper source _
Roll paper
Copies

6. Select Change.
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Administrater mode Log off

Saved job

Printer status Document name
| job nama 1
Utilities.

Device sellings
s

Job management
I User name

Security ot cwmer 1

System info and LAN settings Media type

Language selection Page size
| Template
Manual {Online) Al
Paper source
Roll paper 1

Delete Move

7. Enter name and select OK.

Change

Printer status

Document name
Litilities

Device settings

Job managerment

Security

System info and LAN settings

Language selection

Manual (Online)
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Printer Hard Disk Operations

Printer hard disk operations are available from the following programs and interfaces.

* Printer driver
* Remote Ul

* Operation panel

The hard disk operations available through each interface are as follows.

Operation Printer driver | Remote Ul | Operation
panel
Saving print jobs Save in mail box v - -
Do not save print jobs in the common box - - v
Save print jobs sent from sources other than | - - v
the printer driver
Operations with saved jobs | Print saved jobs - v v
Delete saved jobs - v v
Job queue management Display job queue - v v
Delete - v v
Preempt jobs - v v
Operations with held jobs - v v
Mail box management Move saved jobs - v -
Modify saved jobs - v -
Modify mail boxes - v -
Print a list of saved jobs - - v
Display a list of saved jobs - v v
Other operations Display free hard disk space - v v
Initialize hard disk - - v
Display the time of printing - v v
Display error messages - v v
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Checking Free Hard Disk Space

Check the space available on the printer's hard disk as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap H Printer information.

= Menu Operations

3. Tap Hard disk information.

The free hard disk space appears.

Using Remote Ul

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Hard disk information.

The free hard disk space is shown in the upper-right corner.

Adimmisdialor mode Log of

Hard disk information

Printer status Hard disk capacity

| 260.0GE
Lrtilinies

| Job box free space
Device settings 140.0GE

Job management
Security
Syslem info and LAN seltings

Language selection

Manual (Onling)
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Troubleshooting

Frequently Asked Questions

¢ | want to easily create vertical or horizontal banners.

¢ Does this printer support sub-ink tank system?

« | want to know how to configure roll cutting.

« | want to configure so that the roll is cut automatically after waiting for the ink to dry.

¢ | want to print borderless (without a border)

« | want to know the paper types that can be used in this printer.

« The paper type that | want to print is not displayed on the Touch Screen.

« What type of function is color calibration?

¢ Can | perform duplex printing?

« | want to perform enlargement printing.

Examples of Problems

* Problems Regarding Paper

o Clearing Jammed Roll Paper

o Clearing a Jammed Sheet

o Roll paper cannot be inserted into the Paper Feed Slot

o Paper cannot be fed automatically

o Cannot load sheets

o Paper is not cut straight

o Paper is not cut

o The size of clear film cannot be detected

o Margins are wide

o When printing on thin roll paper, the printed surface becomes scratched

* Printing Does Not Start

o The Data lamp on the Control Panel does not light up

o The printer does not respond even if print jobs are sent

o "Injecting the ink" is displayed

o "Agitating the ink" is displayed

¢ The Printer Stops During a Print Job

o Printing stops and an error message is displayed
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o The printer ejects blank, unprinted paper

* Problems with the Printing Quality

o Printing is faint

o Paper rubs against the printhead

o The edges of the paper are dirty

o The surface of the paper is dirty

o The back side of the paper is dirty

o Immediately after borderless printing, the trailing edge margin is soiled during regular printing

o Printed colors are inaccurate

o Banding in different colors occurs

o Colors in printed images are uneven

o Image edges are blurred or white banding occurs

o The contrast becomes uneven during printing

o The length of printed images is inaccurate in the feeding direction

o Images are printed crooked

o Documents are printed in monochrome

o Line thickness is not uniform

o Lines or colors are misaligned

o Borders appear in borderless printing

¢ Cannot Print over Network

o Cannot Connect Printer to Network

o Cannot Print over TCP/IP Network

o Cannot Print over Bonjour networks (Mac OS)

¢ Cannot Find Printer on Network

o Cannot Find Printer on Check Printer Settings Screen (Windows)

o Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

o Searching Printer by IP Address or Host Name During Setup

« Installation Problems

o Removing Printer Software

¢ Other Problems

o The printer does not turn on

o The printer takes time to start up

o |f the Printer Makes a Strange Sound

o Messages adyvising to check the maintenance cartridge are not cleared

o The printer consumes a lot of ink
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o Printed pages are not collected cleanly in the basket

o When Trim edge first is set, the trimmed paper is drawn into the roll unit

o |nk Level Detection

« List of Support Code for Error
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Q

| want to easily create vertical or horizontal banners.

A You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the
roll width. This is an easy way to create vertical or horizontal banners.

= Printing Hanging and Horizontal Banners (Large-Format Printing) (Windows)

= Printing Hanging and Horizontal Banners (Large-Format Printing) (Mac OS)
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Q

Does this printer support sub-ink tank system?

A This printer supports hot-swap ink tank replacement.

Even if an ink tank becomes empty during printing, since a certain amount of ink always is stored in a sub-
ink tank, you can replace the ink tank while printing.

=p Replacing Ink Tanks
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Q

| want to know how to configure roll cutting.

A Cutting methods can be selected in the printer settings and printer driver settings.

To automatically cut roll paper after printing, open the Cutting mode settings on the printer, and then under
Automatic cut set Automatic Cutting in the printer driver to Yes.

When using paper that is easily scratched, or paper where the ink requires extra time to fix, we recommend
setting Cutting mode on the printer to Eject cut.

=} Specifying the Cutting Method for Rolls

=) Cutting Roll Paper after Printing (Windows)

=p Cutting Roll Paper after Printing (Mac OS)
If using the Media Take-up Unit, see the pages below for cutting settings and rolling settings after cutting.

=p Switching Roll Unit Modes

= Removing Printed Paper from the Roll Unit
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Q

| want to configure so that the roll is cut automatically after waiting
for the ink to dry.

A You can set an ink drying time in the printer driver.
You can also configure the same settings on the printer itself.

= Main Tab Description (Windows)

= Paper Detailed Settings (Mac OS)

=$ Specifying the Ink Drying Time for Rolls

=$ \lenu Structure
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Q

| want to print borderless (without a border)

A If printing on roll paper, you can set borderless printing in the printer driver settings. (If printing on
sheets, borderless printing is not possible)

=) Prints without Edges Based on the Scenarios (Windows)

= Prints without Edges Based on the Scenarios (Mac OS)
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Q

| want to know the paper types that can be used in this printer.

A For information about paper that can be used with this printer, see the imagePROGRAF home page
or refer to the media information list.

=» Paper Information List
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Q

The paper type that | want to print is not displayed on the Touch
Screen.

A If using a new paper type, start the Media Configuration Tool to get the latest media information.

=$ Updating paper information
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Q

What type of function is color calibration?

A The Color Calibration function operates during printing to correct color differences caused by
differences between printers or by printer deterioration.

We recommend color calibration in the following situations.
« After initial printer installation
* When replacing the print head
» When you sense a change of color compared to previously
* When you want to coordinate color and print from multiple printers
+ When the execution guide is displayed

=) Managing Colors

=¥ Performing Color Calibration

697



Q

Can | perform duplex printing?

A This printer cannot print double-sided.

An alternative to double-sided printing is to use the Folded Duplex function of the Windows software
Canon imagePROGRAF Free Layout, which prints two pages on one side, folds the sheet back from the
center, and hangs it.
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Q

| want to perform enlargement printing.

A Use the printer driver to adjust the original to the paper size and width, or print enlarged or reduced
by specifying a magnification factor.

= Scaled Printing (Windows)
= Scaled Printing (Mac OS)
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Problems Regarding Paper

 Clearing Jammed Roll Paper

* Clearing a Jammed Sheet

» Roll paper cannot be inserted into the Paper Feed Slot

« Paper cannot be fed automatically

» Cannot load sheets

» Paper is not cut straight

» Paper is not cut

* The size of clear film cannot be detected

* Margins are wide

« When printing on thin roll paper, the printed surface becomes scratched
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Q

Clearing Jammed Roll Paper

A If roll paper jams, follow the steps below to remove jams.

»>Note

+ If "The paper is jammed. Lift the release lever and remove the paper." appears on the touch screen,

Step 1 and Step 9 can be skipped.

1. Turn off the power to the printer.

=$ Turning the Printer On and Off

2. Open the top cover.

P»»Note

« If the roll paper is very curled or the leading edge of the roll paper blocks the Carriage, setting the
cutting method for the roll paper to User cut and leading edge detection to Do not detect may

stop the paper from blocking the carriage.

=$ Specifying the Cutting Method for Rolls

3. If the Carriage is out, move the Carriage out of the way, away from the paper.
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232 Important

» Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these may
cause malfunction.

4. Lift up the release lever.
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5. Holding the paper on both sides, pull the jammed portion out toward the front. Use scissors
or a cutting tool to cut away the printed or wrinkled portion.

&Caution

» Be careful not to injure yourself or scratch the printer when cutting.

6. If the Carriage is on the left, move the Carriage to the right until it stops.
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22 Important

» Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may
occur when you turn on the printer.

7. While holding the leading edge of the roll paper in the middle and gently and evenly pulling
until it reaches the output guide (A) position, align the right edge of the roll paper parallel to
the paper alignment line (B), and lower the release lever.

2»P»Important

* Do not pull the roll paper forcefully to make it line up with the paper alignment line (B). This might
cause the roll paper to feed at an angle.

8. Close the top cover.
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9. Turn on the power to the printer.

=$ Turning the Printer On and Off

The roll is advanced and the printer is ready to print.

»P»Note

+ To trim the leading edge cleanly, select the paper being fed on the touch screen, and then cut the
leading edge by tapping Cut paper in Feed/cut.

=p Specifying the Cutting Method for Rolls
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Q

Clearing a Jammed Sheet

A If a sheet jams, follow the steps below to remove it.

1. Turn off the power to the printer.

=§ Turning the Printer On and Off

2. Open the top cover.

22»Important

» Do not touch the linear scale (A), carriage shaft (B), or ink tube Stabilizer (C). Touching these may
cause malfunction.
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5. If the paper is visible, hold the paper and pull it out toward the front.
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6. If you cannot see the paper, lift the output guide, remove the roll holder, and remove the
jammed paper from underneath.

After removing the paper, inspect the interior to ensure paper fragments or other objects do not remain,
and lower the output guide.

7. If the Carriage is on the left, move the Carriage to the right until it stops.

2»2Important

» Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may
occur when you turn on the printer.

8. Lower the release lever and close the top cover.
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9. Turn on the power to the printer.

=§ Turning the Printer On and Off
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Q

Roll paper cannot be inserted into the Paper Feed Slot

Is the roll paper curled?

Straighten out curls and reload the roll.

Is paper jammed in the feed slot?

Remove the jammed paper.

=$ Clearing Jammed Roll Paper

=$ Clearing a Jammed Sheet

Check that the correct paper source has been selected

Select Paper settings in the touch screen menu, and then select the paper source.

Is the roll unit in Take-up mode when feeding from the roll unit?

Select Roll unit use setting in the touch screen menu, and set it to paper feed mode.

= | oading the Lower Roll on the Roll Unit (Option)
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Q

Paper cannot be fed automatically

A This paper cannot be fed automatically.
Set Paper retention setting to Release in the touch screen menu and feed the paper manually.

=p Menu Structure
2»2»Note

» While this setting is selected, you cannot use automatic roll paper switching.
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Q

Cannot load sheets

Check that the correct paper source has been selected

Select Paper settings in the touch screen menu, and then select the paper source.
Tap Load paper. and load the paper.

=p |oading Sheets in the Printer
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Q

Paper is not cut straight

Is the edge of the paper cutting position creased?

Straighten out any curling by the edges of the paper.

Is the edge of the paper cutting position lifting up when cutting?

Reload the paper correctly.

Is the paper a type that can be cut with the cutter blade?

Set Cutting mode in the touch screen menu to User cut, then and cut the roll paper with a cutting implement
such as scissors.

= Specifying the Cutting Method for Rolls

Check that the Cut speed setting is correct

Change the Cut speed setting in the touch screen menu.

=p Menu Structure

Did the printing material slip diagonally while being cut?

Set the Cutting mode in the touch screen menu to Eject cut, and then hold and cut the material after it has
printed.

=} Specifying the Cutting Method for Rolls

Is the cutter blade attached properly?

Attach the cutter blade properly.
=) Replacing the Cutter Blade

Check 7

Is the edge of the cutter blade blunt?

Replace the cutter blade.

713



= Replacing the Cutter Blade

714



Q

Paper is not cut

Is Automatic Cutting in the printer driver set to No or Print Cut Guideline?

Set the printer driver Automatic Cutting setting to Yes.

= Page Setup Tab Description (Windows)

= Paper Detailed Settings (Mac OS)

Is Cutting mode in the touch screen menu set to Eject cut or User cut?

If Cutting mode is set to Eject cut, select Feed/cut in the touch screen menu and cut the paper.
If Cutting mode is set to User cut, cut the roll paper with a cutting implement such as scissors.

=} Specifying the Cutting Method for Rolls

Is the cutter blade attached?

Attach the cutter blade.
=$ Replacing the Cutter Blade

Is the cutting method for paper ejected after printing set to Do not cut when the roll unit is
set to Take-up mode?

Follow the steps below to change the settings.
1. Select the roll unit on the touch screen.
2. Tap Use in take-up mode, and then select Use the cutting mode setting.

3. Set the Cutting mode for Roll paper 1 on the touch screen to Automatic cut.
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Q

The size of clear film cannot be detected

Is the platen dirty with ink?
Open the top cover and clean the entire platen area.

=$ Cleaning Inside the Top Cover
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Q

Margins are wide

Is auto cut being used on printed material with a wide margin on the trailing edge only?

Rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection.

This operation is normal.

Is leading edge detection set to Do not detect?

Do not detect may have been set by responding to the message Do you want to set to detect the leading
edge of the paper? when Cutting mode was set to User cut in the touch screen menu.

If the message Do you want to set to detect the leading edge of the paper? appears when setting Cutting
mode to User cut, select Detect (recommended).

Please note that if Detect (recommended) is selected and the paper has a strong curl, the print head may rub
against the edge of the paper when printing starts.

=$ Specifying the Cutting Method for Rolls
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Q

When printing on roll paper, the printed surface becomes
scratched

Depending on the paper, the printed surface may become scratched when the paper is
fed.

In this case, you must set Paper retention setting to Release on the touch screen, and then manually feed the
paper. Lift the release lever, feed the roll paper until the leading edge is visible on the platen, lower the release
lever, and then proceed to the next step. If Paper retention setting is set to Release, you will no longer be able
to automatically switch between the upper and lower roll paper.

Has the roll paper lost tension during printing?
If the roll paper loses tension, the paper surface could be damaged and the paper could wrinkle or fold.
Set Roll paper tension (printing) in the touch screen menu to High.

=$ Menu Structure
2»2Note

» Carrying out Adjust print quality is recommended when changing Roll paper tension (printing)
settings.
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Printing Does Not Start

« The Data lamp on the Control Panel does not light up

» The printer does not respond even if print jobs are sent

* "Injecting the ink" is displayed

» "Agitating the ink" is displayed
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Q

The Data lamp on the Control Panel does not light up

Does the printer have power?

Check that the power cord is firmly plugged all the way in. Push the ON button to turn on the power to the printer.

Was the correct printer selected?

In Windows, select the printer by clicking Select Printer or Printer in the printing dialog box and try printing
again.

In Mac OS, open the dialog box of the printer driver, select the printer from the list of Printer, and try printing
again.

Is the print job paused?

In Windows, restart the print job as follows.
1. Select the printer icon in the Printers and Faxes (or Printers ) window.
2. Clear Pause Printing in the File menu to restart the print job.

In Mac OS, restart the print job as follows.
1. Click Print & Scan (or Print & Fax).

2. Select the printer, and then Resume Printer (or Start Jobs ) in the Printers menu to restart the print job.
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Q

The printer does not respond even if print jobs are sent

Is Pause printing set to Enable?
Set Pause printing on the touch screen menu to Disable.
= Pausing Printing
Check 2
Is Save in mail box selected as the printer Output Method?

Print the job saved on the printer's hard disk.

=$ Printing Saved Jobs

Is the print job pending?

Manage the jobs on hold and print as needed.

=) Managing Pending Jobs (Printing or Deleting Jobs on Hold)
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Q

"Filling the ink" is displayed

A The print head and sub-ink tank are being filled with ink.

Wait until the system has been filled with ink.

»>»Note

» This message might appear if you force the power off while the printer is operating.
Always follow the correct procedure when turning off the power.

=$ Turning the Printer On and Off
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Q

"Agitating the ink" is displayed

A Ink agitation is in progress.
Please wait until ink agitation is finished.

Agitation time varies depending on time elapsed since powering off (approximately 1 minute to 20 minutes).
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The Printer Stops During a Print Job

* Printing stops and an error message is displayed

» The printer ejects blank, unprinted paper
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Q

Printing stops and an error message is displayed

A The last portion of roll paper was used during a print job, and paper could not be advanced because
the trailing edge is taped to the roll.

Remove the used roll and insert a new roll.

=$ Removing the Upper Roll from the Printer

=) Removing Rolls From the Roll Holder

=p | oading and Printing on Rolls
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Q

The printer ejects blank, unprinted paper

The leading edge of the roll paper may have been trimmed

The leading edge of the roll paper may be trimmed if Trim edge first is not set to OFF in the touch screen menu.

=$ Cutting the Leading Edge of Roll Paper Automatically

Is the print head nozzle blocked?

Print a nozzle check pattern to check the print head status.

=P Checking for Nozzle Clogging

Is the correct printer driver selected?

Print again using the correct printer driver for your printer.
If none of the above apply, there may be a printer malfunction.

Contact your Canon dealer for assistance.
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Problems with the Printing Quality

* Printing is faint

 Paper rubs against the printhead

» The edges of the paper are dirty

* The surface of the paper is dirty

» The back side of the paper is dirty

» Immediately after borderless printing, the trailing edge margin is soiled during reqular printing

* Printed colors are inaccurate

» Banding in different colors occurs

» Colors in printed images are uneven

* Image edges are blurred or white banding occurs

» The contrast becomes uneven during printing

» The length of printed images is inaccurate in the feeding direction

» Images are printed crooked

* Documents are printed in monochrome

* Line thickness is not uniform

* Lines or colors are misaligned

» Borders appear in borderless printing
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Q

Printing is faint

Is the reverse side of the paper being used for printing?

Print on the printing surface.

Is the print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.
= Checking for Nozzle Clogging
»P»Note

+ To automatically check for nozzle blockages after printing, set Auto nozzle check in the touch screen
menu to a setting other than Disable.

To show warnings based on nozzle check results, set Nozzle check error display in the touch screen
menu to Enable.

However, printing may be stopped by warnings if this setting is set to Enable.

=$ Menu Structure

Was the printer left with the ink tank out?

The ink supply may become blocked by ink if the ink tank is left out.

If this happens, leave the printer for at least 24 hours with the ink tank in, and then carry out Print head
cleaning.

=$ Cleaning the Print Head

Are paper scraps stuck in the top cover?

Follow the steps below to remove paper scraps left inside the top cover.
1. Open the top cover and make sure that the carriage is not over the platen.
2. Remove any paper scraps left inside the top cover.

= Clearing Jammed Roll Paper

=F Clearing a Jammed Sheet

3. Close the top cover.
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Was the paper cut before the ink dried?

Set a longer Ink drying wait time in Advanced paper settings in the touch screen menu.

=$ Menu Structure

Is the printer driver Print Quality set to Fast?
Follow the steps below to set Print Quality to a setting other than Fast, and then print.
* Windows
Change the Print Quality settings in the printer driver Advanced Settings.
=P Changing the Print Quality and Correcting Image Data (Windows)
» Mac OS

Change the Print Quality in the printer driver Quality & Media settings.
= Changing the Print Quality and Correcting Image Data (Mac OS)

When Fast or Standard is selected, the printing time is shorter and less ink is used than with Highest or High,
but the print quality is reduced.

Does the paper used for printing create a lot of cutting dust?

Set Cut-dust reduction in the touch screen menu Advanced paper settings to ON.

= Reducing Dust from Cutting Rolls
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Q

Paper rubs against the printhead

Is the media type specified in the printer driver the same as the media type loaded in the
printer?
Load paper of the same type as you have specified in the printer driver.

= | oading the Upper Roll on the Printer

=) | oading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.
2. Change the paper type in the printer driver and try printing again.

Is the paper loaded properly?
If not loaded properly, paper can buckle and rub against the print head.
Reload the paper.

= | oading the Upper Roll on the Printer

= | pading Sheets in the Printer

Is the print head height set too low?

Set Paper Thickness (Head Height) in the touch screen menu to Auto.

= Troubleshooting Paper Abrasion and Blurry Images

Is the paper thick, or a type that curls easily or is prone to buckling after absorbing ink?

If using paper-based printing material such as Heavyweight Coated Paper, set Transport unit vacuum strength
in the touch screen menu to Medium-strong or Strong. If that does not resolve the problem, increase the Paper
Thickness (Head Height) setting in the touch screen menu.

=p Adjusting Vacuum Strength

=P Troubleshooting Paper Abrasion and Blurry Images

If using film-based printing material such as CAD Tracing Paper, set the Transport unit vacuum strength in the
touch screen menu to Standard, Medium-strong, or Strong. If that does not resolve the problem, increase the
Paper Thickness (Head Height) setting in the touch screen menu.
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=$ Adjusting Vacuum Strength

=} Troubleshooting Paper Abrasion and Blurry Images

If using paper thinner than 0.004 inches (0.1 mm), set Transport unit vacuum strength in the touch screen
menu to Weak. If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the
touch screen menu.

=) Adjusting Vacuum Strength

=$ Troubleshooting Paper Abrasion and Blurry Images

When loading paper in the printer, is the media loaded the same as the media type
selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

= | oading the Upper Roll on the Printer

=} | oading Sheets in the Printer

Does the paper have a strong curl at the front edge or is it buckled?

Set Cutting mode in the touch screen menu to User cut, and set leading edge detection to Do not detect.

To keep track of the amount of roll paper remaining in this situation, set Manage remaining roll amount to OFF
before loading the roll paper, and then set Manage remaining roll amount back to ON after the roll paper is
loaded.

=) Specifying the Cutting Method for Rolls

=$ Keeping Track of the Amount of Roll Paper Left
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Q

The edges of the paper are dirty

Was printing borderless or on small paper?

The platen may become dirtied by printing borderless or on small paper sizes.
Open the top cover and clean the platen.

=$ Cleaning Inside the Top Cover

Is Extension for borderless printing in the touch screen menu set to Large or
Standard?

Set Paper with adequate width in Extension for borderless printing to Small.

=p Menu Structure

Is the media type specified in the printer driver the same as the media type in the printer?

Make sure the same type of paper is specified on the printer as in the printer driver.

=p Changing the Type of Paper

Follow the steps below to change the printer driver settings.
1. To stop printing, press the Stop button.
2. Change the type of paper in the printer driver and try printing again.

Is the paper creased or curled?

Straighten out the wrinkles or curls and reload the paper. Do not use paper that has been printed on previously.

=$ | oading the Upper Roll on the Printer

= | pading Sheets in the Printer

Is Cut-dust reduction in the touch screen menu Advanced paper settings set to ON?

A cut dust reduction line is printed at the paper cut position when Cut-dust reduction is set to ON.
If cutting dust reduction is not required, set Cut-dust reduction to OFF.

=p Menu Structure
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Is the print head height set too low in the touch screen menu?

Set Paper Thickness (Head Height) to Auto.

=$ Troubleshooting Paper Abrasion and Blurry Images

Is the paper thick, or a type that curls easily or is prone to buckling after absorbing ink?

If using paper-based printing material such as thick-coat paper, set Transport unit vacuum strength in the
touch screen menu to Medium-strong or Strong. If that does not resolve the problem, increase the Paper
Thickness (Head Height) setting in the touch screen menu.

=) Adjusting Vacuum Strength

=} Troubleshooting Paper Abrasion and Blurry Images

If using film-based printing material such as tracing paper, set the Transport unit vacuum strength in the touch
screen menu to Standard, Medium-strong, or Strong. If that does not resolve the problem, increase the Paper
Thickness (Head Height) setting in the touch screen menu.

=$ Adjusting Vacuum Strength

= Troubleshooting Paper Abrasion and Blurry Images

Is the output guide clean?

Clean the output guide.

=} Cleaning the Printer Exterior
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Q

The surface of the paper is dirty

Is the paper retainer clean?

Clean the paper retainer.

=$ Cleaning Inside the Top Cover

Does this paper take longer to dry?

Set the Ink drying wait time in the touch screen menu to approximately 1 minute.

=p Menu Structure
2»>Note

* When printing on paper that takes longer to dry, the paper may curl during printing and come in contact
with the output slot.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans
in the touch screen menu.

However, note that printing will now take longer.

=p Menu Structure

»>»Note

* In a hot and humid environment, rolling paper printed with images containing areas of saturated color
may transfer ink to the contact surface, affecting print quality.

Move the printer to a different environment, or let the paper dry before rolling it.
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Q

The back side of the paper is dirty

Was the previous print job borderless, or printed on small paper?

Open the top cover and clean the platen.

=$ Cleaning Inside the Top Cover

Is Detect paper width in the touch screen menu set to OFF?

Printing with Detect paper width set to OFF may cause the platen to be dirtied.
Set Detect paper width in the touch screen menu to ON, and then open the top cover and clean the platen.

=p Cleaning Inside the Top Cover

To continue printing with Detect paper width set to OFF, first open the top cover and clean the platen, and then
manually feed roll paper over the platen when printing.

=} Cleaning Inside the Top Cover

=$ Feeding Roll Paper Manually

Paper may be gripped weakly over the platen.

Set a higher Transport unit vacuum strength in the touch screen menu.

=$ Adjusting Vacuum Strength

Is Extension for borderless printing in the touch screen menu set to Large or
Standard?

Set Paper with recommended width and Paper with adequate width in Extension for borderless printing to
Small.

=p Menu Structure
2»2»Note

* In a hot and humid environment, rolling paper printed with images containing areas of saturated color
may transfer ink to the contact surface, affecting print quality.

Move the printer to a different environment, or let the paper dry before rolling it.
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Q

Immediately after borderless printing, the trailing edge margin is
soiled during regular printing

A In some situations, borderless printing with automatic cutting of the leading and trailing edges on roll
paper may transfer ink on the cutter blade to the next item printed.

Follow the steps below to change Between Pages in Drying Time to between 30 seconds and 3 minutes
and perform borderless printing.

» Windows
1. Click Specify for Media Type on the Main sheet of the printer driver.

2. Select an ink drying time from the Between Pages list in Drying Time.

* Mac OS
Select an ink drying time from the Drying Time list on the Paper Detailed Settings sheet of the printer
driver.
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Q

Printed colors are inaccurate

Has color been adjusted in the printer driver?

Follow the steps below to adjust color settings.

+ Windows
Adjust the color settings with Color Mode > Color Settings in Advanced Settings in the printer driver.

= Main Tab Description (Windows)

* Mac OS
Adjust the color settings in the printer driver Color Options.

=} Color Options (Mac OS)

Has the computer or monitor color been adjusted?

Take the actions below.
+ Refer to the computer and monitor documentation to adjust the colors.

+ Adjust the settings of the color management software, referring to the software documentation as needed.

Is the print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

=) Checking for Nozzle Clogging

Is Application Color Matching Priority set to Off in a Windows printer driver?

In the printer driver Layout sheet, click Special Settings, and then set Application Color Matching Priority to
On in the dialog box that appears.

=) Layout Tab Description (Windows)

Has the print head been replaced?

Differences between one print head and another may result in a change in color after replacing a print head.
Execute color calibration.

= Performing Color Calibration
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The print head characteristics may have changed

The characteristics of a print head may change with repeated use, including color.
Execute color calibration.

= Performing Color Calibration

Color varies even between printers of the same model due to differences in firmware and

printer driver versions, settings, or environment

Follow these steps to prepare the printing environment.
1. Use the same version of firmware or printer driver.
2. Specify the same value for all settings items.
3. Execute color calibration.

=» Performing Color Calibration

Was Select Your Place of Residence changed in the Media Configuration Tool when
reinstalling the printer driver?

Changing the region selection of the Media Configuration Tool deletes the region-specific paper information
originally registered on the printer before installation. Using paper with deleted information when executing color
calibration will prevent the resulting calibration adjustment value from being applied to all other types of the
paper.

Prepare paper compatible with calibration in the newly selected region and perform calibration again.

=» Performing Color Calibration
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Q

Banding in different colors occurs

Are paper actually loaded on the printer and the media type selected on the touch screen
the same?

Select the correct media type in the touch screen menu when loading paper in the printer.

= | pading the Upper Roll on the Printer

=) | oading Sheets in the Printer

Has the paper feed rate been calibrated properly?

Adjust the feed amount.

=) Adjusting Feed Amount

Print job may have been interrupted while receiving, and therefore not printed at a fast

frame rate
Exit other applications and cancel other print jobs.
Check 4
Is Set priority in the touch screen menu set to Prioritize length accuracy?

Setting Set priority to Prioritize print quality and adjusting the feed amount can help.

=p Adjusting Feed Amount

Check if the print head is in the right position

Adjust the print head position.

=$ Automatic Adjustment to Straighten Lines and Colors

Make sure that the print head nozzle is not blocked

Print a test pattern to check the nozzles and see if they are clogged.

=p Checking for Nozzle Clogging
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»P»Note

+ To automatically check for nozzle blockages after printing, set Auto nozzle check in the touch screen
menu to a setting other than Disable.

To show warnings based on nozzle check results, set Nozzle check error display in the touch screen
menu to Enable.

However, printing may be stopped by warnings if this setting is set to Enable.

=$ Menu Structure

Low Print Quality setting causing lines in the printing

Follow the steps below to set Print Quality to Highest or High, and then print.

* Windows
Change the Print Quality settings in the printer driver Advanced Settings.

= Changing the Print Quality and Correcting Image Data (Windows)

* Mac OS
Change the Print Quality in the printer driver Quality & Media settings.

= Changing the Print Quality and Correcting Image Data (Mac OS)

When Fast or Standard is selected, the printing time is shorter and less ink is used than with Highest or High,
but the print quality is reduced.

Is the media type specified in the printer driver the same as the media type loaded in the
printer?
Load paper of the same type as you have specified in the printer driver.

= | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

=p | oading Sheets in the Printer

Follow the steps below to change the printer driver settings.
1. To stop printing, press the Stop button.
2. Change the type of paper in the printer driver and try printing again.
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Q

Colors in printed images are uneven

Does this paper curl easily?

Colors in printed images may be uneven at the leading edge of paper that curls easily. Change the Transport
unit vacuum strength in the touch screen to increase the grip on the paper, or set a margin of at least 0.8
inches (20 mm) at the front edge of the paper.

=$ Adjusting Vacuum Strength

Colors in printed images may be uneven if the Print Quality setting is too low

If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher
Print Quality setting.

If using Mac OS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

When Fast or Standard is selected, the printing time is shorter and less ink is used than with Highest or High,
but the print quality is reduced.

=P Changing the Print Quality and Correcting Image Data (Windows)

= Changing the Print Quality and Correcting Image Data (Mac OS)

Colors in printed images may be uneven on the boundary between shades if there are
dark and light areas in an image

Using the unidirectional printing function may reduce color unevenness in this situation.

Follow the steps below for unidirectional printing.

* Windows
Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional
Printing.

* Mac OS
Open Paper Detailed Settings in the printer driver, and then select Unidirectional Printing.

If printing borderless, colors in printed images may be a little uneven at the leading edge
of the paper because printing is interrupted to cut the paper
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Set the printer driver Automatic Cutting settings to No, and then print. Doing this prints only the left and right
sides borderless. Cut the top and bottom borders with a cutting implement such as scissors after the printed
materials are output and cut.

»P»Note

+ Selecting a higher Print Quality in the printer driver Advanced Settings may resolve the problem.

= Changing the Print Quality and Correcting Image Data (Windows)

= Changing the Print Quality and Correcting Image Data (Mac OS)

Check if the print head is in the right position

Adjust the print head position.

=$ Automatic Adjustment to Straighten Lines and Colors

Color may be uneven if printing materials were stacked while drying

To avoid uneven colors, we recommend drying each sheet separately.

Density may be uneven if using Glossy Paper or Coated Paper

Set Print Quality to Highest or High, and then print.

Is the media type specified in the printer driver the same as the media type loaded in the
printer?
Load paper of the same type as you have specified in the printer driver.

= | pading the Upper Roll on the Printer

=) | oading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.
2. Change the type of paper in the printer driver and try printing again.

Is Ink drying target area for Pause between scans in the touch screen menu set to
Leading edge?

If the Ink drying target area for Pause between scans is set to Leading edge, color may be uneven
approximately 4.3 to 6.3 inches (110 to 160 mm) from the front edge of the paper. (The position depends on the
Print Quality settings)

In this case, set Ink drying target area for Pause between scans to Overall.
However, note that printing will now take longer.

=) Menu Structure
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Q

Image edges are blurred or white banding occurs

Paper may be gripped too strongly over the platen

Set a lower Transport unit vacuum strength in the touch screen menu.

= Adjusting Vacuum Strength

Check if the print head is in the right position

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, set the print
head to the optimal height and then adjust the position of the print head.

=P Adjusting the Print Head

Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the problem.

=} Troubleshooting Paper Abrasion and Blurry Images

Is the media type specified in the printer driver the same as the media type loaded in the
printer?

Load the printer with the media type specified in the printer driver.

=$ | oading the Upper Roll on the Printer

= | pading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.
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Q

The contrast becomes uneven during printing

Has the paper feed rate been calibrated properly?

Adjust the feed amount.

=$ Adjusting Feed Amount

Is the media type specified in the printer driver the same as the media type loaded in the
printer?

Load the printer with the media type specified in the printer driver.

= | oading the Upper Roll on the Printer

=} | oading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.
2. Change the type of paper in the printer driver and try printing again.
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Q

The length of printed images is inaccurate in the feeding direction

Is Set priority for Paper feed adjustment in the touch screen menu set to Prioritize
print quality?

Set Set priority for Paper feed adjustment to Prioritize length accuracy, and then carry out Adjust feed
length.

=$ Adjusting Feed Amount

Is the media type specified in the printer driver the same as the media type loaded in the

printer?
Load the printer with the media type specified in the printer driver.

= | oading the Upper Roll on the Printer

=} | oading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.
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Q

Images are printed crooked

Is Skew detection accuracy in the touch screen menu set to Loose or OFF?

Set Skew detection accuracy to Standard, and then reload the paper.

=$ Menu Structure

Is Detect paper width set to OFF?

Set Detect paper width in the touch screen menu to ON.

=p Menu Structure

Has the roll paper been loaded at an angle?

If there is a gap between the roll paper and roll holder, reload the roll.

=} | oading Rolls on the Roll Holder

=p | oading the Upper Roll on the Printer

746



Q

Documents are printed in monochrome

Is Color Mode set to Monochrome, or Print Target set to Monochrome (Photo) in a
Windows printer driver?

In the Advanced Settings of the printer driver, specify Color in Color Mode and try printing again.

Is Black and White Photo Print selected in a Mac OS printer driver?

Deselect Black and White Photo Print in the printer driver Quality & Media settings, and then print again.

The print head nozzle may be blocked

Print a test pattern to check the color ink nozzles and see if they are clogged.

=$ Checking for Nozzle Clogging
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Q

Line thickness is not uniform

Is Fast Graphic Process set to On in the Windows printer driver Special Settings dialog
box?

Access the printer driver Properties dialog box from Print in the File menu of the source application, and follow
these steps to print.

1. Deselect Preview before printing in the Main sheet.
2. Deselect Page Layout in the Layout sheet.

3. Click the Special Settings button in the Layout sheet, and then set Fast Graphic Process to Off in the
Special Settings dialog box that opens.

Is the media type specified in the printer driver the same as the media type loaded in the
printer?
Load the printer with the media type specified in the printer driver.

= | oading the Upper Roll on the Printer

=) | oading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.

Adjust the position of the print head

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, set the print
head to the optimal height and then adjust the position of the print head.

=p Adjusting the Print Head
2»>Note

» Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the
problem.

=} Troubleshooting Paper Abrasion and Blurry Images
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Q

Lines or colors are misaligned

Adjust the position of the print head

If borders are misaligned or the print results are not uniform, adjust the position of the print head.

= Adjusting the Print Head

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, set the print
head to the optimal height and then adjust the position of the print head.

=P Changing the Print Quality and Correcting Image Data (Windows)

= Changing the Print Quality and Correcting Image Data (Mac OS)
»»Note

» Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the
problem.

=} Troubleshooting Paper Abrasion and Blurry Images

Is the media type specified in the printer driver the same as the media type loaded in the
printer?
Load the printer with the media type specified in the printer driver.

= | oading the Upper Roll on the Printer

=) | oading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.
1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.
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Q

Borders appear in borderless printing

If printing full-scale borderless, is the selected paper wider than the source size?

For borderless printing at actual size, use roll paper that has the same width as the actual page size.

=¥ Printing Full-Size without Margins (Windows)

= Printing Full-Size without Margins (Mac OS)

Does the source file have margins?

Check that the printing image data does not have any objects like crop marks and transparent objects.

Is a margin set in application software?

Check that no margins are configured in the application software you are using.

Is the Extension for borderless printing set to Small?

In Extension for borderless printing in the touch screen menu, set Paper with recommended width and
Paper with adequate width to Standard.

=p Menu Structure

Is the width of the paper recommended for borderless printing?

For paper sizes that are not recommended for borderless printing, a slight margin will automatically be generated
on the left and right. You can set the amount of border at this time with Extension for borderless printing >
Paper with adequate width in the touch screen menu.

However, Extension for borderless printing is increased, the platen may become dirty.

For details on paper sizes recommended for borderless printing, see Paper Sizes.

= Paper Sizes
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Cannot Print over Network
» Cannot Connect Printer to Network
» Cannot Print over TCP/IP Network

» Cannot Print over Bonjour networks (Mac OS)
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Q

Cannot Connect Printer to Network

A

Is the Ethernet cable connected correctly to the printer's Ethernet port?

Make sure the printer is connected to the network with the correct Ethernet cable, and then turn the printer on.
For instructions on connecting the cable, refer to the Setup Guide.

Make sure the Link indicator is lit.

The top and bottom indicators are lit if the printer is connected via 1000Base-T. The top indicator is green if the
printer is connected via 100Base-TX, and the bottom indicator is orange if connected via 10Base-T.

If the Link indicator is not lit, check the following points.

* The hub is on.
* The end of the Ethernet cable is connected correcily.

Insert the Ethernet cable until it clicks and locks in place.
» There is no problem with the Ethernet cable.

If there is any problem, replace the Ethernet cable.
» Check the communication mode with the hub.

Although the printer normally detects the hub communication mode and transmission rate automatically (in
auto negotiation mode), sometimes the hub settings cannot be detected. In this case, configure the
connection method manually, specifying the communication mode in use.
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Q

Cannot Print over TCP/IP Network

A

L CESIN |s the printer's IP address configured correctly?
Make sure the printer's IP address is configured correctly.

»» Note

» For Windows, you can configure the printer's IP address using IJ Network Device Setup Utility.
+ For wired LAN:
= Performing/Changing Wired LAN Settings

* For wireless LAN:

= Performing/Changing Wireless LAN Settings

Are the printer's TCP/IP network settings configured correctly?

Make sure the printer's TCP/IP network settings are configured correctly.

Is the computer you are trying to print from configured correctly?

Make sure the computer's TCP/IP network settings are configured correctly.
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Q

Cannot Print over Bonjour networks (Mac OS)

A

Is the computer you are trying to print from configured correctly?

Make sure the computer is configured correctly.

Are the computer and printer on the same network?

Due to the nature of Bonjour, printing may not be possible if the printer is on another network behind a router.
Make sure the computer and printer are on the same network. For information about network settings, ask your
network administrator.
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Cannot Find Printer on Network
» Cannot Find Printer on Check Printer Settings Screen (Windows)
» Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

» Searching Printer by IP Address or Host Name During Setup
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Q

Cannot Find Printer on Check Printer Settings Screen (Windows)

A

If the printer cannot be found and the Check Printer Settings screen appears after searching the printer by
Automatic search on the Search for Printers screen, click Redetect and search for the printer again by
the IP address on the Search for Printers screen.

If the printer has not been found after searching it by the IP address, check network settings.

The prinbar Soukl not be dabao bed on B natwork

Ifthe printer's network s tup has not Bean comple b-d, oomple be e
nabwork g tup, end then cick Redetact

Too b how o Sat ap the seteork, chok lnstructions.,

Wrelers LAN Setup lnormaticn |

Inptructions | T | eich | Cwcel |
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Q

Cannot Proceed beyond Printer Connection Screen/Connect Cable
Screen

A

If you cannot proceed beyond the Printer Connection screen or the Connect Cable screen, check the
following.

Make sure USB cable is securely plugged in to printer and computer.

Connect the printer and the computer using a USB cable as the illustration below. The USB port is located at the
back of the printer.

L@gg
N
[

Check the items below only if you cannot proceed beyond the Printer Connection screen.

o A Follow procedure below to connect printer and computer again.

32 Important

* For Mac OS, make sure the lock icon is on the lower left of the Printers & Scanners screen (Print & Scan
screen in Mac OS X v10.8 or Mac OS X v10.7).

If the f] icon (locked) is displayed, click the icon to unlock. (The administrator name and the password
are necessary to unlock.)

1. Turn off printer.

2. Unplug USB cable from printer and computer and connect it again.
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3. Turn on printer.

If you cannot resolve problem, follow procedure below to reinstall printer driver.
» For Windows:
1. Click Cancel.
o If the Installation Failure screen appears:
1. Click Start Over.
2. Click Exit on Start Setup screen and finish setup.
o |If the Connection failed. screen appears:
1. Click Next.
2. Click Next on displayed screen.
3. Click Back to Top on Select Printer screen.
4. Click Exit on Start Setup screen and finish setup.
2. Turn off printer.
3. Restart computer.
4. Make sure you have no application software running.

5. Redo setup according to instructions on Canon website.

> Note

* You can use the Setup CD-ROM to redo setup.

* For Mac OS:
1. Click Next.
Click Exit on displayed screen and finish setup.
Turn off printer.
Restart computer.

Make sure you have no application software running.

o o ~ 0D

Redo setup according to instructions on Canon website.
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Searching Printer by IP Address or Host Name During Setup

If the printer cannot be found on the Select Printer screen, search for the printer by an IP address or host
name. Select Specify the IP address and run the search radio button and click Next. The screen to select
searching criteria appears.

1. Check printer's IP address or host name.

To check the printer's IP Address or host name, print out the network settings information or use the
operation panel to display it.

» Display on the touch screen.
= | AN settings
* Print the network settings.

= Printing Network Settings

12> Note

* If you use the printer in an office, ask the network administrator.

2. Specify searching method.

Select one of the method below.

)

Prigtm Search Method Saelection

® Search by IPvd address

) Search by IPvE address

) Search by host name

To specity an IF address and run the search, you must assign an IF address 1o the printer beforehand, For more details.
click [Ondine Manual]

Ondine Manual

Back ) Next )

1. Search by IPv4 address
Select to search for printers by IPv4 address.
2. Search by IPv6 address

Select to search for printers by IPv6 address.

759



3. Search by host name

Select to search for printers by host name. A host name is referred to as LLMNR host name or
Bonjour name.

3. Enter IP address or host name and click Next.

Printer search starts.

If an error screen appears:
Resolve the error according to the instruction on the screen.

If the IP address you entered is already used for another device, follow the procedure below to specify
printer's IP address.

1. Flick HOME screen and tap n Device settings.

= Menu Operations

2. Tap LAN settings.

If you specify the administrator password, enter the password.
3. Tap Other settings.

4. Tap TCPI/IP settings.

If you specify IPv4 address:
1. Tap IPv4.

2. Tap OK on the displayed screen.
3. Tap IP address.
4. Tap Manual setup.
Tapping Auto setup specifies the IP address automatically.

5. Enter IP address.
6. Tap OK.
7. Enter subnet mask.
8. Tap OK.
9. Enter default gateway.
0. Tap OK.

The IPv4 address has been specified.

If you specify IPv6 address:
1. Tap IPv6.

2. Tap OK on the displayed screen.
3. Tap Enable/disable IPv6.
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4. Tap Enable.

The IPv6 address has been specified.

32 Important

« If firewall is enabled on the computer, printers on a different subnet may not be detected. Disable
firewall.

If firewall interferes with printer search:

- If message appears:

If a message appears warning that Canon software is attempting to access the network, set the
security software to allow access.

After allowing the software to access, specify the IP address or host name and search for printers
again.

If the printer is found, follow the instructions on the screen to continue to set up the network
communication.
 If no message appears:

Cancel searching printers, and then set the security software to allow Canon software below to
access the network.

o For Windows:

Setup.exe or Setup64.exe in the win > Driver > DrvSetup folder on the Setup CD-ROM
o For Mac OS:

Setup.app, canonijnetwork.bundle, cnwidsd.plugin, cnwidss.plugin

After setting the security software, specify the IP address or host name and search for printers again.

»>» Note

» For more on firewall settings of your operating system or security software, see instruction manual or
contact its manufacturer.
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Installation Problems

* Removing Printer Software
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Q

Removing Printer Software

A Follow the steps below to remove utility software installed on the computer.

»2Important

* You must log in as an administrator or have administrator permissions.

»>»Note

» See the pages below for how to remove printer drivers.

= Deleting the Unnecessary Printer Driver (Windows)

= Delete the Unnecessary Canon IJ Printer from the Printer List (Mac OS)

Removing the IJ Network Device Setup Utility (Windows)

Follow the steps below to remove the IJ Network Device Setup Utility.

* Windows 10
1. Right-click the start button and open Control Panel.

2. Under Programs, select Programs and Features, select IJ Network Device Setup Utility from
the list of programs, and then click Uninstall.

* Windows 8.1 and Windows 8
1. Use the Settings charm on the desktop to open the Control Panel.

2. Under Programs, select Programs and Features, select |J Network Device Setup Utility from
the list of programs, and then click the Uninstall button.

¢ Windows 7 and Windows Vista
1. Select Control Panel from the start menu.

2. Select Uninstall a program.
3. Select IJ Network Device Setup Utility, and then click the Uninstall button.
3»Note

« If the User Account Control dialog box is displayed, click Yes.
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Other Problems

» The printer does not turn on

» The printer takes time to start up

« If the Printer Makes a Strange Sound

* Messages advising to check the maintenance cartridge are not cleared

* The printer consumes a lot of ink

 Printed pages are not collected cleanly in the basket

« When Trim edge first is set, the trimmed paper is drawn into the roll unit

* Ink Level Detection

764



Q

The printer does not turn on

Is the power cord plugged in?

Plug the power cord into the outlet, and then turn on the printer.

Is the specified voltage being supplied?
Check the voltage of the outlet and breaker.

=} Specifications
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Q

The printer takes time to start up

A The printer may have shut down incorrectly last time. This may happen after power outages or if the
printer is unplugged before it is turned off.

In this case, the next time power is restored, the printer's hard disk is checked, and startup may take some
time.

Please wait a while, because it may take several minutes to finish checking the hard disk.

If an error message is displayed after the hard disk check, follow the instructions indicated to resolve the
problem.
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Q

If the Printer Makes a Strange Sound

Has an unusual noise been produced from the vicinity of the roll holder?

If dust accumulates on the gear (A) at the end of the roll holder, a noise may produced from that area.

When the noise starts, clean the gear with the following procedure.
1. Remove the roll holder from the printer.
2. Wipe the dust off the gear with a damp, tightly wrung cloth, and then dry with a dry cloth.

3. Insert the roll holder in the printer.

Operating noise may be heard from the printer even when not printing.

The following sounds do not indicate a problem with the printer.

* A suction sound can be heard from the platen

To prevent the paper from rising, the surface of the platen has vacuum holes that create suction on the
paper.

* Roll paper makes a fluttering sound during printing.

There may be a fluttering sound when large paper is advanced.
* You suddenly hear the sound of cleaning operations.

Cleaning is automatically performed at specified intervals in order to keep the printer maintained.
* You suddenly hear the sound of ink agitation.

Ink is automatically agitated after specified intervals to maintain optimal print quality. Agitation takes
approximately 1 minute 30 seconds.

Ink is also agitated automatically at the following times. Please note that no other operations can be
performed while "Agitating the ink" is on the touch screen.
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o After the printer is turned on
o After data transmission
o After ink tank replacement

In other cases, contact your Canon dealer.
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Q

Messages advising to check the maintenance cartridge are not
cleared

A The newly replaced maintenance cartridge is not recognized.
Remove the newly replaced maintenance cartridge, and then reinsert it again firmly.

=) Replacing the Maintenance Cartridge
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Q

The printer consumes a lot of ink

Are lots of full-color materials being printed?

In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does not indicate a
problem with the printer.

Is System cleaning being carried out frequently?

System cleaning uses a lot of ink. This is normal. We recommend that you only carry out System cleaning
after the printer has been transported, if has not been used for a long time, or if there is a problem with the print
head.

You have just finished initial installation, when more ink is consumed to fill the system.

If using the printer for the first time, or using it after transport, the ink tank will supply an initial fill of ink to the print
head.

Although the amount of remaining ink may drop as a result, it does not indicate a problem.

Is the print head nozzle blocked?

Check for nozzle clogging.

=$ Checking for Nozzle Clogging
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Q

Printed pages are not collected cleanly in the basket

Is the roll unit in place?

The basket may not be able to catch printed paper properly if the roll unit is in place.
Refer to Example Basket Configurations and try another basket position.

=$ Example Basket Configurations

Is the basket in the right position for the media type and size?

The optimal basket position depends on factors such as media type and size and the conditions the printer is
being used under.

Refer to Example Basket Configurations and try another basket position.

=) Example Basket Configurations
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Q

When Trim edge first is set, the trimmed paper is drawn into the
roll unit

Is the basket in position 17?

If the roll unit is being used as a paper feeder and the basket is in position 1, the paper strip discarded by Trim
edge first for borderless printing or paper loading may get drawn into the roll unit.

In this situation, refer to Example Basket Configurations and try another position.

=$ Example Basket Configurations
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Q

Ink Level Detection

A The printer ink tank detects the amount of ink remaining to prevent running out of ink while printing
and to avoid printer failure.

=p |nk Tanks

When using an ink tank refilled with ink, the function for detecting the remaining ink level may not operate
properly and printing may stop. If you want to use an ink tank refilled with ink, you need to disable the
function for detecting the remaining ink level.

Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc.
is not liable for any damage that may occur as a result of refilling ink.

»2»Important

* Once the function for detecting the remaining ink level is disabled, it cannot be restored for that ink
tank. To restore the function for detecting the remaining ink level, replace the ink tank with a new ink
tank for that printer.

+ Repeatedly removing and inserting the same ink tank can cause the contacts between the ink tank and
printer to malfunction, ink may leak from the ink tank, and the printer may become damaged.

Releasing ink level detection
Ink level detection will be deactivated if you load ink tanks once emptied.

If The above ink tank may be an ink tank that ran out of genuine Canon ink or a counterfeit Canon
ink tank. appears on the touch screen, follow the steps below.

1. Move through the screens, performing the actions described in the messages that appear on the
touch screen.

2. If an instruction to disable detection of remaining ink appears on the touch screen, hold down the
Stop button for at least 5 seconds and then release it.

Ink level detection is now released.
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List of Support Code for Error

Support codes appear on the PC when an error occurs.
Support codes are error identification numbers that appear alongside error messages.

If an error occurs, check the support code and follow the recommended steps to resolve the issue.

Support code displayed
+ 1000 - 1222

1005 100A 100B 100E 100F 1012

1018 1019 1021 1022 1023 1024

1025 1051 1052 1054 1055 1056

1057 1061 1200 1201 1210 1213

1214 1300 1306 1317 1318 1322

1323 1324 1325 1401 1403 1408

1409 140A 140B 140C 140F 1477

1478 1480 1481 1485 1492 1494

1495 1500 1551 1552 1570 1571

1660 168B 1720 1721 1722 1730

1731 1752 1753 1756 1757 1875

» 2000 - 2777

2001 2002 2130 2131 2132

» 3000 - 3227

3000 3001 3101 3200 3201 3250

3306 3311 3312 3313 3314 3315

3316 3317 3330 3331 3332 3333

3334 3335 3336 3340 3341 3350

3351 3352 3414 3415 3416 3417

3418 3419 3420 3421 3422 3423

3424

* 4000 - 42727
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4107 4111

4112

4113

4114

4115

4116 4117

4118

4119

4120

4121

4801 4900

4901

4903

4905

4910

4911 4913

4920

4922

4924

4925

4926 4927

4931

4932

4933

4934

4935 4950

4951

4952

4953

4954

4955 4956

4957

4959

5000 - 5277

5106 5200 5A60 5A61 5B16 5B20

5B21 5C00

6000 - 62727

6502 6700

6702

6820

6900

6901

6902 6910

6911

6920

6921

6930

6931 6932

6933

6940

6941

6942

6943 6944

6945

6946

7000 - 7227

7001 7003

7004

7050

7051

7052

8000 - 8277

8200

9000 - 9277

9000 9110

A000 - 2277

B20A B510
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1005

Cause

You have attempted to print on a sheet, but no sheet is loaded.

What to Do

Check the media size and type for the print job on the touch screen, and then tap OK.

» Continuing to print
Tap Load paper., and then load the paper.

=$ | oading and Printing on Sheets

+ Stopping printing
To stop printing, tap Cancel on the touch screen or press the Stop button.
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100A

Cause

You have attempted to print on a roll, but no roll is loaded.

What to Do

Tap Load paper. on the touch screen, and then load the paper roll and print.

= | oading Rolls on the Roll Holder

=$ | oading the Upper Roll on the Printer
2»>»Note

+ To stop printing, tap Cancel on the touch screen or press the Stop button.
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100B

Cause

Tried to print from Roll paper 2 but no paper roll has been loaded.

What to Do

Tap Load paper. on the touch screen, and then load the paper roll and print.

= | oading Rolls on the Roll Holder

=$ | oading the Upper Roll on the Printer
2»>»Note

* To stop printing, tap Cancel on the touch screen or press the Stop button.
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100E

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC16-202E
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100F

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC21-2F6D
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1012

Cause

You have attempted to print on a sheet, but no sheet is loaded.

What to Do
Tap Load paper. on the touch screen, and then load cut paper and print.

= | oading and Printing on Sheets
2»>»Note

« To stop printing, tap Cancel on the touch screen or press the Stop button.
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1018

Cause

The Roll paper 1 feeder has not been calibrated.

What to Do

Calibrating, please remove the upper roll holder.
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1019

Cause

The roll unit feeder has not been calibrated.

What to Do

Calibrating, please remove the roll unit roll holder.
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1021

Cause

The printer has received a print job longer than the amount of roll paper left.

What to Do

» Continuing to print
To continue printing, tap Print with the loaded paper. on the touch screen.

However, the roll paper may run out during the print job and you may not be able to print all of the
document.

* Replacing paper
Tap Replace the paper and print on the touch screen.

Change the Paper Source in the printer driver, or replace the paper with paper of the right length for
the print job, and then try again.

If using the Media Take-up Unit, tap Cancel on the touch screen to stop printing.

Remove the printed paper from the Media Take-up Unit, replace the paper with paper of the right
length for the print job, and then try again.

=p Removing the Upper Roll from the Printer

= | oading the Upper Roll on the Printer

=$ Removing Printed Paper from the Roll Unit

+ Stopping printing
To stop printing, tap Cancel on the touch screen or press the Stop button.
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1022

Cause

Received a print job that is longer than the paper length remaining on Roll paper 1.

What to Do

» Continuing to print
To continue printing, tap Print with the loaded paper. on the touch screen.

However, the roll paper may run out during the print job and you may not be able to print all of the
document.

* Replacing paper
Tap Replace the paper and print on the touch screen.

Change the Paper Source in the printer driver, or replace the paper with paper of the right length for
the print job, and then try again.

If using the Media Take-up Unit, tap Cancel on the touch screen to stop printing.

Remove the printed paper from the Media Take-up Unit, replace the paper with paper of the right
length for the print job, and then try again.

=p Removing the Upper Roll from the Printer

= | oading the Upper Roll on the Printer

=$ Removing Printed Paper from the Roll Unit

+ Stopping printing
To stop printing, tap Cancel on the touch screen or press the Stop button.
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1023

Cause

Received a print job that is longer than the paper length remaining on Roll paper 2.

What to Do

» Continuing to print
To continue printing, tap Print with the loaded paper. on the touch screen.

However, the roll paper may run out during the print job and you may not be able to print all of the
document.

* Replacing paper
Tap Replace the paper and print on the touch screen.

Change the Paper Source in the printer driver, or replace the paper with paper of the right length for
the print job, and then try again.

=p Removing the Lower Roll from the Roll Unit (Option)

=$ | oading the Lower Roll on the Roll Unit (Option)

+ Stopping printing
To stop printing, tap Cancel on the touch screen or press the Stop button.
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1024

Cause

Possible causes include the following.

* The roll is empty.

» There is remaining roll paper, but because it could not be advanced, it could not be detected.

What to Do

» The roll paper has run out
Follow the steps below to replace the used roll with a new roll of the same type and size.

1.

Lift up the release lever and remove the roll paper.

=$ Removing the Upper Roll from the Printer

=p Removing Rolls From the Roll Holder

. Load the new roll.

= | oading Rolls on the Roll Holder

=P | pading the Upper Roll on the Printer

. If no barcode was printed on the roll, specify the paper type.

=$ Changing the Type of Paper

. If Manage remaining roll amount is set to Enable in the touch screen menu and there is no

barcode printed on the paper roll, set the paper length.

=) Specifying the Paper Length

. If "There is a job whose printing is not complete. Do you want to print this job?" appears on

the touch screen, tap Yes. Printing will resume, starting from the page on which the error
occurred.

» Feed stopped because the end of the paper roll is attached to the core with tape
Remove the used roll paper and insert a new roll paper.

=p Removing the Upper Roll from the Printer

=p Removing Rolls From the Roll Holder

=$ | oading and Printing on Rolls

» Feed stopped because the remaining paper roll is too heavy
It may be helpful to change the printing mode, which will change the paper feed timing.

If using Windows, select a higher Print Quality setting under Advanced Settings in the printer driver.

If using Mac OS, select Quality & Media in the printer driver, and then select a higher Print Quality
setting.

= Setting the Print Quality Level (Custom) (Windows)

=} Setting the Print Quality Level (Custom) (Mac OS)
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2»>»Note

« To stop printing, press the Stop button.
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1025

Cause

Roll paper 2 is empty.

What to Do

Follow the steps below to replace the used roll with a new roll of the same type and size.
1. Lift up the release lever and remove the roll paper.

=$ Removing the Lower Roll from the Roll Unit (Option)

=) Removing Rolls From the Roll Holder

2. Load the new roll.

= | oading Rolls on the Roll Holder

=p | oading the Lower Roll on the Roll Unit (Option)

3. If no barcode was printed on the roll, specify the paper type.

=$ Changing the Type of Paper

4. If Manage remaining roll amount is set to On in the touch screen menu and there is no barcode
printed on the paper roll, set the paper length.

=} Specifying the Paper Length

5. If "There is a job whose printing is not complete. Do you want to print this job?" appears on the
touch screen, tap Yes. Printing will resume, starting from the page on which the error occurred.

2»>»Note

* To stop printing, press the Stop button.
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1051

Cause

The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
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1052

Cause

The width of the roll paper set in Fit Roll Paper Width in the printer driver is not the same as the width of
the roll paper loaded in the printer.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
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1054

Cause

The paper in the printer is smaller than the paper size set in the printer driver.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
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1055

Cause

The paper size in the printer cannot be printed borderless.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
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1056

Cause

The paper position is not suitable for borderless printing.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
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1057

Cause

The paper position is not suitable for borderless printing.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
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1061

Cause

The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do

Tap OK on the touch screen.

Make sure that the media type that appears on the touch screen is the same as the media type that has
been loaded, and then tap OK.

* Printing again
Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Cancel on the touch screen to stop printing.

2. Change the media type in the printer driver settings to the media type loaded in the printer, and
then try again.

* Replacing paper
Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Replace the paper and print on the touch screen.
2. Load the printer with the media type specified in the printer driver.

= | oading and Printing on Rolls

=p | oading and Printing on Sheets

» Printing without changes
To continue printing, tap Print with the loaded paper. on the touch screen.

However, note that this error may cause paper jams and affect the printing quality.

796



1200

Cause

Top cover or print head locking cover is open.

What to Do

Open the top cover and make sure the print head locking cover is closed properly.
Make sure there are no foreign objects caught in the top cover, and then close the top cover.

If this error appears again, close the top cover, turn the power off, wait a moment, and then turn the power
back on.

»»Note

« If installing a print head, close the top cover after finishing.
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1201

Cause

The ink tank cover is open.

What to Do

Close the ink tank cover.
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1210

Cause

The ink tank cover is open.

What to Do

Close the ink tank cover.
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1213

Cause

The release lever is raised.

What to Do

Lower the release lever.

If the error occurs again, turn off the printer and wait a while before restoring power.
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1214

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes

EC19-2F21 EC51-2F38
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1300

Cause

Paper jammed inside the printer while printing.

What to Do

1. Release the release lever and remove the jammed paper.

=) Clearing Jammed Roll Paper

=$ Clearing a Jammed Sheet

2. Load the paper.

=) | oading the Upper Roll on the Printer

= | oading Sheets in the Printer

3. If "There is a job whose printing is not complete. Do you want to print this job?" appears on the
touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.
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1306

Cause

A print job for rolls was received when a sheet is loaded.

What to Do
Follow these steps to load and print on a roll.
1. To remove the cut paper, tap Remove paper on the touch screen.

=p Removing Sheets

2. Load a new roll.

=$ | pading the Upper Roll on the Printer
2»>»Note

* To stop printing, tap Cancel on the touch screen or press the Stop button.
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1317

Cause

Paper loaded crooked was detected when the paper was advanced.

What to Do

Lift up the release lever and reload the paper.

= | oading the Upper Roll on the Printer

=$ | oading the Lower Roll on the Roll Unit (Option)

=$ | oading Sheets in the Printer

If this error appears again even after reloading the paper roll, remove the roll holder from the printer, insert
the paper roll firmly into the roll holder until it is up against the flange, and then insert the roll holder into
the printer.

=$ | oading Rolls on the Roll Holder
»2»Important

« If this message continues to appear even after taking the steps above, or if you do not want this
message to appear, set Skew detection accuracy in the printer menu to Off or Loose. However,
note that the paper will be printed skewed, which could cause paper jams and abnormal print results,
or dirty the platen and the reverse of the next printed sheet.
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1318

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
ECOF-2F93
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1322

Cause

Cannot detect paper size because paper is not in the correct position or because curled paper has been
loaded.

What to Do

Lift up the release lever and reload the paper.

=$ | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

=p | oading Sheets in the Printer

If "There is a job whose printing is not complete. Do you want to print this job?" appears on the
touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

2»»Note

« If this error appears again even after reloading the paper roll, remove the roll holder from the printer,
insert the paper roll firmly into the roll holder until it is up against the flange, and then insert the roll
holder into the printer.

= | oading Rolls on the Roll Holder

» This error might also appear if the platen has been dirtied by ink or another substance, or if the size
of clear film could not be detected. In this case, open the top cover and clean the entire platen area.

= Cleaning Inside the Top Cover
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1323

Cause

An unsuitable paper size has been loaded.

What to Do
Lift up the release lever and reload paper of suitable size.
= Paper Sizes

32»Note

» Load unused A4/letter size or larger paper if printing calibration and nozzle check patterns. Each
calibration may take several sheets of paper.
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1324

Cause

A print job for printing on sheets was sent when a roll is loaded.

What to Do

Follow the steps below to print again.
1. Tap Remove paper on the touch screen to stop printing.

2. Remove the paper roll, load cut paper of the size and type specified in the printer driver, and then try
again.

=P Removing the Upper Roll from the Printer

=) | oading and Printing on Sheets

2»>»Note

« To stop printing, tap Cancel on the touch screen or press the Stop button.
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1325

Cause

Received cut paper print data when using roll paper on roll equipment.

What to Do

Follow the steps below to print again.
1. Tap Cancel on the touch screen to stop printing.

2. Remove the paper roll, load cut paper of the size and type specified in the printer driver, and then try
again.

=) Removing Printed Paper from the Roll Unit

=) | oading and Printing on Sheets
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1401

Cause

Failed to recognize print head.

What to Do

Open the top cover and reattach the print head.

=p Replacing the Print Head
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1403

Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

=p Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1408

Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

=p Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1409

Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

=p Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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140A

Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

=p Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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140B

Cause

Failed to recognize print head.

What to Do

Open the top cover and reattach the print head.

=p Replacing the Print Head
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140C

Cause

There is a problem with the print head.

What to Do

Turn off the power, wait a moment, and then turn it back on.
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140F

Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

=p Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.

817



1477

Cause

There is a problem with the print head.

What to Do

Open the top cover and replace theprint head with a new one.

=p Replacing the Print Head
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1478

Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

=p Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1480

Cause

The attached print head was previously used in a different model.

What to Do
Attach the correct print head.

=p Replacing the Print Head
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1481

Cause

The attached print head was previously used in a model that uses a different ink set.

What to Do
Attach the correct print head.

=p Replacing the Print Head
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1485

Cause

Cannot use attached print head.

What to Do
Attach the correct print head.

=p Replacing the Print Head
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1492

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes

EC3F-2F40 EC3F-2F41
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1494

Cause

There may be a problem with the print head.

What to Do

Turn off the power, wait a moment, and then turn it back on.
If the error appears again, remove and reattach the print head.

=p Replacing the Print Head

If that does not get rid of the error, replace the print head with a new one.
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1495

Cause

The print head nozzle is blocked.

What to Do

Follow the steps below to clean the print head.
1. Tap Cancel on the touch screen to stop printing.
2. Clean the print head.
=p Cleaning the Print Head

If this message still appears when printing, replace the print head.

= Replacing the Print Head
»2»Important

+ To continue printing, use the touch screen and tap Continue printing. However, the print results may
not be satisfactory.
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1500

Cause

The ink in the ink tank is running low.

What to Do

Prepare a new ink tank.
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1551

Cause

A genuine Canon ink tank with a history of past use has been detected.

What to Do

To dismiss the message, tap OK on the touch screen.
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1552

Cause

A genuine Canon ink tank has been inserted.

What to Do

To dismiss the message, tap OK on the touch screen.
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1570

Cause

The ink in the ink tank has run out.

What to Do

Open the ink tank cover, and then replace the ink tank before the ink in the sub-ink tank of this printer
becomes insulfficient.

=} Replacing Ink Tanks
2»>»Note

* You can replace the ink tank even while printing.
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1571

Cause

Ink tank removed during printing.

What to Do

If replacing the ink tank, insert a new ink tank.

=p Replacing Ink Tanks
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1660

Cause

Ink tank not inserted.

What to Do

Insert the ink tank correctly.

=p Replacing Ink Tanks
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168B

Cause
The ink tank cannot be recognized.

Printing cannot be executed because the ink tank may not be compatible with this printer.

What to Do

Install the appropriate ink tank.
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1720

Cause
The maintenance cartridge is full.

It needs to be replaced.

What to Do

Replace the maintenance cartridge.

= Replacing the Maintenance Cartridge
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1721

Cause

The maintenance cartridge is not installed.

What to Do

Install the maintenance cartridge.

=) Replacing the Maintenance Cartridge
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1722

Cause

Incorrect type of maintenance cartridge.

What to Do

Insert the correct maintenance cartridge.

=) Replacing the Maintenance Cartridge

If this error continues to appear, contact a Canon customer service center.

835



1730

Cause

The ink tank may be an ink tank that ran out of genuine Canon ink or a counterfeit Canon ink tank.

What to Do

To print, you must replace the ink tank or disable the function for detecting the remaining ink level.

To disable the function for detecting the remaining ink level, press and hold the printer's Stop button for at
least 5 seconds, and then release it.

By this operation, the fact that you have disabled the function for detecting the remaining ink level will be
memorized. Please be advised that Canon shall not be liable for any malfunction or trouble caused by
continuation of printing under the ink out condition or by using refilled ink tanks.

2»»Note

« |f the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the
LCD when checking the current ink level.

To report the counterfeit ink tank, access Canon website from the following link.

= Report Counterfeit
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1731

Cause

Non-genuine Canon ink tank has been detected.

What to Do

To print, you must replace the ink tank or disable the function for detecting the remaining ink level.

To disable the function for detecting the remaining ink level, press and hold the printer's Stop button for at
least 5 seconds, and then release it.

By this operation, the fact that you have disabled the function for detecting the remaining ink level will be
memorized. Please be advised that Canon shall not be liable for any malfunction or trouble caused by
using a non-genuine Canon ink tank.

2»»Note

« |If the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the
LCD when checking the current ink level.

To report the counterfeit ink tank, access Canon website from the following link.

= Report Counterfeit
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1752

Cause

The ink has run out.

What to Do

Open the ink tank cover, and then replace the ink tank.

=p Replacing Ink Tanks
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1753

Cause

The remaining level of the ink cannot be correctly detected.

What to Do
Replace the ink tank. Printing will restart.

=p Replacing Ink Tanks

An ink tank that was once empty is installed.

If you want to continue printing, you need to disable the function for detecting the remaining ink level.

To disable this function, press and hold the printer's Stop button for at least 5 seconds, and then release
it.

By this operation, the fact that you have disabled the function for detecting the remaining ink level will be

memorized.

Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of
printing under the ink out condition or by using refilled ink tanks.
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1756

Cause

The ink may become insufficient.

What to Do
To perform the next process or to continue the specified process, replace the ink tank.

=p Replacing Ink Tanks
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1757

Cause

Cannot fill ink reserve tank.

What to Do
Check the touch screen, remove the ink tank for the affected color, and then reinsert it.
If the inserted ink tank is empty, replace it with a new ink tank.

= Replacing Ink Tanks
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1875

Cause

Attempted to print on roll unit roll paper, but roll unit is not powered on or has been removed.

What to Do

Turn off the power and check the connection with the roll unit.
= Roll Unit

= Switching Roll Unit Modes
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2001

Cause

An incompatible device is connected.

What to Do

Check the device connected to the USB flash drive port.

Only USB flash drive can be connected to this device for direct printing.
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2002

Cause

An incompatible USB hub is connected.

What to Do
If USB flash drive is connected to this device through a USB hub, remove the USB hub.
Connect the USB flash drive directly to this device.
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2130

Cause

The roll paper width set in the print job is not the same as the width of the roll paper in the printer.

What to Do
Tap OK on the touch screen.
Check the Page size and Type in the print job that appears on the touch screen, and then tap OK.

« Continuing to print
Tap Print with the loaded paper. to go ahead and print on the loaded paper.

However, note that this error may cause paper jams and affect the printing quality.

* Replacing the paper roll and printing
Tap Replace the paper and print, and then replace the paper with roll paper of the width specified in
the print job Page size settings.

=$ Removing the Upper Roll from the Printer

=$ Removing the Lower Roll from the Roll Unit (Option)

=$ Removing Rolls From the Roll Holder

= | oading Rolls on the Roll Holder

=) | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

» Stopping printing
Tap Cancel on the touch screen or press the Stop button.
3»Note

» To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll
paper width in the dialog box that appears.

» To change print settings in Mac OS, open the printer driver and select Fit Roll Paper Width, and then
set the roll paper width in that panel to the width of the paper loaded in the printer.

» To suppress this message, set Detect paper setting mismatch in the touch screen menu to Do not
detect.

=$ \Menu Structure
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2131

Cause

The roll paper loaded in the printer is narrower than the roll paper width in the print job.

What to Do
Check the Page size and Type in the print job that appears on the touch screen, and then tap OK.

» Continuing to print
Tap Print with the loaded paper. to go ahead and print on the loaded paper.

However, note that this error may affect the printing quality.

* Replacing the paper roll and printing
Tap Replace the paper and print, and then replace the paper with roll paper of the width specified in
the print job Page size settings.

= Removing the Upper Roll from the Printer

=$ Removing the Lower Roll from the Roll Unit (Option)

=p Removing Rolls From the Roll Holder

= | oading Rolls on the Roll Holder

=$ | oading the Upper Roll on the Printer

=} | oading the Lower Roll on the Roll Unit (Option)

« Stopping printing
Tap Cancel on the touch screen or press the Stop button.
3>»Note

» To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll
paper width in the dialog box that appears.

» To change print settings in Mac OS, open the printer driver and select Fit Roll Paper Width, and then
set the roll paper width in that panel to the width of the paper loaded in the printer.

» To suppress this message, set Detect paper setting mismatch in the touch screen menu to Do not
detect. However, note that this error may affect the printing quality.

=$ \Menu Structure

846



2132

Cause

Cannot print internal printer data, such as test prints, for the following reasons.
* The paper roll loaded in the printer is too small.

» The cut paper loaded in the printer is the wrong size or type.

What to Do

* Roll
Tap Replace the paper and print on the touch screen, or lift up the release lever and replace the

paper with paper of the correct size.

To stop printing, tap Cancel or press the Stop button.

» Sheet
Lift up the release lever and load paper of the same size and type as the first page.

To stop printing, press the Stop button.
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3000

Cause

The print head has not been calibrated.

What to Do

Print head alignment is recommended.

=) Adjusting the Print Head
2»>»Note

» This message will appear until Print head alignment is carried out.
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3001

Cause

The print head nozzle is becoming blocked.

What to Do
Check the printed materials.
If the printed materials are scratched, clean the print head.

=} Cleaning the Print Head
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3101

Cause
Common Calibration or Unique Calibration is now recommended.

This message appears when the Calibration guide setting is set to Enable and any of the following
apply.
» The printer is loaded with a media type not suitable for Color Calibration, and the specified
conditions have been met since the last time Common Calibration was carried out.

» The printer is loaded with a media type suitable for Color Calibration, but there are no Color
Calibration results for that media type and the specified conditions have been met since the last time
Common Calibration was carried out.

» The printer is loaded with a media type suitable for Color Calibration, but there are no Color
Calibration results for that media type and also no Common Calibration results.

What to Do

Carry out Common Calibration as needed.

= Performing Color Calibration
2»>»Note

 To suppress this message, set the Calibration guide setting in the touch screen menu to Disable.

=$ \enu Structure
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3200

Cause

It is almost time to replace consumables for which service is required.

What to Do
This can used for a little while, until the message "Part replacement needed." appears.

Contact your Canon dealer for assistance.
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3201

Cause

It is past the recommended time to replace consumables for which service is required.

What to Do

Contact your Canon dealer for assistance.
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3250

Cause

The maintenance cartridge is almost full.

What to Do

Prepare a new maintenance cartridge because an error may occur if you continue to use the printer while
the maintenance cartridge is full.

= Replacing the Maintenance Cartridge

853



3306

Cause

Media information cannot be recognized because the printer media information is corrupt.

What to Do

Start the Media Configuration Tool, and then recover the media information.
=» Media Configuration Tool Guide (Windows)

=» Media Configuration Tool Guide (Mac OS)

To set the Media Configuration Tool to recovery mode, open the Media Configuration Tool, select this
device and then click OK.

Select and load the media information backup file.

If you do not have a media information backup file, contact a Canon customer service center.
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3311

Cause
Incorrect print data.

lllegal number of parameters.

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3312

Cause
Incorrect print data.

Required items have been omitted.

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3313

Cause
Incorrect print data.

Data out of range.

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3314

Cause
Incorrect print data.

Resolution value out of range.

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3315

Cause
Incorrect print data.

Compression method value out of range.

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3316

Cause
Incorrect print data.

Incorrect data formatting (color sequence, bit count).

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3317

Cause
Incorrect print data.

lllegal combination of resolution and image data format.

What to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3330

Cause

Print data may be corrupt.

What to Do
Check the print job.
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3331

Cause

Print results may be abnormal as there is a large volume of print data.

What to Do
Check the print job.
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3332

Cause

Unsupported JPEG data format.

What to Do

Print from a PC.
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3333

Cause

Unsupported JPEG data format.

What to Do
Print from a PC.
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3334

Cause

PDF data is print protected.

What to Do

Open the PDF file in Adobe Acrobat and make sure it can be printed.
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3335

Cause

Corrupt PDF file.

What to Do
Open the PDF file in Adobe Acrobat and check it.

The file can also be printed from Adobe Acrobat.
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3336

Cause

Fonts were substituted because the fonts in the PDF file are not embedded or installed.

What to Do

Set the fonts used in the PDF file to be embedded, and then save again.
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3340

Cause

Print data contains no image processing parameters.

What to Do
Check the print job settings.
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3341

Cause

Print data contains illegal image processing table.

What to Do

Check the print job image processing table.
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3350

Cause

Free space on the personal box on the printer hard disk is less than 1 GB.

What to Do

Delete unneeded jobs stored in personal boxes.

= Deleting Saved Jobs
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3351

Cause

100 jobs are stored in the Personal Box.

What to Do
Delete any unneeded jobs saved in the personal box.

= Deleting Saved Jobs
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3352

Cause
The printer hard disk is full, so the job will only be printed.
(The print job will not be saved to the hard disk.)

What to Do

To save the print job, delete any unneeded jobs saved in the personal box.

= Deleting Saved Jobs
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3414

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the address and port numbers of the sending mail server (SMTP server) are correct in the
RemoteUl mail server settings.

= Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3415

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the address and port numbers of the receiving mail server (POP3 server) are correct in the
RemoteUl mail server settings.

= Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3416

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.
Check that the mail server and device secure connection (SSL) settings match.
Check the secure connection (SSL) settings in RemoteUl.

= Setting Mail Server

Contact the mail server administrator to configure a secure connection (SSL) to the mail server.
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3417

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.
Check that the mail server and device secure connection (SSL) settings match.
Check the secure connection (SSL) settings in RemoteUl.

= Setting Mail Server

Contact the mail server administrator to configure a secure connection (SSL) to the mail server.
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3418

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the sending mail server (SMTP server) is correctly configured in the RemoteUl mail server
settings.

= Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3419

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the sending account and password are correctly configured in the RemoteUl mail server
settings.

= Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3420

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the receiving mail server (POP3 server) is correctly configured in the RemoteUl mail server
settings.

= Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3421

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the receiving account and password are correctly configured in the RemoteUIl mail server
settings.

= Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3422

Cause

Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the settings on the mail server and the APOP settings on this device match.
Check this device's APOP settings in RemoteUl.

=) Setting Mail Server

Contact the mail server administrator for configuring APOP on the mail server.
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3423

Cause

Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.
Check if the RemoteUl mail server settings are correct.

=p Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3424

Cause

Sending mail failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Specify the correct destination mail address and try again
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4107

Cause
Possible causes include the following.
» Received print job for upper roll paper while lower roll paper is in use.

» Received print job for lower roll paper while upper roll paper is in use.

What to Do

Tap OK on the touch screen to dismiss the error.

Remove the printed matter, and then try again.
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4111

Cause

The media type specified is incompatible with this device.

What to Do

Tap OK on the touch screen to dismiss the error.

Check the media type settings, and then try again.
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4112

Cause

Received a print job specifying paper feed from the roll unit, but the roll unit is not set to paper feed.

What to Do
To stop printing, tap OK on the touch screen or press the Stop button.
Check the roll unit settings, and then try again.

= Switching Roll Unit Modes
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4113

Cause
Cannot print borderless for the following reasons.
 Printer driver is not set to Fit Roll Paper Width.

* Roll paper is not wide enough, or the paper is out of position.

What to Do

 Stopping printing
Tap Cancel on the touch screen.

* Replacing paper
Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

=$ Removing the Upper Roll from the Printer

=P Removing the Lower Roll from the Roll Unit (Option)

=) Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

=) | oading Rolls on the Roll Holder

=} | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.
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4114

Cause

The paper position is not suitable for borderless printing.

What to Do

» Stopping printing
Tap Cancel on the touch screen.

* Replacing paper
Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

=$ Removing the Upper Roll from the Printer

=$ Removing the Lower Roll from the Roll Unit (Option)

=p Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

= | oading Rolls on the Roll Holder

= | pading the Upper Roll on the Printer

=p | oading the Lower Roll on the Roll Unit (Option)

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

2»»Note

» Because paper expands or contracts depending on the environment of use, it may become narrower
or wider than the supported width for borderless printing.

Use each media type under the appropriate usage conditions. See the media information list for
usage conditions.

= Paper Information List
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4115

Cause

The paper in the printer cannot be printed borderless.

What to Do

+ Stopping printing
Tap Cancel on the touch screen.

* Replacing paper
Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

=$ Removing the Upper Roll from the Printer

=$ Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

= | oading Rolls on the Roll Holder

=p | pading the Upper Roll on the Printer

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.
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4116

Cause

The paper is loaded askew.

What to Do

* Reloading paper
Tap Replace the paper and print on the touch screen, and then load the paper so that the edges are
inside the borderless printing ink grooves.

Insert the roll paper firmly until it is against the roll holder flange.

= | oading Rolls on the Roll Holder

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

» Stopping printing
Tap Cancel on the touch screen to stop printing.

2»»Note

 To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not
detect.

However, note that this error may affect the printing quality.
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4117

Cause

The print job received specifies a type or width of paper that is not compatible with borderless printing.

What to Do

» Changing the print job settings
Follow these steps to change the settings of the print job to enable borderless printing.

1. Tap Cancel on the touch screen to stop printing.
2. Check that the printer driver for the printer has been selected, and then try again.
See the media information list for media types compatible with borderless printing.

= Paper Information List

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

2»>»Note

« To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not
detect.

However, note that this error may affect the printing quality.
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4118

Cause

The paper size in the printer cannot be printed borderless.

What to Do

» Stopping printing
Tap Cancel on the touch screen to stop printing.

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

2»>»Note

» See the media information list for media types compatible with borderless printing.

= Paper Information List
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4119

Cause

Cannot print borderless because the paper is out of position.

What to Do

* Reloading paper
Lift up the release lever and reload the roll paper.

=$ | oading the Upper Roll on the Printer

=} | oading the Lower Roll on the Roll Unit (Option)

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

 Stopping printing
Tap Cancel on the touch screen to stop printing.
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4120

Cause

The print job received specifies a type or width of paper that is not compatible with borderless printing.

What to Do

» Changing the print job settings
Follow these steps to change the settings of the print job to enable borderless printing.

1. Tap Cancel on the touch screen to stop printing.

2. Check that the printer driver for the printer has been selected, and then try again.
See the media information list for media types compatible with borderless printing.
= Paper Information List

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

2»>»Note

* To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not
detect.

However, note that this error may affect the printing quality.

895



4121

Cause
Cannot print borderless for the following reasons.
* Fit Roll Paper Width is not specified in the printer driver.

* Roll paper is not wide enough, or the paper is out of position.

What to Do

» Stopping printing
Tap Cancel on the touch screen to stop printing.

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.
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4801

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch

screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC01-2F90 ECO01-2F95 ECO04-2F31 EC04-2F91 ECO05-2F92 EC06-2F9A
EC06-2F9B ECO06-2F9C ECO07-2F19 ECOF-2F96 EC11-2F2A EC12-2F29
EC12-2F2B EC12-2F2C EC13-2F17 EC15-2E23 EC16-2021 EC16-2022
EC16-2027 EC16-202A EC16-2038 EC17-2023 EC17-2024 EC17-2028
EC17-2029 EC17-2039 EC1B-2030 EC1B-2031 EC1B-2032 EC1B-2033
EC1C-2034 EC1C-2035 EC1C-2036 EC1C-2037 EC21-2F51 EC21-2F54
EC21-2F57 EC21-2F59 EC21-2F5B EC21-2F5D EC21-2F61 EC21-2F64
EC21-2F66 EC21-2F67 EC21-2F68 EC21-2F6E EC21-2F70 EC21-2F71
EC21-2F72 EC21-2F7D EC22-2F30 EC22-2F47 EC23-260E EC23-260F
EC23-2F11 EC23-2F18 EC23-2F32 EC25-2F16 EC31-2F09 EC31-2F10
EC31-2F1B EC31-2F1C EC31-2F1D EC31-2F1E EC31-2F1F EC31-2F22
EC31-2F23 EC31-2F94 EC33-2601 EC33-2604 EC33-2F3A EC34-2602
EC34-2605 EC34-2F3B EC35-2603 EC35-2606 EC35-2F3C EC51-2F14
EC51-2F15 EC51-2FDD EC51-2FDE EC51-2FDF EC51-3301 EC51-3302

EC51-3303 EC54-290A EC55-2F20 EC58-2F12
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4900

Cause
The printer hard disk is full.

What to Do
Press the Stop button to stop printing, and then take the following action.
» Cancel the Print job in the job queue.

= \anaging Job Queue (Deleting or Preempting Other Jobs)

» Delete unneeded jobs stored in personal boxes.

=% Deleting Saved Jobs
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4901

Cause

The printer hard disk has not been formatted.

What to Do

Tap OK on the touch screen to begin formatting the hard disk.

When formatting is complete, the data on the hard disc will be erased and the printer will automatically
restart.
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4903

Cause

The maximum number of jobs have been saved in the box.

What to Do
Take the actions below.
» Cancel the Print job in the job queue.

= \anaging Job Queue (Deleting or Preempting Other Jobs)

» Delete unneeded jobs stored in personal boxes.

=% Deleting Saved Jobs
2»>»Note

« To stop printing, press the Stop button.
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4905

Cause

A printer error has occurred.

What to Do

Turn the power off, wait a moment, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed code

EC51-3304 EC51-3306 EC51-3307 EC51-3308 EC51-3309 EC51-330A
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4910

Cause

The width of the roll paper set in Fit Roll Paper Width in the printer driver is not the same as the width of
the roll paper loaded in the printer.

What to Do
Tap OK on the touch screen to go to the next screen.
Check the media type and size that appear and tap OK.

* Printing without changes
Tap Print with the loaded paper. on the touch screen.

However, note that this error may cause paper jams and affect the printing quality.

+ Stopping printing
Tap Cancel on the touch screen to stop printing.

* Replacing the roll paper
Follow the steps below to replace the paper with roll paper of the width set in the printer driver.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

=) Removing the Upper Roll from the Printer

=$ Removing the Lower Roll from the Roll Unit (Option)

=$ Removing Rolls From the Roll Holder

2. Replace the paper with paper of the width set in the printer driver.

= | oading Rolls on the Roll Holder

= | oading the Upper Roll on the Printer

= | oading the Lower Roll on the Roll Unit (Option)

Printing begins.
3»Note

» To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll
paper width in the dialog box that appears.

» To change print settings in Mac OS, open the printer driver and select Fit Roll Paper Width, and then
set the roll paper width in that panel to the width of the paper loaded in the printer.
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4911

Cause

The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do

» Changing the printer driver print settings
Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Cancel on the touch screen to stop printing.

2. Change the media type in the printer driver settings to the media type loaded in the printer, and
then try again.

* Replacing paper
Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Cancel on the touch screen to stop printing.
2. Load the printer with the media type set in the printer driver, and then try again.

=p | oading and Printing on Rolls

=) | oading and Printing on Sheets

* Printing without changes
To continue printing, tap Print with the loaded paper. on the touch screen.

However, note that this error may cause paper jams and affect the printing quality.
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4913

Cause
Cannot print borderless for one of the following reasons.
» The paper size in the printer cannot be printed borderless.

* The paper is loaded askew.

What to Do

* Replacing paper
Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

= Removing the Upper Roll from the Printer

=p Removing the Lower Roll from the Roll Unit (Option)

=) Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

= | oading Rolls on the Roll Holder

=) | oading the Upper Roll on the Printer

=} | oading the Lower Roll on the Roll Unit (Option)

Printing begins.
3»>»Note

» See the media information list for media types compatible with borderless printing.

= Paper Information List

* Reloading paper
Tap Replace the paper and print on the touch screen, and then load the paper so that the edges are
inside the borderless printing ink grooves.

Insert the roll paper firmly until it is against the roll holder flange.

=} | oading Rolls on the Roll Holder

* Printing with a border
Tap Print with border on the touch screen.

Printing with a border is now enabled.

» Stopping printing
Tap Cancel on the touch screen to stop printing.
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4920

Cause

Cannot cut paper for one of the following reasons.
» Paper that has been cut remains on the output guide.
» There is a foreign object near the output slot that is obstructing the cutter blade.
» The paper is not being used under the recommended usage conditions.

» The paper in use cannot be used with Automatic Cutting.

What to Do

» Paper that has been cut remains on the output guide
Follow the steps below to resume printing.

1. Lift up the release lever and remove the paper.
2. Load the paper.

3. Lower the release lever.

4

. If "There is a job whose printing is not complete. Do you want to print this job?" appears on
the touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

=) | oading the Upper Roll on the Printer

» A foreign object near the output slot is obstructing the cutter blade
Follow the steps below to resume printing.

1. Open the top cover and remove any foreign objects.

2. If "There is a job whose printing is not complete. Do you want to print this job?" appears on
the touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

» Paper not being used under the recommended usage conditions
Every paper type has different recommended conditions of use. Use all paper under its recommended
usage conditions.

See the media information list for recommended usage conditions.
= Paper Information List

» The paper in use cannot be used with Automatic Cutting
Set the roll paper cutting method to User cut and cut the roll paper with a cutting implement such as
SCissors.

=p Specifying the Cutting Method for Rolls

See the media information list for paper types that can be used with Automatic Cutting.

= Paper Information List
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If this does not apply, there may be a cutter blade malfunction.

Contact your Canon dealer for assistance.
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4922

Cause
The Media Take-up Unit cannot roll the paper for one of the following reasons.
» A paper jam has occurred and the roll cannot be rewound.

» The Media Take-up Unit malfunctioned.

What to Do

» The take-up unit's permitted capacity is exceeded
Remove paper from the take-up unit.

Tap OK on the touch screen to dismiss the error.

2»>»Note

* You can wind the paper until the outer diameter of the wound paper is the same as the outer
diameter of the paper core.

» Paper is jammed or could not be rolled
Remove the paper from the Media Take-up Unit.

Tap OK on the touch screen to dismiss the error.

»P»Note

» When printing on light-weight paper or with borderless printing, if the paper's border becomes
ruffled, it may come in contact with the roll holder, resulting in poor winding. If this problem occurs
when winding using a 2-inch paper core, remove the spacer that is held onto the roll holder
flange with 4 hex screws.

* Media Take-up Unit malfunction
Contact your Canon dealer for assistance.

»2»Important

* Printing will pause if there is a Media Take-up Unit error. If you do not want to printing to stop, set
Skip errors during take-up to ON. However, note that this error may cause paper jams and affect
the printing quality.
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4924

Cause

Paper loaded is not suitable for Color Calibration.

What to Do

Follow the steps below to repeat Color Calibration.
1. Tap OK on the touch screen to dismiss the error.
2. Load paper suitable for Color Calibration.

See the media information list for suitable paper.
=» Paper Information List

Make sure the paper in the printer is the same as that in the printer media type settings. The printer will
not calibrate properly if the loaded paper and media type settings are not the same.
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4925

Cause

The performance of some internal printer sensors may be affected.

What to Do

Tap OK on the touch screen to stop Color Calibration.

Contact your Canon dealer for assistance.
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4926

Cause

The supplied paper size is not suitable for Color Calibration.

What to Do
Tap OK on the touch screen to stop Color Calibration.
Load a paper size suitable for Color Calibration, and then repeat Color Calibration.

=p Managing Colors

=p Performing Color Calibration
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4927

Cause
Color calibration may have failed for the following reasons.
» The paper for printing a test pattern is soiled. Otherwise, you have loaded colored paper.

» The printer may be exposed to strong light, such as direct sunlight, which can cause the sensors to
malfunction.

» The test pattern was printed too faintly.

What to Do

Tap OK on the touch screen to dismiss the error, and then take the following actions.
» Load unused paper suitable for Color Calibration.
* Make adjustments to ensure that the printer is not exposed to strong light.
* Print a nozzle check pattern to check the print head status.
If the pattern has gaps or horizontal white lines, the print head nozzle is blocked. Clean the print head.

=$ Checking for Nozzle Clogging
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4931

Cause
Paper feed adjustment may have failed for the following reasons.
» The paper for printing a test pattern is soiled. Otherwise, you have loaded colored paper.

» The printer may be exposed to strong light, such as direct sunlight, which can cause the sensors to
malfunction.

» The test pattern was printed too faintly.

What to Do

Tap OK on the touch screen to dismiss the error, and then take the following actions.
» Load unused paper.
* Make adjustments to ensure that the printer is not exposed to strong light.
* Print a nozzle check pattern to check the print head status.
If the pattern has gaps or horizontal white lines, the print head nozzle is blocked. Clean the print head.

=$ Checking for Nozzle Clogging
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4932

Cause

The print head cannot be calibrated because the printer is loaded with very transparent film-type paper.

What to Do
Tap OK on the touch screen to dismiss the error.
We recommend calibrating the print head with a frequently used, non-film paper.

=p Automatic Adjustment to Straighten Lines and Colors
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4933

Cause

The print head nozzle may be blocked.

What to Do

Follow the steps below to repeat Print head alignment.
1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.

=$ Checking for Nozzle Clogging

3. If the nozzle is blocked, clean the print head.

= Cleaning the Print Head

4. Repeat Print head alignment.

=) Automatic Adjustment to Straighten Lines and Colors
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4934

Cause

The print head nozzle may be blocked.

What to Do

Follow the steps below to repeat Print head alignment.
1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.

=$ Checking for Nozzle Clogging

3. If the nozzle is blocked, clean the print head.

= Cleaning the Print Head

4. Repeat Print head alignment.

=) Automatic Adjustment to Straighten Lines and Colors
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4935

Cause

The print head nozzle may be blocked.

What to Do

Follow the steps below to repeat Print head alignment.
1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.

=$ Checking for Nozzle Clogging

3. If the nozzle is blocked, clean the print head.

= Cleaning the Print Head

4. Repeat Print head alignment.

=) Automatic Adjustment to Straighten Lines and Colors
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4950

Cause
WPS (Push button method) connection failed.

What to Do

Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
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4951

Cause
AOSS (BUFFALO) connection failed.

What to Do

Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
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4952

Cause

Failed to connect to the wireless LAN router.

What to Do

Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
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4953

Cause

Failed to acquire IP address.

What to Do

Check the information that appears on the touch screen, and then try connecting again.
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4954

Cause

Failed to set up wireless LAN using Cableless setup.

What to Do

Tap OK on the touch screen to dismiss the error, and then configure the settings again.
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4955

Cause

IPv4/IPv6 settings were changed, but Wired LAN and Wireless LAN are set to Disable.

What to Do

On the touch screen, tap OK to dismiss the error, and then set Wired LAN and Wireless LAN to Enable.
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4956

Cause
Attempted to change LAN settings, but they cannot be changed for the following reasons.
* Printer is operating

« Printer currently being configured using RemoteUl

What to Do

Tap OK on the touch screen to dismiss the error, exit other processes and then configure the settings
again.
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4957

Cause
Raku Raku WLAN Start (NEC) connection failed.

What to Do

Tap OK on the touch screen to dismiss the error and try connecting again.
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4959

Cause
Direct connection failed.

It is also possible that a Direct connection request was made but a connection could not be established.

What to Do

Tap OK on the touch screen to dismiss the error and try connecting again.
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5106

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC03-4061
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5200

Cause

A printer error has occurred.

What to Do

Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes

EC21-2F76 EC21-2F77 EC21-2F78
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5A60

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC33-4020 EC33-4021 EC33-4022 EC33-4023 EC33-4024 EC33-4025

EC33-4026 EC33-4028 EC33-4029 EC33-402A EC33-402B EC33-402D
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5A61

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC3F-402F
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5B16

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC22-4001
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5B20

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes

EC25-4001 EC41-4001 ECA43-4001 EC44-4001 EC45-4001 EC47-4001
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5B21

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC48-4001
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5C00

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC31-4001
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6502

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC56-2FEQ
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6700

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC57-404F
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6702

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC57-4040
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6820

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC07-4060 EC51-4041 EC51-4042 EC51-4045 EC51-4046 EC51-4047

EC51-404C EC51-404D EC51-404E EC51-4070 EC51-4071 EC51-4072

937



6900

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3000

938



6901

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3001

939



6902

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3006

940



6910

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3002

941



6911

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3003

942



6920

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3004

943



6921

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3005

944



6930

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3100

945



6931

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3101

946



6932

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3102

947



6933

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3103

948



6940

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3104

949



6941

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3105

950



6942

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3106

951



6943

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3107

952



6944

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3108

953



6945

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3109

954



6946

Cause

A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3110

955



7001

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-401A

956



7003

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-405A

957



7004

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-405B

958



7050

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-5001

959



7051

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-5002

960



7052

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-5003

961



8200

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes

EC24-4049 EC24-404A EC24-404B

962



9000

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-2F07

963



9110

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes

EC52-4038 EC52-4039

964



B20A

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes

EC03-403A ECO03-403B

965



B510

Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the
power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC32-4001

966



